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How to use TeamForge 7.1

CollabNet TeamForge makes it easy and fun to manage all phases of the software lifecycle, from requirements
through release. You get software configuration management (SCM), continuous build and test, issue tracking, project
management, lab management, and collaboration tools, all in a single tightly-integrated, cloud-based platform that
empowers distributed teams to deliver great software.

For highlights of the many new features that TeamForge 7.1 offers, take a look at the release notes.

For downloading this Help as a PDF file, see Downloadable help.

Get started with CollabNet TeamForge 7.1

Take these steps to get started quickly and efficiently on your TeamForge 7.1 site.

e Note: If you are coming to TeamForge from a CollabNet Enterprise Edition site, see Moving to a CollabNet
TeamForge project from a CollabNet Enterprise Edition project on page 205 for guidance on how to keep
doing what you were doing on your old site.

Quick start: Working on a TeamForge project
Jump right in! Join a project, check out the code, meet your collaborators.

Join a TeamForge site
To collaborate with others on a CollabNet TeamForge site, start by getting a user account.

e Note: You need a license to use a TeamForge site. Your site administrator may have already assigned you a
license. If not, you'll be asked to choose the type of license you need when you create your account.

* An ALM license enables you to use the full set of tools on the site, including Source Code, Trackers,
Documents, Tasks and Reports.

* An SCM license enables you to use the site for basic source code management. You can browse
repositories and participate in Wiki conversations.

1. If your site authenticates through LDAP, follow these steps.
If your site does not authenticate through LDAP, skip to the next set of steps.

a) Inthe Log Into CollabNet TeamForge section of the site home page, enter your corporate LDAP user name
and password.

.:_ Tip: In most cases, your user name and password are the user name and password with which you log
in to your corporate network.

b) Click Log In.
¢) On the Create Account page, re-enter your LDAP password.
d) Enter your full name and email address and click Create.
2. Ifyour site does not authenticate through LDAP, follow these steps.
a) Click Create an Account in the New Users section of the CollabNet TeamForge home page.
b) On the Create New Account page, enter a user name for your account.

e Note: Your user name must meet these criteria:

» User name is case sensitive.
¢ Minimum number of characters as specified in the site-options.conf file.
* No spaces.
* Should have at least one letter.
» The first character is a letter.
c) Enter and confirm a password.
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d) Fill in the rest of the fields and click Create.
3. Check your email at the address that you provided.
4. Follow the link in the email to the Log In page.

5. Enter your user name and password, and click Log In.

Your CollabNet TeamForge account is now activated.

Join a project
To create, store, and share work on a CollabNet TeamForge site, first join a project.

1. Log into CollabNet TeamForge .

2. On your My Page, click Projects in your personal navigation bar.
Now you're looking at the projects of which you are already a member, if any.

3. Click the All Projects tab to see all CollabNet TeamForge projects you can see, based on each project's access
settings.

4. Select the project you want to join and click Request Membership.

5. On the Request Project Membership page, explain why you want to join the project, and click Submit.
Your request is submitted to the project administrator for approval. You will receive an email notification when
your request is either approved or denied.

' Tip: You can also request project membership by clicking Join this Project on the home page of the project
you want to join.

Identify yourself
To help get started on collaborating with other project members, you can provide some information about yourself.

This information appears whenever someone clicks your name anywhere on the site. For example, when an artifact is
assigned to you, your name appears as a link that other users can click.

1. Click My Workspace in the CollabNet TeamForge navigation bar.

2. Click My Settings in your personal navigation bar.

3. On your User Details page, in the User Details section, click Edit and provide some information to help potential
coworkers get to know you.

a) Click Browse to upload a 100-by-100-pixel picture of yourself, or of something that suggests who you are.
b) Under Detail, provide a summary of your interests, skills, or other characteristics.
4. Seclect the language you prefer to use. You can choose to receive emails from your TeamForge site in English,
Chinese, Japanese, or Korean.
.:_ Note: If your browser is set to use one of the available languages, you should already be seeing
TeamForge in that language in your web browser.
5. If necessary, review and change your password, official name, and email address.
e Note: This is the email address where you receive alerts about changes to items you are involved with,
such as a discussion forum you are monitoring or a code commit associated with an artifact you created.
6. Click Save.

Change your password

To protect the security of your TeamForge account, change the password regularly.
1. Click My Workspace in the CollabNet TeamForge navigation bar.

Click My Settings in your personal navigation bar.

In the User Details section, click Change Password.

In the My Workspace / Change Password page, enter your current password.

AN o

Enter your new password and confirm it.

The password requirements depend on the security policies enforced on your site. Here's an example:
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Current Password:® sanan

Mew Passward:® ﬂ A p——

Confirm Mew

6. Click Update.
You will see a message that your password was changed successfully.

Get the code
Browse CollabNet TeamForge to find the code you want to work on, then check out the code.

You can view the contents of each file in a repository, plus additional information about each file such as revision
history, comments, date and time of submission, and branch and tag information. You can also view differences
(diffs) between any two files.

' Note: You can see only those paths in the repository that the repository administrator has given you access
to.
' Note: If you're getting code from a Subversion replica repository, the TeamForge account used while setting

up the replica determines what's available to be checked out. This account could have been provided total
access to the master repository, or restricted access using path-based permissions.

1. Click Source Code in the project navigation bar.

2. On the list of project repositories, click the name of the repository in which you want to view code.
For each file, the revision number, time since check-in, author, and last log entry appear in the Repository
Browser.

* To view a file, or to view the diffs between two files, click the file name.
» To view a specific version of the file, click Download.
» To view the differences between two files, do either of these:

* Click [select for diffs] next to each of the two files that you want to compare.
+ Enter the file revision numbers in the Diffs between boxes at the bottom of the page.
3. If you need to diff files, choose a display from the Type of Diff menu, then click Get Diffs.
The differences between the two files are displayed.

4. Use your source control client to check out the code to your local machine.

Find a forum
Read through a project's discussion forums to find out about the project's plans, accomplishments, and challenges.

1. Click Discussions in the project navigation bar.
The Forum Summary page displays a list of all project forums, and summary information about each forum's
activity.

2. Click a forum name.
The Topic Summary page displays a list of all forum topics and summary information about each forum topic's
activity.

3. Click a topic name.
The Forum Topic page displays all messages that have been posted in response to the original forum topic.

You can configure your view in the following ways:

* To set the number of messages that display on each page, choose a value from the View menu, then click
Update.

» To display threaded messages, choose one of the following options, then click Update.
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* Nested - by Reply - Displays threaded messages in a hierarchical, nested format of up to 20 layers. This is
the default display.
* Flat - Chronological - Displays all messages in chronological order with no nesting.

Catch up on project news
Watch project news updates to stay up to date on events that might affect your participation in the project.

News items appear on the project home page, on the News tab of each user's My page, and on the CollabNet
TeamForge home page.

1. Go to the project home page.

* From within the project, click Project Home in the project navigation bar.
* From anywhere else in CollabNet TeamForge , choose the project from the Projects menu in the CollabNet
TeamForge navigation bar.

2. Look for news items at the bottom of the project home page.

Each news item lists its author and the date it was posted.

Find project resources
When you want to search for TeamForge objects such as tracker artifacts or documents, you can quickly search using
a unique identifier or a keyword or you can perform an advanced search.

.:_ Tip: In addition to the Jump to ID search, you can select an object category from the drop-down list and
search within the selected object category. You can also select Advanced Search from the drop-down list to
perform an advanced search.

1. Log on to TeamForge.

' Note: If you are not logged on, you can search only projects and items that have been designated public.

2. If you know the unique identifier of an object and want to quickly go to the object, type the unique identifier in the
Jump to ID text box and click the search icon.

' Note: The default quick search option is Jump to ID.

3. Ifyou want to do a keyword search of a specific object type (such as documents or discussions), type the keyword
in the text box, select an object type from the drop-down list and click the search icon.

The following table lists the search-able object types you can select from the drop-down list.

Searchable object types Description

Discussions Select this option to search in discussion forums.
Documents Select this option to search for documents.

File Releases Select this option to search in file releases.
News Select this option to search project news.
Project Pages (Visible) Select this option to search project pages.
Projects Select this option to search projects.

Source Code Select this option to search the source code.
Tasks Select this option to search for tasks.

Trackers Select this option to search for tracker artifacts.
Users Select this option to search for users.

Wiki Select this option to search in Wiki pages.

4. If you want to perform an advanced search, select Advanced Search from the drop-down list.

5. On the Search Criteria page, enter the keywords to search for.
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6. Select the Search Attachments check box and the Search Comments check box if you want to search
attachments and comments respectively.

Attachments refer to tracker artifact attachments. Comments refer to tracker artifact comments and task comments.

7. Select one of the two options, Search Active Versions Only or Search All Versions, to specify whether you
want to search active document versions only or all document versions respectively.

Searching only active document versions allows you to eliminate search results for outdated documents.
8. Click Search.

Your search results are organized by TeamForge application. The search score indicates the relevance of each result
to your search criteria.

o Note: You can see only those items that your project membership and permissions allow you to see.

Filtering tables
Filtering lets you view a subset of a list of items that match your filter criteria.

The TeamForge application uses tables for presenting list of items such as tracker artifacts, documents, tasks, and so
on. You can filter a subset of a list of items that meets your filter criteria on all the tables with filter fields.

1. o Note:

You can find a filter field at the top of each column in most of the tables in the TeamForge application.
The filter field could be a text box or a drop-down list.
You can type your filter criteria in the text boxes. The search text is case-insensitive.

You can also select the filter values from one or more drop-down lists. By default, you can only select
up to five filter values in a drop-down list. However, you can set a value that suits your requirement for
the FILTER DROPDOWN_MAX SELECTION token in the site-options.conf file to increase
or decrease the count.

Some search filters may not appear if your site administrator has not enabled them.

Specify the filter criteria in one or more filter fields (at the top of each column) and click Filter.

Table filter drop-down list with multi-select check boxes

Stories (11 Iltems)

Artifact

art

art

art

art

art

art

2. After filtering, if you want to save a filter for future use:

a) Click Filter and select Save from the drop-down list.
The Save Filter As window appears.

b) Type a name for the filter in the Filter Name text box.

c¢) Click Save.
The filter is saved. You can view and select the saved filters at a later point in time by clicking the Filter drop-
down list.
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Note: You can save filters only in specific contexts. This feature may not be availabe in all the tables
where you can filter table list items.

[

3. After filtering, if you want to clear the filters, click Filter and select Clear from the drop-down list.
4. To delete saved filters:

a) Click Filter and select Delete from the drop-down list.
The Select Filters To Be Deleted window appaers

b) Select one or more filters to delete.

e Tip: Press and hold the Ctrl key to select more than one filter.

c¢) Click Delete.

A message suchas 2 tracker filter(s) have been deleted successfully. isdisplayed if
the process was successful.

Quick start: Managing a TeamForge project
Jump right in! Set up your project site, add your project members, plan out your work.

Create a TeamForge project
Create a new project when you have identified work to be done that has its own distinct character, dependencies or
schedule.

What constitutes a project depends on your organization. Some organizations favor a small number of big, centralized
projects. Others prefer a larger number of smaller, specialized projects. Your site administrator can help you decide if
your work should be part of a larger project or a project of its own.

1. On your TeamForge site's main page, click the Projects drop-down list and select Create New Project.

2. On the Create Project page, give the project a name and a brief description.

* The name will appear in project lists and on the project's home page.
* A terse description is recommended. There will be unlimited room to discuss the project's aims and methods in
detail on the project pages themselves.

3. Provide a URL name for the project, if you want the URL for the project to be different from the internal project
name.
If you do not enter a URL name, the project URL will be the same as the project name.

4. If your site administrator has provided project templates, select the appropriate one for your new project.
Project templates give you ready-made artifact types, work flow support, user roles and other start-up content
appropriate to the kind of project you are creating.

5. Click Create.

The project is submitted to the CollabNet TeamForge site administrator for approval. You will receive an email
notification when the site administrator approves or rejects your project. When your project is approved, you can get
to it from your My Projects page or from the Projects menu in your navigation bar.

Add users to a project
Before a person can work on a project, you have to make him a member of the project.

You can make any registered user on your CollabNet TeamForge site a project member. You can assign roles to the
user at the same time.

Note: Project members, roles and the associated permissions can be inherited via project hierarchy and
reused in subprojects. If your project is a subproject of any other project, you may have inherited some roles,
project members or user groups.

[

Click Project Admin in the project navigation bar.

On the Project Admin menu, click User Membership.

Click Add.

On the Add User page, find the users you want by one of these methods:

Col ol
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» Under Search for Users, filter the list of site users eligible to join this project. You can filter by full or partial
name or user name.

e Note: Search text is not case-sensitive.

* Browse the list of registered users on the site. Sort them by name, user name, email address or membership
status.

The inherited project members continue to hold the inherited roles with corresponding permissions, as
specified in the source projects.

e Note: If a site has a great many users, you must filter them first to narrow down the list. This helps
avoid slowing down the system.
Select the users you want to add.
Under Assign Roles, select the roles you want the users to have.
' Tip: If you prefer, you can skip this step and assign roles later on the Project Admin > Permissions

page. Note that using the Assigned Project Members page, you can assign roles only to the direct project
members.

Save your changes.

* Click Save to return to the Project Membership page.
* Click Save and Add More to keep adding users.

Create a project page
To provide information and functionality to people viewing your project, build one or more project pages.

1.

6.
7.

Go to the page to which your new page will belong.

' Tip: Any project page can have sub-pages belonging to it. A page that belongs directly to the project
home page is called a "top-level page."

Click Configure: On.

. Choose where your new page will fit in your project's structure.

» To create a page just under the project home page, click Add top-level page.

A top-level page's title is always visible in the navigation tree at left.
* To create a page under the page you are on right now, click Add sub-page.
Give your new project page a title.
Keep the title brief and descriptive.

Choose who can see this page.

' Note: Your choice will apply to all subpages that you create under this page.

» To show this page to anyone with the necessary permissions, select Visible. For example, if you have defined
a group of users who have access to your project, your new project page is visible only to those users. If your
project is open to the public, anyone in the world can see it. Use this option when the information on this page
is ready for a wide audience.

* To show this page only to users with the project administrator role, select Hidden. Use this option if you are
drafting content that you aren't ready to share yet, or want to share only with other project managers.

Click Save.
Click Configure: Off.

Now you are ready to build functionality into your project page with components such as text, news or tracker
queries.
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Create a tracker
Create a tracker whenever you need to report and track bugs, feature requests, support requests, or any other type of
issue where ownership, status, and activity must be managed.

Individual tracker entries are referred to as tracker artifacts. A tracker is a set of tracker items with a common
purpose, such as bug reports, feature requests, or tasks.

1. Click Project Admin in the project navigation bar.

Click Tracker Settings.

Click Create.

On the Create Tracker page, provide a name and description for the tracker.

Eal o

e Tip: Descriptions help users learn how best to provide the information you want from them. To maximize
your chances of getting useful data, make your description as informative as you can.

5. Select an icon that suggests the type of work the tracker is handling.

This icon will appear with any artifact in this tracker, wherever it is viewed on the site. For example, if someone
brings an artifact from this tracker into a planning folder, users of the planning folder can glance at the artifact's
icon to see where it comes from.

6. Select the relevant unit from the Display Effort in field. The units displayed here are configured based on the
size of the artifacts in the tracker. Eg. Select the unit as Hours for a tracker of small defects, Days for a tracker of
tasks, and Weeks for a tracker of epics.

.:-_ Note: Configure the units at the project level and not at the planning folder level.

7. Click Create.
The new tracker appears at the bottom of your list of trackers.

8. If necessary, drag the tracker to a place in your tracker list that makes sense.
The order you set here controls the order of every tracker list in your project.

9. You'll probably need some custom fields to capture information that's specific to your project.
See Create your own tracker fields on page 29.

10. To speed up the team's work, you may want to set up some rules for automatically reassigning artifacts when their
contents change.

See Create a tracker work flow on page 31.
Create a planning folder
Create and populate all the planning folders you need to capture the work you are planning.
A planning folder is a way to organize work into feasible chunks and monitor its progress.

e Tip: It often makes sense to set up planning folders affer you have outlined and analyzed the features you
plan to deliver. See Define the scope of your project on page 101.

When you've thought about the general categories the work falls into, you are ready to create planning folders that
reflect those ideas.

A planning folder can represent:

* A set of tasks, such as Iteration 3, or "Initial infrastructure development."

» A period of time, such as "April," or "Q2-2010."

* A phase of development, such as "Testing" or "Deployment."

* A component of the product, such as "Chapter 12" or "Rear stabilizer."

1. Click Trackers in the project navigation bar.

2. Under Planning Folders, click Root Folder, then New.

3. In the view, right-click the Planning Folders node or an existing planning folder and select .
A planning folder in the has the same context menu option.

4. Give your planning folder a brief and descriptive name.



| How to use TeamForge 7.1 | 14

For example, in an agile project, you'll probably want two or more iterations. Make a planning folder called
"Iteration 1," another called "Iteration 2," and so on. In a phased, waterfall-style project, you might name your first
planning folder "Design," the next "Build," and so on.

' Tip: Don't worry if you don't have anything of interest to put into your planning folders yet. The parallel
process of filling out the feature tree will provide plenty of material for this.
5. Use the Description to briefly signal the kind of work that will be contained in this planning folder.

Include enough information to help people get up to speed quickly whey they join your project. But save most of
the detail for the individual tracker artifacts, where project members will spend most of their time.

6. Select a start and end date for the work that this planning folder will contain.

You can change these dates at any time. It's important to specify dates even if they're not firm, however, because a
variety of useful visual aids and reports depend on them.

7. Click OK.

Set up hardware for your team to use

When you set up Lab Management, your team members can use TeamForge to access their own virtual machines for
developing and testing.

Get CollabNet TeamForge Lab Management .

On the Project Admin menu, click Linked Applications.

On the Linked Applications page, click Create.

On the Create Linked Application page, enter the name Lab Mgmt.

Enter the server location or URL of your Lab Management server.

A S o

If you are a CollabNet TeamForge administrator, select whether you want to use single sign-on for the linked
application.

» If you use single sign-on, CollabNet TeamForge manages authentication for Lab Management, and users don't
have to log into Lab Management after they have logged into CollabNet TeamForge.

» Ifyou do not use single sign-on, users must log into Lab Management using its native authentication system.
7. Click Browse and select this icon for the linked application:

i

This icon will appear with the name Lab Mgmt in the project navigation bar.
8. Click Save.

A Lab Mgmt button is added to your project navigation bar. Clicking it launches the application in the main
CollabNet TeamForge project window.

Contribute to a CollabNet TeamForge project

CollabNet TeamForge is a set of integrated tools designed to make your collaborative experience more efficient,
productive and fun.

Plan and track anything

Use the issue tracking system to track and manage everything from requirements, user stories, and feature requests to
defects, build issues, and customer support cases.

Project administrators can model any desired lifecycle process by customizing tracker fields to correspond to the
different states required, defining a work flow that governs the transitions between those states, and specifying which
users can make those transitions.


http://www.open.collab.net/products/CUBiT/
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Estimate effort for agile development
Once the product features have been sketched out, if falls to the project team to figure out what it will take to deliver
them.

Effort estimates are almost always more accurate when they address small, discrete chunks of work. But you need to
forecast effort for a large, complex undertaking. TeamForge helps bridge this gap by dynamically calculating effort
estimates at multiple levels.

There are two ways to determine the effort involved in an artifact:

» Break the work down into discrete chunks, then use your experience and judgment to come up with a real-world
estimate for this artifact.

* Have the effort estimates for all the artifact's children (if any) automatically added and shown in this artifact.
You will be using a combination of these techniques as you work through the estimating process.

Analyzing the work is an iterative, interactive process. As you go through it, you'll find your effort estimates changing
shape in response to feedback from scoping the product and planning out the work.
1. With your team, review the artifacts the product owner has created.
How much effort will each one require? Do any of them require special skills or training? Record your
observations about each artifact in its Comment field.

e Note: This is a rough cut. Don't try to come up with a final effort estimate yet.

2. For each user story, identify the specific tasks that will be required. Create an artifact to contain each of these
tasks.
Declare each of these task artifacts a "child" of the initial artifact.

Now you can attempt to estimate the work involved in each task artifact. This will be the raw material for your
higher-level effort estimates and progress tracking.

3. Back in the "parent" artifact, select Sum effort from children.
Now this artifact's effort ficld shows the total of the effort units assigned to each of its "children."

Note: If an artifact has children that belong to another project, the effort value for those child artifacts is
not counted.

[

4. As you proceed, you will find the overall picture taking on definition.

Relationships among artifacts will emerge, and many of them will seem to fall into one logical group or another.
Let these groupings determine the names and purposes of your planning folders.

Find tracker artifacts

The tracker contains a comprehensive search system that enables you to find a specific artifact or set of artifacts
quickly.

View the right tracker columns

When you're looking at the artifacts list in a tracker or a planning folder, you can can select the columns you want to
see, either for this session or permanently.

You set your column preferences for each tracker or planning folder independently. If your project administrator has
set default columns for the entire project, your individual column choices override those settings.
1. Click Trackers in the project navigation bar.
2. Select a tracker or planning folder and click Columns > Configure.
» Ifyou've already saved a column configuration, click it and skip the rest of these steps.

* To go back to the default column configuration, click System (default) and skip the rest of these steps.
» To set up a new configuration, click Configure.

3. Choose your columns.
a) Move the columns you want from Available Columns to Selected Columns.

Artifact ID : Title, Priority and Status are required columns.
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o Note: Selecting more columns can increase the time required to load the listing page.

b) Remove any columns you don't need from Selected Columns.
c) Use the Move Up and Move Down buttons to change the display order of the columns.
4. Apply your choices to your view of the tracker.

* To use this arrangement this time only, click Apply. The next time you log in, you'll start with the default view
again.

* To save your column layout for repeated use, click Apply and Save, then give your arrangement a name. The
next time you log in, you'll see the column arrangement you just selected. (If you've sorted the records in your
view, that sort order is saved t00.)

o Tip: If you are editing a column configuration that already exists, you can rename it by saving it
under a new name.

5. To make the same set of columns appear every time you come to this tracker or planning folder, select Make this
my default view.

View the right tracker artifacts
When a large number of tracker artifacts makes it difficult to find the one you want, filter and sort the list to narrow
down the possibilities.

1. Click Trackers in the project navigation bar.

2. On the Tracker Summary page, click the title of the tracker in which you want to look at artifacts.
3. o Note:

*  You can find a filter field at the top of each column in most of the tables in the TeamForge application.

» The filter field could be a text box or a drop-down list.

*  You can type your filter criteria in the text boxes. The search text is case-insensitive.

*  You can also select the filter values from one or more drop-down lists. By default, you can only select
up to five filter values in a drop-down list. However, you can set a value that suits your requirement for
the FILTER DROPDOWN MAX SELECTION token in the site-options.conf file to increase
or decrease the count.

* Some search filters may not appear if your site administrator has not enabled them.
Specify the filter criteria in one or more filter fields (at the top of each column) and click Filter.

Table filter drop-down list with multi-select check boxes

Stories (11 Iltems)

Artifact

art

art

art

art

art

art

4. After filtering, if you want to save a filter for future use:
a) Click Filter and select Save from the drop-down list.
The Save Filter As window appears.
b) Type a name for the filter in the Filter Name text box.
c¢) Click Save.
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The filter is saved. You can view and select the saved filters at a later point in time by clicking the Filter drop-
down list.

Note: You can save filters only in specific contexts. This feature may not be availabe in all the tables
where you can filter table list items.
5. To delete saved filters:

a) Click Filter and select Delete from the drop-down list.
The Select Filters To Be Deleted window appaers

b) Select one or more filters to delete.

[

. Tip: Press and hold the Ctrl key to select more than one filter.

c) Click Delete.

A message such as 2 tracker filter(s) have been deleted successfully. isdisplayed if
the process was successful.

6. After filtering, if you want to clear the filters, click Filter and select Clear from the drop-down list.
7. Use the up-down arrow at the top of any column to sort your list by that column.

* Your primary sort column is identified by a superscript 1 next to the up-down arrow, and your secondary and
third-level sort columns, if any, are likewise marked.

* Click the up-down arrow again to reverse the sort order.

View the right planning folder artifacts

When a large number of artifacts in a planning folder makes it difficult to find the one you want, sort the list to

narrow down the possibilities.

1. Click Trackers in the project navigation bar.

2. Select the planning folder you want.
Tip: If there are dozens of planning folders in the list, try toggling to view only the Active planning
folders.

3. Use the up-down arrow at the top of any column to sort your list by that column.

* Your primary sort column is identified by a superscript 1 next to the up-down arrow, and your secondary and
third-level sort columns, if any, are likewise marked.

* Click the up-down arrow again to reverse the sort order.

Tip: You can also drag and drop a planning folder's contents into relative positions based on the sequence in
which you plan to address them.

[

Search atracker

If the filter returns too many results or not enough, try the search facility.

Search for tracker artifacts

Find tracker artifacts by supplying a keyword, an artifact ID, a date range or some other value.

You can also search comments, attachments, and user-defined fields.

1. Click Trackers in the project navigation bar.

2. Set the scope of your search.

» To search all the trackers in your project, click Search Tracker
» To search a specific tracker, click the tracker you want to search, then click Search Tracker in that tracker's
list view.

3. On the Tracker Search Criteria page, enter the keywords to search for.

' Note: Wildcards are allowed.
4. Select the elements of the artifact to search.
For example, to search for a keyword in the title and description fields select All Text Fields. To search for a
keyword in the comments field, select Include Comments.
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' Note: User-defined text fields are not included.

5. If you know the artifact's ID, enter that.

6. Click the calendar icon to select dates, if appropriate. You can also specify relative dates such as "Within the last 7
days".

7. Use as many of the remaining tracker fields as seems useful.

8. Click Search.

All tracker artifacts matching your search criteria are displayed.

.:_ Note: If your search included muliple trackers, the icon next to each artifact in your search results can help
you identify which tracker that artifact belongs to.

Find your own artifacts
To narrow your scope, try searching only for artifacts assigned to or submitted by you.

1. Click Trackers in the project navigation bar.

L

On the list of project trackers, click the title of a tracker.

w

In the tracker artifact list view, click Search Tracker.

>

On the Tracker Search Criteria page, select the User running search option in the Assigned To or Submitted
By fields.

5. Click Search.
All tracker artifacts matching your search criteria are displayed.

Save a search for tracker artifacts
To reuse a search that you devised for tracker artifacts, save the search criteria.

To be able to save your search, you must first select a tracker, and create and run your search.

1. In the Tracker Search Results section, click Save Search.

2. Inthe Save Search As page, enter a descriptive name for the search, and click Save.

The search appears under My Saved Tracker Searches. The name of the search, the tracker for which it was run, the
criteria used, and a system-assigned ID are displayed

Share a saved tracker search
To enable other users to use a search that you have devised, save it as a shared search.

To share your search with other users, you must be a tracker administrator.

1. In the Tracker Search Results section, click Save Search.

2. Inthe Save Search As page, enter a descriptive name for the search.

3. Select the Shared Search option.

The search appears under Shared Tracker Searches. The name of the search, the tracker for which it was run, the
criteria used, the user who created the search, and a system-assigned ID are displayed.

Run a saved search

To find artifacts in the current tracker or a different one in the project, run a saved search in the appropriate context.
1. Click Trackers in the project navigation bar.

On the list of project trackers, click the title of a tracker.

In the tracker artifact list view, click Search Tracker.

Select the Show My Searches Across Trackers and Show Shared Searches Across Trackers options.

AN Sl ol

Expand the My Saved Tracker Searches and Shared Tracker Searches sections.
The saved searches for all trackers in the project are displayed.

6. To run a search for the current tracker, click the Search or Search Here link below the search name in the
required search.
All artifacts in the current tracker, that match the search criteria, are displayed.

7. To run a search for a different tracker, click the Search There link below the tracker name in the required search.
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All artifacts that match the search criteria in the selected tracker, are displayed.

Remove a saved search
To remove a saved search for tracker artifacts, delete it from the list of personal or shared searches.

.:-_ Note: Only tracker administrators can remove a shared search.

Click Trackers in the project navigation bar.

On the list of project trackers, click the title of the tracker in which you want to delete a saved search.

In the tracker artifact list view, click Search Tracker.

Expand My Saved Tracker Searches or Shared Tracker Searches so that the available searches are displayed.
Select a search and click Delete.

A e o

Accept the confirmation message.

The search is removed from the table where you deleted it.

Create a tracker artifact
Create a tracker artifact whenever you need to report and track a bug, feature request, support request, or other type of
issue.

Individual tracker entries are referred to as tracker artifacts, or just artifacts.

1. In any tracker or planning folder view, click Submit New Artifact in and select the tracker in which you want to
create your artifact.
By default, your new artifact is created in the tracker or planning folder you are currently looking at.

2. Answer the questions posed by the required fields.

. Note: Different trackers will have different combinations of fields to fill out, depending on what the
tracker administrator has set up.

a) Provide a Title and Description that summarize the issue or work item in a few words.

' Tip: Descriptions help users learn how best to provide the information you want from them. To
maximize your chances of getting useful data, make your description as informative as you can.
b) For Priority, select a value that expresses the importance or urgency of the work you are describing.
c) Assign the artifact to a project member by choosing a name from the Assigned To list.
' Note: If your project administrator has configured the tracker to automatically assign artifacts to
project members, you can skip this step.
d) Select the planning folder that the work belongs to from the Planning Folder list.

3. Record any other information that may be appropriate.
For example, if your project is using a Scrum-based methodology, your project manager may have provided a
Story Points field to track estimates of relative effort.

4. Add a file attachment, if appropriate.

5. Save your changes.

Create a tracker artifact by email
To create a tracker artifact without being logged into CollabNet TeamForge , send an email to the tracker.

You do not have to be logged into CollabNet TeamForge to submit a tracker artifact using email, but you must have
the tracker submit permission for the tracker to which you are submitting.

Send an email message to <tracker id>@< TeamForge server>.

. Tip: You can find the tracker ID on the List Artifacts page.
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TeamForge maps your email to the tracker record like this:

Email field Tracker field

To Tracker email address
Subject Artifact title

Body Artifact description
Attachments Attachments

Edit a tracker artifact
Updating the information in tracker artifacts is one important way that project members can work together effectively.

When work has been done on a tracker item, or more information is needed, the project member to whom the item is
assigned should update the item's status accordingly. Comments from other project members help the artifact's owner
decide how to handle the work.

For example, when the work defined in the tracker item is completed, change its status from Open to Fixed.

Your tracker administrator may have set up work flow rules that constain your ability to do certain kinds of updates.
For example, an administrator may have specified that only users with the "QA Engineer" role can change an artifact's
status from Open to Closed.

A project manager might also change an artifact's priority, return it to the submitter for additional clarification, or
assign it to a project member for resolution or action.

Generally, the project member to whom the tracker artifact is assigned will update the status. Any project member
with the appropriate permissions can add comments.

o Tip: Each comment in an artifact or task has a unique ID with its own URL. To link directly to a particular
comment, copy that comment's URL and paste it into an email, a project page, or another comment. For
example, to point to the third comment in artifact 12345, write art £12345#3 in your comment. (If
the artifact or task you are linking to is on a different site, give the complete URL, like this: http://
mysite.com/sf/go/task1234#3.)

Click Trackers in the project navigation bar.

On the list of project trackers, click the tracker you want to update.

On the List Artifacts page, select the tracker artifact you want to update.

On the View Artifact page, click Edit.

Eal A
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5. On the Edit Artifact page, make your changes.
a) Select a tracker type from the Tracker drop-down list to change the artifact's tracker type.
b) Edit the artifact's title and description.
c¢) Click Save.

6. On the View Artifact page, change any other fields if required, and click Update.

All updates to the artifact are recorded in the Comments section of the Status/Comments tab.

Edit a tracker artifact by email
To comment on a tracker artifact when you are not logged into CollabNet TeamForge, send an email to the tracker, or
reply to an automatic update email about the artifact.

You can also add a comment or an attachment to a tracker artifact that you are monitoring by responding to the
monitoring email notification.

You can also use email to add an attachment. But to edit any other fields, you must make the changes in CollabNet
TeamForge.

You do not have to be logged into CollabNet TeamForge to edit a tracker artifact using email, but you must have the
tracker edit permission for the tracker containing the artifact you want to edit.

s Tip: Each comment in an artifact or task has a unique ID with its own URL. To link directly to a particular
comment, copy that comment's URL and paste it into an email, a project page, or another comment. For
example, to point to the third comment in artifact 12345, write art £12345#3 in your comment. (If
the artifact or task you are linking to is on a different site, give the complete URL, like this: http://
mysite.com/sf/go/taskl1234#3.)

Send an email message to <artifact id>@<CollabNet TeamForge server>.

s Tip: You can find the artifact ID on the Artifact Details page.
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TeamForge maps your email to the tracker record like this:
Email field Tracker field
To Tracker email address

Subject Artifact title
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Email field Tracker field
Body Artifact description
Attachments Attachments

Change multiple artifacts
When you have a large number of artifacts to update (for example, all the artifacts in a tracker, or a filtered list of
artifacts in a planning folder), you can edit all the artifacts at once.

Note: When you update two or more artifacts at a time, each user who is monitoring any of the changed
artifacts gets a single email describing all the updates.
1. Click Trackers in the project navigation bar.

2. Go to the tracker or planning folder that contains the tracker artifacts you want to edit.

.:_ Tip: In a tracker, you can use the filter to help you find the desired artifacts.

3. Select the artifacts you want to edit, and click Mass Update.
4. For artifacts in a tracker, choose which ones you want to update.

» Selected - Updates only the artifacts that you selected.

» Filtered Set - Updates all artifacts returned by your filter, or all artifacts in the tracker if you did not apply a
filter.

' Tip: Choose Filtered Set when the artifacts span multiple pages and you want to select them all.

5. Make your changes and click Update.

.:_ Important: Some fields in your tracker may have values that depend on values in other fields, or use
validation rules to ensure correct content. If your mass update operation breaks any such dependencies, you
must fix the errors before running the mass update.

Edit multiple artifacts inline
When you have a list of tracker or planning folder artifacts to update, you can edit all the artifacts inline at once.

1. Click Trackers in the project navigation bar.

2. In the List Trackers and Planning Folders page, click the tracker or the planning folder that contains the
artifacts you want to edit inline.

3. Inthe List Artifacts page, click Edit Inline.
To help you identify editable columns, all non-editable columns are disabled. You can see a hand symbol when
you hover the mouse pointer over the editable columns.

4. Click a field in a column and edit the selected artifact.
For example:

* Clicking a field in the Assigned To column lets you edit the person assigned to the specific artifact.

* Clicking a field in the Planned For column displays the Planning Folder dialog box to let you change the
planning folder for the specific artifact.

5. When you are done, click Save.

Move a tracker artifact
As work proceeds on a tracker artifact, its focus may change. If this happens, it may be appropriate to move the
artifact into a different tracker, or to a tracker in a different project.

To move a tracker artifact between projects, you must have either the tracker administration permission or tracker
'view, submit and edit' permissions in both the source and destination projects.

e Important: Tracker 'delete' permission is not required to cut and paste tracker artifacts.

You can move one or more tracker artifacts in the same operation.
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1. Click Trackers in the project navigation bar.
2. On the list of project trackers, click the title of the tracker containing the tracker artifact that you want to move.
3. Select the tracker artifact (or artifacts) that you want to move, and Then click Cut.

CollabNet TeamForge removes the tracker artifacts and places them on the clipboard.

4. Go to the tracker into which you want to paste the tracker artifacts.

e Note: To move the tracker artifacts into another project, first find the destination project using your
Projects menu.

5. Click Paste.

+ Ifall artifact assignees have the appropriate permissions in the destination tracker, the tracker artifacts are now
moved.

» Ifnot, the Paste Artifacts window tells you how many tracker artifacts cannot be reassigned automatically.
6. Choose one of the following methods to reassign any unassigned tracker artifacts.

» Reassign Artifacts to: - Assigns all unassigned tracker artifacts to the project member you select.
* Miyself - Reassigns all unassigned tracker artifacts to you.
7. Click Next.

The tracker artifacts are now moved to the destination tracker. The details of the move are recorded in the Change
Log tab of the Artifact Details page.

+ If the project members to whom the tracker artifacts are assigned have the appropriate permissions in the
destination project, the tracker artifacts are automatically reassigned to the same project members. If not, you are
offered several options for reassigning them.

» Ifboth trackers use the same user-defined fields and field values, values in these fields are retained.
» If each tracker uses different user-defined fields or field values:

* Values are set to the default value, if one was specified by the tracker administrator. Default values are

mandatory for required fields.
* Values are set to None, if no default value was specified by the tracker administrator.

Associate tracker artifacts with other items

You can connect tracker artifacts with other CollabNet TeamForge items such as documents or topics. Creating
associations between items enables you to define relationships, track dependencies, and enforce work flow rules.
Associate a tracker artifact with a document, task, integrated application object, or forum

When a tracker artifact is related to other CollabNet TeamForge items, such as tasks, documents, integrated
application objects, or discussions, you can connect the tracker artifact to the other item by creating an association.

Creating associations between items helps you to define relationships, track dependencies, and enforce work flow
rules.
1. Click Trackers in the project navigation bar.
2. On the list of project trackers, find the tracker artifact with which you want to create an association.
Use the filter if needed.
3. Click the artifact title.

4. On the Artifact Details page, click the Associations tab.
The list of existing associations appears.

5. Click Add.

6. Inthe Add Association Wizard window, select the items with which you want to associate the artifact:
* Enter Item ID - If you know the item's ID, you can enter it directly.

.:-_ Note: To associate an object in an integrated application from within CollabNet TeamForge, use the
[<prefix objectid>] format. Successful associations appear hyperlinked.

' '[}‘Iip: Elat():h integrated application displays its prefix on moving the mouse over the application name in
the tool bar.



| How to use TeamForge 7.1 | 24

* Add From Recently Viewed - Sclect one of the last ten items you looked at during this session.
* Add From Recently Edited - Select one of the last ten items you changed.

7. Click Next.
8. Inthe Add Association comments window, describe the reason for the association.
9. Save your work.

e Click Finish and Add Another to add additional associations.
* Click Finish to return to the Details page.

Note: To remind yourself of the details of the association later, look in the Change Log tab of the associated
Artifact Details page.

[

Associate a tracker artifact with a file release
To track the source and resolution of a bugs or a feature request, associate its tracker artifact with the file release in
which it was discovered and fixed.

Tracker artifacts associated with file releases are also displayed separately, providing a simple way to track all issues
that were discovered in or fixed in a specific file release.

.:-_ Tip: You can also add associations from the tracker artifact's Artifact Details page.

1. On the Project Administration page, enable both the Reported in Release and Fixed in Release fields.

* Reported in Release - When submitting a new artifact, the user can choose from a drop-down list of all
releases in the project to identify the release in which the issue was discovered.

» Fixed in Release - After the issue is fixed, the user can choose from a drop-down list of all releases in the
project to identify the release in which the issue was fixed.

Tip: If either of these fields says Unknown, the artifact you are working on may be associated with a file
release that you don't have permission to view. You can leave that as it is or change it to a file release that
you do have permission to view.

2. When submitting a new artifact, choose the release in which the issue was discovered from the Reported in
Release drop-down list.

The drop-down list shows all releases in the project, except those that are in pending status.

3. After the issue is fixed, update the artifact by choosing the release in which the issue was resolved from the Fixed
in Release drop-down list.

The drop-down list shows all releases in the project, except those that are in pending status.

The associated tracker artifacts are displayed on the Release Details page, in the Reported Tracker Artifacts and
Fixed Tracker Artifacts sections.

Note: To remind yourself of the details of the association later, look in the Change Log tab of the associated
Artifact Details page.

[

Associate a tracker artifact with a code commit
When checking in files to your SCM repository, you can create links to one or more tracker artifacts or other
CollabNet TeamForge items.

Associations track the links between code and the bugs, feature requests, or other tracker artifacts that the code
addresses. You can also associate code commits with other CollabNet TeamForge items, such as tasks or documents.

A project administrator can make associations mandatory for all code commits.
with other CollabNet TeamForge items, such as tasks or documents.
A project administrator can make associations mandatory for all code commits.

You can create tracker artifact associations from whatever interface you normally use to check code into your SCM
repository. You do not have to log into CollabNet TeamForge.

Use the same syntax for commits to CVS, Subversion, and Perforce repositories.
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When making a code commit, add the associate command in the commit message like this:
[<item id>], such as the TeamForgetracker artifact ID or task ID.

» TeamForge item IDs are always letters followed by four or more numbers, such as task1029 or
artf10011.

» To associate a commit with multiple CollabNet TeamForge items, separate the item IDs with commas.
» All associations are displayed in the Associations section of the Commit Details page.
* The Comment section lists the comments made with each commit.

e Note: To associate an object in an integrated application, use the [<prefix objectid>] format.
Each integrated application displays its prefix on moving the mouse over the application name.

e Tip: To remind yourself of the details of the association later, look in the Change Log tab of the associated
) Artifact Details page.

Make a tracker artifact depend on another artifact
To organize your work with tracker artifacts, you can make an artifact a "child" or a "parent" of another artifact.

» A child artifact can have only one parent.
* A parent artifact can have any number of children.
* A parent artifact cannot be closed if a child is open.

' Note: "Open" and "Closed," in this context, refers to a type of status, not the status itself. A tracker
administrator can specify a group of statuses, such as "Deferred," "Fixed," or "Rejected," as equivalent to
"Closed," while "In progress" and "Under consideration" might be specified as "Open" statuses. For example,
when you look at the artifact summaries at the top of any tracker list page, you are seeing a summary of the
status type, not the status, of the artifacts.

1. On an artifact page, click the Dependencies tab.
2. Choose or create the related artifact.

» If the parent artifact already exists, click Choose Child or Choose Parent. In the pop-up, type in the artifact
ID or choose from the list of your recently edited artifacts.

» If the related artifact does not exist yet, click Create Child in or Create Parent in and select the tracker that
the new related artifact will belong to. Fill in the form the same way as you would for submitting an unrelated
artifact.

e Note: If Choose Parent or Create New Parent is not visible, the artifact already has a parent artifact. An
artifact can only have one parent artifact.

3. Click Next.

4. Write a comment that describes the relationship, if appropriate, and click Finish.
The parent-child relationship between the artifacts is established.

» To cancel a parent dependency, click Remove.
* To cancel a child dependency, select the child artifact and click Remove.

.:_ Note: Task dependencies and tracker artifact dependencies are different things.

+ For tracker artifacts, an artifact with dependencies (a "parent" artifact) can't be considered closed unless all
of its dependent artifacts ("children") are closed.

» For tasks, a dependency means one task can't start until another task is completed.

Quickly create dependencies, associations or add attachments
Use the context menu available in planning folder List View to quickly choose a "parent" or "child", remove a
"parent”, add associations, or add attachments to artifacts.

In the planning folder List View, you can see a down arrow icon next to the artifact ID (as shown in the following
screenshot) when you move your mouse over artifact rows.

Down arrow icon
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Artifact ID ¢
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A context-sensitive menu pops up on clicking the down arrow icon.
Context menu if an artifact has a parent

=
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Choose Child
Choose Parent

Remove Parent

Add Association

Add Attachments

Context menu if an artifact has no parent
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Choose Child
" Choose Parent

Remove Parent
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Add Association

Add Attachments

To quickly choose a parent or child, add associations and attachments, or remove a parent:

1. Select a planning folder on the List Trackers and Planning Folders page.
The planning folder List Artifacts page appears.
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2. Move your mouse over an artifact's ID.
A down arrow icon appears.

3. Click the down arrow icon to see the context menu. Depending on the context, you can do one of the following
tasks.

Choose a child

4. Click Choose Child from the context menu.
The Selecting Children... window appears.

5. Select the Enter Artifact ID option and type an artifact ID. This artifact becomes the child.
. Tip: You can also select the Add from Recently Edited option and choose a child from the list of
recently edited artifacts.
6. Click Next.
7. You may add a comment in the Dependency Comment text box.
8. Click Finish.
i« Note: You may also click Finish and Add Another to continue adding more children for the same
artifact.
Choose a parent

9. Click Choose Parent from the context menu.
The Selecting Parent... window appears.

10. Select the Enter Artifact ID option and type an artifact ID. This artifact becomes the parent.
' Tip: You can also select the Add from Recently Edited option and select a parent from the list of
recently edited artifacts.
11. Click Next.
12. You may add a comment in the Dependency Comment text box.
13. Click Finish.
Remove a parent

14. Click Remove Parent from the context menu.
A confirmation message appears: Do you want to remove the dependency?.

15. Click OK.
Add associations

16. Click Add Association from the context menu.
The Add Association Wizard appears.

17. Select the Enter Item ID option and type an artifact ID for creating an association.

' Tip: You can:
+ Select the Add from Recently Viewed option and select an artifact from the list of recently viewed
artifacts.
* Select the Add from Recently Edited option and select an artifact from the list of recently edited
artifacts.
18. Click Next.
19. You may add a comment in the Association Comment text box.
20. Click Finish.
© Note: You may also click Finish and Add Another to continue associating more artifacts.

Add attachments

21. Click Add Attachments from the context menu.
The Add Attachments window appears.

22. Type a comment for the attachments in the Comment Text box.
23. Click Choose File.
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24. Browse and select the file you want to attach.
25. Click the Attach another file link to add more attachments. Repeat this step for adding more attachments.
26. Click Add to attach the selected files to the artifact.

Schedule work on an artifact
To plan how and when an artifact is to be addressed, assign it to a planning folder.

e Note: A planning folder can contain artifacts from many different trackers. When you assign an artifact to a
planning folder, the artifact is still in the tracker where it was created.
1. Click Trackers in the project navigation bar.
2. Find the tracker that contains the artifact you want to assign, and select the artifact.
You can select any number of artifacts at once.

3. Click Plan for and select a planning folder.
The planning folder you assigned is now shown in the Planned For column on the Planning Folder Summary page.

You can always reassign an artifact to another planning folder as conditions change. Any effort data you have
provided is recalculated automatically.

.:-_ Note: When a tracker is disabled, artifacts from that tracker do not contribute to the effort totals calculated
for any planning folder they are in.

.:-_ Tip: When you are working with a single artifact, you might prefer another way to assign it to a planning
folder: open the artifact you want to assign and look for the Planning Folder field. Select a planning folder
for the artifact and save the artifact.

Set up trackers
A tracker is a collection of related artifacts that describe work to be done or issues to be resolved. Every project
should have one or more trackers.

When you start a tracker, you decide which fields will be used, who will use them, and how they will use them.
Create a tracker

Create a tracker whenever you need to report and track bugs, feature requests, support requests, or any other type of
issue where ownership, status, and activity must be managed.

Individual tracker entries are referred to as tracker artifacts. A tracker is a set of tracker items with a common
purpose, such as bug reports, feature requests, or tasks.
1. Click Project Admin in the project navigation bar.
2. Click Tracker Settings.
3. Click Create.
4. On the Create Tracker page, provide a name and description for the tracker.
' Tip: Descriptions help users learn how best to provide the information you want from them. To maximize
your chances of getting useful data, make your description as informative as you can.
5. Select an icon that suggests the type of work the tracker is handling.

This icon will appear with any artifact in this tracker, wherever it is viewed on the site. For example, if someone
brings an artifact from this tracker into a planning folder, users of the planning folder can glance at the artifact's
icon to see where it comes from.

6. Select the relevant unit from the Display Effort in field. The units displayed here are configured based on the
size of the artifacts in the tracker. Eg. Select the unit as Hours for a tracker of small defects, Days for a tracker of
tasks, and Weeks for a tracker of epics.

e Note: Configure the units at the project level and not at the planning folder level.

7. Click Create.
The new tracker appears at the bottom of your list of trackers.

8. If necessary, drag the tracker to a place in your tracker list that makes sense.
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The order you set here controls the order of every tracker list in your project.
9. You'll probably need some custom fields to capture information that's specific to your project.
See Create your own tracker fields on page 29.

10. To speed up the team's work, you may want to set up some rules for automatically reassigning artifacts when their
contents change.

See Create a tracker work flow on page 31.

Enable or disable fields
If a tracker field is disabled, it does not appear on the Artifact page. Most fields can be disabled.

Disabled fields are accessible only to tracker administrators on the Tracker Layout tab.

You can enable or disable any field that is user-defined or configurable. However, you can't disable all configurable
fields. For example, the Status, Category and Planning Folder fields can't be disabled.

.:_ Note: If your goal is to prevent users from entering data into a field when submitting an artifact, but still
display the field on the Edit Artifact and Tracker Search pages, don't disable the field. Instead, clear the
Display on Submit option on the Edit Field page.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From the list of current trackers, click the tracker you want to configure.
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On the Tracker Layout tab, select the fields you want to enable or disable.

* Click Disable to remove them from the Artifact page.
* Click Enable to allow them to be configured and displayed.

Note: Data in disabled fields is still search-able, but disabled fields do not appear as inputs on the Search
pages.
Require users to complete a tracker artifact field

If a field is set as required, users cannot submit artifacts without completing it. Most tracker fields can be required or
optional.

[ 1

Each tracker can have its own required and optional fields. Required fields are marked with a red asterisk * on the
Submit Artifact page.

.:_ Note: When you make a field required, any field whose values depend on that field's values is also required.
See Help users select options in a tracker artifact on page 99 for more about dependent field values.

Click Project Admin in the project navigation bar.
Click Tracker Settings.
From the list of current trackers, click the one you want to configure.
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On the Tracker Layout tab, click the name of the field you want to set as required or optional.
By default, only the Title, Description, Artifact ID, and Status fields are set as required.

5. On the Edit Field page, select or clear the Required option to make a field required or optional.
Required fields automatically show up on the Submit Artifact page.

' Note: System-defined fields and the Status field are always required.

6. For optional fields, select or clear the Display On Submit option.
This specifies whether the field will appear on the Submit Artifact page.
7. Click Save Field.

Create your own tracker fields
To track data that is not captured by the default set of fields, create new fields that fit your project's purposes.

You can create the following user-defined fields in each tracker:

*  Up to 30 text entry fields.
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* Up to 30 date fields.
* Up to 30 single-select fields.
* Anunlimited number of multiple-select fields.

-y Caution: Creating a large number of user fields and multiple-select fields may affect site's performance.

[ ]

Configure tracker "Select" field values
To help users provide meaningful information, supply them with useful field values to choose from in the input fields
in the tracker entry form.

Tip: When you create a user-defined single-select or multiple-select field in a tracker, you add predefined
values to the field. You can change these values at any time.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From the list of existing trackers, click the name of the tracker that you want to configure.

On the Tracker Layout tab, click the name of the field whose values you want to edit.

noR Wb

On the Edit Field page, set up the field values you want you want users to see when they create a tracker artifact.

* To define a new value, click Add.

* To rename a value, edit the existing text. If you rename a value, the value is renamed in all existing artifacts.

* To remove a value, check the box and click Delete. If you delete a value, the value is changed to None in all
existing artifacts.

» Select Default Value to set which option will be chosen if the user makes no selection. When you move a
tracker artifact from one tracker to another, the default field value is the value that comes along.

Note: When you edit the values of the Status field, you are also asked to describe what each value's

[
status means, as shown in the Values section of the Edit Field page. This status meaning is used in
Advanced Search to define which values are returned when searching for open or closed artifacts.
e Note: When you change the tracker fields, the values in the existing artifacts remain unchanged.

6. Click Move Up or Move Down to order the list the way you want it.
7. Click Save Field.
All values are now available in the selection menu for the field.

Assign a tracker artifact automatically
You can configure the tracker to automatically assign newly submitted artifacts to specific project members.

You can assign artifacts to individuals based on the values in the Category or Release field.
1. Click Project Admin in the project navigation bar.
Click Tracker Settings.

From the list of existing trackers, click the tracker you want to configure.

On the Auto Assignment tab, sclect Auto Assign By Category or Auto Assign By Release.

AN ol o

For each category or release value, choose a project member from the Automatically Assign To drop-down
menu.

This menu contains all project members with the tracker edit permission. Click the people icon to display a list of
project members to whom you can auto-assign artifacts. Choose None if you do not want artifacts with a specific
value automatically assigned.

6. Click Save.

Whenever a new artifact is submitted with a value in the relevant field, the assignee receives an email notification and
the artifact appears on his or her My page.

Change a tracker

A tracker's real-world uses often outgrow the name or description you gave it when you created it. When that
happens, it's a good idea to update the tracker to reflect its changing role.
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Click Project Admin in the project navigation bar.
Click Tracker Settings.
From the list of existing trackers, click the tracker you want to edit, and click Edit.

On the Edit Tracker page, provide a new name or description for the tracker, and update the icon.

A o

Update the units from Display Effort in and click Save.

' Note: These units are configured in the Units page at the project level, and not at the planning folder
level.

6. If necessary, drag the tracker to a place in your tracker list that makes sense.

The order you set here controls the order of every tracker list in your project.

Create a tracker work flow
To channel project members' work on tracker items, set up rules for how a tracker item can move forward.

Before creating a tracker work flow, see that these criteria are met:

* You have a tracker to work with.

» The tracker has a set of statuses defined, such as "In progress" and "Ready for QA."

* Roles exist, and you can assign project members to them.

A work flow is a sequence of changes from one status to another. You can define status transitions for any
combination of tracker statuses in the tracker.

1. Click Project Admin in the project navigation bar.

Click Tracker Settings.

From the list of existing trackers, select a tracker.

Click the Workflow tab.
The Workflow page lists all of your status values and the tracker work flow that you have configured.
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On the Workflow page, click the status value for which you want to create a work flow.

6. On the Edit Field Transition Status page, select a status value from the Create Transition to Status drop-down
menu.

e Note: By default, the Any work flow is shown. This means that you are defining work flow rules for the
transition from the status that you selected to any other status.

7. Click Add.
A new work flow is added. The Any work flow is changed to Remaining Statuses.

8. In the Roles to Make this Transition section, specify which users can make this change.
For example, only users with the QA Engineer role are allowed to change artifacts from Open to Cannot
Reproduce.

9. In the Required Field(s) for Status Transition section, select the fields for which the user must provide values.
For example, the user must assign the tracker item to someone and enter a comment.

' Note:
+ Fields that are already required do not appear in this list.
» Fields whose values depend on a required parent field are automatically required. (See Help users
select options in a tracker artifact on page 99 for more on parent and child fields.)
10. Click Save.

The work flow is now saved. When a user submits or edits the status of a tracker artifact, he or she sees only the
options that are allowed by the work flow.
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Export tracker artifacts
To use the contents of artifacts from a tracker or a planning folder in other applications, export themto a . csv,
. xml, or tab-delimited file.

For example, sometimes it can be useful to look at the status of a project by sharing a spreadsheet using Microsoft
Excel or Google Spreadsheets.

[

Tip: You can also export tracker artifacts from a tracker report or a set of search results.

1. Click Trackers in the project navigation bar.

6.

Click a tracker or planning folder.
In a tracker, you can export a subset of the artifacts in the list view by setting up a filter. See View the right tracker
artifacts on page 16.

. Note: All the artifacts in your list are exported, not just checked items.

Click Export.

In the Export Data window, select an export format that you can import into the other application.
For example, to use the data in a spreadsheet program, select . csv.

Move the fields you are interested in from the Available Columns list to the Selected Columns list, then click
Next.

e Note: When you export tracker artifacts directly from a tracker, you can choose from all the fields in the
) tracker. When you export from a planning folder, only the standard fields provided by TeamForge can be
exported.

For more detail on what you can do with different kinds of fields, see What fields can I use in a tracker?
on page 220

In the Export Data confirmation window, click the link to save the file where you want it.

Work on tasks

Manage your project plan by defining units of work and assigning them to project members.

Create a task
Create a task when you identify a unit of work that you want to track to completion as part of your project.

[

A S o

Tip: You can also create tasks by synchronizing task data with Microsoft Project.

Click Tasks in the project navigation bar.

On the Task Summary page, go to the task folder in which you want to create the task.
Click Create.

On the Create Task page, provide a name and description for the task.

Assign the task a priority between 1 (highest) and 5 (lowest).

Assign the task to an individual.

Click the people icon to list the project members to whom you can assign the task.

Assign the task a status.

* Not Started

+ OK

*  Warning
o Alert

+ Complete

Give the task a start and end date.
Click the calendar icon to select dates.

In the Estimated Hours field, write the time you think is needed to complete the task.
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10. Specify whether the time estimate is based on a five-day or seven-day calendar.

.:_ Note: Choose a seven-day calendar to assign a start or end date that falls on on a weekend.

11. Save your work.

* Click Save and View Task to keep defining the task.
» Click Save to save the task and quit.

Edit a task
Tasks often change assignee, start and end dates, and dependencies before they are finished. You can update all those
aspects of a task, along with its status.

1. Click Tasks in the project navigation bar.

2. On the Task Summary page, find the task folder containing the task you want to edit.
3. Click the task name.

4. On the Task Details page, click Edit.

5. On the Edit Task page, make your changes and click Update.

If you change the end date of a task that has dependent successor tasks, you may want to change the start and end

dates of the successor tasks. For example, if a successor task normally starts on a Friday, and is moved out two

days by a change in a predecessor task, its new start date is Sunday (if it uses a seven-day calendar) or Tuesday (if
it uses a five-day calendar).

* To change the start and end dates of all successor tasks, click Move Dependent Task Dates Forward/
Backward x Days. All dependent task dates are moved forward or backward by the same number of days that
the original task end date was moved.

» To apply the date change to only the selected task, without changing the start and end dates of any successor
tasks, click Do Not Change Dependent Task Dates.

» Ifyour end date change impacts successor tasks that you do not have permission to view, these tasks are not
changed.

» Ifyour end date change impacts successor tasks that you have permission to view, but not to edit, these tasks
are marked for change approval by an administrator. The start and end dates for tasks that you have permission
to edit are changed.

* Successors of tasks that are marked for change approval are not changed until approved by an administrator.

» From this page, you cannot change the start and end dates of successor tasks selectively. You must change
all or none of them. To edit the start and end dates of selected successor tasks only, select Do Not Change
Dependent Task Dates, then edit each selected task manually.

Find tasks

Use the task manager to find a specific task or set of tasks quickly. You can filter tasks by predefined fields or search
by keyword, date or other values.

Search for tasks

Use the Search Tasks option to refine your search if task filtering returns too many results.

1. Click Tasks in the project navigation bar.

2. On the Task Summary page, click Task Search.

3. On the Task Search Criteria page, enter the keywords for the search.

' Tip: Wildcards are allowed.

4. Search by the type of content that makes sense to you.

» Search for keywords in the Task Name field.

» Search for keywords in the Task Description field.

» Search the task progress fields: Accomplished, Planned, and Issues.

» Ifyou are searching for a specific task, and you know its task ID, enter the task ID.
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To search by date, select date ranges for start date or end date.
To search by project member, select one or more people.

o Note: Click the people icon to display a list of project members with permissions to edit or create
) tasks.

To search by location, select the Task Folders to search.
To search by Status and Priority, select those.
Click Search.

See the right tasks
Filtering and sorting allows you to find a task or group of tasks using a number of pre-defined fields.

The filter option is available on every item list view in CollabNet TeamForge.

1. Click Tasks in the project navigation bar.

2. On the Task Summary page, click the title of the task folder that contains the tasks you are interested in.

3. o Note:

*  You can find a filter field at the top of each column in most of the tables in the TeamForge application.
* The filter field could be a text box or a drop-down list.
*  You can type your filter criteria in the text boxes. The search text is case-insensitive.

*  You can also select the filter values from one or more drop-down lists. By default, you can only select
up to five filter values in a drop-down list. However, you can set a value that suits your requirement for
the FILTER DROPDOWN MAX SELECTION token in the site-options.conf file to increase
or decrease the count.

+ Some search filters may not appear if your site administrator has not enabled them.

Specify the filter criteria in one or more filter fields (at the top of each column) and click Filter.

Table filter drop-down list with multi-select check boxes

Stories (11 Iltems)
O Prigri Artifact
art
art
art
art
art

art

4. After filtering, if you want to clear the filters, click Filter and select Clear from the drop-down list.

5. Use the up-down arrow at the top of any column to sort your list by that column.

Your primary sort column is identified by a superscript 1 next to the up-down arrow, and your secondary and
third-level sort columns, if any, are likewise marked.

Click the up-down arrow again to reverse the sort order.

Check your assigned tasks
It's a good practice to regularly look at all of your assigned tasks in the My Tasks section of your My Page.

Your My Page provides a central location where you can view and manage all tasks assigned to you from all the
projects that you are a member of.
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o Note: To see tasks assigned to you on a specific project, look at the Tasks section of that project.

1. Click My Workspace in the CollabNet TeamForge navigation bar.
2. If you have more than 20 tasks, click View All to list all of them.
3. o Note:

You can find a filter field at the top of each column in most of the tables in the TeamForge application.
The filter field could be a text box or a drop-down list.

You can type your filter criteria in the text boxes. The search text is case-insensitive.

You can also select the filter values from one or more drop-down lists. By default, you can only select
up to five filter values in a drop-down list. However, you can set a value that suits your requirement for
the FILTER DROPDOWN MAX SELECTION token in the site-options.conf file to increase
or decrease the count.

Some search filters may not appear if your site administrator has not enabled them.

Specify the filter criteria in one or more filter fields (at the top of each column) and click Filter.

Table filter drop-down list with multi-select check boxes

Stories (11 Iltems)

Artifact

art

art

art

art

art

art

4. After filtering, if you want to clear the filters, click Filter and select Clear from the drop-down list.

5. Use the up-down arrow at the top of any column to sort your list by that column.

* Your primary sort column is identified by a superscript 1 next to the up-down arrow, and your secondary and
third-level sort columns, if any, are likewise marked.

* Click the up-down arrow again to reverse the sort order.
6. Click the task name to see the task details.

Update task status
When you have completed some work on a task assigned to you, you must update its status.

If you don't mark a task as completed, you may get an automatic reminder from the task's owner, its administrator, or
other project members.

You can provide task status reports for all of your assigned tasks from a single page.

Note: If you want to enter a status update for only one task, you can do so from the Task Progress section of
the Task Details page.

1. Click Tasks in the project navigation bar.

2. On the Task Summary page, click the My Task Progress tab.

Your My Task Progress page displays a list of all tasks assigned to you.

3. Enter your task status updates in the Accomplished, Planned, and Issues fields.

* Accomplished - Record any accomplishments since your last update.
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* Planned - Describe work you plan to do on the task.
» Issues - Report any issues with the task.

4. If applicable, change the task status.
e Note: Project administrators may require approval for changes to task status. If change approval is
required, you are notified when you submit your status report.
5. Save your changes.

* Click Save Page to finish and save your changes.
» Ifyour tasks cover more than one page, click Save Page and View Next to proceed to the next page.

Schedule a task before or after another task
When one task cannot be done unless another task is done first, set up a dependency to track the relationship between
the two tasks.

For example, if the deadline for a task changes, the tasks that depend on that task can automatically be rescheduled to
reflect the change.

Click Tasks in the project navigation bar.

On the Task Summary page, find the task folder containing the task to which you want to add dependencies.
Click the task name.

On the Task Details page, click the Dependencies tab.

On the Task Dependencies page, click Add in the Predecessors or Successorssection.

A o

In the Add Predecessor window or the Add Successor window, choose a task.

* Enter Task ID - If you know the task ID, you can enter it directly.
* Add from History - The History is a list of tasks that you have submitted or edited.
.:_ Note: To create multiple dependencies, enter multiple task IDs separated by commas, or use the ctrl key
and select multiple tasks from the history list.
7. Click Next.

The Add Predecessor or the Add Successor window shows the dependencies you have added.

View task dependencies
Task dependencies allow you to establish relationships between tasks. Task dependencies show what must be done
before a given task and what will be done after the task is complete.

Click Tasks in the project navigation bar.

On the Task Summary page, find the task folder containing the task that you want to view.
Click the task name.

On the Task Details page, click the Dependencies tab.

Cal ol

For each predecessor and successor task, you can see the person to whom the task is assigned, any issues with the
task, the start and end dates, and the effort expended on the task. For details about a predecessor or successor task,
including that task's predecessors and successors, click the task name.

Associate a task with other items

When a task is related to other CollabNet TeamForge items such as documents, tracker artifacts, file releases,
integrated application objects, or news items, you can connect the document to the other item by creating an
association.

Creating associations between items helps you define relationships, track dependencies, and enforce work flow rules.
Some example uses for task associations include:

* Associating tasks with a master document describing the project, such as a project plan.

* Associating a task with the deliverables it requires, such as a requirements document, completed code, or a file
release.
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* Associating a task with a related object in the integrated application.
» Associating a task with items on which it is dependent, such as closed tracker artifacts.
1. Click Tasks in the project navigation bar.

2. On the Task Summary page, find the task folder containing the task to which you want to add an association, and
click the task name.

3. On the Task Details page, click the Associations tab.
4. Click Add.

5. Inthe Add Association Wizard window, select the items with which you want to associate the artifact:
* Enter Item ID - If you know the item's ID, you can enter it directly.

e Note: To associate an object in an integrated application from within CollabNet TeamForge, use the
[<prefix objectid>] format. Successful associations appear hyperlinked.

' Tip: Each integrated application displays its prefix on moving the mouse over the application name in
the tool bar.
* Add From Recently Viewed - Select one of the last ten items you looked at during this session.
* Add From Recently Edited - Select one of the last ten items you changed.
6. Click Next.
7. Inthe Add Association comments window, describe the reason for the association.

8. Save your work.

e Click Finish and Add Another to add additional associations.
» Click Finish to return to the Details page.

Manage tasks

Project members with the Task Admin permission can perform all task administrative functions such as copying and
moving tasks. They can also create and administer task folders.

Copy atask

Copying a task is useful if you want to use an existing task as a template for creating a new task with many of the
same attributes.

When making a copy of a task, reference to the source task is maintained in the task name and history and in the
Associations section of the Task Details page.

1. Click Tasks in the project navigation bar.

2. On the Task Summary page, find the task folder containing the task that you want to copy.

3. Select the task that you want to copy, and click Copy.
CollabNet TeamForge creates a copy of the the task and places it on the clipboard.

4. Go to the folder where you want to place the copy and click Paste.

You can place a copy in the same task folder or a different task folder.

The task copy is now placed in the selected folder, with the name Copy of <Task Name>.
Move a task
When a task's focus or status changes, it may be useful to move it to a more appropriate task folder.

You can move a task to another folder in the same project or in another project.

To move a task between projects, you must have task administration permission in both the source and destination
projects.

If the project members to whom the tasks are assigned have the appropriate permissions in the destination project, the
tasks are automatically reassigned to the same project members. If not, you must reassign them.

.:_ Important: If you move tasks across projects, the dependencies, resources, and change approval settings
might be changed.

1. Click Tasks in the project navigation bar.
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2. On the Task Summary page, go to the task folder containing the task you want to move.
3. Select the tasks you want to move and click Cut.

4. Go to the folder to which you want to move the tasks, and click Paste.

.:_ Note: To move the tasks into another project, first find the destination project using your Projects menu.

+ If the destination folder is in the same project, the tasks are now moved.
+ If the destination folder is in a different project, the Paste Tasks window appears.

5. If the project members to whom the tasks are assigned don't have the appropriate permissions in the destination
project, reassign the tasks to another project member or to yourself.

6. Click Next.

The tasks are now in the destination folder. The history of the move is recorded in the task history.

Organize tasks

Use task folders to organize tasks according to work group or project phase.
Create a task folder

Set up a task folder to contain tasks that are related to each other.

Task folders, like file directories, let you organize your tasks in a logical, hierarchical manner with labels that are
meaningful to you and your organization.

You can create folders in the root folder or as subfolders in any other folder. There is no limit to the number of folders
you can create.
1. Click Tasks in the project navigation bar.
2. On the Task Summarypage, go to the location where you want to place the task folder.
You can create a task folder in the root folder or in any other task folder.
3. Click New.
4. In the New Task Folder window, write a name for the task folder.
5. Click Save.
The task folder is created.

Rename a task folder
When the focus or function of a group of tasks changes, you may wish to rename the folder they are in.

Click Tasks in the project navigation bar.

On the Task Summary page, find the task folder you want to rename.
Click the folder title and choose Rename from the Edit menu.

In the Rename Task Folder window, provide a new name for the folder.
Click Save.

A

The folder is now renamed.
Reorder task folders
To make it easier for project members to find things, you can arrange task folders alphabetically or otherwise.

By default, task folders are ordered according to when they were created. New task folders are added to the end of the
task tree.

' Note: After you reorder folders, you cannot restore them automatically to their original order. You must
reorder them manually.
1. Click Tasks in the project navigation bar.
2. On the Task Summary page, find the folder containing the subfolders that you want to reorder.
You can reorder the task folders in the root directory, or the subfolders in any folder.
3. Choose Reorder Subfolders from the Edit menu.
4. In the Reorder Subfolders window, order the subfolders.
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* Click Alphabetize to sort in alphabetical order.
* Click a folder and click Move Up or Move Down until the folder is where you want it.

5. Click Save.

Delete a task folder
If you no longer need a task folder, it's a good practice to delete it.

e Important: Deleting a task folder deletes all of the tasks within it. Delete a task folder only if you are sure
) that you no longer need any of the tasks within it. Move any tasks that you want to save before deleting the
task folder.
1. Click Tasks in the project navigation bar.
2. On the Task Summary page, click the task folder that you want to delete.
3. Choose Delete option from the Edit menu.

The task folder is removed.

Manage tasks in Microsoft Project

When you install the Task Management plugin and connect to your CollabNet TeamForge site from Microsoft
Project, you can export and import tasks between the tools.

Install the Task Manager Add-in for Microsoft Project

To synchronize task data between Microsoft Project and CollabNet TeamForge , you must install the CollabNet
TeamForge Task Manager Add-in for Microsoft Project.

Check with your CollabNet TeamForge administrator to get the CollabNet TeamForge Task Manager Add-in for
Microsoft Project.

The CollabNet TeamForge Task Manager Add-in for Microsoft Project requires the following:

* Microsoft Project 2002 on Windows XP or Windows 2
* Microsoft Project 2003 on Windows XP or Windows 2
* Microsoft .NET Framework Version 1.1.

You can download this at no charge from the following URL: http://msdn.microsoft.com/netframework/
downloads/updates/default.aspx

If you do not have the Microsoft .NET Framework installed, you must download and install it during the add-in
installation process and restart the add-in installer.

.:_ Note: If you have installed a previous version of the CollabNet TeamForge Task Manager Add-in for
Microsoft Project or the CollabNet TeamForge Plugin for Microsoft Project, you must uninstall it before
installing the new version.

1. Copy the CollabNet TeamForge Task Manager Add-in for Microsoft Project files from the location provided by
your CollabNet TeamForge administrator.

The add-in files are delivered in a single .ms1i file. Save the .msi file anywhere on your hard drive.

Launch the .ms1 file to begin the installation process.

In the Setup Wizard, click Next until you reach the Select Installation Folder window.

Select the directory where you want to install the add-in.

Select whether you want the add-in to be available to just you, or to anyone using your computer.

Click Next until the installation process begins.

A

In the Installation Complete window, click Close to exit.

The CollabNet TeamForge Task Manager Add-in for Microsoft Project is now installed.

Log in to CollabNet TeamForge

To start working with CollabNet TeamForge tasks in Microsoft Project, the first step is to connect to your CollabNet
TeamForge site.

1. In Microsoft Project, select File > CollabNet TeamForge > Synchronize with CollabNet TeamForge .
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The Log In window appears.

Log In
SOURCEF_ RGE”
Log In to SourceForge

Please log in to SourceForge with wvour UserMame and Password, You will n
ko enter the hostname of the SourceForge inskallation wou wish bo conneck

sername: |u5er1
Passwiord: |********
DB |fﬂ|"EIE-ED“ﬂ|J-I'IEt| Advanced Setkir

| Save This Information

2. Enter the username and password for your CollabNet TeamForge installation.

3. Enter the path to the CollabNet TeamForge server. For example: CollabNet TeamForge .collab.net
g~  Note: Do not include "http://" or "https://" in the path.

4. To enter security and other network information, click Advanced Settingsand specify the details.
For example, here's how you specify that SSL be enabled for your site.

Security and Metwork Settings

SourceForge Advanced Security and Mebwork Setting

[+ Enable secure 551 connection

[ Use HTTP pre-authentication

HTTP UserMame:
HTTF Password:

[ Cwerride IE proxy settings

Prozy Server:

-
Prozy UserMame:

Prooey Password;

5. Click Log In in the Log In window.

After you've logged in, you can synchronize tasks between Microsoft Project and CollabNet TeamForge .
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Create tasks from Microsoft Project
The CollabNet TeamForge Microsoft Project integration allows you to synchronize project plans between Microsoft
Project and CollabNet TeamForge .

By creating detailed project plans in Microsoft Project, you can take advantage of advanced project planning
features such as detailed cost and effort projections. After your project plan is completed, you can log into CollabNet
TeamForge from within Microsoft Project and synchronize the task data from your project plan with a CollabNet
TeamForge task folder. When the data is synchronized with CollabNet TeamForge , you can then execute your
project tasks using the advanced status reporting capabilities, task exception management, and project visibility tools
that CollabNet TeamForge provides. At any time, you can re-synchronize any changes made to task data in either
CollabNet TeamForge or Microsoft Project.

THIS TOPIC APPEARS TO BE UNFINISHED. IT BELONGS IN THE MSPROJECT SECTION ANYWAY.
UPDATE RELTABLE TO REFLECT THIS.

Import tasks in one direction
To perform a one-way import of tasks from CollabNet TeamForge to Microsoft Project, use a blank Microsoft Project
file to synchronize.

o Note: You must have the task administration permission for the CollabNet TeamForge project with which
you want to synchronize your Microsoft Project plan.

1. Open a blank Microsoft Project file.

2. In Microsoft Project, select File > CollabNet TeamForge > Synchronize with CollabNet TeamForge .

3. Ifyou have not logged in to your CollabNet TeamForge site, the Log In window appears. Supply your credentials
and server name and do so now.

4. If your project plan does not have the journal file required for synchronization, the Setup for Synchronization
window appears. Answer Yes for the journal file to be created.

5. In the Selection Dialog, select the task folder whose tasks you want to import, and click Next.

-

=1 Forge.collab.net

i CollabMet User Information

1 Crasherator

1 Engineering

1 Marketing Resources

7 sb-saturn

7 SourceFarge Produck Developrent

Cancel Mext =3 Jﬂ

o Note: The window displays all CollabNet TeamForge projects of which you are a member, and all task
folders in each project.

+

+

+

+

6. If there is any data that could prevent successful synchronization, the Warnings Fields window is displayed.
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A Warnings Fields

k5 Project dogs not allow null values. The following tables show tasks fields which will be impor
on the SorceForge estimated hours of the task and the MS Project start date.

T ashk Mame | Field | SorceForge Value

<zonpt language="lavazcnpt' > alert["hi [tazk nam...  Start Date 1140001

<zoniph language="javazcnpt > alert"hi [tazk nam...  End Date 110001

test for remove azsigned Start Date 1./1/0001

test for remove aszigned End Date 110001

taskpd Start Date 1140001

tazkpd End Date 110001

test 2 Start Date 1./1.40001

best 2 End Date 1410001

test 3 Start Date 1./1.40001

test 3 End D ate 141400

a) Click Cancel, and correct the issues identified in this window.
b) When you're done, click OK in the Warnings Fields window .
7. In the Synchronization Summary window, click OK to proceed with the synchronization.

8. When Microsoft Project asks you whether you want to save your changes, select OK.

The tasks from your CollabNet TeamForge task folder are imported into your Microsoft Project plan.

Assign aresource when there is no match in CollabNet TeamForge

When you export tasks from Microsoft project to CollabNet TeamForge , if a task is assigned to a resource name that
does not have an exact match in CollabNet TeamForge , you will be provided various options for assigning the task to
a resource during synchronization.

o Note: When a resource name in Microsoft Project exactly matches a user name in CollabNet TeamForge
user.

The Resource Assignment window appears during the synchronization process, after you have selected the File >
CollabNet TeamForge option in Microsoft Project.

1. In the Resource Assignment window for the task, choose whether to assign the task to yourself, or to any project
member with the appropriate permissions, or leave it unassigned.

2. Select whether or not you want to apply the resource mapping to all tasks assigned to that resource.

3. Click OK.
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b

Tazk 'Fix izzuel 2345 iz azzigned to a rezource which
not found in the SourceForge membership list.

Rezource Aszignment Action
" Azsign task to SourceForge project merber
o+ Azsign to exporter [kavitha)
" Do mot aszsign task

SourceForge Project Membership List

M apping Optionz

*  Arnnlo achon o thiz tazk onlu

The synchronization process continues.
Synchronize task data with
You can synchronize task data between CollabNet TeamForge and Microsoft Project from within a Project file.

The CollabNet TeamForge Task Manager Add-in for Microsoft Project adds the Synchronize with CollabNet
TeamForge option to your Microsoft Project File menu.

e Important: When you synchronize task data between Microsoft Project and CollabNet TeamForge , only
) certain fields' data is retained.

You must have the task administration permission for the CollabNet TeamForge project with which you want to
synchronize your Microsoft Project plan.

1. Make sure your Microsoft Internet Explorer proxy settings are configured correctly to access the Internet, whether
or not you are using Microsoft Internet Explorer as your Web browser.
If you receive a connection error when synchronizing task data, check with your system administrator for your
organization's proxy settings.

2. Open the Microsoft Project file that you want to synchronize with CollabNet TeamForge.
' Note: You can also synchronize using a blank Microsoft Project file. Use this method if you want to do a

one-way import from CollabNet TeamForge to Microsoft Project.
3. From the File menu, choose CollabNet TeamForge > Synchronize with CollabNet TeamForge .
4. In the Login to CollabNet TeamForge window, provide the following information:

*  Your CollabNet TeamForge user name and password.
» The server name of your organization's CollabNet TeamForge installation.

.:_ Note: Do not enter the http:// or https:// before the server name.

5. Click Login.

6. In the CollabNet TeamForge Selection Dialog window, choose the CollabNet TeamForge project and task folder
with which you want to synchronize your Microsoft Project plan, and click Next.
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a) If your Microsoft Project plan contains any conflicts that would prevent successful synchronization, a list of
possible problems appears in the Incompatible Tasks window. Click Cancel, then correct any issues. Repeat
until all synchronization issues are corrected.

b) If one or more tasks are assigned to resource names that do not have an exact match in CollabNet TeamForge
, the Resource Assignment window appears. For all tasks that do not have exact resource matches, you must
reassign the tasks.:

7. Click OK.
The Synchronization Summary window lists the following:

* All the tasks that were added or deleted in CollabNet TeamForge that will be imported into Microsoft Project.
* All the tasks that were added or deleted in Microsoft Project that will be exported to CollabNet TeamForge.
8. Click OK.

» Ifyou do not have any conflicting task changes, your tasks are now synchronized. To establish the relationship
between your Microsoft Project plan and the CollabNet TeamForge task folder, save the changes to your
Microsoft Project plan.

Note: If you choose not to save, your synchronization changes will not be saved in Microsoft Project

[
and you will not be able to perform subsequent synchronizations with that task folder. After you have
saved synchronization changes once, you can then choose not to save your changes to Microsoft
Project. However, your changes are always saved in CollabNet TeamForge.

e Note: Use this method if you want to do a one-way export from Microsoft Project to CollabNet

TeamForge.
» Ifyou have conflicting task changes, the Task Conflict window appears.

You can use all values assigned in Microsoft Project or use all values assigned in CollabNet TeamForge.

Note: When editing start and end dates, you must choose both values from the same source. For
example, you cannot choose a start date from CollabNet TeamForge and an end date from Microsoft
Project.

9. Click Next.

[ 1

Your tasks are now synchronized, and you can save the changes to your Microsoft Project plan. For future
synchronizations, your Microsoft Project plan is now bound to the CollabNet TeamForge task folder with which you
synchronized. You will not be prompted to select a task folder after the first synchronization.

Note: If you want to synchronize your Microsoft Project plan with a different task folder, you must unbind
it from CollabNet TeamForge. To unbind your Microsoft Project plan from CollabNet TeamForge , click
Microsoft Project Tools > CollabNet TeamForge Options > Unbind Project Plan from CollabNet
TeamForge .

[ N

After you unbind your Microsoft Project plan, you cannot synchronize it with the original task folder, but you
can synchronize it with any other task folder.

Synchronize with a different task folder
If you have If you have already synchronized your Microsoft Project plan with a task folder, but later want to
synchronize it with a different one, you must unbind your project plan from CollabNet TeamForge.

When your tasks are synchronized and you save the changes to your Microsoft Project plan, the plan is bound
to the CollabNet TeamForge task folder involved. You will not be prompted to select a task folder after the first
synchronization.

1. In Microsoft Project, select Tools > CollabNet TeamForge Opions > Unbind Project Plan from CollabNet
TeamForge .
2. Save the project plan when prompted.

After you unbind your Microsoft Project plan, you will not be able to synchronize it with the original task folder, but
you can synchronize it with any other task folder.
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Document your work
The document management system is a centralized repository for creating, storing, and managing information about a

project.

Find and view a document

You can find and view a document by navigating to it, by searching for it, or by viewing it from a URL or unique
identifier. You can also open a document from CollabNet TeamForge directly into Microsoft Office applications.

Go to a document

If you know where a document is posted, or would like to browse to see what documents are available, you can find a
document by navigation.

You can get to documents from your project home page or by searching the project's documents page.

1. Choose a way to find documents:

* Look for a Documents window on your project home page. If your project manager has created a document
component, you will find all your project documents there.

+ If there is no Documents component, click Documents in the project navigation bar.

2. Select a documents folder.

You can expand the document tree by clicking the + icon next to a folder.
3. o Note:

You can find a filter field at the top of each column in most of the tables in the TeamForge application.
The filter field could be a text box or a drop-down list.

You can type your filter criteria in the text boxes. The search text is case-insensitive.

You can also select the filter values from one or more drop-down lists. By default, you can only select
up to five filter values in a drop-down list. However, you can set a value that suits your requirement for
the FILTER DROPDOWN_MAX SELECTION token in the site-options.conf file to increase
or decrease the count.

Some search filters may not appear if your site administrator has not enabled them.

Specify the filter criteria in one or more filter fields (at the top of each column) and click Filter.

Table filter drop-down list with multi-select check boxes

Stories (11 ltems)

] Priori

Artifact

art

art

art

art

art

art

4. After filtering, if you want to clear the filters, click Filter and select Clear from the drop-down list.

5. Use the up-down arrow at the top of any column to sort your list by that column.

* Your primary sort column is identified by a superscript 1 next to the up-down arrow, and your secondary and
third-level sort columns, if any, are likewise marked.

* Click the up-down arrow again to reverse the sort order.

6. To view or save a document, click the file type icon to the left of the document name.
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Documents with file types that can be viewed in a browser, such as HTML and text, are displayed in a CollabNet
TeamForge window. For other file types, use the appropriate viewing software.

7. To view additional information about the document, click the document name.
Search for a document

Search for a document by its title, its content, the project or folder in which it is located, its file type, or its creation
date.

If you don't know which project to search, or want to search for documents and other types of items simultaneously,
use global search.

1. Click Documents in the project navigation bar.

2. Click Search Documents.

3. On the Document Search Criteria page, enter the desired search criteria.

' Tip: You can use wildcards.

» To search by name, enter the text of the document name in the Search Name field.

* To search by name or description, enter the text in the Search Keywords field and select Search Name and
Description.

» To search by document content, enter the text in the Search Keywords ficld and Search Within Document.
» To search all document versions, select Search All Versions.

* To search by location: If you know the document is located in the current folder, check the current folder in the
Category field. Otherwise, the default Root Category searches all document folders in the project.

* To search by author, enter the user name in the Edited or Updated By field. Click the People icon to display a
list of project members.

» To search by date range, enter the start and end dates for the search. Click the Calendar icon to select dates
from a calendar.

4. Click Search.

CollabNet TeamForge lists the documents matching your search criteria. From this page, you can open or view the
details of each document.

Create a document
You can create a document by uploading a file or by entering the text directly into CollabNet TeamForge.

You can also create a document in CollabNet TeamForge automatically detects the file extension for many common
file types.
1. Click Documents in the project navigation bar.
2. Using the document tree, find the folder in which you want to create the document, and click Create.
You can create a document in the root document folder or any other document folder.
3. On the Create Document page, enter a name and description for the document.
4. Identify the status of the document.
* Draft - The document is not yet completed.
* Final - The document is finished.
5. If you want to prevent others from editing the document, select Lock Document.
6. Select the document creation method.

* To upload a document, select Upload From File and browse to the desired file.
* To enter the content as text, select Create Online.

7. Write any comments you may have about this version of the document.

8. Save your changes:

* Click Save to save the document and return to the document list view.
* Click Save and View Document to save the document and display the document details.
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Edit a document

When you are called on to help develop a document, you can edit the document online or by posting a new version.
Update a document

To update a document, you can upload a new document version or change the document's name, description, or lock
status.

You can also update a document in CollabNet TeamForge directly from one of the following Microsoft Office
applications:

*+ Word
* Excel
* Project

e PowerPoint

Click Documents in the project navigation bar.

Using the document tree, find the folder containing the document that you want to edit.
Select the document you want to edit by clicking the document name.

On the Document Details page, click Edit/Update.

A

On the Edit Document page, make your changes.

» Update the name or description by entering new text in the appropriate field.
» Change the status value if appropriate.
» To prevent others from editing the document, select Lock Document.
* Update a binary document by selecting Upload From File, then browsing for the updated file.
» Update a text document by selecting Create Online, then editing the document text.
6. Enter a version comment to describe the changes made, if appropriate.
7. Click Save.
The document is now updated.

Change the active document version
You can specify which version of a document is the active version at any time.

CollabNet TeamForge stores every document version that you or any other user posts. When you open a document
from the document list view, you open the active document version. When you open a document's Document Details
page, the information you see is about the active document version.

The Versions section of the Document Details page lists all document versions and indicates which one is currently
active. By default, the most recently posted document version is the active version.
1. Click Documents in the project navigation bar.
2. Using the document tree, find the folder containing the document.
3. Select the document by clicking its name.
e Tip: On the Document Details page, in the Versions section, the active document is indicated with a
check in the Active column.
4. Select the version that you want to make the active version, and click Mark As Active.
The selected document version is now the active version.
Lock a document

While you are working on a document, you can lock it to prevent others from editing it and then posting new versions
to CollabNet TeamForge .

When a document is locked, any user with the document view permission can view or download the document, but
only document administrators and the document creator can post new versions to CollabNet TeamForge .

You can lock a document when you create it or at any time afterward.

. Note: Locking a document does not prevent it from being edited in its native application.
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On the Document Details page, confirm that the lock status is currently Unlocked.
Click Edit/Update.
On the Edit Document page, select Lock Document.

Click Save.
The document is now locked. It is represented by the Padlock icon in the document list view.

Tl ol

Unlock a document
To work with a document that someone else has locked, you must unlock the document.

Only a document administrator and the document creator can unlock a document.

1. On the Document Details page, confirm that the lock status is currently Locked.
2. Click Edit/Update.

3. On the Edit Document page, clear Lock Document.

4. Click Save.

The document is now unlocked. All project members with the Document Edit permission can now update the
document.

Get a document reviewed

There are a few things you have to do to get the most out of a document review.

Start a document review

To get a document reviewed, select the appropriate reviewers, set a due date, and explain to the reviewers what you
need from them.

Before starting a document review, you must create the document in CollabNet TeamForge .

1. Click Documents in the project navigation bar.
2. In the document tree, click the title of the document you want input on.
3. On the Document Details page, click the Review tab, then click Start a Review.
' Note: If a review is already in process, Start a Review does not appear, because you can only have one
review at a time.
4. On the Start a Review Cycle page, give the review a descriptive name.
5. Enter a due date for reviewers.
Click the Calendar icon to select dates.
' Tip: Comments are due at 12:00 midnight on the date selected. Therefore, if you want all document
reviews to be completed by end of day Tuesday, select Wednesday as the review end date.
6. Select the required and optional reviewers.

Click the People icon to pick from a list of project members whose access permissions enable them to see this
document.

7. Write a message to your reviewers describing the document and the type of input you need from them.

Your reviewers will get this message in an automatic email that shows you as the sender.

' Tip: If you add yourself to the reviewers list, you will get a copy of this email for future reference.

8. Click Save.
The document is now submitted for review.

» All reviewers receive an email with the details of the review, your message, and a link to the Review Details page
where they can download the document and post their responses.

* The document status is changed to Review and remains so until the review is closed.

.:_ Tip: To help keep track of the development of your document, associate a tracker artifact with your
document review.
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Read review responses
After starting a document review, you receive email notifications whenever a reviewer posts review responses.

You can read the review responses from the email or from the Review Details page. The Review Details page is the
starting point for managing all document review activities.

1. Click Documents in the project navigation bar.

2. Using the document tree, find the folder containing the desired document.

3. Click the title of the document.
4

. On the Document Details page, click the Review tab.
A summary of all open and closed reviews appears.

5. Click the title of the desired review.
Review comments are listed in the bottom section of the page.

You can also reach the Review Details page by clicking the link provided in any related email notification or by
clicking the title of the review in the My Document Reviews section of your My page.

Edit review details

At any time after a review is started, you can change the review name, the required and optional reviewers, and the
due date.

When you edit review details, affected reviewers get an email notification with the details of the change.

1. Find the Review Details page.
The review details are listed in the top section of the page.
2. Click Edit.
3. On the Edit Review Cycle page, make your changes.
* Click the Calendar icon to select dates from a calendar.
» Click the People icon to display a list of project members from whom you can select.
4. Click Save.

*  When you add reviewers, new reviewers receive an email with the details of the review.

*  When you remove reviewers, removed reviewers receive an email telling them that their reviews are no longer
necessary.

*  When you change the due date, outstanding reviewers receive an email with the new due date.

Send areminder email
To help project members keep track of their review obligations, you can send a reminder email to reviewers who have
not yet submitted their responses.

On the Review Details page, find the outstanding required and optional reviewers.
Click Send Reminder Email.

On the Send Reminder Email page, write a message to include in the email.

o M.

Choose whether to send the document as an attachment to the email.

. Note: The URL to the document is included in the email regardless of whether the document is attached.

5. Click Send.

The email is sent to all reviewers who have not yet submitted responses.
Close a document review
After a document review is completed, close the review.

Reviews are never closed automatically. You must close any outstanding reviews on a document before you can start
a new one on the same document.

.:_ Note: You can close a review even if the due date has not yet passed.

1. On the Review Details page, click Close Review.
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2. On the Close Review page, change the document status to Final or Draft.
3. Click OK.

The review is now closed. Any reviewers with outstanding reviews receive email notifications that the review is
closed. No additional review responses can be submitted.

Review a document
To contribute to a review, you look at the document, consider responses from other reviewers, and post your own
responses.

When you are identified as a reviewer of a document, two things happen:

* Youreceive an email about the review. The details include the due date, whether you are a required or optional
reviewer, and any message text entered by the review submitter. The email also includes a link to submit your
response.

* A new entry in the Documents Awaiting Review section of your My Page provides a summary of the review,
including the review due date, the project in which the document is posted, and the person who is requesting your
review.

1. Go to the Review Details page by clicking the link provided.

*  Click the link in the email notification you received with the review details.

» Click the title of the document in the Documents Awaiting Review section of your My page.
2. on the Review Details page, in the Submit a Response section in the center of the page, enter your response.
3. If appropriate, use the Browse button to attach a marked-up copy of the document, or another attachment.
4. Click Submit.

Your response is now submitted.

* The review submitter receives an email notification containing your response.
* Your response comments appear in the Responses section of the Review Details page.

Associate a document with other items
When a document is related to other CollabNet TeamForge items such as tasks, tracker artifacts, file releases, or news
items, you can connect the document to the other item by creating an association.

Creating associations between items enables you to define relationships, track dependencies, and enforce work flow
rules. Some example uses for document associations include:

* Associate a requirements document with supporting feature requests or bugs in the tracker.
» Associate a document, or a document review, with the task that requires it as a deliverable.

* Associate a master document, such as a product plan, with other supporting documents such as a test plan or beta
plan.

» Associate a product announcement document with a file release.
1. Click Documents in the project navigation bar.

2. Using the document tree, find the folder containing the document to which you want to add an association. Select
the document by checking the box, then click Details.

3. On the Document Details page, click the Associations tab.
4. Click Add.

5. Inthe Add Association Wizard window, select the items with which you want to associate the artifact:
* Enter Item ID - If you know the item's ID, you can enter it directly.

e Note: To associate an object in an integrated application from within CollabNet TeamForge, use the
[<prefix objectid>] format. Successful associations appear hyperlinked.

' '[}‘Iip: Elat():h integrated application displays its prefix on moving the mouse over the application name in
the tool bar.

* Add From Recently Viewed - Sclect one of the last ten items you looked at during this session.
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* Add From Recently Edited - Select one of the last ten items you changed.
6. Click Next.
7. Inthe Add Association comments window, describe the reason for the association.

8. Save your work.

* Click Finish and Add Another to add additional associations.
* Click Finish to return to the Details page.

Manage documents

Project members with the Document Admin permission can copy, move, and delete documents. They can also create
and administer document folders.

Copy adocument

If a given document belongs logically to two or more document folders, keeping a copy in each folder can help users
locate it.

Copying a document can also be useful if you want to use an existing document as a template for creating a new
document. When making a copy of a document, reference to the source document is maintained in the document title
and the Associations tab.

' Note: Each copy must be maintained separately. Edits made to one copy are not propagated to other copies.

1. Click Documents in the project navigation bar.
2. Using the document tree, find the folder containing the document that you want to copy.

3. Select the document you want to copy, then click Copy.
CollabNet TeamForge creates a copy of the document and places it on the clipboard.

4. Find the folder where you want to place the copy, then click Paste.
You can place a document copy in the same folder or a different folder.
The document copy is now placed in the selected folder, with the name "Copy of <Document Name>". The reference
to the source document is also maintained in the Associations section of the Document Details page.
Move a document

You can move it to another document folder within the project or to a document folder in another project at any time.
This allows you to reorganize documents as needed.

You can move one or more documents in the same operation. You cannot move a document while it has an open
review.

e Note: To move a document between projects, you must have document administration permission in both the
source and destination projects.

Click Documents in the project navigation bar.

In the document tree, find the folder containing the document you want to move.

Check the box next to the document you want to move, and click Cut.

W=

Find the folder to which you want to move the document, and click Paste.

.:_ Note: To move the document into another project, first find the destination project using your Projects
menu.

The document is now moved to the selected folder.
Delete a document
If you no longer need a document, you can delete it.

Deleting a document deletes all of the document's versions, plus the document's details and review history.

.:_ Note: You must be a document administrator to delete documents.

1. Click Documents in the project navigation bar.

2. Using the document tree, find the folder containing the document that you want to delete.
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3. Select the document you want to delete.
4. Click Delete.

The document is deleted.

Organize documents

Project members with the Document Admin permission can create, edit, move, reorder, and delete document folders.
Create a document folder

Document folders, like file directories, allow you to organize your documents in a logical, hierarchical manner using
labels that are meaningful to you and your organization.

You can create folders in the root folder or as subfolders in any other folder. There is no limit to the number of folders
you can create.

Click Documents in the project navigation bar.

Using the document tree, find the location where you want to place the folder.

Click New.

In the Create Folder window, enter a name for the folder.

Click Save.

Nk W=

The folder is created.
Rename a document folder
When the function of a document folder has changed, it's a good idea to rename the folder.

Click Documents in the project navigation bar.

Using the document tree, find the folder that you want to rename, and click the title to select it.
Choose Renamefrom the Edit menu.

In the Rename Document Folder window, enter a new name for the folder.

Click Save.

Nk W=

The folder is now renamed.
Move a document folder
You can move a document folder within a project.

You can move a folder in the following ways:

* From the root folder to a subfolder.
*  From a subfolder to the root folder.
* From a subfolder to another subfolder.

When you move a document folder, any documents and subfolders that it contains are also moved to the destination
folder.

Project members monitoring the destination folder will continue to receive monitoring notifications after a folder is
moved. Project members not monitoring the destination folder will not receive further monitoring notifications.

1. Click Documents in the project navigation bar.

1

Using the document tree, find the folder that you want to move. Click the title to select it.
Choose Cut from the Edit menu.

Using the document tree, find the folder into which you want to move the selected folder. Click the title of the
folder to select it.

W

.:_ Note: You can move a folder into the root folder or into any other folder.

5. Choose Paste option from the Edit menu.
The folder is moved to the destination folder.
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Reorder document folders
To change the order in which document folders are displayed, you can alphabetize them or reorder them arbitrarily.

By default, document folders are ordered according to when they were created. New document folders are added to

the end of the document tree.

1. Click Documents in the project navigation bar.

2. Using the document tree, find the folder containing the subfolders that you want to reorder. Click the title to select
it.

3. Choose Reorder Subfoldersfrom the Edit menu.

4. Organize the subfolders:

» To sort them alphabetically, click Alphabetize.

» To reorder a specific folder, select it by clicking the title, then click Move Up or Move Down until the folder
is where you want it.

5. Click Save.

Delete a document folder
If you no longer need a document folder, it's a good idea to delete it.

Deleting a document folder deletes all of the documents within it.

. Important: Delete a document folder only if you are sure that you no longer need any of the documents
within it. Move any documents that you want to save.

1. Click Documents in the project navigation bar.

2. Using the document tree, find the folder you want to delete.

3. On the document folder Edit menu, click Delete.
If the folder contains one or more documents that you do not have permission to delete, you cannot delete the
folder.

Work with documents from Microsoft Office

You can use the File menu of your Microsoft Office application to work with documents that are stored on your
TeamForge site.

Open a TeamForge document in Microsoft Office

You can get to your Microsoft Word, Excel, Project, and PowerPoint documents in CollabNet TeamForge even if the
CollabNet TeamForge web interface is not open.

1. Open your Microsoft Office application.

2. From the File menu, choose Open from CollabNet TeamForge .

3. In the Login window, provide the following information:

*  Your TeamForge user name and password.
» The URL of your organization's TeamForge installation.

.:_ Note: Do not enter the http:// or https:// before the server name.
4. Click Log In.

The Selection Dialog window shows all of the projects, document folders, and documents that you have
permission to view.

5. Select the document you want to open.

The document opens in your Microsoft Office application.

Save a document to TeamForge

You can store your Microsoft Office documents in CollabNet TeamForge even if the CollabNet TeamForge web
interface is not open.

CollabNet TeamForge works with Microsoft Word, Excel, Project, and PowerPoint.

1. Open your Microsoft application.
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2. Open the document you want to save.
3. From the File menu, choose Save to CollabNet TeamForge .
4. In the Log in window, enter the following information:

*  Your TeamForge user name and password.
» The URL of your organization's TeamForge installation.

e Note: Do not enter the http:// or https:// before the server name.

5. Click Log In.
The Selection Dialog window displays all of the projects and document folders in which you have permission to
create documents.

6. Select the document folder in which you want to save the document.

e Note: Do not click on an existing document. This will prompt you to update that document.

7. Inthe Document Properties window, clear Use Filename, then enter a name in the CollabNet TeamForge
Document Name field.

By default, the file name is used as the document name.
8. Write a description for the document.
9. Choose whether the document is in draft or final status.
10. To lock the document and prevent others from editing it, select Lock Document.
11. Write a version comment, if appropriate.
12. Click OK.

The document is now saved in CollabNet TeamForge. You can see the document by going to the CollabNet
TeamForge document folder that you selected.

.:-_ Note: After you save a document to CollabNet TeamForge, future saves will also save in CollabNet
TeamForge. If you want to save a document to a local drive, choose Save As from your File menu.

Communicate with project members

You can communicate with project members via discussion forums, mailing lists, wiki pages, and project news
announcements.

Participate in discussions and mailing lists

CollabNet TeamForge discussions provide workspaces where project members can discuss project-related topics
online or by email.

Create a forum topic

Create a new forum topic to begin discussion of a new subject.

A topic starts a message thread to which other users can reply. A forum can have any number of topics.

A forum topic is similar to an email, in that you can use it communicate with other people subscribed to the forum,
as if it were an email list. If the forum owner has enabled the forum to work as a mailing list, then you can post to the
forum by email as well.

1. Click Discussions in the project navigation bar.

On the Forum Summary page, click the title of the forum in which you want to create a topic.

On the Topic Summary page, click Create.

On the Create a Topic page, describe the topic in the Subject field.

A T

Write the message in the Message field.
After the topic is created, other users can reply to this message.

6. If you want the message sent by email to people who are not members of the forum, add their email addresses to
the Other Recipients field. If there is more than one, put commas, semicolons or spaces between them.
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.:-_ Note: In a moderated discussion forum, addresses in the Other Recipients field get your message
only after the moderator approves the message.

7. To add an attachment to the topic, click Browse and select the file.
8. Click Save.

.:-_ Note: If this discussion forum is moderated, the topic is held until a moderator approves or rejects it. (Except
if it is from a trusted user. These messages don't require moderation.)

Search for posts
Search for a post by using keywords, specifying the forum it belongs to, selecting the sender of the post or entering
relative date or date range.

You can search for posts either across all forums or within specific forums.

1. Click Discussions in the project navigation bar.
2. On the Forum Summary page, click Search Posts.

3. On the Post Search Criteria page, enter the desired search criteria.

' Tip: You can use wildcards.

» To search by subject, body or attachments, enter the text in the Search Text field and select Subject, Body
and/or Attachments options.

* To search by forum name, select the forum in the Forum field.

e Note: When none of the forum options are selected, the system searches for matching posts across all
) forums.

* To search by post-sender, select the user name in the Posted By field.

' Note: You can select User running search option to display your posts.

» To search by time span, specify relative dates such as "Within the last 7 days".

» To search by date range, enter the start and end dates for the search. Click the Calendar icon to select dates
from a calendar.

4. Click Search.
All posts matching your search criteria are displayed in the Search Results page.
Reply to a forum message

You can post a message in any topic in any forum you have access to. You can also post a message in reply to another
message.

If the forum is moderated, you must have posting permission. Contact the forum moderator.

' Tip: If you are getting your forum messages delivered as email, you can reply to a post by email too.

1. Click Discussions in the project navigation bar.

2. On the Forum Summary page, find the topic in which you want to post a message.

3. In the section containing the message to which you want to respond, do one of the following:
* Click Quote to quote the original message in your response message.
* Click Reply to omit the original message from your response message.

4. Write the message.

5. To add an attachment to the message, click Browse and select the file.

6. Click Save.

The forum message is posted. Other project members can reply to it using the same process.

e Note: A message to a moderated discussion forum is held until a moderator acts on it. (Except if it is from a
trusted user. These messages don't require moderation.)
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Subscribe to a discussion or mailing list
When you monitor a discussion forum, you are notified of contributions to the forum by email. Monitoring a forum is
the same thing as subscribing to a mailing list.

A bell icon in the Monitoring column indicates that you are subscribed to a forum.

It looks like this:

|:_£H|

» Ifyou prefer to do it by e-mail:
a) To subscribe in message by message type subscription, send an email to <Email address name in
Mailing list>-<project name>-subscribel@<domain name>
b) To subscribe in digest type, send an email to <Email address name in Mailing list>-
<project name>-digest-subscribe@<domain name>
¢) You can also change the subscription type from message by message to digest and vice-versa.
» Ifyou prefer to do it through the web interface:

a) Click Discussions in the project navigation bar.
b) Click Monitor.
Set the notification frequency using "Monitoring Preference" as it suits you.

Subscribe others to a discussion or mailing list
You can add other users to a discussion.

If you are a forum administrator, you can also add users to the discussion as a group.

1. Click Discussions in the project navigation bar.

2. Select the forums that you want to add users to.

3. In the Monitor list, click Users Monitoring Selected.

4. Click Add and move the users you want into the Users to Add column.

e Tip: To add users as a group (assuming you are a forum administrator), do the same operation on the
User Groups tab.

Post to a forum by email
If the forum also works as a mailing list, you can create a forum topic by sending an email message to the forum. You
can also reply to a post by replying to the email.

If the forum is moderated, you must have posting permission. Contact the forum moderator.
The forum's email address, if it has one, appears on the Topic Summary page.

e Tip: If a forum is not set up to work as a mailing list, you can still get posts by email when you monitor the
forum. See Monitor many items on page 83.

1. Click Discussions in the project navigation bar.

2. On the Forum Summary page, click the forum in which you want to create a topic.

3. On the Topic Summary page, find the email address in the Mailing List field. Send your email message to that
address.

CollabNet TeamForge maps your email to the forum topic like this:

Email Field Forum Topic field
To Forum email address
Subject Title of forum topic
Body Text of forum topic
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Email Field Forum Topic field

Attachments Attachments

Emails from the forum can be read in RTF (Rich Text Format) or HTML format. The format of the message is
delivered as an attachment to the post. Embedded attachments, such as text or images, are also delivered.

A message to a moderated discussion forum is held until a moderator acts on it. (Except if it is from a trusted user.
These messages don't require moderation.)

In a moderated discussion forum, if you add other addresses in the cc: field of your email, those addresses get your
email only after the moderator approves the message.

Associate forum messages with other items
When a forum message concerns some other CollabNet TeamForge item, such as a document, a tracker artifact, a file
release, a code commit, or a task, link the message to the item under discussion by creating an association.

Creating associations between items enables you to define relationships, track dependencies, and enforce work flow
rules.
1. Click Discussions in the project navigation bar.
2. On the Forum Summary page, find the forum message with which you want to create an association.
Any existing associations are displayed in the Associations section.
3. Click Associate.

4. Inthe Add Association Wizard window, select the items with which you want to associate the artifact:
* Enter Item ID - If you know the item's ID, you can enter it directly.

e Note: To associate an object in an integrated application from within CollabNet TeamForge, use the
[<prefix objectid>] format. Successful associations appear hyperlinked.

' Tip: Each integrated application displays its prefix on moving the mouse over the application name in
the tool bar.
* Add From Recently Viewed - Select one of the last ten items you looked at during this session.
* Add From Recently Edited - Select one of the last ten items you changed.
5. Click Next.
6. Inthe Add Association comments window, describe the reason for the association.
7. Save your work.

* Click Finish and Add Another to add additional associations.
* Click Finish to return to the Details page.

Administer forums and mailing lists
Forum administrators create forums and do what is needed to keep them on track, such as editing or moderating
forum posts.

You can choose to make a discussion forum either public or private.

You can be a forum or mailing list administrator without being a project administrator. Ask your project administrator
or site administrator to grant you forum administration permissions.

Forum administrators can enable or disable forum moderation and add or remove moderators and trusted users. Any
project member with forum post permissions can be a moderator.

Forum administrators can also make forums work like mailing lists.

Guest users can monitor a forum if email monitoring is set to "Allow all site users and guests". Additionally, guest
users can email-post or subscribe to a forum if the mailing list is enabled and "Email Posting" is set to "Allow all site
users and guests" from the discussion settings.

e Tip: Who can post by email to a discussion forum is controlled by the "Email Posting" options set for the
forum. It does not depend on the permissions set for users of the Web forum.
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Create a discussion forum
Encourage project members to work together by creating discussion forums to which project members with the
appropriate permissions can post messages.

Discussion forums can also function as mailing lists.

As a forum administrator, you can choose to make a discussion forum either public or private.

1.

7.

Click Discussions in the project navigation bar.

2. On the Forum Summary page, click Create.
3.
4. To make it a private discussion forum, set the Type to Private.

On the Create Discussion Forum page, enter a title and description for the forum.

Private discussion forums restrict anyone without specific access permissions from posting to the forum. For
example, you may want to restrict a preliminary planning discussion to your project's core team before sharing it
more widely.

If you want the forum to work as a mailing list, select Enable Mailing List.

a) Provide a name for the mailing list in the Email Address field.

' Note: The mailing list name must be unique within a project.

b) Set who can post to the forum via emails. Choose either User with Roles and Permissions (default) or Allow
only forum admins from the Email Posting drop-down list.

c) Set who can subscribe to monitoring via emails. Choose either User with Roles and Permissions (default) or
Allow only forum admins from the Email Monitoring drop-down list.

Note: Sclecting Allow only forum admins for Email Monitoring will not restrict users with
'Discussion-View' permission from getting monitoring emails in case they choose to monitor the forum
via the web UI.

d) Choose how replies to posts are handled by setting the Reply Behavior.

[

' Tip:
* Many users are accustomed to having their replies go automatically to the whole list. Others are

used to having replies go just to the original sender. You should check with your users to see what
makes more sense for a particular mailing list.

*  When Reply Behavior is set to "To the list," email replies are sent to the list as a whole, not to the
individual post. This may be a change from what some users are used to.

e) Specify a prefix for the subject lines of messages from this list.

This can help users sort their incoming messages, if they are subscribed to multiple lists.

f) You may limit the size of emails (including attachments, if any). Enter the size (in MB) in the Message Size
field.

g) Under Footer Text, provide any information you want to show up at the bottom of each email that subscribers
receive.

For example, you may want to offer useful web locations or email addresses.
To make this a moderated forum, select Enable Moderation.
a) Use the User Picker to add moderators.

A moderated discussion must have at least one moderator.

' Note: If your project includes members of a parent project, you can select those members too.
b) Use the User Picker to add trusted users.
Posts by trusted users do not need moderator approval.

On the Create Discussion Forum page, click Save.

If you set your forum to work as a mailing list, all project members monitoring the forum will receive notifications
whenever a new topic or message is posted.
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Rename or edit a discussion forum
To help keep a forum or mailing list focused, try updating its title.

As a forum administrator, you can enable/disable mailing list or moderation features or just update their settings for
the discussion forum.

1. Click Discussions in the project navigation bar.

2. On the Forum Summary page, select the forum you want to change, and click Edit.

3. On the Edit Forum page, make your changes.

4. Click Save.

e Note: All project members monitoring the forum receive notifications of the update.

Add or modify moderators
As a forum administrator, you can add or remove forum moderators.

' Note:

e If a forum is moderated, it must have at least one moderator.
*  When you designate a forum moderator, you also become a moderator yourself.

Click Discussions in the project navigation bar.
On the Forum Summary page, select the forum for which you want to add or modify the moderators.
On the Topic Summary page, click Edit.

Pl ol

On the Edit Discussion Forum page, add or modify the forum moderators.

e Note: The existing moderators are listed.

5. Click the User Picker icon to add or remove forum moderators.

You can select one or more moderators.

e Note: You can select the inherited project members also from the list.

a) To add moderators, select the required users, click Add and click OK.
b) To remove moderators, select the required users, click Remove and click OK.

6. On the Edit Discussion Forum page, click Save.

Moderate a discussion forum by email
If your discussion forum is also a mailing list, you can approve or reject the post by email.

A message to a moderated discussion forum is held until a moderator acts on it. (Except if it is from a trusted user.
These messages don't require moderation.)

As a moderator, you get an email when a message is awaiting moderation. The email contains the URL where you can
approve or reject the message.

See the notification email for your options.

Option Description

To accept the message: Send an email to <postld>-accept@<domain>, or just
click Reply.

To accept the message and add the sender to the Send an email to <postld>-allow@<domain>, or click

"Trusted Users" list: Reply-to-All

To reject the message: Send an email to <postld>-reject@<domain>.

To add your comments to the message: Include your comments in the Start Comment and

End Comment blocks in your response email. Your
comments will appear in the approved post.
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Approve a forum post
If a post is appropriate, you can add it to the forum by approving it.

A message to a moderated discussion forum is held until a moderator acts on it.

As a moderator, you get an email when a message is awaiting moderation. The email contains the URL where you can
approve or reject the message.

.:_ Note: If your discussion forum is also a mailing list, you can approve or reject the post by email. See the
options in the notification email.

.:_ Note: If the sender consistently contributes useful and appropriate input, you can save the moderation time
by designating that user as a "trusted" user. Posts from trusted users don't have to be moderated.
1. Click My Workspace in the project navigation bar to return to your My Page.
2. On My Page, click the Items Awaiting My Approval tab.
The number of posts awaiting approval are displayed against the project names.
3. To view forum details, click the hyperlinked Number of Posts for your project.
4. Click the number of posts awaiting approval link on the Forum Summary page.
' Notg:. The Forum .Summary page displays all the forum names and the corresponding number of posts
awaiting approval, if any.
5. Select either of the three approval techniques in the Posts Awaiting Approval tab.
As the moderator of the post, you will be able to view the topic title in the All Topics tab; and post title in the
Posts Awaiting Approval tab on the Topic Summary page.

.:_ Note: In the All Topics tab, the hourglass icons differentiate the topics that contain posts awaiting
approval. To view posts nested within a topic, you can use the hyperlinked topic title.

Option Description

To approve posts and senders individually: Select the post and click Approve or Approve and
Trust.

To approve multiple posts and senders at once: Select all the posts to be approved and click Approve

or Approve and Trust below the post details.

To view the post details and approve: Click the post title and click Approve or Approve and
Trust on the Review Post Awaiting Approval page
after reading the details.

Reject a forum message
If a proposed message is not appropriate or does not contribute to the goals of your discussion forum, you can reject
it.

A message to a moderated discussion forum is held until a moderator acts on it. (Except if it is from a trusted user.
These messages don't require moderation.)

As a moderator, you get an email when a message is awaiting moderation. The email contains the URL where you can
approve or reject the message.

.:_ Note: If your discussion forum is also a mailing list, you can approve or reject the post by email. See the
options in the notification email.

e Note: You can reject posts with or without comments or reasons for rejection.

1. Click My Workspace in the CollabNet TeamForge navigation bar.
2. On My Page, go to Items Awaiting My Approval.

3. On the Forum Summary page, click Number of posts awaiting approval.
Topics that contain posts awaiting approval have an hourglass icon.

4. On the Posts Awaiting Approval tab, choose your method of rejection.
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Option Description
To reject the posts individually: Select the each post, then click Reject at the end of the
post.

To bulk-reject the posts: 1. Select all the posts you want to reject, then click

Reject below the post details table.

To view the post details and reject: Click the hyperlinked post title, then click Reject on
the Review Post Awaiting Approval page.

To explain your rejection with a comment: Click Reject With Comment instead of Reject.
e Note: The rejection comment is posted to the

message sender.

Rejected messages are deleted from the posts awaiting approval list and the message senders are notified by email.
Delete a forum message
When a message in a forum is off topic or potentially harmful, you may want to delete it.

Before deleting a forum message, consider leaving it in place so that future users can consult it if they need to.
Consider this even if the message does not seem very useful right now.

e Important: You cannot delete the topic starter's original message without deleting the entire topic.

1. Click Discussions in the project navigation bar.

2. On the Forum Summary page, find the forum message that you want to delete.
3. Click Delete and confirm that you want to delete the forum message.

The forum message is deleted.

Delete a forum topic
If you no longer want a forum topic in your project, you can delete it.

e Important: Deleting a forum topic deletes all of the forum messages in the topic. Delete a forum topic only
if you are sure that you no longer need any of the forum messages in it.

Click Discussions in the project navigation bar.

On the Forum Summary page, click the title of the forum containing the topic that you want to delete.

On the Forum Topic page, select the topic you want to delete.

El o

Click Delete and confirm that you want to delete the topic.

The forum topic is deleted.
Stop moderating a forum
If a moderated discussion forum does not require posts to be moderated anymore, moderation can be disabled.

To change a moderated discussion forum to unmoderated discussion forum in CollabNet TeamForge, select the forum
and turn off its moderation feature.

.:_ Note: Users with forum admin permissions only can enable/disable moderation.

Note: On disabling moderation on a moderated forum, the posts awaiting approval are automatically
approved.

=

Click Discussions in the project navigation bar.
On the Forum Summary page, select the moderated forum that does not require moderation anymore.
On the Topic Summary page, click Edit.

L=

On the Edit Discussion Forum page, to disable moderation, de-select the Enable Moderation check box.

' Note: The following message is displayed: "Any post awaiting moderation will be approved
automatically."
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5. Click Save to turn off the moderation.
To keep moderation enabled, select Cancel.

e Note: The moderated discussion forum changes to an unmoderated discussion forum and any posts sent to
the forum will be displayed without any restrictions.

Share project news

Regular project news announcements help members stay in touch with events that can affect their work on the project.
Post a news item

To help project members stay up to date, post regular news items on the project home page.

News items are posted and displayed on the project home page and on the CollabNet TeamForge home page.
1. Go to the home page of the project in which you want to post the news item.

» From within the project, click Project Home in the project navigation bar.

* From anywhere in CollabNet TeamForge , choose the project from the Projects menu in the CollabNet
TeamForge navigation bar.

2. Inthe Project News section, click Create News Post.
3. On the Create News Post page, write a title for the news item.
4. Write the news item in the message field.
The news item can be up to 4000 characters long, including spaces.
5. Click Create.
The news item shows up on the project home page and the CollabNet TeamForge home page immediately.

Delete a news item
It's a good idea to promptly delete a news item that is out of date or otherwise incorrect.

Deleting a news item from a project also deletes it from the CollabNet TeamForge home page.
1. Find the project home page.
* From within the project, click Project Home in the project navigation bar.
* From anywhere in CollabNet TeamForge navigation bar.
2. In the Project News section, click Delete next to the news item that you want to delete, and confirm that you want

to delete the news item.

The news item is deleted.
Edit a news item
To keep the project news in sync with the developments, modify the news items as and when required.

1. Find the project home page where you want to update the latest news.

* From within the project, click Project Home in the project navigation bar.

*  From anywhere in CollabNet TeamForge , choose the project from the Projects menu in the CollabNet
TeamForge navigation bar.

2. Inthe Project News section, click Edit next to the news item that you want to modify.
3. On the Edit News Post page, modify the title and/or the content of the news item.
4. Click Save.

The news post appears on the project home page, along with your name and the time at which you modify the post.

Contribute to the project wiki
The TeamForge Wiki allows you to create an unlimited number of Wiki pages in each TeamForge project. Wiki pages
are a tool for managing project information as unstructured, linkable content.
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Start a Wiki
To start communicating with other project members via Wiki, create a new page in your project's Wiki.

Every CollabNet TeamForge project starts with a blank Wiki. You do not need to create a Wiki before you can begin
adding content. After a Wiki is started, any user with the appropriate permissions can add or edit content; however,
you cannot delete all of the content to start over with a new, blank Wiki.

1. Click Wiki in the project navigation bar.

2. On the Wiki home page, clickEdit.

3. On the Edit Wiki page, write your Wiki text.

Wiki content is a combination of plain text, markup for font elements such as bold or italics, headers, bulleted and
numbered lists, and links.

4. Customize your Wiki entry with any of these optional steps:
a) Use the buttons at the top of the text area to add Wiki markup to your text.
You can also enter Wiki syntax directly into the text area. For an explanation of Wiki syntax, click Syntax
Reference.
b) To insert a link to another CollabNet TeamForge item, enter the item id.
You do not need additional Wiki syntax to create the link.
¢) To change the size of the display window, choose a value from the Field Height menu.
d) To attach an external file to a wiki page, click Add Attachment, then browse for the desired file.
e) To add a version comment, write it in the Version Comment field.
5. Click Preview Changes to see how your Wiki content will look.
You can make further edits from the Previewing Home page before saving your changes.
6. Click Update to save your changes.
Your Wiki is now started.
Add Wiki content

When the information you want to share with other project members does not fit neatly into a tracker comment or a
document review, use a Wiki page for a more free-form communication flow.

After a Wiki is created, any user with the Wiki create, edit, or view permission can add or edit Wiki content. You can
also add associations or multiple attachments, or create additional Wiki pages.

.:-_ Note: You can now add multiple attachments in a Wiki page without updating the Wiki each time to include
another attachment. If attachments are not required they can be deleted before updating the Wiki page.

1. Click Wiki in the project navigation bar.
Any existing Wiki content appears.
2. For more information about this Wiki, click View Details.
3. On the Wiki home page, click Edit.
4. On the Edit Wiki page, make your changes or additions to the Wiki content.

» If you prefer to use buttons to do your text formatting, the way you would with a word processor, click
[NAME OF BUTTON].

» If your tastes run more to typing in your wiki formatting, see Wiki syntax on page 294 for the choices
available.

e Tip: You can use a variety of preconfigured queries to generate up-to-date content for your Wiki page.
For example, to generate a graph of artifact statistics, add this string to your Wiki page (with the square
brackets):

[sf:artifactStatistics]
For more preconfigured Wiki content, see Wiki syntax on page 294.

5. Inthe Version Comment box, note the reason for your change.

It is optional, but advisable, to get in the habit of recording a version comment. If your project manager has made
it mandatory, then you must record a version comment before you can save your changes.
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6. Click Preview Changes to see how your Wiki content will look.
You can make further edits on the Previewing page before saving your changes.
7. Click Update to save your changes.
Create a new Wiki page
A CollabNet TeamForge site can have any number of Wiki pages. All Wiki pages are linked, and their relationships
are traced on the Back Links tab of each Wiki page.
1. Click Wiki in the project navigation bar.
2. On the Wiki home page, click Edit.

3. In the large text field, insert the title of your new page between square brackets, like this:
Please post comments about [test results] here.
Then click Update.
The text between the square brackets becomes a link on your Wiki page.

.:-_ Note: You can also type the new link in CamelCase (each word starts with an upper-case letter, no
spaces) and skip the square brackets.

4. Click the link to the new Wiki page.
The new page is created. The title of the new page is the same text as the link, rendered in CamelCase.

5. On the Create Wiki page, write the content you need, then click Save.

.:-_ Tip: You can use a variety of preconfigured queries to generate up-to-date content for your Wiki page.
For example, to generate a graph of artifact statistics, add this string to your Wiki page (with the square
brackets):

[sf:artifactStatistics]
For more preconfigured Wiki content, see Wiki syntax on page 294.

The new Wiki page is created. The back link to the page from which it was created appears on the Back Links tab of
the Details section.

Search a wiki

Use the wiki search page to find content in a project wiki.

1. Click Wiki in the project navigation bar.
2. On the Wiki home page, click Search Wiki Pages.
3. Try one of the predefined searches.
These can save you time by running some of the most widely used content searches with a single click:

» List the wiki pages that have changed in the last 15 days.
» List the wiki pages that no other wiki page links to.
» List all the pages in this project's wiki.
4. If you need to narrow your search beyond the predefined searches, enter some search terms under Wiki Pages
Search Criteria.

Wildcards are allowed.

» To search active wiki content, enter the search keywords in the in the Search Text field.

» To search active and inactive wiki page versions, select Search All Versions. (By default, searches are
performed on active wiki page versions only.)

» To search wiki attachments, select Include Attachments.

» If you know approximately when the wiki content was created or last edited, enter the start and end dates for
the search and click Search. Click the calendar icon to select dates from a calendar.

» To search by author, enter the author's user name in the Created or Edited By field. Click the people icon to
display a list of project members.

5. Click Search.
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A list of wiki pages matching your search criteria appears.
View a wiki page as HTML
One way to resolve messy or incorrect formatting on a wiki page is by converting the page to clean HTML.

1. Click Wiki in the project navigation bar.
2. Find your wiki page by navigating or searching.
3. Click the View HTML button.

The wiki uses HTML Tidy to display the cleanest HTML it can manage. View the page source to see the results.
View a wiki page as a PDF
When you want to send a wiki page to someone outside the project, it can be handy to convert it to a PDF document.

1. Click Wiki in the project navigation bar.
2. Find your wiki page by navigating or searching.
3. Click the View PDF button.

Depending on how your browser is set up, the resulting PDF document appears or the browser offers to download it
for you.

Manage source code

Browse a project's source code repositories for detailed information about code commits, changed files, and
associations with other CollabNet TeamForge items.

View code commits
To stay up to date with code development on a project, browse the code commits made to each repository integrated
into your CollabNet TeamForge site.

For each code commit, you can view the list of files that were checked in, the version history of each file, and any
associations with other CollabNet TeamForge items, such as tracker artifacts or tasks.

' Note: You can see only those paths in the repository that the repository administrator has given you access
to.

1. Click Source Code in the project navigation bar.
2. From the list of project repositories, select the repository you want to look at, then click View Commits.

The Commits section of the Repository Details page lists all the code commits in the repository. By default, it
shows the commits made over the preceding seven days. For each code commit, you can see:

* The code commit name.

* The name of the developer who made the code commit.
* Any commit message entered by the developer.

* The date on which the code was committed.

e Tip: To get an automatic email notification whenever code is committed to this repository, click the
Monitor down arrow, then choose Monitor Selected. The emails will contain all the details you can see
on this page, unless the repository's owner has chosen to send emails with only the essential information.

Note:

*  You can find a filter field at the top of each column in most of the tables in the TeamForge application.
* The filter field could be a text box or a drop-down list.
*  You can type your filter criteria in the text boxes. The search text is case-insensitive.

* You can also select the filter values from one or more drop-down lists. By default, you can only select
up to five filter values in a drop-down list. However, you can set a value that suits your requirement for
the FILTER DROPDOWN MAX SELECTION token in the site-options.conf file to increase
or decrease the count.

* Some search filters may not appear if your site administrator has not enabled them.

Specify the filter criteria in one or more filter fields (at the top of each column) and click Filter.
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Table filter drop-down list with multi-select check boxes

Stories (11 Iltems)

Artifact

art

art

art

art

art

art

4. After filtering, if you want to clear the filters, click Filter and select Clear from the drop-down list.
5. To view the details of a commit, click its title.

The Files section of the Commit Details page lists all files that were checked in with the code commit, including
the version number of each file and the last operation that was performed, such as modified, deleted, moved,
copied, or added.

* To view the file information, click the file name.
» To view the latest version of the file, click the file version.

6. To look at other items related to this commit, click the Associations tab.

Associate code commits with other items
Create associations between code commits and other CollabNet TeamForge items, such as tracker artifacts or
documents, to help define relationships, track dependencies, and enforce work flow rules.

For example:

» Associate a code commit with the bugs, feature requests, or other tracker artifacts that the code addresses.
» Associate a code commit with the task requiring its completion.

* Associate a code commit with an object in an integrated application.

* Associate a code commit with a requirements document.

Associate code with other items while committing
When you commit files to your source code repository, use the commit comment to quickly link your commit with
one or more tracker artifacts or other CollabNet TeamForge items.

Associations track the links between code and the bugs, feature requests, or other tracker artifacts that the code
addresses. You can also associate code commits with other CollabNet TeamForge items, such as tasks or documents.

A project administrator can make associations mandatory for all code commits.
with other CollabNet TeamForge items, such as tasks or documents.
A project administrator can make associations mandatory for all code commits.

You can create tracker artifact associations from whatever interface you normally use to check code into your SCM
repository. You do not have to log into CollabNet TeamForge.

Use the same syntax for commits to CVS, Subversion, and Perforce repositories.

When making a code commit, add the associate command in the commit message like this:
[<item id>], such as the TeamForgetracker artifact ID or task ID.

» TeamForge item IDs are always letters followed by four or more numbers, such as task1029 or
artfl10011.
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» To associate a commit with multiple CollabNet TeamForge items, separate the item IDs with commas.
» All associations are displayed in the Associations section of the Commit Details page.
* The Comment section lists the comments made with each commit.

e Note: To associate an object in an integrated application, use the [<prefix objectid>] format.
Each integrated application displays its prefix on moving the mouse over the application name.

Tip: To remind yourself of the details of the association later, look in the Change Log tab of the associated
Artifact Details page.

Create associations with code that is already committed

At any time after a code commit is made, you can associate the code commit with other CollabNet TeamForge items,
such as tasks, integrated application objects or documents.

1. Click Source Code in the project navigation bar.

2. On The list of project repositories, select the repository containing the code commit with which you want to create
an association.

Click View Commits.
On the Repository Details page, click the name of the commit with which you want to create an association.
On the Commit Details page, click the Associations tab.

On the list of existing associations, click Add.

A A

In the Add Association Wizard window, select the items with which you want to associate the artifact:

* Enter Item ID - If you know the item's ID, you can enter it directly.

e Note: To associate an object in an integrated application from within CollabNet TeamForge, use the
[<prefix objectid>] format. Successful associations appear hyperlinked.

' "l}“lip: Ela];:h integrated application displays its prefix on moving the mouse over the application name in
the tool bar.

* Add From Recently Viewed - Select one of the last ten items you looked at during this session.
* Add From Recently Edited - Select one of the last ten items you changed.

8. Click Next.
9. Inthe Add Association comments window, describe the reason for the association.
10. Save your work.

* Click Finish and Add Another to add additional associations.
* Click Finish to return to the Details page.

Create a source code repository
Each project can have one or more source code repositories.

Before you can create a source code repository, a site administrator must first add one or more SCM servers to the
CollabNet TeamForge environment.
1. Click Source Code in the project navigation bar.
2. In the list of the project repositories, click Create Repository.
3. On the Create Repository page, enter the directory name for the repository.
e Note: For CVS repositories, the directory name is the name of the directory relative to the CVS server's
repository root directory. A UNIX group by the same name is also created to enforce permissions.
4. Enter a name and description for the repository.

If you plan to use an SCM server that requires approval for new repositories, use the Description field to provide
your reason for asking to create this repository.

5. Choose the server on which you want to create the repository.

Note: The menu contains all of the SCM servers that the CollabNet TeamForge administrators have
added to the CollabNet TeamForge environment.
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6. If you want to require that each code commit be associated with an artifact (or a task or some other work item),
select Association Required on Commit.

7. For security reasons, you may want to restrict email notifications to the essential information. If so, select Hide
Details in Monitoring Messages.

8. Click Save.

Your request for a new repository is submitted. You will receive an email notification when your repository is created
or if your request for a new repository is denied.

+ Ifthe SCM server that you chose does not require approval for new repositories, the repository is created.

» Ifthe SCM server that you chose requires approval for new repositories, a CollabNet TeamForge administrator
must approve your repository before it is created.

Note: By default, repository requests on unmanaged CVS servers require approval, because the SCM
administrator must manually create the repository.

Replicate a repository

When a Subversion Edge replica has been successfully registered with a TeamForge SCM integration server, it
is available to project administrators in projects using that server to house repositories. To replicate a Subversion
repository, you need to add it to a replica server.

Before you can replicate a Subversion repository, an administrator must first add one or more replica servers. This
involves converting a Subversion Edge server, and then approving the replica in TeamForge.

1. Click Source Code in the project navigation bar.
2. In the list of project repositories, select the one you want to replicate and click Edit.

The Edit Repository page lists the available replica servers. Here's an example:

Replica servers hosting repository: Desktop
Status Name Hostname/IP address Description Owner

(i) Mo results found.

Available Replica Servers

* Name % Hostname/IP + Description = Owner -
Status address
] Tokyo cul26.doud.sp.collab.net  Replica in Tokyo office Subversion
Replication
| Replicate repasitory

If you don't see any available replica server listed here, it may be because none were created for this Subversion
server, or there are pending replicas which haven't yet been approved by a TeamForge administrator.

3. Inthe Available Replica Servers section, select a replica server and click Replicate Repository.
You will see it in the list of replica servers hosting the repository.

» To see details such as the hostname and the user managing the replica repository, and recent replication command
history, click the Status icon for the repository.
» For the Subversion checkout command, see the project's Source Code page.

Note: The TeamForge account used while setting up the replica determines what's available to be checked
out from a replica repository. This account - the Managed By user in the Repository Replica Details
page - could have been provided total access to the master repository, or restricted access using path-based
permissions.

[
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Check command history
Recent command history for a replica server or a specific repository allows you to check for errors and see whether
there are pending commands.

* Maybe a repository revision is not showing up. You can check for errors to know it's not just because the
repository is still synching.

* You can also check if there are commands waiting in the queue -- you'd be able to see whether the repository is
truly in synch.

* To check the command history for a replica repository, follow these steps:

a) Click Source Code in the project navigation bar.
b) In the list of repositories, click the icon for the one you're interested in.
You'll see repository details and command history. Here's an example:

Repository Replica Details

Replica Server: Tokyo SErver: Subversion
Hostniame: cu126.doud.sp.collab. net Repository MName: Benchmark
Managed By: Subversion Replication Description: SV henchmarks
Last Contact: “Wed Apr 06 12:23:32 PDT

2011

| Browse Repasitary Repli

Replication Command History Page 1 of 3 (45 Items) |7 tide| "B Apply | B Remove | | = Rows-
Status =2 Command ¥ Revision =2 Created Date %1 Last Contact
Any - From p4/p5/2011 = (MM/dd fyyyy)
To  p4fos/2011 (M/dd fyyyy)
Q Sync repaository 70 Wed Apr 06 12:21:50 POT 2011 Wed Apr 06 12:21:54 PLT
2011
Q Sync repository o9 Wed Apr 06 12:21:46 POT 2011 Wed Apr 06 12:21:54 PLT
2011
v Sync repository o3 Wed Apr 06 12:21:41 POT 2011 Wed Apr 06 12:21:43 PO

o Tip: You can also check command history by clicking on the Status icon in the Edit repository page.

*  You need to be a TeamForge administrator to check the command history across a replica server.
a) On the site administration navigation bar, click Integrations.

b) On the SCM Integrations page, click the name of the replica server you're interested in.
The Edit System page displays the command history.

Check out Subversion code anonymously
When you want to experiment with the code, you can do an anonymous checkout from the Subversion repository.

The checkout command uses a unique system-created user called "guest" and works without authentication.

To make anonymous checkout possible, the project administrator must set public and repository view permission to
"All Users."

The checkout command differs based on whether a user is logged in or not.

*  When you are not logged in, use this command to check out: svn checkout --username guest
<domain>/svn/repo URL name

*  When you are logged in, use this command to check out: svn checkout --username <logged
in username><domain>/svn/repo URL name
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Access CVS with a stored SSH key
If you don't want to enter your password each time you access a CVS repository, you can create a set of SSH
authorization keys and use the public-key method for automatic authentication.

Secure shell (SSH) can use public-key cryptography to confirm your identity, authenticate you to the remote host, and
encrypt data transmission. On many TeamForge sites, access to CVS repositories is authenticated using SSH.

' Note: These instructions will help you only if all the following are true:

* You're using CVS.

*  The CVSROOT (or "cvs -d") info given you by your admin (or the CTF "Repositories" list) does not
include :pserver:

*  Your admin has set up SSH access for you.
Check with your site administrator if you are not sure about any of these conditions.

1. Generate an SSH key pair according to the instructions in the documentation for your SSH client.
(Each SSH client provides its own mechanism for key pair generation.)

Log into TeamForge .

On your My Workspace screen, click My Settings in your personal navigation bar.

On your User Details page, click Authorization Keys.

A S

On the Authorization Keys page, copy the public key from the . pub file in your SSH installation directory and
paste it into the Authorized Keys field.

6. Click Update.

Your SSH public key is now saved. When you log into a CVS repository on your TeamForge site, SSH automatically
checks your private key against this public key and authenticates you. You do not have to enter a password.

e Note: You can store multiple SSH public keys in TeamForge, but only one for each client machine.

Provision hardware
Use TeamForge Lab Management to access virtual or physical machines where you can build and test your code.

.:-_ Tip: For more information about the new features in TeamForge Lab Management 2.2, see this introductory
video. (You'll need a free open.collab.net membership to watch it.)

Get an account on this system
If you are new to this system and require access, contact a TeamForge (or CEE) administrator in your organization.

The administrator will add a role to your CollabNet TeamForge (or CEE) account which will enable you to access
resources on this site.

What Lab Management systems are assigned to me?
The easiest way to see what Lab Management systems are assigned to you is to check the My Pages page.

Each system assigned to you is listed on the My Pages page, organized by project.

For more details on a particular system, click the name of the system. On the host status page, you can get more
information about the host's configuration and performance, release the system, and more.

Find an available host to use
To work in the Lab Management environment, you need to either allocate a system to yourself or log into someone
else's system in your project.

1. Click My TeamForge Lab Management or the Projects tab and select your project.

.:-_ Important: It is usually considered impolite, and may even be a violation of your company's policies,
to check out a system from one project that you are a member of in order to do work related to another
project.

2. Click Project Hosts.


http://www.open.collab.net/nonav/community/sfee/training/wbt11/WhatsNewLM.htm
http://www.open.collab.net/nonav/community/sfee/training/wbt11/WhatsNewLM.htm
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3. In the list of hosts assigned to the project, do what you need to do:
+ Ifthe host is allocated, click the user's name to ask their permission to work on their host.

.:-_ Tip: You may also ask the user if they still need the host, and would they mind releasing the system
so that you or someone else, could check out the host.
» Ifthe host is in the Free state, allocate it to yourself.

' Note: It is polite to ask the owner of a machine if you can use it to log in and run jobs on. TeamForge Lab
Management assumes that all TeamForge Lab Management users in a project should be able to log in to
all systems in a project, to facilitate developer and QA productivity. But, along with this freedom comes
the responsibility to be a "good citizen" and not step on other people's resources.

Allocate yourself a Lab Management machine
When you have been given membership and an appropriate role in a TeamForge Lab Management-enabled project,
allocate a host for your own use.

Your personal host can be rebuilt with any profile whenever you want.

You can install any software you want on it (subject to the CollabNet Terms of Service and your own organization's
security policy, all depending on how and where your TeamForge Lab Management instance is deployed).

You can run any jobs you want on the server (subject to the same conditions as software installation).

1. Find an available host to allocate.

N

On your project's TeamForge Lab Management home page, click the host you've identified.

w

On the host status page, click Allocate to reserve the host for yourself.

=

Specify how long you wish to allocate the host.

* Choose a specific time/date to deallocate the host using the calendar widget.
* Choose a length of time to allocate the host.
» Allocate the host indefinitely (until you or a project admin frees the host).

.:-_ Note: Your project administrator may have set a limit on the amount of time a machine can be allocated.
If this is the case, then you will receive an error message if you try to allocate a host for a longer period.

You can always change the allocation time for your host later, if you decide that you need the host for a shorter or
longer amount of time (subject to the maximum limits set by your project administrator).

Compare profiles or profile versions

To choose a profile for your TeamForge Lab Management system, compare different profiles and profile version in
the Profile Library.

1. On your project's home page, select Profile Library.
The table shows all profiles in your project.
2. Choose a profile from each of the sets of profiles and click Compare selected profiles.
.:-_ Note: Profiles must first be added to your project as "allowed profiles". It is not possible to compare
profiles before you have added them to your project.
3. On the Profile Compare screen, select the versions of each profile to compare.
The default version is the latest version of the profile, but any version of a profile can be compared against any
version of any other profile.

.:-_ Note: Any two profiles can be compared, even if they are from two different operating systems. For
example, TeamForge Lab Management will let you compare a Solaris profile and a Windows XP profile
(but do not expect the results to be very meaningful).
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Create a profile from a host
Let's say you've built a generic Lab Management host and customized it for your team. With Lab Management 2.4,
you can create a profile based on the host image and store it in the Project Build Library (PBL) for your project.

' Note:
* You can only create profiles from ESX guests.

» These OS profiles are supported: RHEL 5, CentOS 5, SLES/11, Windows XP and And Windows Server
2003. Windows Server 2008 and Solaris profiles are not supported.

When creating a profile that contains user-specific software or services, here are a couple of things you should be
aware of:

+ If the software or service is run by a user who is a locally-created user (say, an 'oracle' user who was manually
created on the node), the profile should be easily portable to other projects.

» If the software or service is run by a user who is a Lab Management user, the profile will only work in projects
where that user has access. In projects where that user has no access, it's not likely that the profile will work well -
it may not work at all.

1. Bring up your host's Admin tab.

2. In the Create Profile from This Node section, enter a name for the profile.

Only alphanumeric characters, hyphens, underscores, and periods are allowed.

Create Profile from This Node

I_reate a new profile based on this guest. This guest will be inaccessable while the new profile is being cr

Profile Profile names may only contain alphanumeric cha
Name: | nderscores, and pericds (i.e., "a-z0-9_.-").

Profile
Description:

Storage Project freedom public PEL storage -
Location:

Create P net

rofile from cu035.h.sp.colla

3. Provide a description for the profile.

4. Select the PBL location for the project.
The profile will be stored here.
5. Click Create Profile from <hostname>.

Your host will be switched to a clone, and inaccessible for few minutes. When it gets back to the allocated state, the
profile will be created. The profile will be available in your project and in any project that allows public profiles.

Rebuild a system
You can rebuild a host with a specific profile that you choose from within your project.

Usually you will want the latest (highest) revision of the profile you are working with. However, profiles are
versioned, like source code. This means that you can always build with an older version of an operating system or
package if you need to.

e Note: Profiles are assigned to projects by your project administrator.

p—

. On the Project Host properties screen, select the host to rebuild.
Click the Configuration tab.
Select a profile from the Profile drop-down list and click Rebuild.

N
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You can check the status of the host's progress by refreshing your browser.

Log into a TeamForge Lab Management system
You can log into any machine that is assigned to a project you are a member of and that you have the requisite
permissions for.

For security reasons, all TeamForge Lab Management systems are on a private network, inaccessible from anywhere
outside of CollabNet. To access these systems, you must tunnel through the TeamForge Lab Management Manager.

If you need access to a system that belongs to a project you are not a member of, you have two options:

* Ask to join the project, or to get permission within that project to access TeamForge Lab Management hosts.
» Ask the owner of the system, or a project/domain administrator, to create an account for you on the machine.

e Note: This may violate your organization's security policy, so check with your site administrator before
creating any accounts. If the account is temporary, you will be responsible for removing it.

Log into a UNIX system
To log in to UNIX systems, such as Linux and Solaris machines, you must use port forwarding over SSH.

Port forwarding over SSH is a secure way to tunnel traffic over the Internet.

1. Setup your SSH tunnel.

a) From a Linux or Solaris system, or from a Windows system with Cygwin, the command to set up an SSH
tunnel to "cu086.$vars.mgr _domain" through the TeamForge Lab Management Manager host "$external_host"
would look like this:

ssh -L22000:cu086.$%vars.mgr_domain:22 S$external host -1 username

b) From a Windows system without Cygwin installed, set up the tunnel using PuTTY.

All connections to "localhost" port number 22000 are now tunneled to "cu086.$vars.mgr _domain" port number 22
(SSH) through the TeamForge Lab Management manager host "$external host"

2. Log into "cu086.$vars.mgr _domain" by issuing this command:
ssh localhost -p 22000 -1 username

Log into a Windows system
To log into a Windows system in TeamForge Lab Management, you must use SSH with the Remote Desktop Protocol
(RDP), which renders a full Windows graphical environment on your desktop.

The TeamForge Lab Management environment includes Windows XP Professional and Windows 2003 Server
machines.

.:_ Tip: You can automate this whole process with a tool called Wissh. CollabNet does not provide support for
this tool, but it is something which we recommend.
1. Set up your SSH tunnel to the TeamForge Lab Management machine.

a) If you have Cygwin installed, use a command like this. For example, "cu087.$vars.mgr domain", through the
TeamForge Lab Management Manager host "$external host"

ssh -L3390:cu087:3389 Sexternal host

b) If you do not have Cygwin, set up the tunnel using Putty.
2. Start Remote Desktop by clicking Start > Programs > Accessories > Communications > Remote Desktop
Connection.
e Note: If you are using Linux to access a Windows system, you can use the rdesktop program, which
provides the same functionality.
3. In the Remote Desktop Connection dialog box, enter localhost:3390 and click OK.

This initiates a remote desktop connection to the TeamForge Lab Management host.
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4. At the login prompt, enter your TeamForge Lab Management username and password.
If you are an authorized user on the machine, you are granted access and the correct privileges.

5. If your remote Desktop Connection to 1ocalhost does not work, try this workaround:
a) Copy the two files mstsc.exe and msctax.dl1 to another folder.

These files should be in the directory C: \WINDOWS\system32,orin C: \Program Files\Remote
Desktop if you installed the Remote Desktop Client from the Windows 2003 CD.

b) Right-click the mstsc.exe file and select Properties.
c) On the Compatibility tab, select Run this program in compatibility mode for Windows 98.
d) Start up the new copy of mstsc.exe from the new location.

You should now be able to connect to 1ocalhost at IP address 127.0.0.1.

Set up atunnel with PUTTY

Summary to come...

1. Launch the PuTTY application.

For Host name, enter the TeamForge Lab Management Manager host "$external host".
For Connection type, enter "SSH".

In the left pane, open Connection list.

Open SSH list and click Tunnels.

In the right pane, enter "3390" for Source port and "cu087.$vars.mgr domain:3389" for Destination, and click
Add.

7. Select the forwarded port from the list and click Open.

AN

8. At the login prompt, enter your TeamForge Lab Management username and password.
The RDP tunnel is now set up.

e Note: This procedure is equivalent to running this SSH command:
ssh -L3390:cul087.$vars.mgr domain:3389 Sexternal host

Set up a VNC server on TeamForge Lab Management
To allow remote access to an X Windows display on Linux from a remote computer, set up a VNC console.

VNC is a convenient and effective way to access an X Windows display from a remote computer. Some applications
require X, and since users don't have access to consoles on TeamForge Lab Management nodes, VNC might be the
only way those applications can be accessed.

1. Seta VNC password using the vincpasswd command.

[grue@cu0l2 gruel]$ vncpasswd
Password:
Verify:

e Tip: This doesn't need to be the same as your TeamForge Lab Management password, but keep in mind
that this password will give the bearer access to an X session as your username, so keep it something
reasonably hard to guess.

2. Edit the file /etc/sysconfig/vncservers. Add an entry for your session number, defaulting to 1,
followed by your username.

Use this as an example file:

VNCSERVERS="1:grue"

3. Start the VNC service.

[grue@cul0l2 grue]$ sudo /etc/init.d/vncserver start
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Starting VNC server: l:grue [ OK 1]

e Note: To stop the VNC server on your machine, run the command like this: [grue@cu012 gruel$
sudo /etc/init.d/vncserver stop

4. If you want VNC to start up each time this server is rebooted, use the chkconfig command to turn it on.
[grue@cu0l2 gruel$ sudo /sbin/chkconfig vncserver on
e Note: To prevent the VNC server from starting up on your machine when it is rebooted, run the command
this way: [grue@cu012 gruel]$ sudo /sbin/chkconfig vncserver off

Connect to a VNC server from your desktop
To access an X Windows display from a remote computer, install and connect a VNC client.

VNC saves your desktop session and allows you to connect to it later. For example, you can start an X session at
work, then log off your computer, go home, start up your computer again, and resume your same X session. In this
sense it is very similar to the screen (1) utility, which allows users to create, disconnect and reconnect to text-
based terminal sessions.

1. Install a VNC client on your computer.

' Tip: Either of these recommended packages is available for all major desktop operating systems.
* TightVNC
+ RealVNC

2. Setup an SSH tunnel to port 5901 on the proper TeamForge Lab Management node.

For example, let's say you are the user grue and you have set up a VNC server on the machine cu012.
$vars.mgr_domain. The port forwarding command would look like this:

ssh -L5901:cul0l2.Svars.mgr domain:5901 Sexternal host
. Note: Multiple -1 options can be combined on the same command line.

3. Start your VNC client software, and give the following information:

e« Hostname: localhost
 Port: 5901

Your VNC desktop session appears.
When you are done with the session, you can close the VNC client application on your desktop.

.:-_ Important: Keep in mind that closing the VNC client does not close applications that are currently running.
You can connect to this session again at any time later and your complete session is saved.

For security purposes, we recommend that you do not keep any windows open which contain root shells or
other software running as the root user. This will mitigate the risk of someone being able to access your
VNC session without you knowing it.

Transfer files in and out of the system

You can use WebDAV, SFTP or Windows RDP to transfer files in and out of a TeamForge Lab Management system.
Transfer files with WebDAV

The most useful way to get files in and out of the TeamForge Lab Management environment is via WebDAV.
Connect to WebDAV with Windows Explorer on Windows XP

With a software update, Windows can be used to connect to a DAV share on a TeamForge Lab Management system.

Microsoft recommends you install this Software Update for Web Folders before using Web Folders. You may need
this update for Web Folders to work properly.

1. Launch Windows Explorer.

2. On the Tools menu, click Folder Options and select the View tab. Clear Hide extensions for known file types.


http://www.microsoft.com/downloads/details.aspx?familyid=17c36612-632e-4c04-9382-987622ed1d64&displaylang=en%20
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This will make file names that begin with a dot (".") to appear properly (for example, your .bashrc file).
3. Launch Internet Explorer.
4. On the File menu, click Open.
5. Enter the URL for your home directory, which will always end in /home /USERNAME.
For example:
https://$external host/home/user
6. Select Open as Web Folder.
7. Enter your user name and password when prompted.
8. If the connection is successful, you will see a new entry added to My Network Places. You can re-connect to this
folder in the future by going to My Network Places and selecting this folder.

As of this writing Microsoft does not provide a client that can mount a Web Folder as a drive letter using an
encrypted, authenticated connection, but a third-party tool called Webdrive can do this.

Connect to WebDAV with Mozilla Firefox on Windows XP

Firefox isn't a WebDAYV client, but it will interface with the Windows native WebDAYV client to open up WebDAV
shares.

1. Install the openwebfolder Firefox plug in and restart Firefox.

2. Log into TeamForge Lab Management and go to the Summary page of any host you have access to.

3. Under Access Options, right-click the link pointing to your home directory and select Open As Webfolder.
4. Enter your user name and password.

Your WebDAYV home directory is now mounted.

Connecting to WebDAV with Mac OS X

To connect to a TeamForge Lab Management system from a Mac, open up your TeamForge Lab Management home
directory via DAV access.

This procedure has been tested with Mac OS X 10.4.8 (Tiger) and should work for all Mac OS X versions.
1. In the Finder, click Go > Connect to Server.

e Note: You can also press emd-K on the keyboard.

2. For Server Address, enter the URL corresponding to your home directory.
For example, https://$external host/home/user (where "user" is your user name).

Click Connect.

If prompted, click Continue.

In the Verify Certificate dialog, enter your TeamForge Lab Management user name and password.

Select Remember this password in my keychain if you want to store your user name and password locally.
Click OK

A A

You should now see your folder.

e Note: Files and directories beginning with a "." are not shown in the graphical folder view, but are accessible
via the command line in OS X.

Connect to WebDAV with Nautilus on Linux

The Nautilus file browser -- the default file browser on distributions like Red Hat, Fedora and Ubuntu -- has built-in
support for DAV folders.

From the main desktop, go to Places > Connect to Server.

For Service type, sclect Secure WebDAV (HTTPS).

For Server, enter the name of the TeamForge Lab Management server, e.g., Sexternal host

For Folder, enter /home /user, where "user" is your user name.

You can leave the User Name, Port, and Name to Use For Connection fields blank.

Click Connect.

A o


http://openwebfolder.mozdev.org
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This creates an icon on the desktop, which brings up your home directory when accessed.

Transfer files with SFTP

Secure File Transfer Protocol (SFTP) can be a useful way to transfer files between your desktop and TeamForge Lab
Management.

SFTP is an extension to the Secure Shell (SSH) protocol, which emulates File Transfer Protocol (FTP). File transfers
made with SETP show up immediately in your TeamForge Lab Management environment. Any TeamForge Lab
Management client machines you are logged into immediately reflect changes made to your home directory from your
desktop.

1. On Linux, UNIX, or Windows with Cygwin, run the command-line SFTP program with a command like this:
sftp username@Sexternal host
' Note: There are also graphical clients available for Linux.
2. On Windows, we recommend using the Filezilla program to manage your SFTP transfers.

Filezilla is available as a plugin for the Firefox web browser with an easy-to-use Explorer-like interface.

Connect to TeamForge Lab Management with Windows Remote Desktop

If you are connecting to a Windows host via Remote Desktop, you can share drives from your local system to the
remotely connected system.

1. On the Start menu, click All Programs > Remote Desktop Connection.

2. Click Options and click the Local Resources tab.

3. Click Disk Drives > Connect

Find a build
You can search for file names (not file content) in the Project Build Library.

Search for files in Project Build Library using these fields:

* Project

»  User

» File Name: Shell-like regular expressions are permitted. For example, for searching all RPMS you can type
*.rpm.

» Description: Substring-like pattern matching is permitted. For example, to search all files added by the
pbl fsckscript, type pbl fsck.

e Note: Exclude directories from your search results with the Exclude option.
Connect to network services outside TeamForge Lab Management

TeamForge Lab Management systems are firewalled from the outside world, for our users' safety. However, you can
use port forwarding to connect to machines outside of TeamForge Lab Management.

For example, you may need to connect to a web server holding the results of your nightly builds, or access an external
web server where libraries are installed.

Reach a TeamForge Lab Management server from the outside

Use port forwarding to allow users outside the TeamForge Lab Management environment to access specfic ports on
specific hosts inside the TeamForge Lab Management network.

Port forwarding must be set up by a TeamForge Lab Management Domain Administrator: neither you nor your
project administrator can do this. This is necessary because port forwarding can open up security holes.

A Caution: Exposing an insecure network service outside of the TeamForge Lab Management environment
could put your whole project and the entire TeamForge Lab Management environment at risk, if that service
is compromised.

Contact your Domain Administrator and give them the following information.

¢ Your name.
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*  Your project.

* The host you want to expose a port from.

* The port number you would like to expose.

» The service you would like to run on this port.

» Security precautions you have taken to insure that this service is safe to expose outside of TeamForge Lab
Management.

Note: Your Domain Administrators may have more stringent information gathering or signoff processes
which you will be subject to.

[

Reach outside destinations from within TeamForge Lab Management

TeamForge Lab Management has no built-in features to allow outbound network access to be granted by an
administrator. However, if you need access to external destinations from inside TeamForge Lab Management, you
have a couple of options.

Try one of these approaches:

+ Contact your Domain Administrator and ask CollabNet to open up a hole in the firewall for this purpose.
* Get the files you need into your home directory from outside CollabNet, and access them that way.

Allocate a host from a cloud
To allocate a host from a cloud into a project, specify its type, size and profile information.

In Lab Management, you can allocate from virtual machines on physical hosts and EC2 hosts. You cannot allocate a
physical machine from a cloud

1. In your TeamForge Lab Management project, click Hosts.

2. Click Allocate for the cloud from which you want to allocate your host.

The clouds you can choose from depend on the ones available in the Lab Management domain, and which of these
the administrator has made available for your project.

3. In the Clouds page, select a host type and size.

Different host types have different attributes such as CPU, disk size and RAM. They also have different costs and
available profiles.

4. Select the system profile you want on your host.
A profile in Lab Management is a collection of software packages that comprise a runnable operating system and
accompanying set of applications.

Note: Profiles have different costs. For example, a profile might include some licensed software that adds
to the cost.

[

5. Select the number of hosts you want to allocate.
The default is one.
6. To customize your host, click Advanced options.

a) Enter a description for the host.
b) Select whether you want the host allocated up to a certain date, or for a specific number of days.

By default, the host is allocated indefinitely until you free it.
7. Click Allocate Host.

Tip: You can see information about the host in your My Pages.

Build and test your software

When your project manager makes CollabNet Build & Test available, you can set up the CollabNet plugin for Hudson
(or Jenkins) in your development environment.

For more information, please see:

*  Hudson wiki for the CollabNet plugin


http://wiki.hudson-ci.org/display/HUDSON/CollabNet+Plugin
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» Jenkins wiki for the CollabNet plugin

Release products
Publish the ouput of your project to selected audiences as packages and releases.

Download a release
Downloading a release brings all the release's files to your local machine in a single . zip file.

Click File Releases in the project navigation bar.
On the Package Summary page, click the title of the package containing the release you want to download.
On the Package Details page, click the title of the release.
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On the Release Details page, click Download Release.
CollabNet TeamForge prepares the compressed file in . zip format.

You are prompted to open or save the file.

Create a package
A package is a folder into which one or more related releases are published.

For example, you might create a package to represent a product deliverable or major component. You can then create
releases within the package for product builds or other groups of files.

. Note: A package must exist before you create the releases and individual files that will go into the package.

Click File Releases in the project navigation bar.

On the Package Summary page, click Create.

On the Create Package page, enter a title and description for the package.
Click Save.
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The package is created.

When you have created a package, you can publish a release into the package.

Create a release
A release is a group of one or more files that are published as a unit.

Before creating a release, you must have a package into which your release will go.

1. Click File Releases in the project navigation bar.

2. On the Package Summary page, click the title of the package in which you want to create the release.
3. On the Package Details page, click Add.

4. On the Create Release page, write a name and description for the release.

5. Set the status of the release.

Pending Releases with pending status are not visible in the
drop-down lists displayed when you set Reported In
Release and Fixed In Release fields in an artifact. Use
Pending status when you have created a release but
have not yet finished adding files.

Active Releases with active status are visible in the drop-down
lists displayed when you set Reported In Release and
Fixed In Release fields in an artifact.

6. Identify the maturity level of this release.

Use one of these predefined values:

*  Development build


https://wiki.jenkins-ci.org/display/JENKINS/CollabNet+Plugin
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* Alpha

* Beta

* General availability
7. Click Save.

The release is created. You can begin adding files.

e Tip: To facilitate tracking, you may want to match this release to the planning folder that tracks the work
that's going into the release. If you do that, the relevant work items will automatically appear on the Planned
Tracker Artifacts tab. See Create a planning folder on page 102.

Add files to arelease
After you have created a release, you can add one or more files. All files in a release are published as a unit.

Project members can download the entire release in a single . zip file, or download only selected files.

1. Click File Releases in the project navigation bar.

On the Package Summary page, click the title of the package containing the release.
On the Package Details page, click the title of the release.

On the Release Details page, click Add.

On the Add File page, go to the desired file, then click Save.
The file is added and you are returned to the Release Details page.
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6. Repeat the last two steps until all files are added.

After you have added your files, you might wish to change the status of the release from pending to active. This will
allow users with appropriate permissions to select the release when entering or updating an artifact. You can also
change the maturity level if needed.

Update files in a release
You can replace an existing file in a release with a new file.

Click File Releases in the project navigation bar.

On the Package Summary page, click the title of the package containing the release.

On the Package Details page, click the title of the release containing the file that you want to update.
On the Release Details page, select the file you want to update, and click Update.

In the Update File window, go to the new file with which you want to replace the current file.

Click Save.

A o

The file is now updated.

Delete files from arelease
If a file is no longer needed, it's a good idea to delete it from the release.

Click File Releases in the project navigation bar.
On the Package Summary page, click the title of the package containing the desired release.

On the Package Details page, click the title of the release containing the file that you want to delete.
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On the Release Details page, choose the file you want to delete, and click Delete.
The file is deleted.

Update release attributes
As your release matures, you should update its maturity level and status.

1. Click File Releases in the project navigation bar.
2. On the Package Summary page, click the title of the package containing the release.
3. On the Package Details page, click the title of the release containing the file that you want to delete.



| How to use TeamForge 7.1 | 81

4. On the Release Details page, click Edit.
5. On the Edit Release page, identify the maturity level of this release.
Use one of these predefined values:
* Development build
* Alpha
* Beta
* General availability
6. Choose a new status for the release.
A release can be in Active or Pending status.
7. Click Save.

Change a package's name or description
When the purpose or the audience for a package shifts, you may want to rename the package or describe it differently.

Click File Releases in the project navigation bar.
On the Package Summary page, select the package you want to edit, and click Edit.
On the Edit Package page, write the new name or description.
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To make it easier for users to download the package, select Show Download Link in Project List.
This makes the download link show up in the project's entry in the Project Categories system, if the project has
been put in one or more categories. See Categorize a project on page 138.

5. Click Save.

Associate a release with other items
If a file release is related to other TeamForge items, such as documents, tasks, tracker artifacts, integrated application
objects, or news items, you can connect the file release to the other item by creating an association.

Creating associations between items helps you define relationships, track dependencies, and enforce work flow rules.
Some example uses of file release associations include:

* Associate a release with a requirements document.
» Associate a beta release with a task related to managing the beta program.
» Associate a release with tracker artifacts representing bugs fixed in the release.

.:_ Note: You can also associate tracker artifacts such as bugs and feature requests with the related file releases.
You do this as part of working with the tracker.
1. Click File Releases in the project navigation bar.

2. On the Package Summary page, click the title of the package containing the release with which you want to
create an association.

3. On the Package Details page, click the title of the release.
4. On the Release Details page, click the Associations tab and click Add.
5. Inthe Add Association Wizard window, select the items with which you want to associate the artifact:

* Enter Item ID - If you know the item's ID, you can enter it directly.

.:_ Note: To associate an object in an integrated application from within CollabNet TeamForge, use the
[<prefix objectid>] format. Successful associations appear hyperlinked.

' Tip: Each integrated application displays its prefix on moving the mouse over the application name in
the tool bar.
* Add From Recently Viewed - Select one of the last ten items you looked at during this session.
* Add From Recently Edited - Select one of the last ten items you changed.
6. Click Next.
7. In the Add Association comments window, describe the reason for the association.

8. Save your work.
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e Click Finish and Add Another to add additional associations.
* Click Finish to return to the Details page.

Delete a package
If you no longer need a package, you can delete it.

Deleting a package deletes all of the releases and files within it.

Important: Delete a package only if you are sure that you no longer need any of the releases and files within
it.
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1. Click File Releases in the project navigation bar.
2. On the Package Summary page, choose the package that you want to delete.
3. Click Delete.

The package and all of the releases and files within it are now deleted.

Delete a release
If you no longer need a release, you can delete it.

Deleting a release deletes all of the files within it.

' Important: Delete a release only if you are sure that you no longer need any of the files within it.

1. Click File Releases in the project navigation bar.
2. On the Package Summary page, click the title of the package containing the release that you want to delete.

3. On the Package Details page, select the release that you want to delete, and click Delete.

The release and all of the files within it are now deleted.

Watch for changes

When you monitor an item, such as a task or a document, you are notified by email when that item is updated. You
can also monitor a discussion forum or project news by subscribing to its Really Simple Syndication (RSS) feed.

Sort emails from TeamForge automatically

When you are involved in a lot of activities on your TeamForge site, you can start receiving many emails from
project members and administrators. To save time, you can configure your email application to sort these emails
automatically.

For example, you are automatically emailed whenever someone comments on an artifact that you created. You may
also want to join the monitoring lists of items you are interested in, and other team members can add you to the
monitoring list of items they create. All of these things can add up to a good number of emails after you have been on
a project for a while.

Your email program, such as Microsoft Outlook and Mozilla Thunderbird, looks for the X-headers in incoming email
messages and acts on them according to your instructions.

1. In your email client, create a message filter.
* In Mozilla Thunderbird, click Tools > Message Filters.
* In Microsoft Outlook, click Tools > Rules and Alerts.
2. Specify the type of information you want to filter.
For example:
* Use X-TeamForge-ProjectId to identify the project that the incoming email is related to.
* Use X-TeamForge-FolderId to identify messages related to a specific tracker or document folder.
+ Use X-TeamForge-AssignedTo to flag tasks or artifacts that are assigned to you.

* Use X-TeamForge-CommitPath to watch for commits path in a Subversion repository where you are
working.
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* Use X-TeamForge-PlanningFolder to watch for artifacts to be added to or removed from a planning
folder you are working with.
3. Tell your email program what to do with the messages with the X-header that you specified.
For example:

* Automatically move emails into a special "To Do" folder if they are about tracker items assigned to you.
* Color emails red if they are about commits to the Subversion repository path you specified.
* Forward all build-related announcements to your mobile phone for reviewing later.

You can use as many X-headers as you need. If you have set them up judiciously, this can decrease the amount of
time you need to work through your incoming email.

Monitor an item
To get notified by email whenever an item changes, monitor the item.

CollabNet TeamForge , an item is something you produce with the site's tools. These are some examples of items:

*  Documents

e Tasks

» Tracker artifacts

* Discussion forum topics
* Files in a release

1. Go to the folder containing the item or items that you want to begin monitoring.
2. Select the item or items that you want to begin monitoring.

3. Click the Monitor down arrow, then choose Monitor Selected.

You are now monitoring all selected items. The icon is displayed in the item list view and the monitored items appear
in the monitored items list on your personal Monitoring page.

.:-_ Note: When you update two or more artifacts at a time, each user who is monitoring any of the changed
artifacts gets a single email describing all the updates.

To stop monitoring an item, select it, then roll your mouse over the Monitor down arrow and choose Stop
Monitoring Selected.

.:-_ Note: You can also stop monitoring any item from the monitored items list on your personal Monitoring
page.

Monitor many items
To get notified about a whole class of items whenever one is created or changed, monitor the folder that contains the
items.

In CollabNet TeamForge, a folder is a container for multiple items. Any container can be considered a folder, even if
it is not explicitly called a folder.

* A document folder contains documents.

» A task folder contains tasks.

» A tracker is a folder that contains tracker artifacts.

* A forum is a folder that contains discussion topics.
* A repository is a folder that contains code commits.
* A package is a folder that contains files.

1. Select the folder that you want to begin monitoring.
For example, in a project where you are a member, click Source Code in the navigation bar and select one of the
code repositories in the project.

2. Click the Monitor down arrow, then choose Monitor Current Folder.

You are now monitoring the folder. The icon is displayed in the top row of the list view, and the monitored folder
appears in the monitored items list on your personal Monitoring page.
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.:_ Note: You do not receive monitoring notifications for changes that you yourself make to an item in a
monitored folder.

To stop monitoring a folder, click the Monitor down arrow, then choose Stop Monitoring Folder.
.:_ Note: You can also stop monitoring any item from the monitored items list on your personal Monitoring

page.

Monitor an application
To monitor an entire application, such as all trackers or all documents in a project, select it on your personal
Monitoring page.

Monitoring an application keeps you updated on all items and folders within the application. Unlike individual items,
lists of items, and folders, you don't monitor entire applications from within a project.

1. Click My Workspace in the CollabNet TeamForge navigation bar.
2. Click Monitoring in your personal navigation bar.

3. From the Projects and Preferences menu on your personal Monitoring page, choose the project in which you
want to monitor an application.

4. On your All Monitored Objects list for the selected project, click the Monitored Applications tab.
5. On your Monitored Applications page, select the applications that you want to begin monitoring.
6. Click Save.

You are now monitoring the selected applications.

Monitor discussion forums as RSS feed

To get an update in your RSS feed reader each time there is an exchange of ideas in a discussion forum, subscribe to
the forums's RSS feed.

In CollabNet TeamForge, you can subscribe to discussion forums via RSS feeds.

1. Click Discussions in the project navigation bar.

2. On the Forum Summary page, click the title of the forum that you want to subscribe via RSS feed.
3. On the Topic Summary page, click the RSS feed icon J

You can now monitor all topics in the selected discussion forum using your RSS feed reader.

e Note: You can access the project messages via the RSS reader without logging in to TeamForge, so long as
you have the discussion view permissions.

Monitor project news as RSS feed
To get an update in your RSS feed reader each time something important is announced in your project, subscribe to
the project news as RSS feeds.

In CollabNet TeamForge, you can subscribe to project news for all the projects via RSS feeds but not to the news of
any specific project.

1. Click My Workspace in the CollabNet TeamForge navigation bar.
2. On the News tab, click the RSS feed icon. ..a

e Note: You must be a member of a project to view its news.

You can now monitor all project news announcements regarding your projects using your RSS feed reader.

e Note: You can access the project news via the RSS reader without logging into TeamForge, so long as you
have project membership in any project.
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What am | monitoring?
All of your monitored items appear in your personal Monitoring page.

From this list, you can view or stop monitoring any item you are currently monitoring. You can also monitor entire
applications from this page.

1. Click My Workspace in the CollabNet TeamForge navigation bar.

2. Click Monitoring in your personal navigation bar.
Your personal Monitoring page lists all items you are currently monitoring. To view monitored objects for all
your projects, click All Monitored Objects in Edit Monitoring Subscriptions and Preferences pane.

3. o Note:

You can find a filter field at the top of each column in most of the tables in the TeamForge application.
The filter field could be a text box or a drop-down list.
You can type your filter criteria in the text boxes. The search text is case-insensitive.

You can also select the filter values from one or more drop-down lists. By default, you can only select
up to five filter values in a drop-down list. However, you can set a value that suits your requirement for
the FILTER DROPDOWN MAX SELECTION token in the site-options. conf file to increase
or decrease the count.

Some search filters may not appear if your site administrator has not enabled them.

Specify the filter criteria in one or more filter fields (at the top of each column) and click Filter.

Table filter drop-down list with multi-select check boxes

Stories (11 Iltems)

O Prigri

Artifact

art

art

art

art

art

art

4. After filtering, if you want to clear the filters, click Filter and select Clear from the drop-down list.

5. Use the up-down arrow at the top of any column to sort your list by that column.

* Your primary sort column is identified by a superscript 1 next to the up-down arrow, and your secondary and
third-level sort columns, if any, are likewise marked.

* Click the up-down arrow again to reverse the sort order.

To stop monitoring an item from your personal Monitoring page, select the item you want to stop monitoring, then
click Stop Monitoring.

Who is monitoring this item?
To see who is monitoring an item or folder, check the Users Monitoring This Item list.

1. Go to the page where the item appears.
2. Click the item to view the artifact.

3. On the item’s View Artifact page, click Users Monitoring.

The Users Monitoring This Item window displays a list of all users who are monitoring the item.
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Choose monitoring email frequency

How often do you want to receive monitoring email notifications for all the applications, folders and items you are
monitoring?

1. Click My Workspace in the CollabNet TeamForge navigation bar.

2. Click My Settings in your personal navigation bar.

3. On your User Details page, in the User Preferences section, choose an email notification preference.

* Email Per Change: Get a separate email notification for each change to a monitored item.

* Daily Digest Email: Get one email notification each day containing a digest of all changes made to monitored
items in the preceding twenty-four hours.

* Don’t Send Email: Get no email notifications for changes to monitored items. This can be handy when you
are on vacation.

4. Click Save.

After you have set your global email frequency, you can further customize the frequency of application monitoring
emails.

.:_ Note: When you update two or more artifacts at a time, each user who is monitoring any of the changed
artifacts gets a single email describing all the updates.

Choose how often to get emails from specific applications
How many email notifications do you want to get about the applications you are monitoring, and how often?

To further personalize your monitoring preferences, you can set the frequency of email notifications for each
monitored application on a project level. If you don't set your application monitoring email frequency settings, your
global setting applies.

For example, suppose you are contributing code to the "Widgets" project, but your role in the "Gizmos" project is of a
more advisory nature. When you monitor an item in the "Widgets" project you'll want more detailed updates than you
will want from items you've monitored in the "Gizmos" project.
1. Set the global default email frequency from your My Settings page.
See Choose monitoring email frequency on page 86.
2. Click Monitoring in your personal navigation bar.
3. From the Projects menu, choose the project in which you want to configure monitoring email frequency.
4. On the Email Notification Preferences tab, specify how often you want to be notified and click Save.

Any email notification preferences you set here will override the default preferences that you set on your My Settings
page.

Note: When you update two or more artifacts at a time, each user who is monitoring any of the changed
artifacts gets a single email describing all the updates.
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Monitor an item for someone else
To alert another user to an item, add that user to the list of people monitoring that item.

After a user is added to a monitored item, the user can configure their own monitoring preferences for the item, or
stop monitoring the item.

1. Go to the item to which you want to add a user.

Click the item to view the artifact.

On the item's View Artifact page, click Users Monitoring.

In the Users Monitoring This Item window, click Add.

S A

From the list of available project members, select the user or users that you want to add to the monitored item.

e Tip: Press and hold the Ctrl key to select more than one user.

6. Click Add.
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.:_ Tip: You can also click Add All to select all users.

7. Click OK.

The users are now added to the monitored item.

Lead a project team with CollabNet TeamForge

Managing a project means providing tools and processes to give each project member's contributions their greatest
possible impact.

Create a TeamForge project
Create a new project when you have identified work to be done that has its own distinct character, dependencies or
schedule.

What constitutes a project depends on your organization. Some organizations favor a small number of big, centralized
projects. Others prefer a larger number of smaller, specialized projects. Your site administrator can help you decide if
your work should be part of a larger project or a project of its own.

1. On your TeamForge site's main page, select Create New Project from the Projects drop-down list.

2. On the Create Project page, give the project a name and a brief description.

» The name will appear in project lists and on the project's home page.
» A terse description is recommended. There will be unlimited room to discuss the project's aims and methods in
detail on the project pages themselves.

3. Provide a URL name for the project, if you want the URL for the project to be different from the internal project
name.

If you do not enter a URL name, the project URL will be the same as the project name.

4. If your site administrator has provided project templates, select the appropriate one for your new project.
Project templates give you ready-made artifact types, work flow support, user roles and other start-up content
appropriate to the kind of project you are creating.

l‘._ Tip: The "Default Project Access" and "Project Access Editable" options are displayed based on the
) project settings. If you would like to change these settings, ask your site administrator.
5. Click Create.
The project is submitted to the CollabNet TeamForge site administrator for approval. You will receive an email

notification when the site administrator approves or rejects your project. When your project is approved, you can get
to it from your My Projects page or from the Projects menu in your navigation bar.

Build your project web site

Project members and other users need to know how to interact with your project. You can give them the information
and tools they need by creating and maintaining a project web site tailored to them.

You can build your project home page from scratch or assemble it from building blocks provided by TeamForge.

Assemble your project web site
For quick, flexible site building, use the ready-made web page components that come with your TeamForge project
site.

There are components for showing text, wiki pages, charts and graphs, and other purposes. These components make it
easy to put together a sophisticated project site in little time.

Create a project page

To provide information and functionality to people viewing your project, build one or more project pages.

1. Go to the page to which your new page will belong.



| How to use TeamForge 7.1 | 88

.:-_ Tip: Any project page can have sub-pages belonging to it. A page that belongs directly to the project
home page is called a "top-level page."

2. Click Configure: On.
3. Choose where your new page will fit in your project's structure.

» To create a page just under the project home page, click Add top-level page.

A top-level page's title is always visible in the navigation tree at left.
* To create a page under the page you are on right now, click Add sub-page.

. Tip: You can create a free-form page only as a sub-page.

4. Give your new project page a title.
Keep the title brief and descriptive.
5. Choose who can see this page.

.:-_ Note: Your choice will apply to all subpages that you create under this page.

* To show this page to anyone with the necessary permissions, select Visible. For example, if you have defined
a group of users who have access to your project, your new project page is visible only to those users. If your
project is open to the public, anyone in the world can see it. Use this option when the information on this page
is ready for a wide audience.

* To show this page only to users with the project administrator role, select Hidden. Use this option if you are
drafting content that you aren't ready to share yet, or want to share only with other project managers.

6. Select the Freeform check box to create a free-form page.

« Note: A free-form page's title is not visible in the navigation tree at left.

.:-_ Tip: You can not create free-form sub-pages when the top-level page is ‘Hidden’.

7. Click Save.

8. Click Configure: Off .

Now you are ready to build the functionality into your project page with components such as text, news or tracker
queries.

Create a project page component
Put information and resources in your users' hands with project page components.

For example, to let people know about important new developments, create a news component. To enable project
members to find tracker items quickly, create a query component.
1. On the project page, click Configure: On.
2. Click Add new component.
3. Give your new component a title.
Keep the title brief and descriptive.
4. Seclect one of the following component types that suits your need.

Tracker Metrics Add charts about tracker metrics to your project page.

Documents Let project members exchange and review documents
from the project page.

Project News Maintain a journal or blog about your project, share
information and make announcements.

Project Statistics Show visual measures of your project activities on the
project page.
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Text Write free-form messages, reports or rants, in plain text
or HTML.

Tracker Search Results Make saved search results available from the project
page.

Wiki Page Open up your project page to two-way communication.

Subprojects Add a list of subprojects to your project page.

Lifecycle Metrics Add various project lifecycle reports and charts to your
project page.

5. Choose who can see this component.
* To show this component to anyone with the necessary permissions, select Visible.

For example, if you have defined a group of users who have access to trackers in your project, a query
component will be visible only to those users. If your project's trackers are open to anyone, all users who view
this project page will see the query component. Use this option when you are sure the component is ready for
general use.

* To keep this component under wraps until you are ready to show it, select Hidden.
Now only users with the project administrator role can see this component. Use this option if you are drafting
content that you aren't ready to share yet, or want to share only with other project managers.
6. Select one of the locations, Top of page or Bottom of page, where the component shows up on the project page.

7. Depending on the component type you selected, set the properties of the component.

Component In the Properties of this component section...
type
Tracl-(er 1. Select the number of charts from the drop-down list. You can add up to three tracker charts
Metrics to your project page.
2. Select one of the chart types: Burndown, Open by Priority or Open vs Closed.
3. Select a data source for your chart, a tracker or a planning folder.
4. Click Save.
Documents 1. Select a folder from the list to display its contents on the project page.
2. Click Save.
Text 1. Type your free-form messages, rants or announcements in the text box.

2. Click Save.

Tracker Search Make sure one or more shared tracker searches are available to add to the project page. For
Results more information about sharing saved tracker searches, see Share a saved tracker search.

1. Click Add Saved Tracker Searches.

2. Select one or more shared tracker searches from the Select from Shared Tracker
Searches window.

3. Click Add Selected.

4. Select the number of rows of the search results to display from the Display Rows drop-
down list.

5. Click Save.

Wiki Page 1. Type a title for the wiki page.
2. Click Save.
Subprojects 1. Select the number of subprojects to be displayed on the project page.

2. Click Save.
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Component In the Properties of this component section...

type

Lifecycle For more information about adding life cycle metric charts, refer to the topics: An overview of
Metrics the project life cycle metric charts and Add life cycle metric charts to a project page.

8. Click Configure: Off.

Add life cycle metric charts to a project page
Create life cycle metric charts for one or more trackers or planning folders and add them to your project page.

See Life cycle metric charts: How-to on page 367 for more information.

Reorder project page components

To make things easy for your project members, lay out your page components in a useful order.

1. On the project page, click Configure: On.

2. In the title bar of the project page component you want to move, click the up arrow or the down arrow.
3. Click Configure: Off.

Hide a project page component
While you are preparing a project page component, you may wish to keep it from being seen.

You can hide a page component from everyone except other project administrators.

1. On the project page, click Configure: On.
2. In the title bar of the project page component you want to hide, click the edit button.
3. Select the Hidden option for Visibility, and click Save.
4. Click Configure: Off.
Now no one who does not have the Project Admin role can see the component, even if they have access to the project
and to this page. Users with the Project Admin role can see this component only when Configure is set to On.
Rename a project page component
As a page component's focus evolves, it’s a good idea to rename it to match its changing function.
1. On the project page, click Configure: On.
2. In the title bar of the project page component you want to rename, click the edit button.
3. Update the Titleas appropriate to its current function, and click Save.
4. Click Configure: Off.
Edit a project page component
You may want to make some changes to your project page component to make it more useful.
1. On the project page, click Configure: On.
2. In the title bar of the project page component you want to edit, click the edit button.
3. Update the Titleas appropriate to its current function, if required
4. Seclect the Hidden option for Visibility to hide the page while you work on it.
You can hide a page component from everyone except other project administrators.
5. Change the following settings depending upon the project page component that you are editing:
* For a Sub-projects component, you can change the number of projects to be displayed.
* For a Documents component, you can change the folder location.
6. Click Configure: Off.
The project page component is displayed with modified content and/or settings.
Delete a project page component
When a component is no longer useful, remove it from the page to avoid distracting users.
1. On the project page, click Configure: On.
2. In the title bar of the project page component you want to delete, click the X button.
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3. Click Configure: Off.

Control access to a project page
Before you put information or functionality on your project page, make sure it is accessible to the people it is intended
for.

Note: This is only relevant if your page is not hidden. If your page is hidden, users who are not project
administrators cannot see the page even if their role-based permissions would allow it.
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1. Click Project Admin in the project navigation bar.
2. On the Project Settings page, click Permissions.

3. Click the role to which you want to give access to your project page.

' Tip: If the appropriate role does not exist, you must create it first.

4. On the Edit Role page, click Project Pages.
5. Under Project Pages Permissions, sclect the pages that users with this role can see and edit.
» To enable users with this role to create, read and modify all project pages, select the Project Pages Admin
permission.
» To allow users with this role to see pages but not edit them, select the appropriate page in the View section.

» To allow users with this role to modify the contents of a text component project pages, select the appropriate
pages in the Edit Text Content section.

' Note: The project home page is always visible to any user who is authorized to see the project.

Reorder project pages

Facilitate your users’ experience in your project by putting your project pages in an order that matches their needs.
1. Click Configure: On.

2. Select a project page and click Edit Structure.

3. Rearrange the structure of this page in any of these ways:
» Select a page, and use Cut and Paste to place it in a different location.

' Note: When you move a page, all of its sub-pages will also be moved.

* Drag and drop a page to a different position.
* Click Add New Page to add a sub-page to the current page.
» Select one or more pages and click Delete to remove them.

4. Click Save Changes.
5. Click Configure: Off.

Hide a project page
While you are preparing a project page, you may wish to keep it from being seen.

You can hide a page from everyone except other project administrators.

1. Click Configure: On.

2. Click Edit Page Properties.

3. For Visibility, select Hidden and click Save.

Now no one who does not have the Project Admin role can see the page, even if they have access to the project and to
this page's parent page.

When you are finished building your page, don't forget to switch the page to "Visible" so that the intended users can
see it.

Rename a project page

As a page's focus evolves, it’s a good idea to rename it to match its changing function.

1. Click Configure: On.
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2. Click Edit Page Properties.
3. Change the Title as appropriate to its current function, and click Save.
4. Click Configure: Off.

Hand-code your project web site
To fully custom control your project web site pages, build your own HTML and check it into the project's Publishing
repository.

You can link to these pages as you would to any normal HTML page.
Create a custom project home page
If you decide to hand-code your project home page, the page works like any HTML page.

1. Click Project Admin in the project navigation bar.
2. From the Project Home Options, select Show custom web page.
(Show default project pages and components is selected by default.)
3. Addthe index.html file to the publishing/www Subversion repository.
The content of your index.html shows up immediately.
' Note: When you switch to a hand-coded home page, you can still access any project pages you have
created.
4. Click Save.
Your custom Project Home page is now active.

e Note: If your project has any subprojects, the subprojects are also listed. To see them, make sure your
index.html file exists and is in the right repository location.

See what's in your publishing repository
You can view the files in your TeamForge site's publishing repository in via relative URLSs.

1. Enter the URL: https://forge.collab.net/sf/projects/sampleproject/index.html inthe
address bar to display contents of the index.html file.

In this case, your index.html file must be in the publishing repository under the www/sampleproject
path.

The contents of the index.html file are displayed in the Project Home page.

2. Enter the URL: https://forge.collab.net/sf/projects/sampleproject/roles/
roledetails.html in the address bar to display contents of the roledetails.html file.

In this case, your roledetails.html file must be in the publishing repository under the www/
sampleproject/roles path.

The contents of the roledetails.html file are displayed in the Project Home page.

Set up trackers
A tracker is a collection of related artifacts that describe work to be done or issues to be resolved. Every project
should have one or more trackers.

When you start a tracker, you decide which fields will be used, who will use them, and how they will use them.

Create a tracker
Create a tracker whenever you need to report and track bugs, feature requests, support requests, or any other type of
issue where ownership, status, and activity must be managed.

Individual tracker entries are referred to as tracker artifacts. A tracker is a set of tracker items with a common
purpose, such as bug reports, feature requests, or tasks.

1. Click Project Admin in the project navigation bar.

2. Click Tracker Settings.

3. Click Create.
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4. On the Create Tracker page, provide a name and description for the tracker.
.:-_ Tip: Descriptions help users learn how best to provide the information you want from them. To maximize
your chances of getting useful data, make your description as informative as you can.
5. Select an icon that suggests the type of work the tracker is handling.

This icon will appear with any artifact in this tracker, wherever it is viewed on the site. For example, if someone
brings an artifact from this tracker into a planning folder, users of the planning folder can glance at the artifact's
icon to see where it comes from.

6. Select the relevant unit from the Display Effort in field. The units displayed here are configured based on the
size of the artifacts in the tracker. Eg. Select the unit as Hours for a tracker of small defects, Days for a tracker of
tasks, and Weeks for a tracker of epics.

' Note: Configure the units at the project level and not at the planning folder level.

7. Click Create.
The new tracker appears at the bottom of your list of trackers.

8. If necessary, drag the tracker to a place in your tracker list that makes sense.
The order you set here controls the order of every tracker list in your project.

9. You'll probably need some custom fields to capture information that's specific to your project.
See Create your own tracker fields on page 29.

10. To speed up the team's work, you may want to set up some rules for automatically reassigning artifacts when their
contents change.

See Create a tracker work flow on page 31.

Create your own tracker fields
To track data that is not captured by the default set of fields, create new fields that fit your project's purposes.

You can create the following user-defined fields in each tracker:

» Up to 30 text entry fields.

* Up to 30 date fields.

* Up to 30 single-select fields.

* Anunlimited number of multiple-select fields.

Y Caution: Creating a large number of user fields and multiple-select fields may affect site's performance.
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Create a text field
To let users type in data, create a text entry field.

A tracker can have up to 30 text fields.

1. Click Project Admin in the project navigation bar.

Click Tracker Settings.

Click the tracker to which you want to add a text field.

On the Tracker Layout tab, click Add Field.

On the Create Field page, provide a name for the field.

Configure the shape of the field with the Field Width and Field Height fields.

To help users enter the right text values, select Use Text Validation and supply a regular expression that describes
the appropriate values.
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This can help reduce errors and keep your team's data as meaningful as it can be. For more detailed instructions,
see Validate text entries in a tracker artifact on page 100

8. Click Save Field.
The new field is created.
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Create a "Select" field
To let users choose values from a list that you define, create a "Select" field.

You can create up to 30 single-select fields and an unlimited number of multiple-select fields in a tracker.

' Note: Creating a large number of multiple-select and user fields may affect CollabNet TeamForge's
performance.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From the list of existing trackers, click the tracker to which you want to add a "Select" field.

On the Tracker Layout tab, click Add Field.

On the Create Field page, provide a name for the field.
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Use the Input Type menu to specify whether users will be able to select one value or more than one.

If you're going to make this a required field, pick one of the values to be the default value. This value is applied to
existing artifacts and artifacts that are moved from another tracker.

7. Decide whether users must choose a value.
* Required fields automatically appear on the Submit Artifact page.
' Note: If you make the field required, you must specify a default value.

+ If you make a User field required, specify one or more default users.
+ If you make a Date field required, the default is "today."

» For optional fields, select Display on Submit if you want the field to appear when a user first creates an
artifact.

* To prevent the field from being used at all, select Disabled. (By default, new fields are enabled.)
8. Use the Values section of the Create Field page to add more values for the user to choose from.
9. Keep adding values until you have the list of options you want, then click Save Field.

Create a people-picker field
To let users choose other users from a list, create a "people picker" field.

The Assigned to field is a people-picker field that is present in every tracker. An artifact can be assigned to only one
user at a time. You can give yourself more flexibility by adding any number of custom people-picker fields.

For example, your QA team may want to assign a person to track progress on an artifact while it is assigned to a
developer. You might create a people-picker field called "QA monitor" to specify who that person should be.

In people-picker fields you create, users can select multiple users.

. Note: Creating a huge number of user fields can slow down the site's performance.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From the list of existing trackers, click the tracker to which you want to add a people picker field.
On the Tracker Layout tab, click Add Field.

On the Create Field page, provide a name for the field.

On the Input Type menu, select Select User(s).
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In the Default Filter field, choose whether the list of people available in your new field will include members of
this project or everyone who is registered on the site.

Configure the shape of the field with the Field Width and Field Height fields.

9. Click Save Field.
The new field is created.

®
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Organize tracker fields
Most tracker artifacts ask the user for a lot of information. You can arrange the input fields in columns and rows to
make it easier for users to find the fields they need.
1. Click Project Admin in the project navigation bar.
2. Click Tracker Settings.
3. From the list of current trackers, click the tracker whose fields you want to organize.
Click the Tracker Fields tab if it isn't already showing.
4. If some fields seem to be logically connected to each other, create a section to bring them together.
a) Click Add Separator and select Section.
Give the section a short but descriptive label.
b) In the list of fields, drag your new "Section Separator" row to a position that makes sense.
c) Drag the appropriate fields under the Section Separator that you just created.
5. Within a section, arrange fields logically into columns.
a) Click Add Separator and select Column.

Give the column a short but descriptive label.
b) In the list of fields, drag your new "Column Separator" to a position that makes sense.
c) Drag the appropriate fields under the Column Separator that you just created.
d) Create as many columns as you need.

Drag a column separator above another column separator to move it to the left in the artifact entry form. Drag
it below to move it to the right.

6. Within a column, group fields into rows if appropriate.
a) Click Add Separator and sclect Row.

Give the row a short but descriptive label.
b) In the list of fields, drag your new "Row Separator" to a position that makes sense, then drag the appropriate
fields under the Row Separator.

e Note: You can have rows and columns without sections.

Enable or disable fields
If a tracker field is disabled, it does not appear on the Artifact page. Most fields can be disabled.

Disabled fields are accessible only to tracker administrators on the Tracker Layout tab.

You can enable or disable any field that is user-defined or configurable. However, you can't disable all configurable
fields. For example, the Status, Category and Planning Folder fields can't be disabled.

Note: If your goal is to prevent users from entering data into a field when submitting an artifact, but still
display the field on the Edit Artifact and Tracker Search pages, don't disable the field. Instead, clear the
Display on Submit option on the Edit Field page.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From the list of current trackers, click the tracker you want to configure.

S

On the Tracker Layout tab, select the fields you want to enable or disable.

* Click Disable to remove them from the Artifact page.
* Click Enable to allow them to be configured and displayed.

Note: Data in disabled fields is still search-able, but disabled fields do not appear as inputs on the Search
pages.

[ N
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Require users to complete a tracker artifact field
If a field is set as required, users cannot submit artifacts without completing it. Most tracker fields can be required or
optional.

Each tracker can have its own required and optional fields. Required fields are marked with a red asterisk * on the
Submit Artifact page.

[
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Note: When you make a field required, any field whose values depend on that field's values is also required.
See Help users select options in a tracker artifact on page 99 for more about dependent field values.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From the list of current trackers, click the one you want to configure.

On the Tracker Layout tab, click the name of the field you want to set as required or optional.

By default, only the Title, Description, Artifact ID, and Status fields are set as required.

On the Edit Field page, select or clear the Required option to make a field required or optional.

Required fields automatically show up on the Submit Artifact page.

.:-_ Note: System-defined fields and the Status field are always required.
For optional fields, select or clear the Display On Submit option.

This specifies whether the field will appear on the Submit Artifact page.
Click Save Field.

Configure tracker "Select" field values
To help users provide meaningful information, supply them with useful field values to choose from in the input fields
in the tracker entry form.

-
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Tip: When you create a user-defined single-select or multiple-select field in a tracker, you add predefined
values to the field. You can change these values at any time.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

From the list of existing trackers, click the name of the tracker that you want to configure.

On the Tracker Layout tab, click the name of the field whose values you want to edit.

On the Edit Field page, set up the field values you want you want users to see when they create a tracker artifact.

* To define a new value, click Add.

* To rename a value, edit the existing text. If you rename a value, the value is renamed in all existing artifacts.

» To remove a value, check the box and click Delete. If you delete a value, the value is changed to None in all
existing artifacts.

» Select Default Value to set which option will be chosen if the user makes no selection. When you move a
tracker artifact from one tracker to another, the default field value is the value that comes along.

Note: When you edit the values of the Status field, you are also asked to describe what each value's

i
status means, as shown in the Values section of the Edit Field page. This status meaning is used in
Advanced Search to define which values are returned when searching for open or closed artifacts.
.:-_ Note: When you change the tracker fields, the values in the existing artifacts remain unchanged.

Click Move Up or Move Down to order the list the way you want it.
Click Save Field.

All values are now available in the selection menu for the field.
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Configure tracker units
You can estimate the value of efforts meaningfully in the form of units using the TeamForge tracker.

You can set any unit as the default for a tracker or planning folder and create any number of units. The default base
unit is "Hours' which you can rename, but not delete. You can also toggle between the burndown chart and effort
values for any unit.

' Note: You cannot enter decimal values in the Conversion field. Deleting a unit will cause all the associated
artifacts to express effort in the form of the base unit.

Click Project Admin in the project navigation bar.

Click Tracker Settings.

On the Units Layout tab, click Add Field.

On the Add Unit page, enter the Unit Name and Conversion value for the unit.

Click Save.
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Assign atracker artifact automatically
You can configure the tracker to automatically assign newly submitted artifacts to specific project members.

You can assign artifacts to individuals based on the values in the Category or Release field.

1. Click Project Admin in the project navigation bar.
Click Tracker Settings.
From the list of existing trackers, click the tracker you want to configure.

On the Auto Assignment tab, select Auto Assign By Category or Auto Assign By Release.
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For each category or release value, choose a project member from the Automatically Assign To drop-down
menu.

This menu contains all project members with the tracker edit permission. Click the people icon to display a list of
project members to whom you can auto-assign artifacts. Choose None if you do not want artifacts with a specific
value automatically assigned.

6. Click Save.

Whenever a new artifact is submitted with a value in the relevant field, the assignee receives an email notification and
the artifact appears on his or her My page.

Create a tracker work flow
To channel project members' work on tracker items, set up rules for how a tracker item can move forward.

Before creating a tracker work flow, see that these criteria are met:

* You have a tracker to work with.

» The tracker has a set of statuses defined, such as "In progress" and "Ready for QA."

* Roles exist, and you can assign project members to them.

A work flow is a sequence of changes from one status to another. You can define status transitions for any
combination of tracker statuses in the tracker.

1. Click Project Admin in the project navigation bar.

2. Click Tracker Settings.

3. From the list of existing trackers, select a tracker.

4

. Click the Workflow tab.
The Workflow page lists all of your status values and the tracker work flow that you have configured.
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On the Workflow page, click the status value for which you want to create a work flow.
6. On the Edit Field Transition Status page, select a status value from the Create Transition to Status drop-down
menu.

e Note: By default, the Any work flow is shown. This means that you are defining work flow rules for the
transition from the status that you selected to any other status.
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7. Click Add.
A new work flow is added. The Any work flow is changed to Remaining Statuses.

8. In the Roles to Make this Transition section, specify which users can make this change.
For example, only users with the QA Engineer role are allowed to change artifacts from Open to Cannot
Reproduce.

9. In the Required Field(s) for Status Transition section, select the fields for which the user must provide values.
For example, the user must assign the tracker item to someone and enter a comment.

' Note:
+ Fields that are already required do not appear in this list.
+ Fields whose values depend on a required parent field are automatically required. (See Help users
select options in a tracker artifact on page 99 for more on parent and child fields.)
10. Click Save.

The work flow is now saved. When a user submits or edits the status of a tracker artifact, he or she sees only the
options that are allowed by the work flow.

Set default tracker columns
Choose what information is visible by default to users of your project when they open a tracker or planning folder.

Users can also set their own personal default column configurations, which override the project defaults.

1. Click Trackers in the project navigation bar.
2. Select a tracker or planning folder and click Columns > Configure.
+ Ifyou've already saved a column configuration, click it and skip the rest of these steps.

» To go back to the default column configuration, click System (default) and skip the rest of these steps.
» To set up a new configuration, click Configure.

3. Choose your columns.
a) Move the columns you want from Available Columns to Selected Columns.

Artifact ID : Title, Priority and Status are required columns.

e Note: Selecting more columns can increase the time required to load the listing page.

b) Remove any columns you don't need from Selected Columns.
¢) Use the Move Up and Move Down buttons to change the display order of the columns.

4. Apply your choices to your view of the tracker.

* To use this arrangement this time only, click Apply. The next time you log in, you'll start with the default view
again.

» To save your column layout for repeated use, click Apply and Save, then give your arrangement a name. The
next time you log in, you'll see the column arrangement you just selected. (If you've sorted the records in your
view, that sort order is saved t0o.)

Tip: If you are editing a column configuration that already exists, you can rename it by saving it
under a new name.
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5. To make the same set of columns appear every time you come to this tracker or planning folder, select Make this
my default view.

6. To make the same set of columns appear for every user the first time they see any tracker or planning folder in the
project, select Make this the default view for all project members.

The project default configuration you set is now the default configuration for all project members, unless they have
created their own personal default column configuration.

Change a tracker
A tracker's real-world uses often outgrow the name or description you gave it when you created it. When that
happens, it's a good idea to update the tracker to reflect its changing role.
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Click Project Admin in the project navigation bar.
Click Tracker Settings.
From the list of existing trackers, click the tracker you want to edit, and click Edit.

On the Edit Tracker page, provide a new name or description for the tracker, and update the icon.
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Update the units from Display Effort in and click Save.

' Note: These units are configured in the Units page at the project level, and not at the planning folder
level.

6. If necessary, drag the tracker to a place in your tracker list that makes sense.

The order you set here controls the order of every tracker list in your project.

Help users select options in a tracker artifact
You can help users cope with complex information by guiding them to eligible values in single-select fields.

Any tracker that manages real-world information will quickly become very complex. Users can be confused by a
proliferation of "Select" fields. Confusion can lead to inconsistent data, which makes your job harder.

You can help relieve the complexity by showing users their eligible options in a given field based on values they have
already selected in another field. You can create overlapping sequences of dependent fields, with as many levels as
you need.

This simplifies things for the user, but for the tracker administrator it can quickly get complicated. So let's look at an
example.
1. Click Project Admin in the project navigation bar.
2. Click Tracker Settings and create a tracker.
For this example, let's call it the Lunch Planning tracker.
3. Create a single-select field and call it Lunch type.

(For this example, we'll ignore the built-in fields, such as Status and Assigned to. We're just working with fields
that you create.)

4. Create some values for the Lunch type field. Let's call them Buffet, Picnic, and Banquet.

Each type of lunch will make sense in some kinds of locations and not others. For example, you would not
normally plan a banquet lunch in a park. We are now going to make it easy for users to avoid making such a
mistake.

5. Create a single-select field called Location type, with Lunch type as the parent field, and give it some plausible
values.

a) Start by adding an option called Beach. In the Parent Values column, choose Picnic, because that's the kind of
lunch you would have at the beach.
(The Parent Values column lists all the values in the parent field you selected.)

b) Add a Restaurant. In the Parent Values column, hold down the Ctrl key and choose Banquet and Buffet,
because either of those could be held at a restaurant.

6. Create a single-select field called Location, with Location type as the parent field, and give it some values to
choose from.

a) Start with an option called Happy Food Restaurant. In the Parent Values column, select Restaurant, because
that's the type of location that Happy Food Restaurant is.

b) Add another option, Hanalei Cove. Under Parent Values, select Beach.
7. Save your work and go to the tracker whose settings you have been editing.
Try selecting from the interdependent values you have just created.

Observe that the value you choose in the Lunch Type field controls which values are available to you in the Location
Type field, and that selecting a value in Location type in turn controls the values that appear in the Location field.

*  When a user selects Banquet for a lunch type, they can select Restaurant but not Beach in the Location type field.
You will have less error correction to do, and users will avoid confusion.
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*  When a user selects Picnic for their lunch type, the Location Type field offers only Park and Beach. Now you
will not have to go through and clean up after users who mistakenly choose to plan a picnic at Happy Food
Restaurant, and the doorman at Happy Food Restaurant will not have to turn away users who mistakenly show up
with picnic baskets.

.:-_ Important: If you are used to defining your own Tracker fields, the ability to make field values depend on
other values may change how your trackers work in ways you didn't anticipate. Keep these points in mind:

+ Linking fields in this way doesn't modify existing data, but when users later modify fields that are linked,
they will have to adhere to the relationships you set here.

» Ifafield has a parent, and that parent field also has a parent, the top-most parent field must have at least
one value.

*  When a field has a parent field that is required, the child field's default value is set to None. If that
required parent field is deselected, the child field no longer has to be required, but Required remains the
default.

+ If you require a specific field value before an artifact can be placed in a given status, that field's children
are subject to the same requirements. See Create a tracker work flow on page 31 for more about
controlling what status an artifact can be in.

« Ifyou delete a field that contains values that another field's values depend on, the dependent field becomes
a standard single-select field on its own.

*  When you cut and paste an artifact from one tracker to another, only those field values that also exist in
the new tracker come along with the artifact. If those values aren't valid under the dependency rules of the
new tracker, they are still brought along.

Validate text entries in a tracker artifact
You can help users contribute useful information by testing their text entries against rules you configure.

Text fields can be error-prone because they invite free-form input. You can help users provide usable information by
automatically rejecting values that don't match the needs of the tracker.

This simplifies things for the user, but for the tracker administrator it can be complicated. So let's look at an example.

' Note: If your goal is to require users to enter some value, whatever the value is, don't use text field
validation. Select the Required option instead.
1. Click Project Admin in the project navigation bar.
2. Click Tracker Settings and create a tracker.
For this example, let's call it the Bugs tracker. It will be used to record entomological specimens in a collection.
3. Create a text field and call it Legs.
This is for users to record the number of legs each specimen displays.
4. Select Use Text Validation and supply a validation rule that requires the user to enter a number.
For example, if a given insect has six legs, you'll want the user to enter the numeral 6, and not a string such as
"six" or "several."
Try this regular expression:
\d{1,3}
This rule requires the user to enter a number with one, two or three digits. Now, a user who means to record a
centipede with 100 legs but enters 1000 by mistake will not be able to save the artifact until the error is corrected.

5. Enter a sample string to test your regular expression.
Any part of the sample string that matches your regular expression appears under Match Results. If nothing
appears, rework your regular expression until you get a match.

6. Create another text field and call it Location.
This is where users will record the geographical spot where they collected the bug.

7. Select Use Text Validation and supply a validation rule that requires the user to enter a pair of geographical
coordinates.
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For example, if a given insect was found outside CollabNet's California headquarters, you'll want the user to enter
a string like 37.674689,-122.384652, and not something like "Brisbane" or "Out on the lawn."

Try this regular expression:
[(-12[0-91*[.1{0,1}[0-91{0,4}

This rule requires the user to enter two numbers, separated by a comma, in the general format of a pair of mapping
coordinates.

Note: This particular regular expression does not guarantee that the coordinates are valid, just that they
look like coordinates.

8. Save your work. In the tracker whose settings you have been editing, try entering a number greater than 999 in
Legs, or a street address in Location
The red X next to the field indicates that the text entry is incorrect. A green check indicates that the value meets
the requirements.

Notice that any field in which you are validating text entries is identified by Text Entry (with Field Validation)
when listed on the Tracker Layout tab.

Manage a product with CollabNet TeamForge

A product owner can use TeamForge to help define the scope of a product and contribute to its planning and
implementation.

Define the scope of your project
Defining scope is an iterative, interactive process. As you go through it, you'll find elements of your scope expanding,
shrinking or changing shape in response to feedback from analyzing and planning out the work.

e Note: It's a good idea to get the feature definition process under way before setting up planning folders (see
Create a planning folder on page 102), because defining features gives you the raw material for your
planning process.

1. Before you get started, you'll do some kind of user research, even if it's only a few phone calls, to get an idea of
the needs of the customers you hope to satisfy. Express these needs and desires as stories about what a user can do
with your product. Then create an artifact for each user story you identify.

A user story describes the situation after your product has been launched: What can the user do now that they
couldn't do before?

' Tip: For best results, your user story artifact should by limited to a clear description of the capability
you want in the product. Remember that a user story is not an implementation plan. Details about the
implementation will be recorded in the user story artifact, but when you write a user story, try to leave the
implementation up to the developer who will be responsible for it.

2. You may want to define one or more fictional users who resemble the real-life users of your product. This can
help simplify and focus your thinking.
3. Use the Priority field to express your opinion of how important the story is to the user. In general, the most eagerly

desired capabilities will be addressed first. (During implementation planning, your Priority setting will be used as
one input in summing up the effort involved in each priority level.)

4. Make it as clear as you can at the outset what degree of functionality is acceptable. For example, if your team is
creating an airplane, how high must it be able to fly? How far must it go before refueling? How many passengers
must it carry? Stating your acceptance criteria concretely helps reduce the time needed for ongoing reviews and
changes.

Monitor project output
Regularly test and measure the features your team produces, involving real users as much as possible.

Accurately representing the needs and responses of real-life users is a key part of the product owner's role.

1. Schedule acceptance meetings throughout the iteration, either at regular intervals or whenever a given user story is
completed.
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Use the latest working build of the product, and exercise the functionality live.
2. Test that the functionality implemented matches what is specified in the user story.

Also review the user interface and user documentation associated with the user story, if any.
3. Enter any issues in the artifact's Comments field.
4. Update the user story artifact to reflect the outcome.

» Ifauser story is accepted, change the artifact status to "Accepted" or the equivalent.

« If a user story is not accepted, change the artifact status back to "In Development," or the equivalent, for
further work. You can review it again in another acceptance meeting.

' Note: Sometimes a feature turns out not to meet the user's needs even though it has been implemented as
specified. This is normal. It is not uncommon for the user's needs to change after the user story has been
captured, or for the user research process to miss one or more important details. Just note the discrepancy in
the user story and route the artifact back into the appropriate part of the process.

Organize your project with planning folders
Create and populate all the planning folders you need to capture the work you are planning.

A planning folder is a way to organize work into feasible chunks and monitor its progress. When you've thought about
the general categories the work falls into, you can to set up planning folders that reflect those ideas.

A planning folder can represent:

* A set of tasks, such as Iteration 3, or "Initial infrastructure development."
* A period of time, such as "April," or "Q2-2010."

* A phase of development, such as "Testing" or "Deployment."

» A component of the product, such as "Chapter 12" or "Rear stabilizer."

e Tip: It often makes sense to set up planning folders affer you have outlined and analyzed the features you
plan to deliver. See Define the scope of your project on page 101.

When you've set up your planning folders, you have two views available to work with them - List View and Board
View.

For more information, see the related concept: What is a planning folder? What is a planning board? on page 229

Create a planning folder

When you've thought through your plan, express it in one or more planning folders.

1. Click Trackers in the project navigation bar.

2. Under Planning Folders, click the folder in which you want to create a new planning folder. Click New.
3. Inthe Create Planning Folder page, enter a brief and descriptive name for your planning folder.

For example:

» In an agile project, you'll probably want two or more iterations. Make a planning folder called "Sprint 1,"
another called "Sprint 2," and so on.

» In a phased, waterfall-style project, you might name your first planning folder "Design," the next "Build," and
SO on.

.:-_ Tip: Don't worry if you don't have anything of interest to put into your planning folders yet. The parallel
process of filling out the feature tree will provide plenty of material for this.

.:-_ Note: This field is mandatory.

4. Use the Description to briefly signal the kind of work that will be contained in this planning folder.

Include enough information to help people get up to speed quickly whey they join your project. But save most of
the detail for the individual tracker artifacts, where project members will spend most of their time.

5. For Status, (available since TeamForge 5.4), select a value that communicates where the planning folder is in its
life cycle.

For a new planning folder, you'll probably want to select Not started.
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.:-_ Tip: You can create more values to choose from in your Project Settings.

6. If you have set up a file release in the File Releases tool to deliver the work you are tracking here, you can identify
it in the File Release field (available since TeamForge 5.4).

Any artifact you add to this planning folder will also appear in the Planned Tracker Artifacts tab when you look at
that file release.

7. For Capacity, (available since TeamForge 5.4), provide a number that expresses how much work your team
thinks it can do in the period represented by this planning folder.

Tip: When you create a new planning folder, it can be a good idea to set its capacity to zero until you get
a feel for the artifacts and resources you are working with.

[

8. For Points Capacity, (available since TeamForge 7.1), provide a number that represents the amount of work
(expressed as number of story points) that you think can be handled in that specific planning folder.

Note: To assist project managers gauge the planning folder's points capacity, when a planning folder

is selected in one of the planning board swim lanes, this information is displayed as a ratio of planned
number of story points versus the actual number of story points. For more information, see Set up the

planning board on page 105.

[

9. Select or enter a start and end date for the work that this planning folder will contain.

You can change these dates at any time. However, it's important to specify dates even if they're not firm, because
useful visual aids and reports depend on them.

10. Select the unit that is suitable for the planning folder from the Display Effort in field. Eg. if the planning folder
represents a sprint, then select the unit as Hours and if it represents a collection of sprints, then select the unit as
Days.

e Note: Units are configured at the project level and not at the planning folder level.

11. Click Save. The planning folder is created.
Update a planning folder

A planning folder is a dynamic representation of a changing situation. From time to time, you'll want to update its
name, description and other parameters to reflect changes in the underlying work.

1. Click Trackers in the project navigation bar.

2. In the planning folder tree, click the planning folder you want to update.

3. Use the Edit menu to make your changes.
a) Give the planning folder a new name and, if needed, a new description, and click Save.
b) For Status, select a value that communicates where the planning folder is in its life cycle.

Tip: For a new planning folder, you'll probably want to create a status like Not started. You can create
more values to choose from in your Project Settings.

[

c) For Capacity, provide a number that expresses how much work your team thinks it can do in the period
represented by this planning folder.

d) Revise the start or end date of the planning folder to match any changes in your project's real schedule.

e) For Display Effort in, update the unit that is suitable for the planning folder.

Manage statuses for a planning folder
To help team members understand how to work with a planning folder, create statuses for it that correspond to the
planning folder's life cycle.

When you have created a planning folder status, you can apply it to any planning folder in your project.

For example, at a given moment you might have one planning folder in "Under development" status, while another is
in "Finished" status and another is in "Preliminary scoping" status.

Tip: You may also want to move the planning folder to a relative position in the planning folder list that

[
communicates where it stands in the order of work.
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Click Project Admin in the project navigation bar.
Click Planning Folder Settings.
Under Statuses, click Add.

Configure your new planning folder status.

Tl ol

a) Give the status an unambiguous name that others will find easy to understand.
b) Specify whether the status counts as active or inactive.

Project members may want to exclude inactive planning folders from their view, to avoid overload.

c) Select which value is the default value for new planning folders and planning folders that originated in earlier
TeamForge versions.

d) Arrange your planning folder statuses in the order that makes sense for you.

Reorder planning folders
When the sequence of work in your project changes, it's a good idea to reorder the planning folders so that they
accurately reflect the real order of work.

For example, it's not unusual for product owners, who must constantly weigh the changing business value of features,
to ask for one set of user stories to be put aside so that another set can be delivered first. When this happens, a project
manager may want to move the corresponding planning folders so that their relative positions visually confirm their
relationship.

. Tip: You may also want to set the planning folder's status to a value that communicates the change in the
order of work.

By default, planning folders are ordered according to when they were created. New planning folders are added to the
end of the folder tree.

1. Click Trackers in the project navigation bar.

L

In the folder tree, click the folder containing the subfolders that you want to reorder.
Choose Reorder Subfolders from the Edit menu.

b w

Organize the subfolders:

» To sort them alphabetically, click Alphabetize.
» To reorder a specific folder, select it by clicking the title, then click Move Up or Move Down until the folder
is where you want it.

Reorder the contents of a planning folder
You can move artifacts in a planning folder up and down to reflect the order in which they should be addressed.

A set of user stories often includes dependency relationships that require that one user story be addressed before
another. For example, suppose a backend database modification must be in place before a user interface component
can be created to access it. Both user stories may have the same degree of priority, but one has to be done before the
other.

One way to manage this is by ranking the user stories in your planning view so that they reflect the sequence you
want. When you do this, team members have a better chance of selecting work efficiently and reducing the need for
rework.

Note: Rank is not the same as priority. Two artifacts may have the same priority but different ranks, or
sequence positions.

[

1. If you are not an administrator on this project, ask your project administrator or site administrator to assign you
sequencing permission.

2. Click Trackers in the project navigation bar.
3. In the folder tree, open the planning folder containing the artifacts that you want to reorder.
4. Click Rank.
You can now drag and drop the artifacts in your planning folder into whatever relative positions you want.

To go back to the sort order you had before (for example, sorted by priority), click Sort.
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Move a planning folder
A planning folder's position may reflect scheduling changes in relation to the work contained in other planning
folders.

For example, when plans change and the work represented in a later planning folder moves ahead of an earlier
planning folder, move the folders around in the hierarchy to reflect the new relationship.

When you move a document folder, any documents and subfolders that it contains are also moved to the destination
folder. Before promoting a planning folder to a higher level in your hierarchy of folders, make sure its member
artifacts (and its members' parent artifacts, if any) are all assigned to the same planning folder, or to a planning folder
that belongs to the same folder hierarchy.

1. Click Trackers in the project navigation bar.

N

In the planning folder tree, find the folder that you want to move. Click the title to select it.
Choose Cut from the Edit menu.

In the folder tree, find the folder into which you want to move the selected folder. Click the title of the folder to
select it.

oW

e Note: You can move a folder into the root folder or into any other folder, as long as no member artifact
ends up having a parent belonging to a higher-level folder in the same tree.

5. Choose Paste option from the Edit menu.
The folder is moved to the destination folder.

Manage your product release with the planning board

The planning board is an important tool for your TeamForge project's Agile planning activities. It enables you to plan
and monitor the features that are required in each sprint (or iteration), and assign them from the product backlog to
specific sprints.

When you've set up your planning folders, you have two views available to work with them - List View and Board
View.

The Board View complements the List View. While the latter offers you capabilities to accomplish various actions
such as create, edit, and delete artifacts and planning folders, the former offers product owners (or similar users) the
ability to view, rank and move artifacts across the three planning folders (swimlanes) in a physical board-like user
interface. In the planning board, planning folders are represented as swimlanes. In each swimlane, the tracker artifacts
for the selected planning folders are represented as cards.

TeamForge user roles and permissions that are in place for planning folders apply to both views. The changes you
make in either planning folder view are reflected in the other as well.

Set up the planning board
You start populating the planning board by selecting a planning folder for each swim lane.

The drop-down list for each swim lane displays the hierarchy of active planning folders for all the sprints and scrum
teams that are under the project's root planning folder. By default, inactive planning folders are not shown in the

swim lane drop-down list. You can organize the planning board the way you want by populating the swim lanes with
planning folders of interest to you: for example, you may select the planning folder corresponding to the product
backlog in the leftmost swim lane and various teams working on the release in the other two swim lanes, or a different
sprint in each swim lane. Your selections are remembered for the current session.

1. Click Trackers in the project navigation bar.

2. Inthe List Trackers and Planning Folders page, click Board View.
A planning board for the current project context is displayed.

3. For each swim lane in the planning board, select a planning folder from the drop-down list. The tracker artifacts
contained by the planning folders are displayed as story cards within the corresponding swim lanes.

» Ifaselected planning folder has subfolders, the artifacts within the subfolders are not displayed.

» Cards have a color-coded bar to visually identify the priority. In addition, the open and closed cards'
background is color-coded to uniquely identify the status.
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* For each card, the artifact ID, title, priority, status, assigned to and points (story points) are displayed. For an
artifact, the estimated effort (in hours) is shown only if its points = 0. Relevant tooltips appear when you hover
your mouse over these data elements.

Assistive information such as the number of cards in the selected planning folder and planning folder points
capacity are displayed at the top of the swim lane.

For example, in the following screenshot, the planning folder points capacity is shown as 36 / 100 Pts.
Which means, you planned for 100 points, whereas the current points capacity (the sum of all open and closed
artifacts) is 36 points. In other words, you have room for taking up more work in that particular planning folder.

PF2 - || -
| artf1110 (P4) & Puoints: 24
CTF 7.1 Refresh Swimlanes

None Open
|| artf1111 (P4) & Puoints: 12
CTF 7.1 Table Filtering

None Open

You can also see 2 Cards at the top of the swim lane, which is the count of the number of cards in the selected
planning folder (by default, only open cards are counted).

Click the Show/hide closed artifacts toggle button to see the count of both open and closed artifacts.

Show/hide closed artifacts toggle button
e Note: You must have set the Points Capacity while creating planning folders to be able to see the current

points capacity against the planned points capacity. For more information, see Create a planning folder on
page 102.

. Click the swim lane refresh button to refresh individual swim lanes.

Swimlane refresh button

e
wd

. To know more about an artifact, click the artifact ID link.

The View Artifact page is displayed.

. By default, closed artifacts are not shown in swim lanes. Click the Show/hide toggle button to show or hide closed
artifacts in swim lanes.

Show/hide closed artifacts button

. To expand an artifact that has child artifacts, click the "+" symbol in the artifact card. The first, second and third-
level child artifacts are displayed.

When you expand an artifact, the parent and child artifacts are visually outlined by means of colored boxes as
shown in the following screenshot.
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FPF2 - ||
|-;_- artf1110 (P2) & Points: 24
CTF 7.1 Refresh Swimlanes
None Cpen
- L artf1111 (P2) & Points: 12
CTF 7.1 Table Filtering
Mone Open
L| artf1112 (P4) & Foints: 0
Multi-select drop-down lists
None Cpen
L[ anf113 (P4) & Foints: 0

Lucene upgrade to v4 4

None Open

Work with artifact cards

In the planning board, artifact cards are displayed in ranked sequence within each swim lane. Using planning board,
you can quickly add new cards (quick add), edit cards, move cards within a swim lane to rank them and move cards
between swim lanes to reassign them to other planning folders.

The tasks that you can accomplish while you work with planning board include:
* Adding artifacts (quick add) in select planning folders with minimum required artifact information.
o Important:

*  While you quickly add artifacts with data for just three fields such as the tracker type, title and
description, the artifacts are, however, saved with default values for other required fields, which you
may choose to update later.

*  You cannot add artifacts from the planning board if work flow is configured for meta status change
from New to Open.

» Ranking artifacts in select planning folders.
* Reassigning (move) artifacts from one planning folder to the other.
» Editing artifacts.

To quickly add artifacts:

1. Select a planning folder in one of the swim lanes. The quick add (+) button at the top of the swim lane is enabled.

o Note: To be able to add artifacts in planning board, you need to have the required permissions.
Quick add button
'y

2. Click the quick add (+) button. The Create Artifact window appears.
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Create Artifact window

Create Artifact
Tracker® MNone E
Title ™

Description™

| Cancel |

3. Select a tracker type from the Tracker drop-down list.

4. Type a title and description. You can select the Use Title as Description check box to copy the title you type to
the Description text box.

5. Click Submit.
The artifact is added as the bottommost artifact in the swim lane (planning folder). You may choose to rank the
artifact (if you have rank permission) or update the artifact with more meta data later. To update the artifact, click
the artifact ID link.

To rank a card:

6. Drag and drop a card above or below the other cards within a swim lane to position it in the order you want the
artifact addressed.
To be able to rank cards, you need the requisite ranking permission. For related information on ranking artifacts in
the list view, see Reorder the contents of a planning folder on page 104.

To reassign (move) a card:

7. In the course of planning your release, you may want to assign an artifact from the product backlog to a specific
sprint or team, or move an artifact from one sprint to another. To do this, just drag and drop the artifact card from
one swim lane to the other.

Note: When you drop the card, its rank is relative to its position in the new swim lane. However, if a
child artifact is moved to a swim lane (planning folder) where its parent is already present, the child
artifact is filed under its parent and its rank is relative to the parent's position.

To be able to move cards between swim lanes, you need to have the permission to update planning folders and
rank artifact cards.

To edit an artifact:
8. Click the edit artifact button in a card. The Edit Artifact window appears.

o Note: To be able to edit artifacts, you need to have the required permissions.

Edit artifact button
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Edit Artifact : artf4565

Title™

Doc task for patch 1

Description™

Doc task for patch 1

* Primary Attributes

9. You can edit the following in the Edit Artifact window:

* Artifact title
* Artifact description
* Primary and secondary attributes

Priority 4-Low  [7] Estimated Effort 0 Hours
Status . Not Started [] Remaining Effort 0 Hours
Assigned To None =] Actual Effort 0 Hours
» Secondary Attributes
| » Comments
e

You have two expandable frames, Primary Attributes and Secondary Attributes, that list fields you
can edit. The expandable frames and the fields listed in the expandable frames depend on your application

configuration.

In general, you can edit fields such as Priority, Status, Assigned to and estimated, remaining and actual effort.
You can also see other custom fields that are either set as Required fields when a user first creates or edits
an artifact and fields that have work flow configured. For more information, see Require users to complete a

tracker artifact field on page 29 and Create a tracker work flow on page 31.
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o Note: You cannot change the status of an artifact in the Planning Board view, if 'Assigned To' is set as
a mandatory field for status change per your tracker work flow settings (Tracker Settings). However,
you can edit the status of an artifact in the List view with the same 'Assigned To' work flow constraint.

By default, the following field types are non-editable from the planning board's Edit Artifact window: Multiple
select, Date picker and User picker.

Non-editable field types

Create Field

Field Mame:?*
Input Type:® Multiple Select (Specify Field Values) |E|
Disabled: Text Entry

Sinale Select (Snecify EField g

Field Values)

I EvRe sl | Multiple Select (Specify Field types that are non-
SelectDate editable from the planning
Select User(s) board's Edit Artifact window.

Comments

In this expandable frame, in addition to adding comments, you can view the last five comments for an artifact.
10. After editing an artifact, click Update.

Manage task work flow
As a task administrator, you can control how users move tasks along under various conditions.

Alert project members about overdue tasks
If a task is not completed by its proposed end date, you may want to send an automatic reminder to the task's owner,
its administrator, or other project members.

You can choose which of the people involved with the overdue task get the alert, and how late the task must be to
trigger an alert.

1. Click Project Admin in the project navigation bar.

On the Project Admin menu, click Task Settings.

Click the Alerts tab.

On the Alerts page, specify the number of days after a task's due date that an overdue task alert is sent.

Nk wN

Specify the recipients of overdue task alerts.
* Project Role Members - All project members who are assigned that role.

o Note: If you select roles or project members that do not have the task view permission, these project
members will receive Permission Denied errors when attempting to access overdue tasks.

» Specific Project Members - Click the people icon to select from a list of project members.
» Task Creator - The person who originated the task.

o Note: The person to whom the task is assigned receives overdue task alerts automatically.

6. Click Save.

Overdue task alerts are now enabled for all tasks in the project.
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Require approval for changing tasks
During times when changes to tasks carry a high risk, task administrators can prevent users' changes from taking
effect until the administrator approves them.

Requiring change approval keeps you informed about changes to task status, dates, dependencies, and other changes
that can affect the project plan.

You can select the fields for which you want require change approval. Whenever a user makes a change to a field
for which change approval is required, the change request is placed in the Change Requests section of the Task
Summary page, with a link in the Items Pending My Approval section of each task administrator's My Page.

' Note: Changes made by task administrators do not require approval.

Click Project Admin in the project navigation bar.

On the Project Admin menu, click Task Settings.

Click the Change Approval tab.

On the Change Approval page, select the fields for which you want to require change approval.
Click Save.

Nk W=

Change approval is now in force for all future changes made to the selected fields.

Handle a change request
When change approval is in force, changes made by project members to selected task fields must be approved or
rejected by a task administrator.

Change requests are placed in the Change Requests section of the Task Summary page. Change requests are also
displayed in the Items Pending My Approval section of each task administrator's My Page.

1. Click Tasks in the project navigation bar.

2. On the Task Summary page, click the Change Requests tab.

3. Respond to a change request in one of these ways:

» Ifyou do not need to view the request details, select the task and click Approve Selected or Reject Selected.

* To view the request details or add a comment before responding to the change, click the task name and write
your comments, then click Approve Selected or Reject Selected in the Change Requests section of the Task
Details page.

.:_ Note: If you approve a task end date change that impacts dependent successor tasks, you must confirm
your changes for each of the successor tasks individually.

You can also approve or reject change requests from the Items Awaiting My Approval section of your My Page. In
the Tasks Awaiting Approval section, click the task name to view the request details, add a comment, and approve
or reject the request.

Indicate task status with colors
The status of each task is represented by a color. The status color of a task folder is an accumulation of the status
colors of the tasks in the folder.

When a certain percentage of tasks have turned a given status color, the color "rolls up" to the task folder. The status
colors of the task folders also "roll up" to the project according to the same criteria.

The percentage in each case is chosen by the project admin.

1. Click Project Admin in the project navigation bar.

2. On the Project Admin menu, click Task Settings.

3. On the Task Status Rollup page, set your color-coding criteria.

For example:

» A task folder is represented by red when at least 10 percent of its tasks are red.
* A task folder is represented by green when at least 10 percent of its tasks are green.
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* A task folder is represented by gray only when at least 80 percent of its tasks are complete.

When one or more criteria are met simultaneously, the task folder is represented by the most critical of the
applicable status values. For example, using the criteria above, if 10 percent of the tasks in a task folder are yellow
and 75 percent of the tasks in the same folder are gray, the task folder is represented by yellow.

Measure task workloads
For help in planning and allocating resources, look at the project's task workloads.

You can measure the tasks assigned to each project member by status, due date, and estimated and actual effort.

1. Click Tasks in the project navigation bar.

2. On the Task Summary page, click the Workload tab.

3. On the Workload page, find the following information for each project member:
* The number of assigned tasks, organized by status value.

* The total number of incomplete tasks.
* The total estimated and actual effort for all tasks.

Set the default task calendar
For each task, you can specify whether work is tracked son a five-day or a seven-day calendar.

For each CollabNet TeamForge project, you can specify a default task calendar. This selection will be the default
calendar for new tasks. You can override this value for individual tasks.

Five-day calendars count only Monday through Friday. Seven-day calendars also count Saturday and Sunday.

' Note: Changing the default calendar does not update existing tasks.

Click Project Admin in the project navigation bar.

On the Project Admin menu, click Task Settings.

Click the Default Task Calendar tab.

On the Default Task Calendar page, choose a five-day or seven-day calendar as the default for the project.
Click Save.

A N

Your default task calendar will be applied to all new tasks.

Reporting
Generate a report to get a shapshot of what is going on in a project.
Reporting overview
You can generate reports on TeamForge data stored in the datamart by using the TeamForge user interface.

TeamForge data is periodically extracted to a separate database, and reports are then generated from the collected
data.

Reporting process details

The data in your reports comes from a special database that extracts live site data from the production database at
intervals you specify.

You can specify the time at which the reporting data is refreshed from the production database. By default, the
extraction takes place daily at 2:30 a.m. in the TeamForge application server's time zone.

Currently, at the site-level, you can generate these reports:

* Users — Information on the number of users logged in.
*  SCM Activity — Information on the number of commits made in the SCM repository.
» Tracker — Information on tracker artifacts created and closed.

For information on the user, SCM and tracker tables in the datamart, see Datamart schemas on page 117
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Generating reports with the user interface
The user interface provides:

» Graphical and tabular views — Use either view to see SCM activity, and artifacts created or closed.
» The ability to choose metrics and create reports based on specific site or project activities.

* A choice of timeframes — Use the From and To fields to view activity by week, month, quarter, six months or
year. You can also use the Max option to view data from the date of site installation to the current date.

Configuring reporting

Configure a collection of variables in the site-options.conf file to use site-wide reporting functionality. See
Turn on site-wide reporting and the TeamForge Administration Guide for more details.

Advanced reporting options and datamart connection

You can use reports to display data and group relevant information appropriately and specify intervals at which the
datamart extracts TeamForge data from the datamart. For advanced reporting options and datamart information, see
Advanced reporting and datamart access on page 117.

You can also use external reporting tools to connect to the datamart and generate customized reports. See Datamart
access using external tools on page 126.

Metrics overview
Reports can be generated on a regular basis to keep track of the different metrics.

You can generate the following reports at the site level:
Users Logged In

The Users Logged In report provides information on the number of users logged in at the site level. The User schema
contains the user login information; TeamForge captures one fact row for each user that is logged in during the day.
For more information see User schema on page 117

SCM Commits

The SCM Commits report provides information on the number of commits made in the SCM repository. You can
query the SCM schema to obtain useful commit information in the SCM tables. For more information see SCM
schema on page 119

Artifacts Closed

The Artifacts Closed report provides information on the number of closed artifacts. An artifact will be considered as
closed, if the artifact status (meta-status) is changed from Open to Closed today and if the artifact status remains so till
end of the day.

Re-opened artifact

An artifact will be considered as re-opened, if the artifact was in closed status (meta-status) yesterday and if it is
changed to Open status (meta-open)today.

Get reports on project activity
You can keep track of SCM and tracker activity specific to your projects based on data that refreshes with every ETL
cycle.

When you use the Project Activity option on the navigation bar to generate reports, data is obtained from the
datamart.

*  Monitor how many users commit to source code repositories, and how often they do it, over a given period. You
can track SCM commits to Subversion and CVS repositories, and to Git repositories as well, if you have the
TeamForge Git integration set up. This can help you decide how much computing power and storage you should
request for handling source code.

* Monitor the number of artifacts created and closed at the project level.
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» Use the Print option to print reports.

.:_ Note: Only users with Activity Reports view permission and a specific component (Tracker or Source Code)
view permission can view the report results.

Click Projects in the site navigation bar

Click Reports in the project tool bar.

Click Project Activity in the navigation bar.

Tl ol

Click a Zoom option to see a week, a month, a quarter, 6 months, or a year of activity.

The Max option shows all the data that's ever been collected.

o

Use the From and To date fields to view the exact period of activity you are interested in.
6. Roll your cursor over any data point on the graph to see the exact numbers that determine that point's position.
7. Click Grid View to see the data as a table.

You can toggle between chart and grid view as needed.

' Tip: Watch for reports on more types of data in upcoming TeamForge releases.

Report on tracker artifacts
Tracker reports give you a summary of the history of tracker artifacts. A tracker report can cover the tracker artifacts
in a selected tracker or across all trackers in a project.

To generate a report, you must first define the report criteria in a template. You can then run the report at any time
with a single click.

When you use the Task & Tracker option on the navigation bar to generate reports, data is obtained from the
TeamForge database, and not from the datamart.

e Note: Report results contain only those items that you have permission to view. Other project members with
different permissions might get different results when running the same report.

1. Click Reports in the project navigation bar.
If you have administrator privileges on the project, you see a navigation bar with Project Activity and Task &
Tracker. Click Task & Tracker.
2. Choose Tracker Report from the drop-down menu, and click New.
3. On the Tracker Report Criteria: Step 1 of 2 page, define report criteria that are common across all selected
trackers.
a) Write a name and description for your report.
b) Select the trackers from which you want tracker artifact data to be reported.
c) Optionally, select date ranges for create date, last edited date, or closed date.
d) Optionally, select one or more Assigned To or Created By project members.
e) Click the icon to display a list of project members with permissions to edit or create tracker artifacts.
f) Click Next.
4. On the Tracker Report Criteria: Step 2 of 2 page, define report criteria that are specific to each selected tracker.
a) Select values for any or all of the remaining tracker fields.
5. Click Generate Report.

* The Report Summary tab shows your results in graphical format.
» The Report Details tab shows your results in tabular format.

6. To edit the report criteria, click Edit, make the changes, and click Generate Report.
The report is automatically regenerated with the new criteria. The new criteria are also saved in the report template
for future use.

7. Repeat the last two steps until you have the report you want.
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Report on tasks
Task reports display selected summary data about project tasks. You can generate reports on the tasks in a selected
project or across multiple projects.

To generate a report, you must first define the report criteria in a template. You can then run the report at any time
with a single click.

When you use the Task & Tracker option on the navigation bar to generate reports, data is obtained from the
TeamForge database, and not from the datamart.

.:_ Note: Report results contain only those items that you have permission to view. Other project members with
different permissions might get different results when running the same report.
1. Click Reports in the project navigation bar.

If you have administrator privileges on the project, you see a navigation bar with Project Activity and Task &
Tracker. Click Task & Tracker.

2. Choose Task Report from the drop-down menu and click New.

' Tip 3 I.f the option does not appear, the Task tool may be disabled for this project. Check with your
administrator.

On the Task Report Criteria page, write a name and description for your report.

Select the project or projects from which you want task data to be reported.

Optionally, select the status and priority values for the tasks to be included in your report.

SN koW

Optionally, select one or more Assigned To or Created By project members.
Click the icon to display a list of project members with permissions to edit or create tasks.

Optionally, select a start date or end date.

® N

. Select the fields that you want displayed in your report, and click Generate Report.
* The Report Summary tab displays your results in graphical format.
» The Report Details tab displays your results in tabular format.

9. To edit the report criteria, click Edit, make the changes, and click Generate Report.
The report is automatically regenerated with the new criteria. The new criteria is also saved in the report template
for future use.

10. Repeat the last two steps until you have the report you want.

Save a report template
To run reports, you must define the report criteria and save it in a report template.

When you use the Task & Tracker option on the navigation bar to generate reports, data is obtained from the
TeamForge database, and not from the datamart.
1. Click Reports in the project navigation bar.

If you have administrator privileges on the project, you see a navigation bar with Project Activity and Task &
Tracker. Click Task & Tracker.

2. From the drop-down menu, choose a type of report template.

» Task Report - Reports on the numbers of tasks assigned to each user.
* Tracker Report - Reports on the numbers of artifacts submitted to selected project trackers.

3. Click New.

4. On the Task Report Criteria or Tracker Report Criteria page, select your desired report criteria.
The fields on the Report Criteria page depend on the report type.

5. Click Generate Report.

The report results appear and the template is saved.

After you have saved your report template, you are ready to run reports.
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Run areport
Run a report to get fresh data on the status of your project.

You must save a report template before running a report.

When you use the Task & Tracker option on the navigation bar to generate reports, data is obtained from the
TeamForge database, and not from the datamart.

The report data is regenerated each time the report is run.

Tip: You can modify the report criteria before generating the report data. For example, you might want to

"" . . .
run the same report each week, using all of the same report criteria except the start and end dates.

Note: Report results contain only those items that you have permission to view. Other project members with

i
different permissions might get different results when running the same report.

1. Click Reports in the project navigation bar.

If you have administrator privileges on the project, you see a navigation bar with Project Activity and Task &
Tracker. Click Task & Tracker.

2. Click the title of the desired report template.

* The Report Summary tab displays your results in graphical format.
* The Report Details tab displays your results in tabular format.
3. To edit the report criteria, click Edit, make the changes, and click Generate Report.
The report is automatically regenerated with the new criteria. The new criteria are also saved in the report template
for future use.

4. Repeat the last two steps until you have the report you want.

Export report results
To save your report results, you can export the data to a . csv, .xm1, or tab-delimited file.

When you use the Task & Tracker option on the navigation bar to generate reports, data is obtained from the
TeamForge database, and not from the datamart.

Note: If you created a report that includes trackers with different user-defined fields and click Export on the
Report Summary page, the Export Data window will only show the fields that appear in all trackers. To
export user-defined fields, click the Report Details tab and click Export for a specific tracker.

[ 1

1. Click Reports in the project navigation bar.

If you have administrator privileges on the project, you see a navigation bar with Project Activity and Task &
Tracker. Click Task & Tracker.

2. Click the title of the report template.
3. On the Report page, click Export.
4. In the Export Data window, select an export format.

« CSV
e Tab-delimited
« XML

5. Select the fields that you want to export and move them from the Available Columns list to the Selected
Columns list.

6. Click Export.
7. In the Export Data confirmation window, click the link provided if you want to save the file again.

Delete a report template
To avoid confusion, it is a good idea to delete report templates that you no longer need.

When you use the Task & Tracker option on the navigation bar to generate reports, data is obtained from the
TeamForge database, and not from the datamart.

1. Click Reports in the project navigation bar.
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If you have administrator privileges on the project, you see a navigation bar with Project Activity and Task &
Tracker. Click Task & Tracker.

2. Select the report template that you want to delete, and click Delete.

The report template is deleted.

Advanced reporting and datamart access
Using external reporting and OLAP tools, query the datamart directly and generate reports. The database schema
diagrams provide the means to create advanced query scripts to extract required information from the datamart.

Accessing the datamart for reporting provides more analytical data than is provided by the TeamForge user interface
options. The external tool must connect directly to the datamart and is then granted read-only permission to all data in
the datamart.

.:_ Note: It is recommended that you limit the access to the datamart to a limited set of trusted users.

Datamart schemas

The Users, SCM, and Tracker schemas are documented here for use in queries to the datamart. The datamart uses
a "Star Schema" design for tables.

User schema

Query the user schema to obtain useful information in the user database tables detailed here in a schema diagram.

User schema contains user login information; TeamForge captures one fact row for each user that is logged in during
the day.

User schema diagram

user_dimension

ell_job
ob_key user_key
job_name Id
T USEMam e
cif_wersion full_name
etl_start -
— COMPAaNTy_narme
;ﬂa&ﬁgd is_super_user
I5_restricted_user
status
locale
audit_dimension license_type
it usor_tmpsacion o i
P user_trans_key Rom
granularity job_key (FK)
data_source audit_key (FK) 3 g
job_key trans_date_key (FK) date_dimension
status user_key (FK) dlate_key
E e e e e e e e e e ad|v|ty_key [:FKJ -
actor_key date_of_trans
day_of_week
day_of_month
week_of_wyear
OGN : manth_of_year
activity_dimension quarer
activity_kes year
day_of wear
name last_dey_of month_flag
date_name
davname_of_week
weekday_flag
month_narme
calendar_month_year

*History (SCD-2) is maintained forthe highlighted atnbutes



| How to use TeamForge 7.1 | 118

Description of user schema

etl_job Used to track the ETL run status. There is one record
per ETL run for a job, for example, Tracker ETL or
User ETL. et1 job has a 1-to-many relationship
with audit dimension since a job may update
more than one fact table. All report generation queries
must "join" the etl job table with the condition
etl job.status=1, thereby discarding data from
incomplete ETL runs.

audit_dimension Holds metadata about fact table records. There is one
record per fact table for an ETL run.

date_dimension Conformed dimension used for all transaction times.

user_dimension Used for string user attributes and is a "slowly changing
dimension of type 2 (SCD-2)." is_super user,
status,and license type are the SCD-2 fields.

activity _dimension Conformed dimension that stores the activity or
transaction names for various activities being tracked.

user_transaction_fact A fact-less fact table with user data of "daily"
granularity.

Sample queries

You can obtain useful user information by querying the user database, and further refine the results by using filters on
the "date", "user type" (admin or non), "status", and "license type" fields. For example:

* Number of users who are logged in, by day, over a period of time:

SELECT c.date of trans as Date, count(distinct(b.id)) as NumUsers

FROM user transaction fact a, user dimension b, date dimension c, etl job
d

WHERE a.user key=b.user key and a.trans date key=c.date key and
a.job_key=d.job key

and d.status=1 and c.date of trans >= '2012-12-17' and c.date of trans <=
'2012-12-21"

GROUP BY c.date of trans
» List of users who have logged in:

SELECT c.date of trans as Date, b.username as UserName

FROM user transaction fact a, user dimension b, date dimension c,
etl job d

WHERE a.user key=b.user key and a.trans date key=c.date key and
a.job key=d.job key

and d.status=1 and c.date of trans >= '2012-12-17' and

c.date of trans <= '2012-12-21"

GROUP BY c.date of trans, b.username



SCM schema

Query the SCM schema to obtain useful commit information in the SCM tables detailed here in a schema diagram.

SCM schema diagram
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Description of SCM schema

etl_job

Used to track the ETL run status. There is one record
per ETL run for a job, for example, Tracker ETL or
User ETL. et1l job has a 1-to-many relationship
with audit dimension since a job may update
more than one fact table. All report generation queries
must "join" the etl job table with the condition
etl job.status=1, thereby discarding data from
incomplete ETL runs.
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audit_dimension Holds metadata about fact table records. There is one
record per fact table for an ETL run.

date_dimension Conformed dimension used for all transaction times.

activity dimension Conformed dimension that stores the activity or
transaction names for various activities being tracked.

user_dimension Used for string user attributes and is a "slowly changing
dimension of type 2 (SCD-2)." is_super user,
status,and license type are the SCD-2 fields.

project_dimension Used for storing project attributes and is a "slowly
changing dimension of type 2 (SCD-2)." is_deleted
and project access_level are the SCD-2 fields.

repository_dimension Used for storing repository attributes and is a "slowly
changing dimension of type 1."

scm_transaction_fact The fact table for SCM activities with "transaction"
granularity. TeamForge inserts a row in this table for
every SCM activity that it processes in a transaction.

+ TeamForge object id , if available.

e Number of files added, deleted, modified, moved,
copied, if applicable.

Sample queries
You can obtain useful SCM information by querying the SCM database. For example:
*  Number of SCM commits, sorted by date:

select b.date of trans as Date,
count (a.scm_transaction fact key) as NumCommits
from scm transaction fact a, date dimension b
where a.trans date key=b.date key
group by b.date of trans

*  Number of SCM commits, with quarterly trend:

select 'Q'||b.gquarter as Quarter,
count (a.scm_transaction fact key) as NumCommits
from scm transaction fact a, date dimension b
where a.trans date key=b.date key
group by b.quarter

» List of users who made commits.

select b.username as UserName,
count (a.scm_transaction fact key) as NumCommits
from scm transaction fact a, user dimension b
where a.user key=b.user key
group by b.username

* Project-wise commit data:

select b.id as ProjectId, b.title as ProjectName,
count (a.scm_transaction fact key) as NumCommits
from scm transaction fact a, project dimension b
where a.project key=b.project key
group by b.id, b.title
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+ Commits by date, in a specific project:

select c.date of trans as Date, b.id as ProjectId, b.title as
ProjectName,

count (a.scm_transaction fact key) as NumCommits

from scm transaction fact a, project dimension b,
date dimension c

where a.project key=b.project key and
a.trans date key=c.date key

and b.id="proj1008’
group by c.date of trans, b.id, b.title

Tracker schema
Query the tracker schema to obtain useful information in the tracker database tables detailed here in a schema
diagram.

TeamForge constructs the state or field values of the artifact during each update. The schema addresses both activity
queries and total count queries.

TeamForge includes information only for activity in fixed and default artifact fields; flex-fields are not currently
supported. This information includes artifact create, move, update for fixed-value changes, delete,
open_to close,and close to open.
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Tracker schema diagram
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Description of tracker schema

etl_job

audit_dimension

date_dimension

user_dimension

project_dimension

pf_dimension

pf_bridge

tracker_dimension
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Used to track the ETL run status. There is one record
per ETL run for a job, for example, Tracker ETL or
User ETL. et1 job has a 1-to-many relationship
with audit dimension since a job may update
more than one fact table. All report generation queries
must "join" the etl job table with the condition
etl job.status=1, thereby discarding data from
incomplete ETL runs.

Holds metadata about fact table records. There is one
record per fact table for an ETL run.

Conformed dimension used for all transaction times.

Used for string user attributes and is a "slowly changing
dimension of type 2 (SCD-2)." is_super user,
status,and license type are the SCD-2 fields.

Used for storing project attributes and is a "slowly
changing dimension of type 2 (SCD-2)." is_deleted
and project access_level are the SCD-2 fields.

The planning folder dimension for storing planning
folder attributes. Use this table to generate reports
without planning folder hierarchy.

A table for the planning folder hierarchy containing
end-of-day status. pf bridge is a "slowly changing
dimension of type 2 (SCD-2)." You must limit queries

to a given parent planning folder while joining with the
pf bridge table. Use pf bridge to generate reports
around planning folder hierarchy by joining with parent
tables such as artifact daily snapshot fact
orartifact transaction fact.

Joining pf bridge with

artifact transaction fact generates correct
results only if end-of-day in queries is set to "12:00
a.m.". While formulating queries with pf bridge,
please note:

* parent and child fields — Contain values from
pf dimension.pf key;adepth of 0 indicates
self.

e leaf field — Is true if the child is a leaf node,
otherwise false. Every planning folder will have an
entry here with a depth of 0; every parent planning
folder will have entries for all of its children,
recursively, up to the leaf node of all branches.

*+ effective fromandeffective till
fields — Indicate the period when the parent-child
relationship is correct, and can be used in queries to
get the hierarchy for a specified time period.

Used for storing tracker attributes and is a "slowly
changing dimension of type 2 (SCD-2)." is deleted
is the changing field that act as a filter for reports.
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artifact_dimension Used for storing artifact data and is a "slowly changing
dimension of type 1."

group_dimension Used for holding values of the TeamForge tracker
field "group". group dimension has values for all
artifacts from all Trackers.

status_dimension Used for holding values of the TeamForge tracker field
"status". The status_value class field represents
the meta-status of an artifact and has values "Open"
and "Close". status_dimension has values for all
artifacts from all Trackers.

category_dimension Used for holding values of the TeamForge tracker field
"category". category dimension has values for all
artifacts from all Trackers.

customer_dimension Used for holding values of the TeamForge tracker field
"customer”. customer dimension has values for all
artifacts from all Trackers.

release_dimension Used for holding values of the TeamForge tracker
fields "Reported in Release" and "Fixed in Release".
release dimension has values for all artifacts from
all Trackers.

artifact_transaction_fact Every change in fixed or default artifact field values,
or to project or tracker artifacts, results in a row
inserted to artifact transaction fact.
Changes to flex-field values, adding comments,
attachments, and so on do not add a row to the table. The
artifact dimension.date last modified
field has the time in the source tracker at the time of the
ETL run. artifact transaction fact canbe
used to generate reports around activities such as create,
update, delete and move, and for intra-day reports.
artifact transaction fact has a "transaction"
granularity.

artifact_daily_snapshot_fact An aggregate table that holds the daily
snapshot data or end-of-day status.
artifact daily snapshot fact can
be used to generate reports for artifact close &
re-open counts. It is recommended to use this
table for end-of-day reports as it has fewer rows
compared to artifact transaction fact.
artifact daily snapshot fact hasa "daily"
granularity.

Sample queries
You can obtain useful tracker information by querying the tracker database. For example:

* Number of artifacts created in a tracker, sorted by date:

SELECT b.date of trans, count(a.artifact key)

FROM artifact transaction fact a, date dimension b,
tracker dimension c

WHERE a.trans date key=b.date key and
a.tracker key=c.tracker key

and a.activity='Create' and c.title='Tracker-1"
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and b.date of trans >= '2011-10-31' and b.date of trans <=
'2011-11-07"

GROUP BY b.date of trans

ORDER BY b.date of trans

* Number of artifacts created in a tracker, sorted by date and priority:

SELECT b.date of trans, d.title as Tracker, 'P'||a.priority as
Priority,c.id ArtifactId
FROM artifact transaction fact a, date dimension b,
artifact dimension ¢, tracker dimension d
WHERE a.trans date _key=b.date key and
a.artifact key=c. artifact _key and a. tracker key=d.tracker key
and a.activity='Create' and d.title='Tracker-1'
and b.date of trans >= '2011-10-31' and b.date of trans <=
'2011-11-07"
ORDER BY b.date of trans, d.title, Priority

» Number of artifacts created on a particular day in a particular planning folder:

SELECT b.date of trans, c.id ArtifactId, c.title

FROM artifact transaction fact a, date dimension b,
artifact dimension c, pf dimension d, pf bridge e

WHERE a.trans date key=b.date key and
a.artifact key=c. artifact _key and a.pf key e.child

and d.pf key=e.parent and a.activity='Create' and
d.title="Pf-1"

and '2011-10-31"'" >= e.effective from and '2011-10-31"' <
e.effective till

and b.date of trans = '2011-10-31"

ORDER BY b.date of trans

*  Number of closed tracker artifacts, sorted by day:

SELECT b.date of trans, count(a.artifact key)

FROM artifact _daily snapshot fact a, date dimension b,
tracker dimension c

WHERE a.trans date key=b.date key and
a.tracker key=c.tracker key and a.closed __today flag='true'

and c.title='Tracker-1' and b.date of trans >= '2011-10-31'
and b.date of trans <= '2011-11-07"'

" GROUP BY b.date of trans

ORDER BY b.date_of_trans

» List of artifacts in the "Open" state, sorted by day:

SELECT a.date of trans, c.id, c.title
FROM date dimension a inner join artifact daily snapshot fact

b
on a.date of trans >= date(b.effective from) and

a.date of trans < date(b.effective till)
inner join artifact dimension c on

b.artifact key=c.artifact key
inner join status dimension d on b.status key=d.status key
WHERE d.status value class='Open' and a.date of trans >=

'2011-10-31"

and a.date of trans <= '2011-11-02"'
ORDER BY a.date of trans
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Datamart access using external tools
Use external tools to directly query the PostgreSQL or Oracle datamarts to access more TeamForge data than is
available through options on the TeamForge user interface.

Accessing the datamart

You can use OLAP or GUI tools to query your datamart directly to procure all the TeamForge data that is relevant to
your analysis.

The external tool must be in the same network as the datamart to ensure fast access with a direct connection
to the database. On the TeamForge host machine, you must enable REPORTS DATABASE HOST and
REPORT S_DATABASE_PORT for remote access.

e Note: You only have read access; the datamart does not allow writes.

Enabling the datamart for access

You must enable the datamart for direct queries and re-start the site. Once enabled, all data in the datamart can be
queried using external tools.

Enable TeamForge (PostgreSQL datamart) for queries from external tools
You must enable, then re-start TeamForge so that you can use an external tool to query the datamart directly.

You cannot use external reporting tools to connect directly to a datamart if you have a single-box installation using
HOST localhost.

1. Editthe site-options.conf file. Set REPORTS DB ACCESS HOSTS to the IP address or IP address
range (CIDR address) from which the tool will establish connection to the datamart. Specify multiple IPs as a
comma-separated list.

For example: REPORTS DB ACCESS_ HOSTS = 10.0.0.2,10.2.1.0/24

' Note:

+ If the TeamForge site is not within your network and a Network Address Translation (NAT) is
configured, then specify the NAT's external facing IP in the token.

+ Ifyou have used an "advanced" installation method to install TeamForge, you must also manually add
the IP addresses to the pg_hba . conf file.

2. Insite-options.conf, set REPORTS DATABASE READ ONLY USER and
REPORTS_DATABASE READ ONLY PASSWORD with your user and password.

3. On the TeamForge host machine, enable REPORTS DATABASE HOST and REPORTS DATABASE PORT for
remote access.

4. Re-create the runtime environment.
sudo ./install.sh -r -n -V -d <site dir>
5. Start the site.

sudo /etc/init.d/collabnet start

You can now enable trusted users to establish connections by providing them with values of options
REPORTS DATABASE HOST, REPORTS DATABASE PORT, REPORTS DATABASE READ ONLY USER,
and REPORT S_DATABASE READ ONLY PASSWORD.

Enable TeamForge (Oracle datamart) for queries from external tools
You must enable, then re-startTeamForge so that you can use an external tool to query the datamart directly.

You can use external reporting tools to connect directly to a datamart only if you do not have a single-box installation
using HOST localhost.

1. Insite-options.conf, set REPORTS DATABASE READ ONLY USER and
REPORTS DATABASE READ ONLY PASSWORD with your user and password.
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2. On the TeamForge host machine, enable REPORTS DATABASE HOST and REPORTS DATABASE PORT for
remote access.

3. Re-create the runtime environment.

sudo ./install.sh -r -n -V
4. Start the site.

/etc/init.d/httpd start
sudo /etc/init.d/collabnet start

You can now enable trusted users to establish connections by providing them with values of options
REPORTS DATABASE HOST, REPORTS DATABASE PORT, REPORTS DATABASE READ ONLY USER,
and REPORTS DATABASE READ ONLY PASSWORD.

Common errors while connecting to PostgreSQL or Oracle datamarts
You may encounter these errors while configuring your datamart to allow queries from external tools.

PostgreSQL database access error

Error: psgql: FATAL: no pg hba.conf entry for host "111.111.111.111", user "test",
database "datamart"

This error in a PostgreSQL datamart is because TeamForge is not granting access to your IP address.

Solution: Have the TeamForge administrator grant access to your IP address.

PostgreSQL authentication error
Error: psgl: FATAL: password authentication failed for user "test"

Solution: Specify the correct user name and password.

PostgreSQL connection error

Error: psgl: could not connect to server: Connection refused. Is the server
running on host "<datamart-host>" and accepting TCP/IP connections on port
56327

Solution:

* Check the host and port numbers; the database must be running on host "datamart-host" and accept TCP/IP
connections on port 5632.

* Check if remote access is enabled on TeamForge; the Teamforge administrator can enable the required access.

Oracle connection error

Error: ORA-12505, TNS:listener does not currently know of SID given in connect
descriptor.

This error in an Oracle datamart occurs when some connection parameters are set incorrectly.

Solution: Check and set your connection parameters appropriately.

Control project access
To control who can access your project, consider the purpose of your project and the appropriate type of user.

Control access by user role
Project administrators use existing global project roles or create and assign roles to project members to define what
those project members can do in the project.

If you choose to use existing global project roles, you can quickly assign relevant roles to your project members. It is
a good practice to create a new role in your project only when a suitable global project role is not available.
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.:-_ Note: If your project is a subproject of any other project, your project may have inherited some roles from
the parent project. To work with the properties and permissions associated with inherited roles, you must go
to the parent project where those roles are specified.

Give roles to a project member
A project member can have any number of roles. As project administrator, you must assign each project member's
roles.

Permissions are cumulative. The project member has all of the access permissions allowed by all of the assigned
roles, plus any permissions that may have been assigned globally using application permissions.

.:-_ Note: If your project is a subproject of any other project, you may have inherited some roles, project
members or user groups from the parent project. You can assign any role to any project member, regardless
of whether it's a global project role, or the role belongs directly to the project, or is inherited from a parent
project.

1. Click Project Admin in the project navigation bar.

2. On the Project Admin menu, click Permissions, then click the User-Role Matrix tab.

Observe the users listed on the left and all the available roles (global, direct and inherited) on the right.
.:-_ Note: Users can be assigned global, direct and inherited roles. Inherited users have all the permissions
that they have in the parent project.
+ Ifyou assign another inherited role to an inherited user, that user gets both the roles.
+ Ifyou assign a role to a user in a project, that user becomes a current member in that project.
3. Select roles for each project member.

e Note: A user's license type also influences what the user can see and do on your site. A user's license type
supersedes any role assignments.

* An ALM license enables the user who holds it to use the full range of TeamForge features: both the
core source-code management tools and the extended application lifecycle management functionality.
* An SCM license enables the user who holds it to use the core TeamForge source-code management
tools.
Ask your site administrator how many licenses of each kind are available for your users.
4. Click Save.
The roles are now assigned to each project member.

Give a role to multiple project members
A role can be assigned to many users at once.

The user-role matrix provides a convenient way to add project members to a role, but it can become unwieldy if the
project has a large number of users or roles. When that is the case, try assigning roles to multiple users at one time.
1. Click Project Admin in the project navigation bar.
2. On the Project Admin menu, click Permissions.
3. Click the name of the role that you want to assign to project members.
4. On the Role Permissions page, click the Assigned Project Members tab.

The Assigned Project Members page shows all users who currently have the role.

' Tip: You can assign the role only to the direct project members of the project.

e Note: A user's license type also influences what the user can see and do on your site. A user's license type
supersedes any role assignments.

* An ALM license enables the user who holds it to use the full range of TeamForge features: both the
core source-code management tools and the extended application lifecycle management functionality.

* An SCM license enables the user who holds it to use the core TeamForge source-code management
tools.
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Ask your site administrator how many licenses of each kind are available for your users.
5. Click Add and use the Find a User window to move your desired users into the Selected Users list.

' Tip: You can search by full or partial user name or full name to find the right project members.

6. Click OK.

The project members are now assigned the role.

Handle a role request from a project member

A project member in CollabNet TeamForge can ask to be granted a role. As the project administrator, it's up to you to
approve or reject such requests.

When a CollabNet TeamForge project member submits a request for a role in a project, the request is placed in the
User Membership section of the Project Administration page, pending approval by a project administrator. The
request is also displayed in the Items Pending My Approval section of each project administrator's My Page.

1. Click Project Admin in the project navigation bar.

2. On the Project Admin menu, click User Membership, then click the Pending Requests tab.

3. Under Role Requests, sclect the user whose role request you want to approve or reject.

» Click Approve to approve the request and assign the role to the user.
* Click Reject to deny the request.

e Tip: To view the permissions granted via the role, click the role name, if required.

Note: Before approving or rejecting a role request, you can check the roles already assigned to the user by
clicking the user name and selecting the Roles tab.

The user receives an email notification when the request is approved or rejected.

Assign a global project role on request

As a project administrator you can edit a requestable global project role for your project. You can update the settings
to immediately assign the role to a project member on request.

e Note: Only site administrators or restricted site administrators with "Role-Edit" permission can edit global
project role details. Project administrators can only edit requestable global project role's grant settings for
their projects.

Click Project Admin in the project navigation bar.

On the Project Admin menu, click Permissions.

From the list of global project roles, click the requestable global project role you want to edit.

On the Edit Role page, click Edit.

Select the Grant Automatically on Request option and click Save.
Selecting this option enables the project member requesting the role to be assigned the same immediately, without
waiting for an approval.

Nk Wb

The role is modified for your project.
Assign roles to a user group
Enable multiple users to do something all at once by giving their group a role.

A user group can have any number of roles. Each member of the user group has all the access permissions allowed
by all of the assigned roles, plus any permissions that may have been assigned by other methods, such as application
permissions or individually assigned roles.

Roles and the associated permissions can be inherited. If your project is a subproject of any other project, you may
have inherited some roles or user groups. You can assign any inherited role to any user group.
1. Click Project Admin in the project navigation bar.
2. On the Project Admin menu, click Permissions, then click the Group-Role Matrix tab.
Observe the user groups listed on the left and all the available roles (global, direct and inherited) on the right.
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.:_ Note: User groups can be assigned global, direct and inherited roles. The inherited user groups have all
the permissions that they have in the parent project.

» If you assign another inherited role to an inherited group, the members of that group get both the roles.
» If you assign a role to a user group in a project, that user group becomes a direct user group in that
project.

3. Select the roles you want for each user group and click Save.
' Note: When you give a group access to a CVS or Wandisco Subversion repository, members of the group

can view the repository but cannot do repository actions, such as commit and update. You must assign
those permissions to users individually.

The roles are now assigned to each user group.

Assign user groups to a role

To manage permissions for a lot of groups or roles at once, try assigning user groups to roles.

1. Click Project Admin in the project navigation bar.

2. On the Project Admin menu, click Permissions.

3. To display existing global, direct or inherited roles, click the Global project roles, Roles Created For a Project
or Roles Inherited From Parent Project option of View.

Note: If your project is a subproject of another project, you may have inherited some roles or user groups.
The inherited role details like role name, description and the source project name are listed.
You can assign direct user groups to a global/direct/inherited role.
4. Click the name of the role that you want to assign to user groups.
5. On the Role Permissions page, click the Assigned Groups tab.
The Assigned Groups page shows all user groups that are currently assigned the role.

' Tip: You can assign the role only to the direct user groups of the project.

6. Click Add.
7. Type some of the group’s name in the Name (search) box and click Find.
8. In the Find a user group window, select the user groups that you want to add, and click Finish.
' Note: When you give a group access to a CVS or Wandisco Subversion repository, members of the group

can view the repository but cannot do repository actions, such as commit and update. You must assign
those permissions to users individually.

The user groups are now assigned the role.

Create arole

A role defines the applications that project members with that role can use, and the specific things project members
can do in each application.

Any project administrator can create and assign a role.

' Tip: Itis a good idea to check the existing global project roles via Project Admin > Permissions > Roles >
View: global project roles before creating any new role in a project.

Click Project Admin in the project navigation bar.

On the Project Admin menu, click Permissions.

On the Roles tab, click View: Roles Created For a Project.

Click Create.

On the Create Role page, write a name and description for the role.

A o

To let this role be automatically added to any private subprojects of this project, clear the Prevent Inheritance
option.

By default, roles are inherited by public and gated subprojects, but not private subprojects.
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.:-_ Tip: If this project is a subproject of any other project, you may already have inherited some roles.

' Note:
7. To allow project members to be able to request this role, select Requestable Role.
Project members can submit requests for requestable roles, which the project administrator can approve or reject.

. Tip: Select Grant Automatically on Request to skip the need to approve or reject a request.

8. Click Create.
The role is created. The Edit Role page appears.

9. For each application listed on the Role Permissions page, select the permissions and resources you want to make
available to users with this role.

e Tip: You can specify the permissions for integrated applications here too.
e Note: You can specify access to individual top-level folders, but not to specific subfolders.
10. Click Save.

The role is created. You can assign it to project members at any time.

.:-_ Tip: Based on the earlier settings, a project member may be able to submit a request for the role.

Create a project administrator role
The project administrator is responsible for managing the project's users and roles.

The project creator is assigned the Founder Project Admin role, a special role granting all project and application
administration permissions for the project. You can transfer the Founder Project Admin role to another user.

If the project creator is a CollabNet TeamForge administrator, no Founder Project Admin is created.

e Note: By default, project adminstrators do not have application administration permissions, such as Tracker
Admin or Task Admin. Application administration permissions can be included in a project administrator
role, but must be assigned separately.

1. On the Role Permissions page, select Project Admin Permissions.

e Note: Ifthis is an inherited role, you can not edit the permissions associated with it. You can edit the
project members and user groups to whom this inherited role is assigned.

» If you want the role to contain only the project administrator permissions to manage users and roles, Project
Admin Permissions is all you need to select.

» If you want the role to contain additional application administration or other permissions, check the additional
permissions.

2. Click Save.

All project members assigned this role have project administrator permissions to manage the project's users and roles.
Change arole

If users need to do things that are not allowed by a role you have assigned to them, you may need to change the
permissions associated with that role.

When you edit a role, all project members with that role get the updated permissions automatically.

.:-_ Note: If your project is a subproject of any other project, your project may have inherited some roles from
the parent project. To work with the properties and permissions associated with inherited roles, you must go
to the parent project where those roles are specified.

1. Click Project Admin in the project navigation bar.
2. On the Project Admin menu, click Permissions.
3. From the list of roles created for this project, click the role you want to edit.
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.:_ Note: You can assign a role to direct project members and user groups of the project regardless of
whether the role belongs directly to this project or is inherited from a parent project.

4. On the Role page, make the changes you need.

» To edit the title or other role details, click Edit. Make the required changes and click Update.

» To edit the role's permissions, choose an application from the left side of the page and select or deselect
permissions and resources.

» To edit the project members to whom the role is assigned, click Assigned Project Members.
* To edit the user groups to whom the role is assigned, click Assigned Groups.

5. Click Save.

The role is modified.

View users and user groups assigned to a role

Before adding a role to a project member or user groups, see all the users and user groups who are assigned that role
through inheritance.

A user or user group can have any number of roles. Roles and the associated permissions can be inherited via project
hierarchy or project groups.

1. Click Project Admin in the project navigation bar.

N

On the Project Admin menu, click Permissions.

w

In the View drop-down, select Global project roles and from the results, a specific role.

=

In the Assigned Project Members tab, click the View drop-down and make a selection.

* Direct Members displays the users who are directly assigned the role in the project.

* Inherited Members displays the users who inherit the role from parent projects as well as project groups.
5. In the Assigned Groups tab, click the View drop-down and make a selection.

* Direct User Groups displays the user groups that are directly assigned the role in the project.

* Inherited User Groups displays the user groups that inherit the role from parent projects as well as project
groups.

The roles are now assigned to each user group.

Control access by user class
To avoid having to create and assign a lot of similar roles for individual users, give access to applications to whole
classes of users whenever possible.

For each application (tasks, documents, file releases, trackers, and discussion forums), you can assign permissions
globally based on user type.

For example, if you know that you want all project members to be able to view and submit to all project trackers, set
the application's permissions to reflect this. You need to configure these settings only once.
1. On the Project Admin page, configure your project access settings and click Next.

2. On the Edit Default Access Application Permissions page, click the + symbol to expand the section for which
you want to assign permissions.

3. For each application and resource, choose a user type from the drop-down menus.

» All users of the selected type will have the specified permissions: view, submit/view, or post/view.
* For discussion forums and trackers, you can also specify submit or post permissions.

.:_ Note: You can specify access to top-level folders, but not to specific subfolders.

e Note: If you want to control access to an application or resource that is not displayed on the Edit Default
Access Application Permissions page, you can do so using role-based access control.

4. Click Finish.
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Control access by project type
Projects can be open only to project members, open to everyone in the world, or something in between.

By default, all new projects are created as private projects, accessible only to project members. Your system
administrator can change the default access level for new projects.

.:_ Important: Users who do not have access to a project cannot see it on the Home page, in the All Projects
list, or in search or reporting results.
1. Click Project Admin in the project navigation bar.

2. On the Project Admin menu, click Permissions, then click the Default Access Permissions tab to see the
project's current access setting.

3. Click Edit.
4. On the Edit Default Access Permissions page, select the kind of access you want to allow to your project.
* Private - Project members only.

* Gated community - Project members and unrestricted users.
* Public - All users.

.:_ Note: If the option is not available, your system administrator has prohibited changing the access levels
of projects on the site.

Let users see other users' roles
You can enable some project members to view the roles assigned to other project members.

For example, if your project includes both core team members and consultants, you may want to restrict full visibility
of user details to the core team members.

1. Click Project Admin in the project navigation bar.

2. On the Project Admin menu, click Permissions.

3. On the Roles tab, click the role you want to edit.

For example, if you have divided project members into a "Core Team" role and a "Consultant" role, click the
"Core Team" role.

4. Under Project Admin Permissions, select View User Membership.
Now only project members who have the role you edited can see the roles held by other project members.

e Note: They still can't see the actual permissions included in those roles, unless they have Project Admin
status.

Lock or unlock a project
To ensure that no changes occur in a project while you are collating or migrating project data, lock the project. You
must have project administration permissions or be a site administrator to lock or unlock a project.

To lock or unlock a project in CollabNet TeamForge, go to Project Settings and lock/unlock the project.

e Note: A locked project does not allow any member (including project administrators and site administrators)
to make any changes to the project. Besides that, a locked project can not be set as the parent project for any
other project and tasks like adding, editing or deleting integrated applications are also not allowed.

Click Project Admin in the project navigation bar.
The project is locked or unlocked as desired. The lock icon 5 Locked appears on all the project pages while the
project is locked.

e Note: If a locked project has an integrated application, for example, project tracker, all the project tracker
pages are also non-editable while the project is locked. The user who has access permissions for the integrated
application can only view the pages.
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Control access to source code
It's a good idea to make sure your source code can only be used by people who have business with it.

You can control which users can view or commit source code. You can make these distinctions at the repository level
or at the path level within a repository.

1.
2.
3.

Click Project Admin in the project navigation bar.
On the Project Settings page, click Permissions.

Click the role whose access to source code you want to control.

' Tip: If the appropriate role does not exist, you must create it first. See Create a role on page 130.

4. On the Edit Role page, click Source Code.

7.

[

Under Repository Permissions, select a repository in the project and specify this role's access to the repository as
a whole.

» To block users with this role from seeing this repository at all, select No Access.

» To allow users with this role to see everything in the repository but not commit to it, select View Only.

* To allow users with this role to commit to any path in the repository, select View and Commit.

If you want to control access to a specific path within the repository for users with this role, select Path-based

Permissions.

See Who can access source code? and Wildcard-based access control and path-based permissions in TeamForge
for more information.
a) Click Add.
b) Specify a path in the repository.
' Tip: The path does not have to exist when you specify it. You can set a permission for a path that may
be created later.
c) Select No Access, View Only, or View and Commit for this path.

e Note:

+ Ifnone of the available permissions (View Only, View and Commit, or Path-based Permissions) is
selected for any repository, and none of the options under Source Code Permissions is selected, users
with this role do not see the Source Code toolbar button.

« If two paths have different permissions, the permissions on the lower-level path take effect. For
example, consider a role that has "No Access" set for the path /branches/version3/users, but
has "View and Commit" access to /branches/version3/users/vijay. Users with this role
can:

e Check code in and out of the vijay directory.
* Click down through all the directories in that path, including users.
Users with this role cannot check files in and out of the users directory or monitor commits to
users.
Click Save.

Note: You can also restrict the information that goes out with commit notification emails. See Who can
access source code? on page 245.

Control HTML headers in hand-coded project pages
When a HTML page that you created in Microsoft Word or Frontpage looks strange, you may be able to fix it by
suppressing HTML head content.

1.
2.
3.

Click Project Admin in the project navigation bar.
Select Preserve HTML head content.
Click Save.

Pages created in Microsoft Word or Frontpage should render correctly.
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Allow anonymous Subversion checkouts

To grant anonymous checkout access while restricting write access to a Subversion repository, set the project's default
access permissions to public, provide Source Code View permission to all users, and limit other permissions to
specific user classes.

1. Click Project Admin in the project navigation bar.
2. On the Project Admin menu, click Permissions, then the Default Access Permissions tab.

3. Under Application Permissions, choose All users from the drop-down for Source Code View permission.

.:_ Note: You can give all users checkout access to all repositories or a specific repository.

4. For other application permissions, choose a user class based on your access requirement.

Users can now check out from a repository without entering a password.

Show or hide an application
To help users focus on the relevant parts of your project, choose which applications they can jump to from the
navigation bar at the top of any project page.

1. On any project page, click Project Admin.
2. On the Project Settings page, click Project Toolbar.

3. Select the applications that you want to be visible to users in your project, and click Save.
Only the application buttons you have set to Visible are in the navigation bar at the top of the project page.

* Removing buttons from the navigation bar does not remove the application from the site. Users with the
appropriate permissions can still get to the hidden applications by other means, such as clicking a link in an email.
The hidden application button will not appear.

* When an application button is set to Visible, but a given user does not have permission to use that application,
that user still cannot see the application button. For example, if a user has a role that does not permit access to any
source code repositories, that user does not see the Source Code toolbar button, even if the button is enabled for
the project.

» If the Tasks tool is hidden for a project, the option to run reports on the Task tool is also hidden.

» Ifyou create a project template from a project that has hidden applications, any project you create from that
template will have the same applications hidden.

Who can post to discussions by email?
To help reduce the risk of spam or other mischief, you may need to limit the users who can post to your project's
discussion forums by email.

To leverage the advantages of community collaboration, you should keep your forums as open as you can. However,
some projects require tighter control over who can participate in discussions. TeamForge enables you to balance
openness against privacy along a spectrum of choices.
1. Click Project Admin in the project navigation bar.
2. Click Discussion Settings.
3. Set the value of Email Posting to one of these choices (listed from most restrictive to least restrictive).

This option... has this effect:

Allow only forum admins Only users with the "discussion admin" permission can
post by email.

Users with roles & permissions Only registered users with the "topic post" permission
can post by email. This is the default. (For discussions
marked as private, this is the least restrictive setting
possible.)

All logged in users All users who are registered on the site can post by
email.
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This option... has this effect:

Allow known email addresses only Users can post by email only if they have explicitly
been added to the monitoring list. (This can include
people who are not registered site users.)

All site users and guests Anyone can post by email.

If you select a value that's more liberal than the value your site administrator has set for the site as a whole, the
site administrator's setting rules. For example, suppose the site administrator has provided that only users with the
appropriate role ("Users with roles & permissions") can post by email. If your project requires extra security, you
can choose to accept email only from forum administrators. However, you cannot accept email posts from a less
restrictive category of users, such as "All logged in users."

Manage project membership
You can add or remove project members on their request or on your own initiative.
e Note: If your project is a subproject of any other project, your project may have inherited some roles from

the parent project. To work with the properties and permissions associated with inherited roles, you must go
to the parent project where those roles are specified.

Add users to a project
Before a person can work on a project, you have to make them a member of the project.

You can make any registered user on your CollabNet TeamForge site a project member. You can assign roles to the
user at the same time.

.:-_ Note: Project members, roles and the associated permissions can be inherited and reused in subprojects. If
your project is a subproject of any other project, you may have inherited some roles, project members, or user
groups.

Click Project Admin in the project navigation bar.

On the Project Admin mengu, click User Membership.

Click Add.

On the Add User page, find the users you want by one of these methods:

Cal ol

* Under Search for Users, filter the list of site users eligible to join this project. You can filter by full or partial
name or user name.

e Note: Search text is not case-sensitive.

* Browse the list of registered users on the site. Sort them by name, user name, email address or membership
status.

The inherited project members continue to hold the inherited roles with corresponding permissions, as
specified in the source projects.

e Note: If a site has a great many users, you must filter them first to narrow down the list. This helps
avoid slowing down the system.
5. Select the users you want to add.

6. Under Assign Roles, select the roles you want the users to have.
You can select any global project role, role created just for this project, or inherited role that is available.

' Note: If your project is a child project of another project, the members of the parent project become
inherited members of your project. The user roles specified in the parent project are available in your
project provided the role inheritance is not prevented. If you assign a role in your project to a user, that
user becomes a direct member of your project.



| How to use TeamForge 7.1 | 137

.:_ Tip: If you prefer, you can skip this step and assign roles later on the Project Admin > Permissions
page. Note that using the Assigned Project Members page, you can assign roles only to the direct project
members.

7. Save your changes.

* Click Save to return to the Project Membership page.
* Click Save and Add More to keep adding users.

Remove a user from a project
When you remove a user from a project, all items such as tasks and tracker artifacts that were assigned to the user are
re-assigned to None.

e Note: If your project is a subproject of any other project, your project may have inherited some users from
the parent project. To remove an inherited user, you must go to the parent project where that user is a direct
member.

1. Click Project Admin in the project navigation bar.

2. On the Project Admin menu, click User Membership.

3. From the list of current project members, select the user you want to remove and click Remove.

The user is now removed from the project.

Handle a request for project membership
A registered CollabNet TeamForge user can ask to be a member of a project. As the project administrator, it's up to
you to approve or reject such requests.

When a CollabNet TeamForge user submits a request for project membership, the request is placed in the User
Membership section of the Project Administration page, pending approval by a project administrator. The request
is also displayed in the Items Pending My Approval section of each project administrator's My Page.

1. Click Project Admin in the project navigation bar.

2. On the Project Admin menu, click User Membership, then click the Pending Requests tab.

3. Under Users Requesting to Join Project, select the user you want to approve or reject.

* Click Approve to approve the request and add the user to the project.
* Click Reject to deny the request.
4. To view details about the user or add a comment before approving or rejecting the request, click the user name.

This is optional.

The user receives an email notification when the request is approved or rejected.

Handle a request to leave a project
A CollabNet TeamForge user who wants to leave a project must submit a request. The project administrator can
approve or reject the request.

A request to leave is placed in the User Membership section of the Project Administration page, pending approval
by a project administrator. The request is also displayed in the Items Pending My Approval section of each project
administrator's My Page.
1. Click Project Admin in the project navigation bar.
2. On the Project Admin menu, click User Membership, then click the Pending Requests tab.
3. Under Users Requesting to Leave Project, select the user whose request you want to approve or reject.
* Click Approve to approve the request and remove the user from the project.
* Click Reject to deny the request.
4. To view the user details or add a comment before approving or rejecting the request, click the user name.
This is optional.

The user receives an email notification when the request is approved or rejected.
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Create a project template
To make it easier to start projects, provide project templates based on existing projects.

A project template is used to populate new projects with the structure and configuration of the source project.It can
also include the actual contents of the project it is based on, such as tasks, tracker items and documents.

When you create a project template, it is available only to projects on your own site. To make it available more
widely, you can export the project template and share it with others. Ask your CollabNet representative for more
information about doing this.

e Note: The access settings for a project template are the same as the access settings for the project on which
the template is based. For example:

+ If you create a template from a project that has hidden applications, any project you create from that
template will have the same applications hidden.

+ Ifyou create a template from a project that is private, any project created from that template will also be
private.

1. Set up the project that will serve as the basis for the new project template.

' Tip: If you need a clean project template, you may want to create a new project specifically for this
purpose.
2. Click Project Admin in the project navigation bar.
3. On the Project Settings page, click Create Project Template.
4. Write a name and description for the template.
.:_ Tip: Consider the uses that you or other project managers might have for this project template, and
include keywords in your description that are related to those uses.
5. Choose the items that you want to make available in new projects that are created from this template.

» Every new project includes a Trackers component into which you can add new trackers; a Documents folder
into which you can add more document folders and documents; and so on.

» If you wish, you can include the actual trackers from the current project's Trackers component; the actual
documents from the current project's Documents component, and so on.

6. Click OK.

The project template is created. The template is available to all users who have the required permissions to create new
projects.

The template name and description appear on the Template tab of the Projects list, accessible from your personal
navigation bar.

Categorize a project
Organizing projects by categories can help users find what they need on a site quickly and easily.

Project categories express the relationships among projects. If your project is in a category, it is visible to users
browsing projects from the main Project Categories page.

Your project can be in one or more project categories.

1. Click Project Admin in the project navigation bar.

2. On the Project Admin menu, click the Project Categorization tab.
The Project Categorization page lists all the categories the project belongs to.

3. Click Add.
The Select Category window shows all the available project categories.

4. Ifyou find a project category that your project should be in, select that category and click Add.

Your project is now a member of the selected project category. You can repeat this process to add your project to any
number of project categories.
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Make other applications available to project members

You can make it easy for project members to use a wide variety of applications and sites from inside CollabNet
TeamForge.

Link an external application
To make an application or site outside of CollabNet TeamForge available in your project, create a linked application.

You can create as many linked applications per project as you need.

.:_ Tip: Some sites employ page code that disables this feature. For example, some Google apps automatically
generate user login data and append it to their URLs, which prevents them from opening in an iFrame.
1. Click Project Admin in the project navigation bar.

2. On the Project Admin menu, click Project Toolbar. Then click Linked Applications.
The Linked Applications page displays a list of all currently linked applications in the project.

3. On the Linked Applications page, click Create.

4. On the Create Linked Application page, enter a name for the linked application.
This name will appear, with an icon you choose, in the project navigation bar.

5. Enter the server location or URL for the linked application.
6. If you are a CollabNet TeamForge administrator, select whether you want to use single sign-on for the linked
application.

» Ifyou use single sign-on, CollabNet TeamForge users can automatically log into the linked application.

» If you do not use single sign-on, users must log into the linked application using its native authentication
system.

7. Click Choose File and select a gif, . jpg, or .png file to serve as the new icon for the linked application.
Make the image 25 pixels wide and 20 pixels high.

This icon appears with the application name in the project navigation bar. However, the linked application icons
are displayed in grayscale in the project navigation bar.

8. Click Save.

A button for the linked application is added to your project navigation bar. Clicking it launches the application in the
main CollabNet TeamForge project window.

Change a linked application
When the use patterns of a linked application change, you may need to change the way the application integrates with
CollabNet TeamForge .

Click Project Admin in the project navigation bar.
On the Project Admin menu, click Linked Applications.
On the Linked Applications page, select the application you want to edit.

Click Edit.
The Edit Linked Application page appears.

L=

»n

Edit the name of the linked application, if required.
6. Edit the linked application URL, if required.

7. Enable or disable single sign on for the linked application. Only CollabNet TeamForge administrators can enable
or disable single sign on.

8. Click Choose File and select a gif, . jpg, or .png file to serve as the new icon for the linked application.
Make the image 25 pixels wide and 20 pixels high.

This icon appears with the application name in the project navigation bar. However, the linked application icons
are displayed in grayscale in the project navigation bar.

9. Click Save.
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Reorder linked applications
If the order of the buttons for your linked applications makes a difference to users, you can reorder them.

By default, linked application buttons are displayed in the project navigation bar in the order in which they were
added.

1. Click Project Admin in the project navigation bar.

2. On the Project Admin menu, click Linked Applications.

3. On the Linked Applications page, click Reorder.
4

. In the Reorder Linked Applications window, arrange your applications in the order that works best for your
users.

a) Select an application by clicking the title.
b) Click Move Up or Move Down until the linked application is in the correct order.
5. Click Save.

Integrate an external application into your project
To make an application or site outside of CollabNet TeamForge available to your users seamlessly from inside your
TeamForge project, bring it in as an integrated application.

If the application you want to use is not yet available for your project, ask your site administrator to set it up.
You can use as many integrated applications as you wish, after your site administrator has made them available.

1. Click Project Admin in the project navigation bar.

2. On the Project Admin menu, click Project Toolbar.
The Integrated Applications tab displays the list of all currently integrated applications in the project.

3. On the Integrated Applications page, click Add.
4. On the Add Integrated Applications page, select the desired application and click Configure and Add .

a) If your site administrator has made it possible, specify a prefix for the resources created by the application you
are setting up.
A prefix enables TeamForge to provide handy links between objects managed by this application and other
TeamForge objects. For example, if you are bringing in a blogging application:

* You can connect a blog post with a TeamForge artifact using a special link called an "association."
» For each blog post, you can give readers a simplified address, known as a "go URL."

' N ote: For project-level associations and go URLSs the application's prefix is permanent after you save
1it.

b) Set any other configuration parameters you need and save your changes.

* Click Save to return to the Configure Integrated Application page.
* Click Save and Add More to keep adding integrated applications.

An icon for the integrated application is added to your project navigation bar. Clicking it launches the application in
the main CollabNet TeamForge project window.

Export an integrated application

TeamForge site administrators can export an integrated application's variables in XML format and have them
available for editing.

1. Click Admin in the TeamForge toolbar.

2. On the Site Administration page, click Integrated Apps.

3. To export the integrated application, select the integrated application name from the View Integrated
Application page.
4. Click Export.

The integrated application will be exported.
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Remove an integrated application from your project
To stop making an application or site outside of CollabNet TeamForge available to your users from inside your
CollabNet TeamForge projects seamlessly, disintegrate an application.

Note: You may have integrated several external applications per project to maximize the integrated
applications feature's utility. However, because each integrated application adds an icon to the project
navigation bar, a large number of integrated applications can cause horizontal scrolling. Consider removing
the integrated applications that are not in use.

[ 1

1. Click Project Admin in the project navigation bar.

2. On the Project Admin menu, click Project Toolbar.
The Integrated Applications tab displays the list of all currently integrated applications in the project.

3. To remove an integrated application, on the Integrated Applications page, select the integrated application and
click Remove.
The selected integrated application is removed from the project.

The icon of the removed integrated application disappears from your project navigation bar.

' Note: Removing an integrated application, removes all associations to the integrated application too.

Add a parent project to your project

You can coordinate work among multiple projects; enable the user, user group and role inheritance by adding a
common parent project to several projects.

' Note: A subproject can have only one parent. You can change or remove that parent at any time.

Note: You must be a project administrator or site administrator to add/edit or remove the parent projects.

=

Click Project Admin in the project navigation bar.
On the Project Settings page, click Edit Parent.
Click Add Parent.

On the Choose New Parent page, choose a parent project that it makes sense for your project to belong to, and
click Confirm.

Eal ol A

. Note: You cannot add a parent project for the 'Look' project as it is a special project in itself.

Separate a subproject from its parent project

When a subproject grows beyond its original scope, you may want to make it stand-alone project or move it to a
different project hierarchy.

By removing the association with a parent project, you can manage the subproject as a separate project.

Note: Only one parent project can be selected for a subproject. However, the parent project can be changed
or removed, as required.

[ N

1. Click Project Admin in the project navigation bar.
2. On the Project Settings page, click Edit Parent.
3. Change or remove the parent project as required.

You can be a project administrator or a site administrator to change or remove a parent project. As a project
administrator, you can remove or change a parent project only if you have administrator permissions for both the
projects that are being linked.

Note: A parent project can be removed or changed only when its members, user groups and roles are not
in use in any other project. In other words, you can not remove/change a parent project while its members,
user groups or roles are in use in any other project.

[ 1

* « Click Change Parent to choose another parent project.



| How to use TeamForge 7.1 | 142

* On the Choose a Parent Project page, select the desired parent project and click Confirm.

' Note: If the project hierarchy exists, the project and its subprojects are moved only under the project
from which members, user groups or roles are inherited. If project hierarchy does not exist and no
inheritance is in use, the project is made a 'Root' project.

* « Click Remove Parent to remove the association with parent project.
*  On the pop-up message box, click OK, if you wish to make the project a 'Root' project.

The project hierarchy is changed or removed in accordance with role based access control and inheritance rules.

Require a wiki version comment

To help keep track of changes to a Wiki page, require users to record a comment about their changes when they save
the page.

1. On any project page, click Project Admin.
2. On the Project Settings page, click Wiki Settings.
3. Seclect Requires Version Comment on Edit.

Now users who edit a page in your project's Wiki must leave a note describing their changes.

Provision hardware for project members
You can use TeamForge Lab Management to provision physical or virtual hardware on which project members can
remotely build and test their code.

.:_ Tip: For more information about the new features in TeamForge Lab Management 2.2, see this introductory
video. (You'll need a free open.collab.net membership to watch it.)

Set up hardware for your team to use

When you set up Lab Management, your team members can use TeamForge to access their own virtual machines for
developing and testing.

Get CollabNet TeamForge Lab Management .

On the Project Admin menu, click Linked Applications.

On the Linked Applications page, click Create.

On the Create Linked Application page, enter the name Lab Mgmt.

Enter the server location or URL of your Lab Management server.

A o

If you are a CollabNet TeamForge administrator, select whether you want to use single sign-on for the linked
application.

» Ifyou use single sign-on, CollabNet TeamForge manages authentication for Lab Management, and users don't
have to log into Lab Management after they have logged into CollabNet TeamForge.

» If you do not use single sign-on, users must log into Lab Management using its native authentication system.

7. Click Browse and select this icon for the linked application:

i

This icon will appear with the name Lab Mgmt in the project navigation bar.
8. Click Save.

A Lab Mgmt button is added to your project navigation bar. Clicking it launches the application in the main
CollabNet TeamForge project window.

Reallocate a system
To enable a project member to use a system, you must reallocate the system to that user.

You must be a Domain Administrator or Project Administrator to free a host that does not already belong to you.


http://www.open.collab.net/nonav/community/sfee/training/wbt11/WhatsNewLM.htm
http://www.open.collab.net/nonav/community/sfee/training/wbt11/WhatsNewLM.htm
http://www.open.collab.net/products/CUBiT/
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1. Notify the user you're taking the system from through email or some other means, so that they don't lose any
important work which they may not have saved on that system.

The user whose system was deallocated will get an email after the deallocation, but it is a courtesy to notify the
user beforehand.

2. On your project's Project Home page, click the host you want to reallocate.

3. Click Free Host.
The host is now free and can be allocated by anyone in the project. TeamForge Lab Management emails the user
that their system has been deallocated by an administrator.

4. To discourage other users from allocating it, put a note in the host's Description stating something like "This host
reserved for Jane."

5. Notify the user who is going to allocate the new system that their system is now ready.
Edit a project
As a project administrator in TeamForge Lab Management, you can edit certain properties for your project.

1. On the project home page for the project that you wish to edit, click Edit Project.
2. Edit the following parameters:

Project Summary A brief, one-line summary of the project.
Project Description A more detailed explanation of the project.
Project MOTD (Message of the Day) The Project MOTD is displayed to all users in your

projects. This message also may display to users when
they log in to client nodes in your project.

Project-specific host allocation time limits In this section, project administrators can control how
long users in their project can allocate hosts for. If you
set this value to 0 (zero), there is no limit on the time a
host can be allocated.

If you reduce this value, users' hosts in your project
may be deallocated. If deallocations will occur as a
result of your lowering of the maximum allocation
time, you will be warned which systems will be
affected, and given a chance to change your mind.

Delete this Project/Undelete this Project If your project is not deleted and has no hosts, you
will be given the option to delete this project from
TeamForge Lab Management. If your project is
deleted, you will be given the option to undelete it.

Note: only Domain Admins will be able to delete
and undelete projects

Dictate which profiles can be used in your project

To control which operating system profiles the users in your project can build hosts with, adjust the settings in your
profile library.

1. On the Profile Library page, click Add/Remove Profiles.

2. In the list of all potential profiles that you can add to your project, select the profiles you wish to be allowed in
your project and click Save Changes.

Your changes take effect immediately.

.:_ Note: To revert any changes you have made, click Cancel or Reset.

Deliver a build
To get your software into users' hands, upload your build to the Project Build Library.
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Get the PBL upload client
You must download the pbl.py script to transfer files into the Project Build Library.

Th PBL upload client is free, open-source, and freely modifiable and distributable.

Download the PBL upload client from Attp://cubit.open.collab.net/pbl/.

.:-_ Note: The API operations are fully documented, for users who might want to develop their own PBL upload
client.
Upload afile

To upload a file, run the pbl .py upload command.

In this example, we upload a file named Release. zip from our local machine into the public area of the project
myproject, in the directory /foo/bar/baz/.

.:-_ Note: If any part of the requested path does not already exist, pbl . py creates the intermediate directories.

Run the pbl.py upload command like this, substituting the correct values for your situation.

pbl.py upload --api-user=username --api-
key=713cdf90-2549-1350-80c3-2d0bcf9%9al697 --api-url http://Sexternal host/
cubit api/l --project=myproject -t pub -r /foo/bar/baz -d "This is the
description." /home/Release.zip

.:-_ Tip: Wildcards are accepted in the filename argument. If the file argument is a directory, or a wildcard
which includes one or more directories, pbl . py recursively uploads all the subdirectories underneath the
parent. All the files in the recursive upload get the same description.

Once this operation has completed, you can download this file from https://$external host/myproject/
pub/foo/bar/baz/Release.zip.

For other options to pbl.py, run pbl.py help upload.

Change the description of afile

You can change the description associated with a file or directory without changing the file itself or the md5
checksum of the file.

In this example, you have already authenticated and saved your user name and key credentials in your home directory.

Run the pbl.py changedesc command like this:

pbl.py changedesc -1 http://Sexternal host/cubit api/l --project=myproject
-t pub -r /foo/bar/baz/Release.zip -d "This is the new description"

Move a file
With the pbl.py move command, you can move files or directories within a project, or even between projects.

The syntax for this command is a bit different than the rest of the commands, because the other commands only
operate on one project or file or directory at a time, and that is not the case the the move operation.

To move a file, run the pb1 .py move command with these options.

In the simplest case, we move a file, or a directory and all its contents, from one name to another.

--Srcproj projname The name of the project the source file is located in.

--destproj projname The name of the project to move the file to. If left
blank, defaults to value of --srcproj.

--srcpath path The path to the file or directory to move.

--destpath path The destination path for the file or directory specified

in ——srcpath. Two important things to note about
this option:


http://cubit.open.collab.net/pbl/
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» Ifyou specify a path which does not exist, that path
will be automatically created for you as part of the
move.

o Ifthe -—destpath parameter ends with a
slash ("/"), the destination will be assumed to be
a directory. If it does not end with a slash, the
destination will be assumed to be a file. An example
of this behavior is below. This is approximately
how the UNIX "mv" command behaves.

--srctype {pub|priv} The visibility type of the source file, either pub or
priv.

--desttype {pub|priv} The visibility type of the destination file, either pub or
priv.

--force If the destination file exists, the --force option must be

used to replace it.

. Note: Because destpath does not end with a slash -- /foo/bar/baz/Release old.zip --the

last component of the path is interpreted as "a file named 'Release old.zip"'.

pbl.py move -1 http://Sexternal host/TeamForge Lab Management api/l --
srcprj=myproject —--srctype=pub --srcpath=/foo/bar/baz/Release.zip --
destpath=/foo/bar/baz/Release old.zip

To move a file from one project to another, and also change it from public to private, run the command like this.

ol Note: Because destpath ends with a slash -- "/ foo/bar/baz/archive/" -- the last component of the

path is interpreted as "a directory named 'archive''.

pbl.py move -1 http://Sexternal host/TeamForge Lab Management api/l --
srcprj=myproject --destproj=myproject archive --srctype=pub --desttype=priv
--srcpath=/foo/bar/baz/Release.zip —--destpath=/foo/bar/baz/archive/

Allow clouds in a project

To enable project members to allocate hosts from a public cloud in your Lab Management site , you must turn on a
setting to allow the inclusion of public clouds in your project.

1. In Administration > Projects, click Edit for your project.

2. Turn on the Allow Public Clouds setting.

If you want to be able to control the hosts your project members can select from, turn this setting OFF. In this
case, your project members can only select systems from a cloud your project explicitly owns. Your project's
Allowed Clouds page lists all the available clouds from which project members can allocate hosts.

Note: If you think that your project needs more systems than those available from a cloud, you need to ask
the cloud administrator for your site to increase this number.

Provision a Continuous Integration server from a Lab Management cloud

The Lab Management Cloud plugin enables Hudson and Jenkins to automatically create slaves from Lab Management
clouds.

Install the Lab Management Cloud plugin for Hudson and Jenkins

Get the plugin from openCollabNet and upload it using the Plugin Manager.

1. Download the 1abmanagement . hpi file from openCollabNet. (Please check back later for availability.)

2. Inthe Hudson or Jenkins Plugin Manager page, click the Advanced tab.

3. In the Upload Plugin section, browse to the location where you saved the . hpi file and click Upload.

In the Plugin Manager's Installed tab, you should see the Lab Management Cloud plugin enabled.
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Configure the Lab Management Cloud plug in for Hudson and Jenkins
When you add a new cloud, you set up templates specifying details such as the host type and profile for the nodes that
will be provisioned from this cloud.

1. In the Cloud section of the Hudson or Jenkins configuration page, click Add a new cloud and select CollabNet
Lab Management.

Lab Management options are displayed. Here's an example:

Cloud
CollabNet LabManagement
LabManagement URL https://mgr.cloud.sp.collab.net/ L
LUsername Imuseri] [
Fassword RS R R R R R AR R R R RN R R R R R R R R AR R RRB RS I,
AFI Key [

Test Connecton

Project labmgmt i

Cloud YaparCloud s

Templates MName e ,@,
Host Type basic_i386 - @
Size lcpu-lgb-60ghb - 'ﬁ'
Profile ctf6.1-dev-r5.4-i386 - @
Labels o 6.1 'ﬁ'

2 of Executors 1

®

Delete Template |

2. Enter the URL of the Lab Management Manager node. For example, https://mgr.cloud.sp.collab.net/.
3. Provide the user name and password.

This user must have access to the Lab Management project where new hosts will be allocated.
4. Enter the user's API key for the Lab Management web service.

' Tip: Copy and paste the key from the user's Lab Management home page.

5. Click Test Connection to make sure that the options you provided are valid.
6. Specify the Lab Management project where new hosts will be added.
7. Select a Cloud from which new hosts will be allocated.

You can find the list of valid cloud names in the Lab Management Manager interface. For example:
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Cloud tools
Browse All Clouds Name Summary
Allocate From Cloud DevCloud ¥ | WMware-server cloud
PublicCloud ¥ Public cloud for all
How do I... projects
Allocate? VaporCloud Short term allocatior
A

8. Click Add Template to create a template that Hudson will start.
a) Specify a name that characterizes the template.
The name is used to identify the template and is displayed in various parts of the Hudson interface.
b) For Host Type, select the type of hardware you want for the node.
c) For Size, select the amount of resources -- memory, CPU, and disk -- assigned to this template.

You can find the exact amount of resources for each size in the Lab Management Manager's Clouds >
Allocate From Cloud page. For example:

Clouds

A Select a host type and size from a cloud of your choosing. Different host types will have diff
FAaM, networlk, reliability, etc.) and will also have different costs.

Allocate host into project:

labmgmt »

1. Choose a host type and 2. Choose a system profile 3. Customize y

size

Cloud: DevCloud H] (@) centos5_all H|

VMware-server clouds _

wHost type: basic i385 H| 8“”:“?‘3:2:‘ | g —
Centosa_ X & d

Ugzs wapeslasi=iis (@) centcss_xEE_Ef‘—_bas.E H
@ Size: 1cpu-0.5gb-40gb (I (@) ctfs.2-ga-saas-r5.3-x86_64 H Number o
[@] Size: lcpu-1gb-40gh [@ =y e = dors o 2 imae =

Price niE

d) For Profile, select the Lab Management profile to be used for the template.
e) Provide a list of labels separated by white spaces.

Note: The names and labels you provide for the templates are used to specify which jobs will use this
cloud.
f) Enter a value for # of Executors.
This controls the number of concurrent builds that Hudson or Jenkins can perform. So the value affects the
overall system load that might be incurred. A good value to start with is the number of processors on your
system.

When using Hudson or Jenkins in the master/slave mode, setting this value to 0 would prevent the master from
doing any building on its own. Slaves may not have zero executors, but may be temporarily disabled using the
button on the slave's status page.
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9. Click Save.

In the Manage Nodes page, you'll see an option to provision a node from Lab Management.

im S

S

Iy

Jlenkins = nodes

Back to Dashboard s Name | Architecture Clock Differenc
ine _ )
Manage Jenkins - master  Linux (amdad) In =y
,_:5:'
Mew MNode :
| Prowvision wvia LabManagement ™
Confiqure

Run a Hudson or Jenkins job on a host provisioned from Lab Management cloud
When you run a job on a host provisioned from a Lab Management cloud, use a template you defined earlier.

1.
2.

In the Hudson or Jenkins configuration page for the job, provide a name and description.
Select the Restrict where this project can be run option to tie the job to the Lab Management cloud.

3. Enter a label expression.

4.

To always run this job on a specific node, just specify its name. However, when several nodes could be available
and you don't want to tie the job to a specific one, enter an expression based on the name and label values of a Lab

Management cloud template you configured earlier.

Froject name Elastic Provisioning test

Description Runs a build on a dynamically provisioned node from a Lab Management ©

["] Discard Old Builds
] This build is parameterized

"] pisable Build (Mo new builds will be executed until the project is re-enabled.)
] Execute concurrent builds if neceszary (beta)

[¥] mestrict where this project can be run

Label Expression  —r

Specify any other options you want and click Save.

When a node is no longer used, it will be brought down and released.

Supp

ort project teams with CollabNet TeamForge

As a site administrator, you can help project managers and members of the site work together effectively throughout
the application life cycle.
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Move a site from CollabNet Enterprise Edition to CollabNet TeamForge 7.1
As a domain administrator, you will find some aspects of TeamForge similar to CollabNet Enterprise Edition and
others quite different. Here are some steps you can take to ease the transition for yourself and your site's users.

' Tip: Training is available to help you manage the transition. See the CollabNet training portal for details.

1. Get a new password for TeamForge 7.1 site
Your login name is migrated from CollabNet Enterprise Edition to TeamForge 7.1, but your password is not.

To create your new password, click Forgot Your Password? on the TeamForge 7.1 home page.
Your TeamForge site emails you a link you can use to set a new password.
2. Be aware of password policy differences.

TeamForge 7.1 uses a slightly different password policy from your CollabNet Enterprise Edition site. To review
the site's password policy settings, click View Password Policy on the Reset Password page.

Note: Users' password histories are not migrated. This means that if "Size of user's password history" was
set in CollabNet Enterprise Edition, the history will be cleared on migration.
3. Site-wide broadcasts are a good way to keep your site's users up to date during the transition.
See Communicate with all site users at once on page 159.

4. Each of the CollabNet Enterprise Edition tools has its counterpart in CTF. Project information and resources work
a little differently in each one.

For a detailed feature-to-feature comparison, see Migrating tools from Enterprise Edition to TeamForge 7.1 on
page 331.

5. For the end user, permissions mostly work the same way on the new site as on the CEE site. However, it may be
useful to know about the different ways permissions are handled behind the scenes.

For a detailed comparison of permission handling between the two platforms, see How do user permissions in
CollabNet Enterprise Edition map to permissions in TeamForge 7.17 on page 261

6. Project templates are not migrated from CollabNet Enterprise Edition to CTF.

CollabNet will provide support to manually recreate templates after the site is upgraded.

For information about how project templates work in CTF, see Create a project template on page 138.

7. TeamForge 7.1 URLs are different from CollabNet Enterprise Edition URLs. Backward compatibility is provided
for certain important URLs.
For detailed information about how URLs are handled, see How do URLs in CollabNet TeamForge 7.1 compare
with URLs in CollabNet Enterprise Edition? on page 224

8. Remote Publishing

Remote publishing gets its own repository now. It is listed as a publishing repository in the SCM listing page.
Please check out the publishing repository and use it for all remote publishing activities.

9. Customize Project Home Page

Post migration, please check the Project Admin > Project Settings Home Page settings to ensure that the
desired content is displayed as the Home page.

If the Show default project pages and components option is selected, the project home page displays project
pages. You will see the content of index.html (if you had one in CollabNet Enterprise Edition) in the project home
page as an html component. Moving forward, you will have to edit this html component through the PCE only and
you can not edit index.html directly in the repository to modify the project home page.

If the Show custom web page option is selected, the project home page displays content from the www/
index.html of the 'Publishing' repository of the project. In this case, any changes to the www/index.html
file will be visible in the project home page.

You can refer this help page for details: Create a custom project home page on page 92
10. Change of CVS URL


http://www.open.collab.net/training/ctf/
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CVS URLs used in CollabNet Enterprise Edition will work in TeamForge 7.1, but the repository path is different.
See the Source Code tab of the TeamForge 7.1 project for the new checkout command for your CVS repository.
The CVS working copies must be recreated (checked-out afresh).

11. Subversion
Existing Subversion working copies can be used as available and do not require a fresh checkout, except for the
remote publishing content under the "www" folder.

12. Re-do project requests/posts
Unapproved project requests or discussion posts are not migrated to TeamForge 7.1. If you have project

requests in CollabNet Enterprise Edition that were not approved until migration, it will have to be done afresh in
TeamForge 7.1.

13. CollabNet Enterprise Edition's audit history

Audit history from CollabNet Enterprise Edition is not migrated into TeamForge 7.1, but the data is archived.
Please get in touch with your CollabNet representative for accessing the data.

Delegate site administration tasks with site-wide roles
To spread out the site administration burden, consider creating additional site administrators with permissions to do
almost everything a full site administrator can do.

To allow some CollabNet TeamForge users to use one or more TeamForge tools across projects, give them a role that
allows them to use project tools in any project on the site.

Create additional site administrators

To assist in the administration of the CollabNet TeamForge site, a person must have a site administrator user account
with a corresponding role on that site. CollabNet TeamForge administrators can create suitable site-wide roles and
delegate site administration responsibilities.

e Note: You can choose site administration permissions via site-wide roles.

Click Admin in the site navigation bar.
On the site administration navigation bar, click Roles.
Click Create.

On the Create Site-wide Role page, write a name and description for the role.

El o

The role name is case-sensitive.
5. To prevent inheritance of the role into private projects, select the Prevent access option.
.:-_ Note: Selecting the option to prevent role inheritance does not affect access to public and gated projects.

On selecting Prevent access, the user may not be allowed to do project-permissions related tasks in
private projects.

6. Click Create.
The restricted site administrator role is created. The Edit Site-wide Role Permissions page appears.

e Note: You can select the permissions for site administration tools as well as for applications available
across all projects.

7. Select the apt site administration and/or project permissions listed on the Role Permissions page, to match the
responsibility assigned to a user with that role.

' Tip: You may not want to risk delegating the task of deleting projects, users, groups, roles or categories.

. Note: If you are creating a site-wide role that has Project Tracker's "Configure - Site" permission, you
must also assign the "Role - View" permission.

. Note: To manage artifact types globally, users must have project administrator permissions in a site-wide
role.

The role is created. You can assign it to site members at any time.
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Modify the additional site administrators privileges
If restricted site administrators need to do things that are not allowed by a role you have assigned to them, you may
need to change the permissions associated with that role.

When you edit a role, all restricted site administrators with that role get the updated permissions automatically.

.:_ Tip: You may have prevented the access permission into private projects earlier. Now you can modify the
restriction or change other relevant permissions.

Click Admin in the site navigation bar.

On the site administration navigation bar, click Roles.

From the list of roles, click the role you want to edit or select the check box and click Edit.

Tl ol

On the Edit Site-wide Role Permissions page, make the changes you need.

» To edit the title or description of the role, click Edit.

* To edit the site administration and/or project permissions, choose an application from the left side of the page
and select or deselect permissions and resources.

* To edit the site members to whom the role is assigned, click Assigned Users.

5. Click Save.

Make selected users additional site administrators
You can empower site users to assist in site administration by giving them a suitable role.

Depending upon the permissions you grant via site-wide roles, you can select site users who could be granted the
privilege.
1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Roles.
The existing site-wide roles are listed.

3. Click the role that you want to assign to the site users.

4. On the Edit Site-wide Role Permissions page, click the Assigned Users tab.
All users who currently have the role are displayed.

5. Click Add.
6. In the Find a User window, select the site users you want to add, and move them from the Found Users list to the
Selected Users list. Click Add.

e Note: You can search by full or partial user name or full name to find the desired site members.

7. Click OK.

The additional site administrators are now ready to act! Their names are added to the Assigned Users list.

Give project-independent access for project tools

To allow some CollabNet TeamForge users to use one or more CollabNet TeamForge tools across several projects,
create site-wide roles with specific project permissions, minus site administrative permissions. Assign these site-wide
roles to those who may need to access the project tools in any project.

.:_ Note: For example, you may want a user to be able to use Tracker across several projects. You don't need to
create and assign a role supporting the task individually across all projects. Just do it one time as a site-wide
role and assign it to the user.

Click Admin in the site navigation bar.

On the site administration navigation bar, click Roles.

Click Create.

On the Create Site-wide Role page, write a name and description for the role.

Pl ol

The role name is case-sensitive.

5. To prevent inheritance of the role into private projects, select the Prevent access option.
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.:_ Note: Selecting the option to prevent role inheritance does not affect access to public and gated projects.
On selecting Prevent access, the user may not be allowed to do project-permissions related tasks in
private projects.

6. Click Create.
The site-wide role is created. The Edit Site-wide Role Permissions page appears.

e Note: You can select the permissions for applications and resources available across all projects.

7. Select the required project permissions listed on the Role Permissions page, to match the tasks you want the user
with that role to perform.

.:_ Tip: Select "Tracker-Create" permission if you want the user to be able to create new trackers.
The role is created. You can assign it to site members at any time.

Provide ready-made roles
You might want to create roles that projects across the site can use with minimum effort and maintenance. Using

global project roles is an easy way of enforcing role-based similarities and removing role duplication across projects.

You can suggest to the project administrators to use common global project roles while assigning project tasks in
CollabNet TeamForge, instead of creating and managing several similar roles for their individual projects.

Create a global project role
To help project managers get their project members set up quickly, provide ready-made project roles that any project
on your site can use.

. Note: You need the "Role-Create" permission to create global project roles. All site administrators and some
restricted site administrators have this permission.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Roles.

3. Click the Global Project Roles tab.
All the existing Global Project Roles are listed here. It is a good idea to check this list before you create another
role.
e Note: You can suggest that the project administrators check the Project Admin > Permissions > Roles >

) View: Global Project Roles list before creating any new roles in their projects.
4. Click Create.
5. On the Create Global Project Role page, write a name and description for the role.

The role name is case-sensitive.

e Tip: Remember that the role name can not be the same as a site-wide role name.

6. To allow inheritance of the role's permissions into private sub-projects, clear the Prevent Inheritance option.
7. To allow the project members to be able to request this role, select Project members can request this role.

Project members can submit requests for Available upon Request roles. For a project, the project administrators
can set an Available upon Request role to be automatically granted to the project member requesting it.

8. Click Create.
The new global project role is created. The Edit global project role permissions page appears.

9. Select the application permissions that are relevant to the role, from those listed on the Role Permissions tab.

' Tip: You may want to restrain providing project or application administration permissions, until required.

The role is created. The project administrators can assign it to their project members any time.
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Modify a global project role
You may need to add or remove certain permissions from an existing global project role to assign new tasks or change
the access permissions given via the role.

Note: Only site administrators or restricted site administrators with "Role-Edit" permission can edit global
project roles.

[ 1

1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click Roles.
3. Click the Global Project Roles tab.

All the existing global project roles are listed here.

4. Select the role that you want to edit and click Edit or just click the hyperlinked role name.
The Edit global project role page appears.

5. Click Edit to make changes to the role details.
6. Modify the Role Name or Description, if required.
The role name is case-sensitive and must not be the same as a site-wide role.
7. Change the inheritance setting to prevent or allow inheritance of the role's permissions into private sub-projects.
8. To make the role requestable or non-requestable, change the Project members can request this role setting.

Project members can submit requests for Available upon Request roles. For a project, the project administrators
can set a Available upon Request role to be automatically granted to the project member requesting it.

9. Click Update.
The global project role is modified. The Edit global project role permissions page appears.

10. Select the application permissions that are relevant to the role, from those listed on the Role Permissions tab and
click Save.

Tip: You may want to restrain removing project or application administration permissions as the change
impacts existing users too.

[ 1

The role is modified.

Delete a global project role
If you no longer need a global project role, you should delete it.

On deleting a global project role, all the user associations in the projects are removed.

Note: Only site administrators or restricted site administrators with "Role-Delete" permission can delete
global project roles.

[ N

1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click Roles.
3. Click the Global Project Roles tab.

All the existing global project roles are listed here.

4. Select the role that you want to delete and click Delete.
A confirmation message appears.

5. Click Ok to continue with deleting the selected role.

The selected global project role is deleted and all its associations are removed.

Manage projects as a group

To manage two or more independent projects, create a project group in CollabNet TeamForge 7.1. Similar to projects,
a project group provides the platform for sharing project members, roles and permissions across a group of projects.
With some well planned settings, you can manage several of your projects and also effectively control the project
members accessing each project.

To begin controlling multiple projects at one go, create a project group.
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Create a project group
To begin managing your several projects together, create a project group in CollabNet TeamForge 7.1.

.:_ Note: When you create a project group, you are granted administration rights for the group and will be able
to perform actions such as adding or removing a project from the group. You will be listed as an administrator
in the group's Project Group Details. (Site administrators are exempt from this, since they can perform all
actions on the site without requiring specific roles).

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.
3. To create a new project group, click Create Project Group.
4. On the Create Project Group page, write a name and description for the project group.

The project group name must be unique, however, it can be the same as any of the projects.
The project group is created.
In your Project Group page, you can add projects, add project group members or specify roles for the project group.

' Tip: You can always come back to this page later to specify projects, users or roles that affect your project
group.

Edit a project group

You can make changes to a project group to keep it updated with the various projects you may be managing with
that in CollabNet TeamForge C7.1. You must have the administrator permissions for project groups to make any
modifications.

e Tip: You could be either a site administrator or a project administrator, but you must have the project groups
administration permissions to manage projects as a group.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.
3. Click the project group that you want to modify. The Project Group Details page appears.
4. Click Edit and make the changes as required.

You can update the project group name, description as well as the administrators.
5. To add one or more administrators for the project group, click the User Picker icon next to Administrators.
a) On the Find a User page, select the required administrators, click Add and click OK.

The project group administrators are listed on the Project Group Details page.
The project group is modified.

From the Project Group Details page, you can add the projects, add project group members or specify the desired
roles for the project group.

Delete a project group

If the projects being managed under a project group have achieved their targets you may not need the project group
anymore. You can delete a project group in CollabNet TeamForge C7.1. You must have the administrator permissions
for project groups.

e Tip: You could be either a site administrator or a project administrator, but you must have the project groups
administration permissions to manage projects as a group.

1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click Project Groups.
The existing project groups are listed here.
3. To delete a project group, select the project group from the list and click Delete.
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You may get a warning message as the projects being managed under the group may have active role assignments.
Click OK on the message to proceed with deleting the project group.

The project group is deleted.
' Tip: The relationship between projects and the project group is broken and you can no longer manage

projects using the deleted project group.

Add projects to a project group
You may be interested to start using the project group that brings your projects together. Add your projects to your
project group as the initial step.

e Tip: You could be either a site administrator or a project administrator, but you must have the project groups
administration permissions to manage projects as a group.

If you have just created your project group, you might already be on the Project Group Details page. Skip the first
three steps in that case.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Project Groups.
The existing project groups are listed here.

3. Click your project group. The Project Group Details page appears.

4. On the Project Group Details page, click Add to associate your projects with the project group.
A list of projects appears.

' Tip: You can only add the projects for which you are the project administrator.

5. From the Choose a project table, select the projects and click Add.
The selected projects are added to the project group.

If you add an irrelevant project to the group, you can select it from the Project Group Details page and click
Remove to remove it from the project group.

' Tip.: You can always come back to this page later to add more projects, specify users or roles that affect your
project group.

Manage user membership for a project group
Your project group needs to be set up with project group members to facilitate any administrative tasks that you may
want to do.

e Tip: You could be either a site administrator or a project administrator, but you must have the project groups
administration permissions to manage projects as a group.

If you have just created your project group, you might already be on the Project Group Details page. Skip the first
three steps in that case.
1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.

Click your project group. The Project Group Details page appears.

From the left navigation pane, click the User Membership link to add users to the project group.
On the Project Group Membership tab, click Add.

On the Add User page, find the users you want by one of these methods:

SN koW

» Under Search for Users, filter the list of site users eligible to join this project group. You can filter by full or
partial name or user name.

e Note: Search text is not case-sensitive.
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* Browse the list of registered users on the site. Sort them by name, user name, email address or membership
status.

.:_ Note: If a site has a great many users, you must filter them first to narrow down the list. This helps
avoid slowing down the system.
7. Select the users you want to add.

8. Under Assign Roles, sclect the roles you want the users to have.
You can select any available global project role or role created just for this project.

' Tip: If you prefer, you can skip this step and assign roles later on.

9. Save your changes.

» Click Save to return to the Project Group Membership page.
* Click Save and Add More to keep adding users.

The selected users are granted membership to the project group.

If you add a user who may not need to be a member of the project group, you can select the user from the Project
Group Membership page and click Remove to remove the user's membership.

Manage users' access to project groups

As a project group administrator, you know that the key to any user's access to the project group and the projects
belonging to the group, is in the role you assign to the user. You can do almost all the role-related activities with
project groups that you could do with individual projects.

You can create site-wide roles and assign the users to those roles and then bring them into your project group. You
can create roles specifically for your project group and assign users to those or use global project roles, as required.
The permissions inherited via the assigned roles are subject to the "Prevent Inheritance" option setting done while
creating the roles.

Give a role to project group members

A role can be assigned to many project group users at once.

While the user-role matrix provides a convenient way to add project group members to a role, it can become unwieldy
if the project has a large number of users or roles. When that is the case, try assigning roles to multiple project group
users at one time.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.
3. Click your project group. The Project Group Details page appears.
4. From the left navigation pane, click the Permissions link to specify user roles applicable to the project group.

5. On the Roles tab, click the Global Project Roles or Roles Created For a Project option of View, to display
existing global roles or roles created just for this project.

6. Click the name of the role that you want to assign to project group members.

7. On the Edit Role page, click the Assigned Users tab.
The Assigned Users page shows all users who currently have the role.

8. Click Add.

9. In the Find a User window, select the project group members you want to add, and move them from the Found
Users list to the Selected Users list.

* Click Add to move selected users.
e Click Add All to move all users.

.:_ Note: You can search by full or partial user name or full name to find the desired project group members.

10. Click OK.
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The project group members are now assigned the role.

Give roles to a project group member

A project group member can have any number of roles. As project group administrator, you must assign each project
group member's roles with care. The roles would impact not just an individual project, but would also grant same
permissions across the projects in a project group.

Permissions are cumulative. The project group member has all of the access permissions allowed by all of the
assigned roles, plus any permissions that may have been assigned globally using application permissions.
1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.
3. Click your project group. The Project Group Details page appears.
4. From the left navigation pane, click the Permissions link to specify user roles applicable to the project group.
5. Click the User-Role Matrix tab.
Observe the users listed on the left and all the available roles (global and direct) on the right. Users can be
assigned global roles and roles created just for this project.
6. Select roles for each project member.
7. Click Save.
The roles are now assigned to each project group member.
Assign roles in multiple projects to a user group
Project managers can assign a role to multiple users at once by assigning the role to a user group that contains all

those users. As a site administrator, you can do the same thing across multiple projects, by treating the projects as part
of a project group.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Project Groups, then click the project group you want to give a
role to.

3. On the Project Group page, click Permissions .

4. On the User Group-Role Matrix tab, add the user group you want, then select the roles you want to assign to that
user group.

5. Click Finish or Finish and Add More.
' Note: When you give a group access to a CVS or Wandisco Subversion repository, members of the group

can view the repository but cannot do repository actions, such as commit and update. You must assign
those permissions to users individually.

Assign user groups to arole
To manage permissions for a lot of groups or roles at once, try assigning user groups to roles.
1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.
3. Click your project group. The Project Group Details page appears.
4. From the left navigation pane, click the Permissions link to specify user roles applicable to the project group.

5. On the Roles tab, to display existing global or direct roles, click the global project roles or Direct Roles option
of View.
You can assign the project group users or user groups to a global project role or a role created just for this project.
6. Click the name of the role that you want to assign to the user group members in the project group.
7. On the Edit Role page, click the Assigned User Groups tab.
The Assigned User Groups table shows all user groups who currently have the role.

8. Click Add.
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9. Type some of the group’s name in the Name (search) box and click Find.
10. From the Add User Group to Role table, select the user groups that you want to add, and click Finish.
' Note: When you give a group access to a CVS or Wandisco Subversion repository, members of the group

can view the repository but cannot do repository actions, such as commit and update. You must assign
those permissions to users individually.

The user groups are now assigned the role.

Create arolein a project group

A role defines the applications that project group members with that role can use, and the specific things project group
members can do in each application.

Any project groups administrator can create and assign a role. It is a good idea to check the existing global project
roles before creating any new role for a project group.

e Note: Any existing site-wide or global project role can be associated with a project group. It is advisable to
check the permissions granted via a role before assigning it to users or user groups in a project group as it
would impact more than a single project.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.
3. Click your project group. The Project Group Details page appears.
4. From the left navigation pane, click the Permissions link to specify user roles applicable to the project group.
5. On the Roles tab, click View: Roles Created For this Project Group.
You can view global project roles by selecting View: Global Project Roles before creating a new role for this
project.
6. Click Create.
7. On the Create Role page, write a name and description for the role.
8. To allow the inheritance of the role into private subprojects, de-select the Prevent Inheritance option.

.:_ Note: By default, the role inheritance into private subprojects is prevented. For example, you may not
want administrator roles to be inherited in subprojects, until required.

' Note: Seclecting the option to prevent role inheritance does not affect public and gated projects.

9. Click Create.
The role is created. The Edit Role page appears.

10. For each application listed on the Role Permissions page, select the permissions and resources you want to make
available to users with this role.

.:_ Note: You can specify access to individual top-level folders, but not to specific subfolders.

11. Click Save.

The role is created. You can assign it to project group members or user groups associated with the project group at
any time.

Edit arole in a project group

As a project group administrator, you may need to update the permissions granted by a role being used across the
projects.

While modifying a role, it is better to be cautious about granting more access than required by the users or a user
group. In the case of project groups, as a role could be mapped across projects, consider being restrictive.

1. Click Admin in the site navigation bar.

2. Click your project group. The Project Group Details page appears.

3. From the left navigation pane, click the Permissions link to specify user roles applicable to the project group.

4. On the Roles tab, click View: Roles Created For a Project. The existing roles created for this project are listed.
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You can view global project roles by selecting View: Global Project Roles, if required.
5. Select the role that you want to modify and click Edit.
6. On the Edit Role page, make the desired changes.

You can update the role name, description and inheritance settings on clicking Edit.

The role's permissions, assigned users or assigned user groups can also be modified as required.
7. Click Save after making the changes.
The role in the project group is updated.

Delete arole in a project group
When you no longer need a role that you created for a project, it's a good idea to delete that role.

Any project groups administrator can create and assign a role. It is good to keep the project role tray as small and as
manageable as possible.

e Note: Any existing site-wide or global project role can be associated with a project group. It is advisable to
check the permissions granted via a role before assigning it to users or user groups in a project group as it
would impact more than a single project.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Project Groups.

The existing project groups are listed here.

3. Click your project group. The Project Group Details page appears.

4. From the left navigation pane, click the Permissions link to specify user roles applicable to the project group.

5. On the Roles tab, click View: Roles Created For a Project.
You can view global project roles by selecting View: Global Project Roles. However, you can only delete roles
created for this project here.

6. Select the role and click Delete.

You may get a warning message if the role you are trying to delete is in use. Click OK to proceed with deleting
the non-required role.

The selected role is deleted.

Manage users
You can help projects succeed by creating and managing user accounts.

Communicate with all site users at once
To say something to everyone who uses your site, post a site-wide broadcast message.

For example, if you plan to upgrade your site, you may want to let users know a few days before your upgrade that
the site will be unavailable for a short time.

The broadcast message can be viewed even without logging into CollabNet

1. Click Admin in the site navigation bar.
2. Click System Tools on the site administration toolbar.
3. Click Broadcast Message.

4. In the Broadcast Message field, type the message you want to broadcast and click Broadcast.

The message is displayed on all the pages of the site until it is deleted or replaced.
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Create a new user account
To participate in a CollabNet TeamForge site, a person must have a user account on that site. CollabNet TeamForge
administrators can create these user accounts. This topic applies to sites with no LDAP authentication.

.:-_ Note: If your CollabNet TeamForge installation authenticates against an LDAP directory, CollabNet
TeamForge administrators cannot create new user accounts. On a site with LDAP authentication, each user
must log into CollabNet TeamForge using his or her LDAP user name and password.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Users.

3. Click the drop-down arrow next to Create and click Single User.

You can select Multiple Users to create several user accounts at one time.

4. On the Create User page, enter a user name for the user.

e Note: Your user name must meet these criteria:

» User name is case sensitive.

¢ Minimum number of characters as specified in the site-options.conf file.
* No spaces.

* Should have at least one letter.

* The first character is a letter.

5. Enter and confirm a password for the user, if you prefer to set the user's password yourself.
e Tip: To invite users to create their own password, leave the Password field blank. A password ticket
email will be sent to users to let them create a password.

6. Enter the user's full name and email address.

.:-_ Tip: You can add more email addresses for the user after you finish creating their profile.

7. Enter the user's organization.
Organization can be a geographic designation, a corporate division, or whatever you want. It's advised to keep it
consistent across your site.

8. Choose a user type.

* CollabNet TeamForge administrator - Administrators have unlimited access to all data in CollabNet
TeamForge.

* Restricted user - Restricted users can only access projects of which they are members.

You can choose only one user type for each user.

e Note: If you do not select Restricted user, the user will be unrestricted. Unrestricted users can access all
projects that have not been made private by a project administrator.

9. To send a welcome message to the user, select Send Welcome Message.
10. Click Create.

The user account is created.

Create multiple user accounts
To participate in a CollabNet TeamForge site, a person must have a user account on that site. CollabNet TeamForge
administrators can provide access to multiple users by creating their accounts together.

.:-_ Note: If your CollabNet TeamForge installation authenticates against an LDAP directory, CollabNet
TeamForge administrators cannot create new user accounts. On a site with LDAP authentication, each user
must log into CollabNet TeamForge using his or her LDAP user name and password.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Users.

3. Click the drop-down arrow next to Create and click Multiple Users.
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4. On the Create Multiple Users page, enter up to 25 lines like this, one user per line:
username username@yourdomain.org name organization Restricted
e Note: Usernames must meet these criteria:
* 1to 31 characters.
*  Only alphanumeric characters.
* No spaces.

e At least one letter.
» The first character is a letter.

' Tip:
* Organization field is optional.
* To create an unrestricted user, omit "Restricted." Restricted users can only access projects of which

they are members, while unrestricted users can access all projects that have not been made private by a
project administrator.

* Use quotes around the full name or the organization information if it is more than a single word.
* A maximum of twenty-five user accounts can be created at one time.
5. Click Create.

The user accounts are created and password e-mails are sent to all the new users.

Create a user group
To manage multiple users at once, create a group that represents them.
1. Click Project Admin in the project navigation bar.
2. On the Site Administration page, click User Groups.
e Note: In TeamForge 7.1, Groups (in earlier versions of the product) has been renamed to User Groups
to better distinguish user groups from project groups.
3. Click Create and provide a name for the group and a description of its purpose.
' Note: If your project is a child of another project, it may have inherited one or more user groups from its

parent project. To work with inherited users and user groups, you must go to the project that they belong
to.

4. Click Create.

Add a user to a user group

Put together multiple users who share characteristics in a user group.

1. Click Project Admin in the project navigation bar.

2. On the Site Administration page, click User Groups.
Note: In TeamForge 7.1, Groups (in earlier versions of the product) has been renamed to User Groups
to better distinguish user groups from project groups.

3. Under User Groups, click the group to which you want to add the user.

4. On the Edit Group page, clickAdd.

5. Use the picker to move users into the group, and click OK.

You can select the inherited project members also from the list.
6. Click Return.

Find a user
To find a user, filter the list all CollabNet TeamForge users on your site.

1. Click Admin in the site navigation bar.
2. Click Users in the Site Administration toolbar.
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o Note:

*  You can find a filter field at the top of each column in most of the tables in the TeamForge application.
* The filter field could be a text box or a drop-down list.
*  You can type your filter criteria in the text boxes. The search text is case-insensitive.

*  You can also select the filter values from one or more drop-down lists. By default, you can only select
up to five filter values in a drop-down list. However, you can set a value that suits your requirement for
the FILTER DROPDOWN MAX SELECTION token in the site-options.conf file to increase
or decrease the count.

» Some search filters may not appear if your site administrator has not enabled them.
Specify the filter criteria in one or more filter fields (at the top of each column) and click Filter.

Table filter drop-down list with multi-select check boxes

Stories (11 Iltems)

O Prigri

Artifact

art
art
art
art
art

art

After filtering, if you want to clear the filters, click Filter and select Clear from the drop-down list.

All users meeting your filter criteria are displayed.

Find a user's groups
You can get a consolidated view of all user groups of which a user is a member.

1.
2.

Click Admin in the site navigation bar.
On the Users page, click the User Group Membership tab.

The groups listed on this tab are the groups that this user is a member of.

Edit a user account
When a user has trouble accessing the site, you may need to reset the user's password or change the user's account
status.

[

Nk W=

Note: If your CollabNet TeamForge site uses LDAP for single-sign-on, passwords must be reset in the
LDAP system, not on the Web administration pages. Ask your system administrator for help.

Important: To avoid disasters, TeamForge makes it impossible to delete or deactivate the TeamForge admin
account. You also can't remove the TeamForge admin flag or mark the admin user as a restricted user.

Click Admin in the site navigation bar.

On the site administration navigation bar, click Users.

On the All Users list, click the name of the user whose account you want to edit.

On the User Details page, click Edit.

On the Edit User Information page, make your changes and click Update.

You can specify upto a maximum of three alternate email addresses, if required.
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Act on multiple user accounts at once
A CollabNet TeamForge administrator can edit the status of multiple user accounts simultaneously.

For example, if you have multiple pending new accounts to approve, you can approve them in a batch instead of
individually editing each account.

.:-_ Note: A pending user is a user who has requested an account but has not yet confirmed his or her email
addresses.
.:-_ Important: In the case of CollabNet TeamForge admin accounts, you cannot make any of these edits:

* Delete the account.
» Change the account status to anything but active.
* Remove the CollabNet TeamForge admin flag.
* Mark it as a restricted user.
Click Admin in the site navigation bar.
On the site administration navigation bar, click Users.

On the Users page, sclect the users whose status you want to edit.

o M.

Click the desired status change.
* Delete - Deleted users are removed from all projects. All assigned items are removed from the user. Deleted

users do not count against your CollabNet TeamForge license count.

* Deactivate - Deactivated users cannot log in to CollabNet TeamForge and do not receive notification
messages, but they remain members of projects and selection lists.

* Activate - Active users have full use of CollabNet TeamForge , subject to RBAC permissions.

Reset the admin account password
If your CollabNet TeamForge installation authenticates against an LDAP directory, follow these instructions to reset
your admin account password.

If your installation does not validate against LDAP, click Forgot Your Password on the CollabNet TeamForge home
page to reset the password for the admin account.
1. With a web browser, go to the URL http://<host>sf/sfmain/do/forgotAdminPassword.

2. On the Admin Account Password Retrieval page, Click Send Email.
CollabNet TeamForge sends an email to the address specified for the admin user.

3. Check your email and click the link provided to reset your password.
4. On the Reset Password page, enter and confirm a new password.
5. Click Reset Password.

You can now log into CollabNet TeamForge with your new password.

Add ALM functionality to your site
If you started using TeamForge as a source code management application, you can expand it to support the full range
of application lifecycle management functions.

Your license key allows for some number of users with ALM licenses and some number of users with SCM licenses.
(What's the difference?) To convert your site to ALM mode, one or more ALM user licenses must be included in your
license key and not assigned to any user.

» Ifyoudon't already have a license to use TeamForge in ALM mode, talk to your CollabNet representative about
getting one.

* To apply your ALM site license, see Supply your TeamForge license key from Teamforge user interface.

1. Click Admin in the site navigation bar.

2. Click License Key in the Site Administration toolbar.

3. Click the Change Site Mode to drop-down list and select ALM.
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Your site's users can now see and use the full range of applications on your site, including Tracker, Documents,
Tasks, and Reports.

Note: When your site is in ALM mode, any users you create get ALM licenses by default until all the
available ALM licenses are used.

[

Restrict your site to source code functionality
TeamForge suppports the full range of application lifecyle management functions, but you can also use it for only the
core source code management (SCM) functions.

Note: Your site may have been switched to SCM mode due to a license issue. (Why?) If this is the case, see
Add ALM functionality to your site on page 163 to fix it.

1. Click Admin in the site navigation bar.

2. Click License Key in the Site Administration toolbar.

3. Click Change Site Mode to SCM.

Your site's users can now see and access only the Source Code, Discussions, and Wiki tools in the toolbar.

.:-_ Note: When your site is in SCM mode, each user you create gets an SCM license by default.

View all roles assigned to a user
A user can have multiple roles in different projects either by being directly assigned those roles or by inheriting them.
You might find it useful to see all the roles assigned to a user in a TeamForge site before adding or removing a role.

1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click Users.
3. In the Roles tab, select a role type in the View drop-down - Directly Assigned Roles, Roles Inherited From Parent
Project or Site-wide Roles.
* Roles created for this project include the roles the user is directly assigned or assigned through a user group in
projects and project groups.
* Inherited roles include the roles the user inherits from parent projects and project groups.

Support projects

CollabNet TeamForge administrators can do a variety of things to help projects on the site be successful.

Create a new project
CollabNet TeamForge administrators can create new projects without having to submit them for approval.

Note: When a CollabNet TeamForge administrator creates a new project, he or she is not made a member of
the project, and the Founder Project Admin role is not created. To designate a project administrator, you must
add the user to the project, then create and assign a project administrator role manually.

[

Click Admin in the site navigation bar.
On the site administration navigation bar, click Projects.
In the list of CollabNet TeamForge projects, click Create.

S

On the Create Project page, provide a name for the project.
This is the name that will appear in all project lists and on the project home page.

5. Enter a URL name for the project, if appropriate.
This is the name that will appear in the project's URL.

6. Write a description of the project.
7. Select a project template.

A project template is used to pre-populate new projects with the structure and configuration of an existing project.
If you do not want to use a project template, choose None.
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.:_ Note: If you create a project from a template that contains an integrated application, you may have to
provide some information specific to the integrated application. For example, for Project Tracker you must
set a new artifact prefix that is different from the prefix in the template.

8. Click Create.

The project is created.

Approve a new project
Any registered CollabNet TeamForge user can request a new project. A new project is activated only after a site
administrator approves it.

Before approving a new project, you have the option to review the project details.

1. Click Admin in the site navigation bar.

L

On the site administration navigation bar, click Projects.
Click the Pending Projects tab.

On the Pending Projects page, select the projects you want to approve.

W

» Click Approve to approve the project and move it to the All Projects page with status Active.
* Click Reject to reject the project and remove it from the list.

The project requester receives an email notification when the project is approved or rejected. If you entered a
comment, that also appears in the email notification.

Rename a project
As the focus of a project shifts, its name or description can become obsolete. A site administrator can update the name
or description to help keep the project current.

Click Admin in the site navigation bar.

Click Projects.

In the CollabNet TeamForge project list, click the project you want to edit.
On the project home page, click Project Admin.

On the Project Settings page, make the changes you need.

Click Save.

U o

Delete a project
If you no longer need a project or any of the data in it, you should delete it.

Deleting a project deletes all of the data within it, with the exception of source code data, which is maintained
separately from the rest of the site's content.

A Caution: Delete a project only if you are sure that you no longer need any of the data within it. Move any
~ items that you want to save.
' Note:

*  You can delete a parent project only when its members, user groups and roles are not in use in any other
project.
*  When you delete a parent project, the direct subprojects are moved one level up; that is, under the
immediate parent of the deleted project.
» Ifthe deleted project has no parent, its subprojects become root-level projects.
1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click Projects.
3. From the CollabNet TeamForge project list, choose the project that you want to delete and click Delete.

The project is deleted.
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Delete a project
If you no longer need a project or any of the data in it, you should delete it.

Deleting a project deletes all of the data within it, with the exception of source code data, which is maintained
separately from the rest of the site's content.

A Caution: Delete a project only if you are sure that you no longer need any of the data within it. Move any
items that you want to save.

Note:
*  You can delete a parent project only when its members, user groups and roles are not in use in any other
project.

*  When you delete a parent project, the direct subprojects are moved one level up; that is, under the
immediate parent of the deleted project.

+ If the deleted project has no parent, its subprojects become root-level projects.
1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click Projects.
3. From the CollabNet TeamForge project list, choose the project that you want to delete and click Delete.

The project is deleted.

Lock or unlock a project
To ensure that no changes occur in a project while you are collating or migrating project data, lock the project. You
must have project administration permissions or be a site administrator to lock or unlock a project.

To lock or unlock a project in CollabNet TeamForge, go to Project Settings and lock/unlock the project.

.:-_ Note: A locked project does not allow any member (including project administrators and site administrators)
to make any changes to the project. Besides that, a locked project can not be set as the parent project for any
other project and tasks like adding, editing or deleting integrated applications are also not allowed.

Click Project Admin in the project navigation bar.

The project is locked or unlocked as desired. The lock icon 5 Locked appears on all the project pages while the
project is locked.

. Note: If a locked project has an integrated application, for example, project tracker, all the project tracker
pages are also non-editable while the project is locked. The user who has access permissions for the integrated
application can only view the pages.

Update a project template
To revise or correct an existing project template, overwrite it with a template of the same name.

You must be a site administrator to overwrite an existing project template.

1. Revise the project that will serve as the basis for the new project template.

.:-_ Tip: You can disable a project template while you make changes to the project. To disable a project
template, use the My Workspace > Projects > Templates page.

Click Project Admin in the project navigation bar.

On the Project Settings page, click Create Project Template.

On the Create Template page, select Replace Existing Template and choose the template you want to overwrite.

A I

Provide the description for the template.

(If you want to change the template name too, create a new template from the same project and disable the
existing template.)

e Tip: It's a good idea to use the description to note the changes from the previous version of the template.

6. Select the items you want to be available when new projects are created from this template.
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The replacement project template is created. Its name and description appear on the Template tab of the Projects list,
accessible from your personal navigation bar.

Enable or disable project templates
Site administrators or users with site-wide roles with the project administration permissions only can enable/disable
project templates.

In CollabNet TeamForge, enable a project template to make it available for use while creating new projects.

1. Click My Workspace in the TeamForge toolbar.
2. On the My Workspace page, click Projects and select the Templates tab.
3. To make the project template available for use, select the template and click Enable.

4. To stop making the project template available for use, click Disable.

When projects are created afresh, only the enabled project templates are displayed.

Require documents to be associated with artifacts
To help reduce the problem of "orphan" documents, require users who create a document anywhere on the site to
associate the document with an artifact.

"Orphan" documents are documents that are abandoned because they are not connected to any tracked activity.

Open the conf/site-options.conf file in a text editor.
Change the value of the sf.requireAssociationOnDocumentCreate variable to true

Change the value of the sf.allowedAssociationTypeOnDocumentCreate variable to [ TrackerArtifact]

Pl A

If you want to prevent users from associating documents with closed artifacts, change the value of the
sf.requireArtifactToBeOpenOnDocumentAssociation variable to true

ol

Save conf/site-options.conf.

6. Recreate the runtime environment.

./install.sh -V -r -d /opt/collabnet/teamforge

Manage project categories

To help users navigate your site, help them sort projects into categories that make sense.

Add a project category

When you set up project categories for your site, project administrators can use this taxonomy to organize their
projects.

You can create any number of top-level categories and any number of sub-category levels.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Categories.

3. In the Project Categories tree, find the location where you want to create the new category.
» Highlighting Project Categories creates a new top-level category.
» Highlighting any category creates a sub-category beneath it.

4. Click New.

5. In the Create Category window, write a name and description for the category.

6. Click Save.

The category is created. It appears in the Project Categories navigation tree, and is available for use by all project

administrators when categorizing their projects.

Edit a project category

A project category's membership and function may change over time. If it does, you can update the category's name
or description.

1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click Categories.
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The Project Categories tree displays the hierarchy of existing categories.
3. In the Project Categories tree, find the category that you want to edit.
4. Make the changes you need and click Update.

Move a project category
You can reorganize projects by moving a project category to another place in the project category hierarchy.

You can move a project category in the following ways:

* From a top-level category to a sub-category
* From a sub-category to a top-level category
* From a sub-category to another sub-category

When you move a project category, any sub-categories that it contains are also moved to the destination category.
1. Click Admin in the site navigation bar.

On the site administration navigation bar, click Categories.

On the Project Categories page, find the project category you want to move.

On the Edit menu, click Cut.

Find the location to which you want to move the selected project category.

AN ol o

You can move a project category either to the root category or into any other project category.
6. Choose the Paste option from the Edit menu.
The project category is now moved to the selected destination.

Delete a project category
If you no longer need a project category, you should delete it.

When you delete a project category, all of its sub-categories are also deleted.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Categories.
The Project Categories tree displays the hierarchy of existing categories.

3. Using the document tree, find the project category that you want to delete.
4. Choose Delete from the Edit menu.

The project category and all of its sub-categories are deleted.
Stop using project categories
If you do not need to sort projects into categories, remove the ability to do so on your site.

By default, project categorization is disabled for new CollabNet TeamForge installations.

' Note: Disabling project categorization does not delete categories you have already set up.

1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click Categories.

3. On the Project Categories page, select Disabled and click Update.

Project categorization is disabled for your CollabNet TeamForge installation.

Add a parent project to your project
You can coordinate work among multiple projects; enable the user, user group and role inheritance by adding a
common parent project to several projects.

' Note: A subproject can have only one parent. You can change or remove that parent at any time.
.:-_ Note: You must be a project administrator or site administrator to add/edit or remove the parent projects.

1. Click Project Admin in the project navigation bar.
2. On the Project Settings page, click Edit Parent.
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3. Click Add Parent.
4. On the Choose New Parent page, choose a parent project that it makes sense for your project to belong to, and
click Confirm.

' Note: You cannot add a parent project for the 'Look' project as it is a special project in itself.

Separate a subproject from its parent project
When a subproject grows beyond its original scope, you may want to make it stand-alone project or move it to a
different project hierarchy.

By removing the association with a parent project, you can manage the subproject as a separate project.

e Note: Only one parent project can be selected for a subproject. However, the parent project can be changed
or removed, as required.

1. Click Project Admin in the project navigation bar.
2. On the Project Settings page, click Edit Parent.
3. Change or remove the parent project as required.
You can be a project administrator or a site administrator to change or remove a parent project. As a project

administrator, you can remove or change a parent project only if you have administrator permissions for both the
projects that are being linked.

.:_ Note: A parent project can be removed or changed only when its members, user groups and roles are not
in use in any other project. In other words, you can not remove/change a parent project while its members,
user groups or roles are in use in any other project.

* + Click Change Parent to choose another parent project.
* On the Choose a Parent Project page, select the desired parent project and click Confirm.

' Note: If the project hierarchy exists, the project and its subprojects are moved only under the project
from which members, user groups or roles are inherited. If project hierarchy does not exist and no
inheritance is in use, the project is made a 'Root' project.

* « Click Remove Parent to remove the association with parent project.
*  On the pop-up message box, click OK, if you wish to make the project a 'Root' project.

The project hierarchy is changed or removed in accordance with role based access control and inheritance rules.

Provide source control services

You can add a source control server to the CollabNet TeamForge environment at any time after CollabNet TeamForge
installation is complete.

Integrate a source code server
A site must have one or more servers to handle source code repositories and users. The source code server can be the
same machine as the application server or a separate machine.

When you set up a managed software configuration management (SCM) server, you enable users to create, manage
and share repositories through CollabNet

Note: The ability to add integration servers depends on the value of the
DISABLE CREATE INTEGRATION_SERVERS flag in the site-options.conf file. You can add
new integration servers when the flag is set to its default value of "false".

TeamForge.

You can integrate more than one source code server of a given type. For example, you can have two or more
Subversion servers on your site. Consult a system administrator about the requirements for setting this up.

e Tip: If you use a source code solution other than Subversion, CVS, or Perforce, you can integrate it using the
CollabNet TeamForge SOAP APIs. This enables you to exchange commit data with any SCM application.
Consult your CollabNet TeamForge system administrator.
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.:-_ Note: CVS servers that integrate with CollabNet TeamForge must use the native UNIX/Linux authentication
method, and not external authentication mechanisms such as NIS, NIS+, Winbind, Active Directory, or
LDAP. TeamForge creates and manipulates local system accounts using the default useradd, usermod,
groupadd, groupdel, and userdel commands. It expects to find any accounts or groups it created in /
etc/passwdand /etc/group.

Click Admin in the site navigation bar.

Click Integrations.

On the SCM Integrations page, click Create.

On the Create Integration page, write a name and description for the integration.

A o

Choose the type of SCM server you want.

.:-_ Note: When you give a group access to a CVS or Wandisco Subversion repository, members of the group
can view the repository but cannot do repository actions, such as commit and update. You must assign
those permissions to users individually.

.:-_ Note: The SCM Adapter option only works if you have created your own SCM integration using the
CollabNet TeamForge SOAP APIs.
6. Supply the host name for the Soap Service Host.
This is the network address of the machine on which the integrated service, such as Subversion, is running.
Note: The default 1ocalhost will work only if the integration server is on the same server as the
CollabNet TeamForge server.
7. Leave the default values in the SOAP Service Port field.

8. Specify whether users will use SSL to connect to their repositories.

9. Change the Repository Root value if you want to store the repository on your server in a different location.
The repository root is the top-level directory under which all source code repositories reside.

10. Select Requires Approval if an administrator must approve all repositories created on the server. By default,
unmanaged servers require approval for all repositories, because repositories must be created and integrated
manually.

11. For a Subversion or CVS server, supply the URL by which your users will access the service.

This will be of the form http://<myscmserver.com>/integration/viewvc/viewvc.cgi

.:-_ Important: If your system administrator has upgraded your site from SourceForge Enterprise Edition 4.4
or earlier, remove the port number in the SCM Viewer URL.
.:-_ Tip: If you are working with a CVS server that uses Pserver authentication, ask your system
administrator for the right URL.
12. Click Save.

CollabNet TeamForge attempts to validate the SCM viewer URL. If it cannot validate the URL, you can:

* Correct it if you have entered it incorrectly.

» Select Save with errors if the URL is different for an end user than it is for the CollabNet TeamForge server;
for example, if you have a firewall in place.

» Ifyou are adding a managed source code server, it is now added. All projects can now establish repositories on the
server.

+ Ifyou are adding an unmanaged CVS server, all projects can now request repositories on the server. A CollabNet
TeamForge administrator must create and integrate them manually.

.:-_ Note: Only CVS servers can run unmanaged.
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Approve a source control repository request
When a user requests a source code repository on a source control server for which you have required approval, a
CollabNet TeamForge administrator must approve the request before the repository is created.

When adding a source control server integration, you have the option to require CollabNet TeamForge administrator
approval for all repositories created on the server.

When a user requests a source code repository on a managed SCM server, the repository is created automatically after
it is approved by a CollabNet TeamForge administrator.

Note: Before approving a source code repository request for an unmanaged SCM server, a CollabNet
TeamForge administrator must create and integrate the repository manually.

[

1. Click Admin in the CollabNet TeamForge navigation bar.
2. On the site administration navigation bar, click Integrations.
3. On the SCM Integrations page, click the Pending SCM Integrations tab.

Note: Non-site administrators can now access the SCM Integrations tab if they have permission to
manage SCM integrations.

i
4. From the list of pending SCM repository requests, select the SCM repositories that you want to approve.

* Click Approve to approve the repository.
» Click Reject to reject the project and remove it from the list.

The person who requested the repository receives an email notification when the repository is approved or rejected. If
you entered a comment, that also appears in the email notification.

Approve an unmanaged CVS server access request
When a user asks for access to an unmanaged CVS server, an administrator must approve or reject the request.

When a project administrator assigns a role that provides SCM access to a project member, a CollabNet TeamForge
administrator must manually create the user account on the SCM server. Because user creation is not managed by
CollabNet TeamForge , CollabNet cannot verify that the user account has been created. A TeamForge administrator
must confirm that he or she has created the account.

Requests for SCM access removal are also submitted for manual confirmation by a TeamForge administrator.
Click Admin in the site navigation bar.

On the site administration navigation bar, click Integrations.

On the SCM Integrations page, click the SCM Access Requests tab.

Create the requested user account on the unmanaged CVS server.

Nk

After the user account is created, select the request and click Approve.

The user receives an email notification that the user account has been created.

Edit SCM integration details
You can move or reconfigure a source control server without having to reintegrate the server into CollabNet
TeamForge .

Tip: If you edit or lose the permissions on your SCM server, use the Synchronize Permissions button on the
SCM Integrations page to recreate the correct permissions on your SCM server from CollabNet TeamForge .

[

Click Admin in the CollabNet TeamForge navigation bar.
On the site administration navigation bar, click Integrations.

On the SCM Integrations page, click the title of the SCM integration you want to edit.

Cal ol

On the Edit Integration page, make the changes you need and click Save.
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Move a source code repository
When the existing code base for an application may need to be managed by a different team or project, you can move
the source code repository from the first project into the other one.

e Note: You can move only Subversion repositories this way.

Open the project from which you want to move a source code repository.
Click Source Code in the project navigation bar.

Select the repository you want to move and click Cut.

Open the project into which you want to move the repository.

Click Source Code in the project navigation bar.

Click Paste.

A e o

Connect to a Subversion Edge console
When a Subversion Edge server has been converted to a SCM Integration server in TeamForge, you can log into its
management console from within TeamForge.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Integrations.

3. In the list of servers on the SCM Integrations page, click the Open Console link for the Subversion Edge server
you want to connect to.

' Note: Only Subversion Edge servers have this link.

The login page for the server's management console appears. You can log in using your TeamForge administrator
credentials and view statistics such as network throughput and disk space usage for the server.

Discover a Subversion Edge server
Subversion Edge (version 1.1 and higher) servers register their service on your local network using the DNS-Service
Discovery protocol. TeamForge administrators can see them.

Subversion Edge servers that were converted to TeamForge servers are displayed in the SCM Integrations page.

1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click Integrations.

3. On the SCM Integrations page, click Discover Subversion Edge Servers.

A Java applet is launched, and you will see a list of Subversion Edge servers in your LAN.
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COLLABNET TeamForge.

Site Administration
Y o 73 | . =
Projects Users Groups Integrations Categories

Discover Subversion Edge Servers

CollabNet Subversion servers register their service on your network using the DNS
can only discover services running on the same TCP/IP subnet. Although with the ¢

http://127.0.1.1: 8080/csvn
http://10.1.6.53:3343/csvn
http://10.1.6.222:3343/csvn
http://10.1.7.73:8080/csvn
http://10.1.6.41:3343/csvn

Current Domain: ) http://cul87.cubit.sp.collab.net: 808

Having problems viewing the applet? Try Java WebStart

[ % Launch |

You can click on a server to connect to it. To bring in the power and capabilities of TeamForge, you can convert
the Subversion Edge server to a managed SCM integration server in TeamForge.

Note: The number of commits made in a Subversion Edge Server can be tracked through reports. The
commits made after integrating with TeamForge are available for reporting.

[i_"':—

Manage replicas
A replica server in TeamForge is a Subversion Edge server that replicates the content of an existing core SCM

integration server.

Approve areplica server request
When there is a request for a replica of a core SCM integration server, a TeamForge administrator must approve the

request before the replica is created.

Replica requests from a TeamForge admin user or site administrator are automatically approved. Replicas requested
by other users need approval by a TeamForge administrator.

1. Click Admin in the CollabNet TeamForge navigation bar.
2. On the site administration navigation bar, click Integrations.


http://help.collab.net/topic/csvn/action/convertcsvntotf.html
http://help.collab.net/topic/csvn/action/convertcsvntotf.html
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3. On the SCM Integrations page, click the Pending SCM Replicas tab.
4. From the list of pending SCM replica requests, select the SCM replicas that you want to approve.

* Click Approve to approve the replica.
* Click Reject to reject the replica and remove it from the list.

When a replica is approved, it is listed in the SCM Integrations page beneath the master SVN server.

Edit replica settings

As a TeamForge site administrator, you can configure replica settings for the polling frequency of the master, and
repository initialization and synchronization events.

Replication events, such as creating new repositories and synching commits, are stored in a queue on the TeamForge
application server. The replica server polls the TeamForge application server for new events and then processes those
events on the replica server.

These events are divided into two separate pools:

» New repository initializations - this includes creating the repository and performing the initial synchronization of
the content.
» All other events

When existing repositories are selected for replication, this can take a long time. It could take many hours or even
days to fully replicate an entire repository across a WAN. These big events are processed in their own thread pool, so
that other repositories which are already synchronized don't have to wait in line for them to finish.

For each pool, you can define how many simultaneous events will be processed. The higher the number, the greater
the potential load on both the TeamForge replica server and the Subversion master. However, this can also decrease
the wait time for a given commit to appear on the replica server.

1. Click Admin in the CollabNet TeamForge navigation bar.

2. On the site administration navigation bar, click Integrations.

3. On the SCM Integrations page, click the name of the Subversion Edge replica you want to edit.

The Edit System page for the replica appears. Here's an example:



8.
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Subversion Edge Replica

Mame; = London|
Description:* a . N Command polling interval:*
escription:
P pEs Tl T L LT Maximum simultaneous new repository initializatio
Maximum simultaneous repository synchronizatior
Hostname: cul35.doud.sp.collab.net

Master Integration Server: Subwversion

Managed By: Subversion Replication (svnedge)
Approval Status; Approved
Last Contact: Wed Mar 23 15:13:28 PDT 2011

Recent Replication Command History

Status Replica Command Repository Revision Created Date
-.J SYNC repo reps1004: i18n 8 Wed Mar 23 12:29:25P0T
Q Start replicating repo reps1005: Docs S Wed Mar 23 12:16:36 POT
', Startreplicating repo reps1004: i18n = Wed Mar 23 12:07:43 POT
() Update server properties - - Wed Mar 23 12:07:26 POT

Ranlirs carvar rem eet anmrmeed _ _ -

Change the replica name or description if required.

' Tip: Including the geographic location would help users select a nearby replica.

Set Command polling interval to define how frequently the replica polls the master looking for new events. The
replica will process all new events when it polls.

The default value for this setting is 60 seconds, but it can range from 5 to 1000000 seconds.
Set Maximum simultaneous new repository creations to a low value.

New repository initializations can take a long time and generate a lot of load. So you wouldn't want to allow too
many of them to run at once. This value can range from 1 to 100, but we suggest you keep it at 3 or less.

Set Maximum simultaneous repository synchronizations taking into account how many repositories you will be
replicating and how many you think are likely to have commits occurring within the polling interval.

This value can range from 1 to 100. You may want to set this higher than the previous field, but we suggest you
keep it at 10 or less. There's no reason to enter too high a number because you are merely specifying how many
synchs can run at the exact same time -- and it never runs more than one per repository.

When you've made your changes, click Save.

Remove areplica
When you remove a replica from TeamForge, it is restored to a Subversion Edge server in standalone mode.

1.
2.
3.

Click Admin in the CollabNet TeamForge navigation bar.
On the site administration navigation bar, click Integrations.
In the Edit System page for the replica, click Delete.

The replica is removed from TeamForge. The repositories that existed on the replica are deleted.
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Integrate an unmanaged CVS repository with CollabNet TeamForge
After creating the repository, you must modify two triggers, verifymsg and loginfo, to complete the integration
with CollabNet TeamForge .

The triggers must be modified manually, because much of the information in the triggers is specific to your CollabNet
TeamForge installation.

Each trigger must be modified to run a . java program. These topics provide an annotated example and instructions
on modifying and installing the trigger files.

' Note: You must create the CVS repository before you can modify and install the trigger files.

Note: CVS servers that integrate with CollabNet TeamForge must use the native UNIX/Linux authentication
method, and not external authentication mechanisms such as NIS, NIS+, Winbind, Active Directory, or
LDAP. TeamForge creates and manipulates local system accounts using the default useradd, usermod,
groupadd, groupdel, and userdel commands. It expects to find any accounts or groups it created in /
etc/passwdand /etc/group.

Create a loginfo trigger file
Here's now to create the loginfo trigger file.

1. Check out the module CVSROOT from the CVS repository.

The CVSROOT module is automatically created in all new CVS repositories, and contains the verifymsg and
loginfo files. When created, the files contain only comments.

2. Begin modifying the file by inserting ALL followed by a tab.
This enables CollabNet TeamForge to see all modules in the repository.

3. Modify the path to your Java home directory as in this example and add it to the file, followed by a single space.

Example Modification
/usr/local/java/j2sdkl.4.1 01/bin/ Replace /usr/local/java/j2sdkl.4.1 01/
java -cp with the directory in which you have installed Java.

4. Modify the paths to the . jar files as shown here, then add them to the file separated by colons.

Examples Modifications
/yourdirectory/sourceforge home/ Replace /yourdirectory/ with the directory in
lib/saaj.jar /yourdirectory/ which you have installed CollabNet TeamForge .

sourceforge home/lib/axis-1.1lrcl-
va.jar /yourdirectory/

sourceforge home/lib/

saturn.jar /yourdirectory/
sourceforge home/lib/jaxrpc.jar /
yourdirectory/sourceforge home/
lib/externalintegration.jar /
yourdirectory/sourceforge home/
lib/commons-discovery.jar /
yourdirectory/sourceforge home/lib/
commons-logging.jar /yourdirectory/
sourceforge home/lib/log4j-1.2.8.jar

5. Modify the parameters as follows:

Example Modification

-Dintegration.name=exsy 1001 Replace exsy1001 with the ID of your SCM server
integration with CollabNet TeamForge .
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Example Modification

Note: To find the ID, click Admin >
Integrations > Integration Name. The ID
appears at the end of the URL.

-Dcvs.cvsroot=$CVSROOT No change
-Dappserver.url=http://localhost:8080/ce-soap60/ Replace localhost with the name of your machine
services/ScmListener running CollabNet TeamForge .

Note: If needed, replace 8080 with your

SOAP server port.
-Dcvs.username=$USER No change
-Dlog4j.configuration=file:/yourdirectory/ Replace /yourdirectory/ with the directory in
sourceforge home/etc/externalintegration/log4j.xml which you have installed CollabNet TeamForge .
-Dexternalintegration.triggers.log.dir=/tmp No change

6. Add the following Java class containing the body of the trigger.

com.vasoftware.sf.externalintegration.triggers.cvstriggers.LogInfo
${sVv}
7. Check your file against the completed example shown on Completed loginfo trigger file.
8. When you are finished, check the modified file back into your CVS repository.
If you have not already done so, repeat the process for the verifymsg trigger file.

.:-_ Note: If you make an error in the file, commits made to the repository will not fail, but you will receive
error messages.

Create a modified verifymsg trigger file
Here's how to modify the verifymsg trigger file.

1. Check out the module CVSROOT from the CVS repository.

The CVSROOT module is automatically created in all new CVS repositories, and contains the verifymsg and
loginfo files. When created, the files contain only comments.

2. Begin modifying the file by inserting .* followed by a tab.

This enables CollabNet TeamForge to see all modules in the repository.
3. Modify the path to your Java home directory as indicated below.

Add it to the file, followed by a single space.

Example Modification

/usr/local/java/j2sdk1.4.1_O1/bin/java -cp Replace /ust/local/java/j2sdk1.4.1 01/ with the
directory in which you have installed Java.

4. Modify the paths to the .jar files as shown in the following table.
Then add them to the file separated by colons.

Examples Modifications
/yourdirectory/sourceforge home/lib/saaj.jar / Replace /yourdirectory/ with the directory in which
yourdirectory/sourceforge home/lib/axis-1.1rc1- you have installed CollabNet TeamForge .

va.jar /yourdirectory/sourceforge home/lib/
saturn.jar /yourdirectory/sourceforge home/lib/
jaxrpc.jar /yourdirectory/sourceforge _home/
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Examples

Modifications

lib/externalintegration.jar /yourdirectory/
sourceforge home/lib/commons-discovery.jar /
yourdirectory/sourceforge _home/lib/commons-
logging_jar /yourdirectory/sourceforge home/lib/
log4j-1.2.8.jar

Modify the parameters as follows:

Examples

Modifications

-Dintegration.name=exsy 1001

Replace exsy1001 with the ID of your SCM server
integration with CollabNet TeamForge .

Note: To find the ID, click Admin >
Integrations > Integration Name. The ID is
at the end of the URL.

-Dcvs.cvsroot=$CVSROOT

No change

-Dappserver.url=http://localhost:8080/ce-soap60/
services/ScmListener

Replace localhost with the name of your machine
running CollabNet TeamForge . If needed, replace
8080 with your SOAP server port.

-Dcvs.username=$USER

No change

-Dlog4j.configuration=file:/yourdirectory/
sourceforge home/etc/externalintegration/log4j.xml

Replace /yourdirectory/ with the directory in which
you have installed CollabNet TeamForge .

-Dexternalintegration.triggers.log.dir=/tmp

No change

Add the following Java class containing the body of the trigger:
com.vasoftware.sf.externalintegration.triggers.cvstriggers. VerifyMessage

Check your file against the completed example shown on Completed verifymsg trigger file.

Check the modified file back into your CVS repository.

If you have not already done so, repeat the process for the loginfo trigger file.

Note: If you make an error in the file and check it back into your CVS repository, all commits made to
the repository will fail. To correct the file, you cannot simply check it out and fix it. You must fix it on the
repository. After fixing the file on the repository, you must then check it out, fix it again, then check it back

m.

Change your site's look and feel

You can redesign some aspects of your site to suit your organization's needs and preferences.

These instructions support only some basic types of customization. Almost infinite varieties of customization are
possible. To get into specific customization options in more detail, search or post a question on the CollabNet
TeamForge discussion forum or talk to your CollabNet representative.

[

Important: Because of the many new features in TeamForge 6.1, the effects of some of your existing
customizations may have changed. As you begin using TeamForge 6.1, pay special attention to any SOAP
calls or Velocity macros contained in the files you have customized.

Customize anything on your site
Follow these general instructions to customize a page, picture, text string, or other element on your site.

[

1.

Important: Custom branding changes can be overridden when your site is upgraded to a new version. You
may have to reapply any look-and-feel modifications after an upgrade.

Download the sample branding files.



http://forums.open.collab.net/ds/viewForumSummary.do?dsForumId=736
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Choose one of these files:

*  Basic branding package: Contains the files you need to do most of your branding tasks. Safest to use this file if
you are doing your own branding.

* Advanced branding package: Contains all the files that can be customized. For use when someone from
CollabNet is helping you with your branding.

go-  Note: Itis important that you have the most recent available version of this archive as a starting point.
Check that the version number at the top of the readme . txt file in your copy of the branding package is
the same as your version of the application. If it is not the same, check www.collab.net to see if there is a
more recent version.
2. Inthe look project, check out the branding repository.
3. Copy the default version of the appropriate file from the branding zip file to the equivalent directory in your local
copy of the branding repository.
4. Change the file to produce the results you want.
For example:
» To change a logo on your site's home page, overwrite the home . gi £ file with a new file of the same name.
* To change a logo on a project home page, overwrite the project.gif file with a new file of the same name.

5. Commit the changed files into your site’s branding repository.

s Important: Your branding repository does not have to contain all the files that are in the sample branding
zip file, but the structure of your repository must be an exact mirror of the structure of the sample file set.

M - WallabHeilenginecringWCSFE 5. 0% randing O5Wranding QuwickStarl.zip r__lrﬁﬁl
Fl= Ed Wew  Faecribes Tock  Heb Fu

@Fh'k L > I*,I - swwch [ Folars | [T25]- Project: look

. -
ez ([0 Dol olel B er g seioc CFE S0 aniog 5 Beeniding_ickStart o | B o Lot = L | e e
Progectriome  Tracesr  Coouments Tasks  Source Code Dsossos

Folier Tasks LJ LJ LJ J branding]
[} himi s is
- !
Dither Maces _,_..JI = File = lh-_': Agc +  suthor + I;:':ng

2y Braniog 05 s REALME_.,
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W v stk Haces O tmnpiaes B 2days avilskobosfial
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Customize the home page of your site
To change the content of your site's main page, replace the home . vm file or add either domain home.html or
DomainHome.html.html file to the html folder in the branding repository.

g~  Note: For the general steps for changing the look and feel of a page, see Customize anything on your site on
page 178.

The \branding\templates\sfmain\home.vm template controls the look, feel and structure of the standard
home page. The default version allows users to log in and sign up for new user accounts, if CollabNet TeamForge is
configured to allow user self-creation.

If the DomainHome.html.html or domain home.html file is checked into the branding repository, the
contents of the file are displayed as the site home page.

e Tip: If both DomainHome.html.html and domain home.html files exist in the repository, the
contents of the DomainHome.html.html are displayed.

L,

Check-in the customized branding file


../../com.collabnet.doc.common/downloads/BrandingBundle-Basic-7.1.0.0.115.zip
../../com.collabnet.doc.common/downloads/BrandingBundle-Advanced-7.1.0.0.115.zip
http://www.collab.net
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Edit the home . vm template to produce the page you want.
You can change these objects on the site home page:

Object Description

siteNews The html block that shows site news. The html block
itself is not customizable.

e Note: By uncommenting this object and
commenting out "communityNews" object,
site news can be displayed across all projects

in the site.
communityNews The html block that shows community news.
. Note: By uncommenting this object,

and commenting out "siteNews" object,
community news (news from the look project)
can be displayed across all projects in the site.

mostActiveProjects The html block that shows the most active projects.
The html block itself is not customizable.

displayActivityGraph A flag that indicates that the activity graph should be
displayed.
displayTeamForgeLinks A flag that indicates that CollabNet TeamForge quick

links should be displayed.

Customize the home page of projects
To change the default main pages of the projects on your site, edit the project home . vm file.

' Note:1 For the general steps for changing the look and feel of a page, see Customize anything on your site on
page 178.

Edit the project home.vm template to produce the project page you want.
You can change these objects on the project home page:

Object Description

projectData The object that contains the information
about the project. It implements the interface
com.collabnet.ce.customization.IProjectData.

adminList The list of project administrators. Each
object of the list implements the interface
com.collabnet.customization.IUserRow.

memberList The list of project members. Each object
of the list implements the interface
com.collabnet.customation.IUserRow.

projectMember A flag that indicates that the user is a member of the
project.
joinProjectButton The button that contains the link to

the Join Project page. It returns a
com.collabnet.ce.customization.widgets. Button.

useCustomHomePage A flag that indicates that the page shows the Wiki
Home page instead of the standard Home page.
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Object Description
customHomePage The html that displays as the Project Home page.
editCustomHomePageButton The button that is used to edit the

custom Home page. It returns a
com.collabnet.ce.customization.widgets. Button.

projectAdmin A flag that indicates whether or not the current user is a
Project Admin.

useCustomProjectLogo A flag that indicates that the Wiki project logo image
will be used instead of the standard project logo.

customLogoPathString The url from where the custom project logo image can
be loaded.

Change your site's outgoing emails
When you site sends out automated emails, the text of the emails can be customized to fit your site's specific needs.

e Note: Before customizing your site, download the branding files. See Customize anything on your site on
page 178.

You control screen labels and messages by overriding the resource bundle keys that specify the text strings that
appear in Velocity macros and JSPs.

1. In your local copy of the branding repository, create a directory called templates/mail.

2. Inthe templates/mail directory, create a file containing the custom content for an email that the system
sends out. Give the file the same name as the equivalent sample email file in the branding files package.
For example, to override the email that is sent out to new members of the site, name the file templates/mail/
user welcome.vm. Use Velocity syntax to identify the parts of the email, like this:

##subject

Welcome to our TeamForge site!

##subject

##body

Here is the content that I want to appear in emails coming from my site...
##body

e Note: To customize a template in a specific language, identify the locale as an extension to the file
name. For example, to create a user welcome file in Japanese, name the file templates/mail/
user welcome ja.vm

3. Commit your new and changed files into the repository.

Provide external applications

If your site's users need access to an application or web site that is not part of CollabNet TeamForge, you can make it
available by linking or integrating from within your CollabNet TeamForge site.

Provide a linked application

To bring an external tool into your environment quickly and easily, set it up as a linked application.

Create a site-wide linked application

When you create a site-wide linked application, it appears in all projects on your CollabNet TeamForge site.

Site-wide linked applications are especially useful for incorporating corporate standard external applications, such as
a company intranet sites, into your CollabNet TeamForge installation.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Integrations > Site-wide Linked Applications.

3. On the Site-wide Linked Applications page, click Create.
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4. On the Create Site-wide Linked Application page, provide a name for the linked application.
This name appears on the link in the CollabNet TeamForge navigation bar.
5. Enter the server location or URL for the linked application.

6. Select whether you want to enable single sign-on for the linked application.

» If you use single sign-on, access to the linked application is managed through the CollabNet TeamForge
authentication system. Users are not required to log into the linked application after they have logged into
CollabNet TeamForge .

» If you do not use single sign-on, users will be required to log in to the linked application using its native
authentication system.

7. Choose how you want the linked application to appear when a user clicks it.

* In the same window. The linked application takes over the entire browser window, replacing whatever the user
was looking at.

* In a new window. The linked application launches in a separate browser window.

* In an iframe. The linked application appears in a box in the same window, framed by the CollabNet
TeamForge site's header and navigation controls.

8. Click Save.

A link for the site-wide linked application is added to your CollabNet TeamForge navigation bar. Clicking the link
displays the application in the main CollabNet TeamForge window.

Edit a site-wide linked application

When the use patterns of a linked application change, you may need to change the way the application integrates with
CollabNet TeamForge .

Click Admin in the site navigation bar.
On the site administration navigation bar, click Integrations > Site-wide Linked Applications.
On the Site-wide Linked Applications page, click the name of the linked application that you want to edit.

o M.

On the Edit Site-wide Linked Application page, make the changes you need.

You can edit these elements:

» The name of the application.

» The application's URL.

*  Whether the application uses single sign-on.

*  Whether the application is displayed in a new window, in the same window, or in an IFrame.

' Note: You cannot change the application icon.
5. Click Save.

Provide integrated applications for use in TeamForge projects
To make a tool comprehensively available to your users, set it up as an integrated application.

Before you can make an integrated application available to project admins, your system administrator must integrate
the application with your site. This may involve modifying the application. How this is done depends in part on the
application.

Integrate an external application into a TeamForge site

When you integrate an external application into your CollabNet TeamForge site, your site's project administrators can
choose to include the integrated application alongside the built-in tools in their projects.

When you have integrated the application, project administrators on your site can add it to their set of collaboration
tools. Objects they create will share the core TeamForge features, such as authorization, authentication, go-urls,
association, linkification, templating, Project Pages components, search, and source code management support.
1. Find the XML files that describes your integrated application.

For an example of a working XML file, see pebble-app.xml.

2. Log into TeamForge as an admin user.
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Click Integrated Apps in the Site Administration toolbar.
Click Create.

Use the Browse window to find the configuration file you created, then click Next.

A

On the Preview screen, review the parameters you set in the configuration file.

e Note: You may have to revise one or more values to ensure they are valid.

7. Click Save.

The application is now available for all projects on your site. You can direct project administrators to these
instructions to add it to their own project toolbars.

Enable or disable integrated applications

Site administrators can enable or disable integrated applications.

In TeamForge, enable an integrated application to make it available for use in the projects.

. Tip: You can also disable an integrated application to restrict it from being added to projects.

Click Admin in the TeamForge toolbar.
On the Site Administration page, click Integrated Apps.

To make the integrated application available for use, select the integrated application and click Enable.

L=

To stop making the integrated application available for use, click Disable.
The system asks for confirmation before disabling an integrated application. Click OK to disable the integrated
application.

A disabled integrated application can be re-enabled when there is a need to use that integrated application in a project.

Remove an integrated application from your project
To stop making an application or site outside of CollabNet TeamForge available to your users from inside your
CollabNet TeamForge projects seamlessly, disintegrate an application.

e Note: You may have integrated several external applications per project to maximize the integrated
applications feature's utility. However, because each integrated application adds an icon to the project
navigation bar, a large number of integrated applications can cause horizontal scrolling. Consider removing
the integrated applications that are not in use.

1. Click Project Admin in the project navigation bar.

2. On the Project Admin menu, click Project Toolbar.
The Integrated Applications tab displays the list of all currently integrated applications in the project.

3. To remove an integrated application, on the Integrated Applications page, select the integrated application and
click Remove.
The selected integrated application is removed from the project.

The icon of the removed integrated application disappears from your project navigation bar.

' Note: Removing an integrated application, removes all associations to the integrated application too.

Set site-level permissions for an integrated application
In CollabNet TeamForge, as the site administrator you can set the site-level permissions for an integrated application.

The default access permissions are usually set using the configuring xml file for each integrated application.
However, you may want to provide permission access at site-level for some of the users.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click Integrated App.

3. Set the permissions for the integrated application and click Submit.
The permissions are set for the selected integrated application.
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.:_ Note: It is possible that an integrated application may be added to a project by a restricted user whose project
administration permissions come from a global project role. In such a case, you could be left with no one
authorized to administrate the integrated application. TeamForge handles that situation in one of two ways:

+ If one or more users with the "Founder project administrator" role is a member of the project, then the
restricted user who did the integration gets that role too.

 Ifthere is no project member with the "founder project administrator" role, the restricted user who did the
integration gets a new administrator role called "<integrated application name> Administrator."

View integrated application information
TeamForge site administrators, and users with site-wide roles and the IAF permission, can view information about an
integrated application's configuration and other details.

1. Click Admin in the site navigation bar.

2. On the Site Administration navigation bar, click Integrated Apps.

3. Onthe Choose an Integrated Application page, click the name of the integrated application that you want to
view.

The configuration details of the integrated application are displayed.

Edit an integrated application
TeamForge site administrators can update an integrated application's URLs (SOAP endpoint URL, administration
URL, browser URL) and other parameters by uploading XML files containing the changes.

Click Admin in the TeamForge toolbar.

On the Site Administration page, click Integrated Apps.

On the Choose an Integrated Application page, select the integrated application you want to edit.
Click Edit.

On the Edit Integrated Application page, make the changes you need.

Nk

You can edit these elements:
» The Deployment Configuration File.
» The Application Configuration File.
6. Click the Browse tab and select the files to attach.
7. Click Next.
Export an integrated application
TeamForge site administrators can export an integrated application's variables in XML format and have them
available for editing.
1. Click Admin in the TeamForge toolbar.
2. On the Site Administration page, click Integrated Apps.
3. To export the integrated application, select the integrated application name from the View Integrated
Application page.
4. Click Export.

The integrated application will be exported.

Add a custom event handler to your TeamForge site
An event handler is a program that watches for events on a TeamForge site and communicates them to another
system. You can add your own event handlers to the set that are built into TeamForge.

For example, some of your site's members may be using TeamForge alongside a legacy issue tracking system. You
may want to write an event handler that listens to the "Artifact Create" event on your TeamForge site and sends the
details about any newly created artifact to the legacy system through a webservice.

1. Create your custom event handler and package itas a . jar file.
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2. Check with your system administrator that the ENABLE Ul FOR CUSTOM EVENT HANDLERS variable in the
site configuration file is set to true.

Click Admin in the site navigation bar.

Click System Tools on the site administration toolbar.

Click Custom Event Handlers.

Click Create and use the Browse control to locate your . jar file.
Click Add.

A A

Note: If the system reports "Error Parsing Event Jar File," debug your event handler until the error
message no longer appears.

[ N

Your . jar file is uploaded to your TeamForge site and the event cache is cleared. All the events you specified in
your event handler are now captured and sent to the external web service.

System tools to monitor your site
To facilitate troubleshooting, keep an eye on key data about your CollabNet TeamForge site.

Check your server's status
As a first troubleshooting step, check the Server Status page to see if your servers are running and connected to the
main CollabNet TeamForge server.

Note: The Server Status page provides only the current status of each server. It is not a diagnostic tool, and
you must correct any connection or configuration issues on the server in question.

[ N

Click Admin in the site navigation bar.
On the site administration navigation bar, click System Tools.

On the System Tools menu, click Server Status.

L=

On the Server Status page, find the status of the server you are interested in.

*  SOAP server

* Email server

* Search server

» All integrated SCM servers

For each server, you see one of the following status messages:

* OK - The server is running and connected to the main CollabNet TeamForge server.
* Could Not Connect - The server is not running or is not connected to the main CollabNet TeamForge server.

Read your site's logs
Inspecting the system logs for your CollabNet TeamForge site may product useful information for solving problems.

1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click System Tools.

3. On the System Tools menu, click System Logs.
All the logs the server has written are listed.

4. On the Site Configuration page, click the log file you are interested in.

For explanations of some of the most useful logs, see Log files.

Configure your site's log level
Change your site's log level in the Configure Logging page.

The Configure Logging page lets you change the application server (JBoss) log level. Changing the application
server log level affects only the server.log and vamessages. log files.

1. Click Admin in the site navigation bar.

2. On the site administration navigation bar, click System Tools.
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3. On the System Tools menu, click Configure Logging.
4. On the Configure Logging page, select either INFO or DEBUG from the Log Level drop-down list.

' Note:

* The default log level is INFO.

* The server.logand vamessages. log files grow in size if you change the log level from INFO
to DEBUG.

» JBoss restart is not required after changing the log level using the Configure Logging page.

5. Click Save.

Get build information
For solving some kinds of problems, it may be useful to know which software components are installed, the exact
build number, and other technical information about your CollabNet TeamForge site.

1. Click Admin in the site navigation bar.
2. On the site administration navigation bar, click System Tools.
3. On the System Tools menu, click Build Information.
4. On the Build Information page, inspect the detailed information about the software underlying your instance of

CollabNet TeamForge.

Option Description
Version The release of the product.
Build Number Number of times the software was compiled and
packaged.
Operating System This is always Linux.
Operating System Version The variety of Linux in use. See Software requirements

for CollabNet TeamForge 7.1 for eligible Linux
distributions and versions.

Applied Patches Identifiers of any software updates that have been
installed to deliver added functionality or bug fixes.

Instance Identifiers for any packages of customizations that have
been applied. See Customize a site.

RPM All the software packages that have been installed to
support CollabNet TeamForge.

Get reports on site activity
You can keep track of various kinds of user activity, such as the number of user logins, source code commits, and
tracker activity on your site.

*  Monitor the total number of commits on your site by all users, in all projects, per day. You can track SCM
commits to Subversion and CVS repositories, and to Git repositories as well, if you have the TeamForge Git
integration set up.

* Check how many users log into your site in a given period. For example, to assess the impact of changes you've
made to your site's look and feel (see Customize anything on your site on page 178), look for trends in the user
login numbers for the week following the changes.

* Check the artifacts that are created and closed in a given period.

1. Click Admin in the site navigation bar.

2. Click Reports in the Site Administration toolbar and select one of the available reports.

3. Click a Zoom option to see a week, a month, a quarter, 6 months, or a year of activity.
The Max option shows all the data that's ever been collected.

4. Use the From and To date fields to zero in on the exact period of activity you are interested in.
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5. Roll your cursor over any data point on the graph to see the exact numbers that determine that point's position.
6. Click Grid View to see the data as a table.

You can toggle between chart and grid view as needed.

Keep your site secure
As site administrator, you are responsible for making sure passwords are effective and hackers can't get in.

Set password requirements
For security reasons, you may want to enforce a password policy that requires certain password characteristics.

You can specify the following characteristics:

*  Minimum number of characters

» At least one number

* At least one non-alphanumeric character
* Mixed upper and lower-case characters
* Allowed invalid login attempts

» Disallow old passwords

* Use of dictionary words

* Default password expiry

» Disable/delete user accounts

*+ Inthe site-options.conf file, set the following variables.

.:-_ Note: Default values are indicated by brackets.

+ MINIMUM PASSWORD LENGTH =[8]

« PASSWORD REQUIRES NUMBER = true | [true]

« PASSWORD REQUIRES NON ALPHANUM = true | [true]
« PASSWORD REQUIRES MIXED CASE = true | [true]

+ REQUIRE PASSWORD SECURITY = true | [true]

* LOGIN ATTEMPT LOCK = 3

' Tip: This option controls locking out the user account after "n" invalid login attempts. Set this to
zero or a negative number to lock the user account when the user provides an incorrect password for
the first time. Set this to a positive number, say "2", to allow the user two wrong password attempts.
The user account would be locked at the "x+1" (here, third) attempt. When a user's account is locked,
either an administrator must unlock it or the user can use the "Forgot Your Password?" link to reset the
password.

« PASSWORD HISTORY AGE=5 | [5]

' Tip: The maximum allowed value of PASSWORD HISTORY AGE token is 10. This option disallows
the previous "n" passwords, while setting a password. However, if this option is set to zero, a negative
number or it is left empty, the user can use any previous password. The password being set must
satisfy the existing password policy each time.

* ALLOW PASSWORD DICTIONARY WORD=true

.:-_ Note: You must set the "REQUIRE PASSWORD SECURITY" option to "true" in the site-
) options.conf file, for "LOGIN ATTEMPT LOCK", "PASSWORD HISTORY AGE" and
"ALLOW_PASSWORD DICTIONARY WORD" security setting to take effect.

Prevent cross-site scripting (XSS)

By using the upload document function, an attacker could potentially upload an HTML page to CollabNet TeamForge
that contains active code, such as JavaScript. This active code would then be executed by clients' browsers when they
view the page.

To prevent an attack of this sort, you can specify whether or not HTML code is displayed in CollabNet TeamForge.
This flag applies to all documents, tracker, task, and forum attachments, and files in the file release system.
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In the <SOURCEFORGE_SITE DIR>/sourceforge home/etc/
sourceforge configuration.properties file, setthe sf.safeDownloadMode flag to one of the
following values.

» none: All file types that can be displayed inline are displayed inline, including HTML and text.

' Note: This is the CollabNet TeamForge default.

* html: HTML files are not displayed inline. All other file types that can be displayed inline are displayed

inline, such as text. When a user tries to launch an HTML file, he or she is prompted to download and save the
file locally.

* all:No file types are displayed inline. When a user tries to launch any file, he or she is prompted to
download and save the file locally.

Support hardware provisioning
You can provide project managers with a TeamForge Lab Management site where project members can remotely
build and test their code.

.:-_ Tip: For more information about the new features in TeamForge Lab Management 2.2, see this introductory
video. (You'll need a free open.collab.net membership to watch it.)

Set up a new TeamForge Lab Management project
To start using TeamForge Lab Management project, create or select a TeamForge (or CollabNet Enterprise Edition)
project to link to.

e Note: You can use Lab Management with either CollabNet TeamForge or CollabNet Enterprise

) Edition. These instructions assume you are using TeamForge. For information about working with
CollabNetEnterprise Edition projects, see the kelp for CEE project managers.

Log into TeamForge Lab Management as an administrator.

Click the Administration tab.

On the Administration menu, click Manage Projects.

Select the Add New Projects tab.

A

If Lab Management is connected to a TeamForge server, the Name field displays a drop-down list of projects
instead of requiring a text entry. Select the project you want to add to Lab Management.

6. Inthe Summary field, write a brief summary of the project.
. Note: The TeamForge Lab Management project summary may be different from the CEE or SFEE
project summary.
7. Click Add New button.

Your project is added. You can now pass the project on to the Project Admin of the project to begin administrating
and configuring.

e Note: If your project is an SFEE project, you will see that TeamForge Lab Management has added some
Roles to your project.

Move hosts from one project to another
When a project has too many machines or needs more, you may wish to reallocate hosts between projects.

You must be a domain administrator to move hosts between projects.

1. Notify the project administrator of the project you are taking hosts from, so their project members won't lose
important work which they may not have saved on that system.

Go to the Project Home page for the project which contains the host you are moving.

Select the Hosts tab to bring up the hosts list and click the host you want to re-allocate.

Click the Admin tab for the host.

From the Project drop-down box in the Allocation Details section, select the project that you want to move to.

S R
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.:-_ Note: If you do not see a drop-down box here, it means:

* The host is a virtual guest. Virtual guests must remain in the same project as their parents.

» The host contains virtual guests that are not all allocated to the same user. From the web interface, you
can only change the project of a virtual host if the parent and all its guests are allocated to the same
user.

* The host is a cloud source.

6. Click Update to move the host (and its guests, if any).

7. If you are concerned about the security or contents of the machine that has been moved to the new project, rebuild
the machine as soon as possible.

This is the only way to ensure that only the exact software and users that you specified will be on the machine.

.:-_ Note: For a more flexible way of moving hosts between users and projects, you can use a TeamForge Lab
Management API client to perform the move.

Forward a port
To make a service accessible to users, sometimes you may need to forward a port on a Lab Management box to an
external-facing port.

e Note: Port forwarding is only needed if Lab Management has been setup in an isolated deployment mode.
If you can access the nodes directly, without tunneling through the manager, then you do not need to worry
about setting up port forwards.

1. In the left-hand column of the Administration screen, click Port Forwarding.
2. Select a host and specify the type of traffic you want to forward.

Host The TeamForge Lab Management host that you want
to access the network service from. For example,
cu0l4.1lmdomain.yourdomain.net

Host Port The port on the Host -- the hostname you selected
above -- that you want to access the network service
on. For example, if you would like to forward a web
server, you would select Host Port 80.

External Port The port on the TeamForge Lab Management
Manager host that you would like to forward
the traffic to. For example, if you would like
to forward the above web server on Host
cu0l4.lmdomain.yourdomain.net and
Host Port 80 to port 8080 on the TeamForge Lab
Management Manager host, you would enter 8080 in
this field.

e Note: Only certain ports may be selected for
the External Port. The list of ports is given at
the top of the screen.

Protocol The protocol or protocols to support when forwarding
traffic. Choose one of these:

« TCP
e UDP
¢ Both TCP and UDP

Note: If you're unsure, ask the requestor for
clarification. Most network services will only
require TCP.



Description

3. Click Add New to add your new forwarding.
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A textual description of the service that is being
forwarded. All users in the project will see this
description when they view the Summary page for the
Host.

' Note: The Description is mandatory.

The new forwarding is active immediately. To test your new forwarding, try accessing the external port on the
TeamForge Lab Management Manager from your desktop.

e Tip: If the network service requires special client software, especially if the forwarding is using the UDP
protocol, you may not be able to easily test it. In that case, contact the requestor and ask them to verify

that the forwarding works properly.

Stop port forwarding

When you don't want to forward a port, you can delete or suspend forwarding for that port.

1. In the left-hand column of the Administration screen, click Port Forwarding.

2. Ifyou want to remove the port forwarding permanently, click Delete for the forwarding you wish you delete.

Forwarding for this port is immediately disabled and deleted forever.

e Note: You can always create a new forwarding with the same properties in the future.

3. If you think you might need this forwarding again soon, clear Enable and click Update for the forwarding you

wish to disable.

Enable the forwarding again by selecting Enable again and click Update again.

Set up host URL mapping

If you have real users accessing services on a box you have set up virtually with TeamForge Lab Management,
consider giving them a human-friendly URL to go to. You can do this by mapping an arbitrary URL to the host's real

URL.

e Note: Only TeamForge Lab Management domain administrators can administer host URL mappings.

1. On the Administration tab, click Host URL Mapping in the navigation bar.

2. Provide the following information about the service you wish to map:

Host

Host Port

Host URL

Mapped URL

The TeamForge Lab Management host that you want
to access the network service from. For example,
cu0l4.1lmdomain.yourdomain.net

The port on the Host -- the hostname you selected
above -- that you want to access the web service on.
For example, if you would like to map a web server
running on port 8080, you would select Host Port
8080.

The URL path on the Host that you want to map to.
For example, if you want to map the URL http://
cu0l4.lmdomain.yourdomain.net:8080/
build/, you would enter /build for the Host URL.

The location (URL path) on the TeamForge Lab
Management manager to map the Host URL to. The
location will be under the directory /apps. For
example, if you enter mybui1d for Mapped URL in
our example, you will then be able to reach http://
cu0l4.lmdomain.yourdomain.net:8080/
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build/ ashttp://
mgr.lmdomain.yourdomain.net/apps/
mybuild/.

Valid characters for Mapped URL's are: Letters,
numbers, spaces, underscores, and hyphens.

Use SSL Whether or not to force requests for the mapped URL
to use SSL. Mapped URL's will always be accessible
via SSL, even if this box is not checked. But, if you
check this box, it will be impossible to access this
URL without SSL. In general, unless there is a very
good reason for turning the Use SSL option off, we
recommend keeping it on.

Dynamic Rewriting Set to either Safer or More Aggressive. Using the
Safer option, only HTML attributes which are known
to contain URL's are dynamically rewritten. But in
some cases, especially with applications that use
embedded Javascript code, this will not be sufficient
and some parts of your application will not work
properly. In this case, try the More Aggressive option.
This option still attempts to be careful about what
it rewrites, but looks into the HTML more deeply
and will rewrite a wider variety of HTML tags and
attributes.

Description A textual description of the web service that is
being mapped. All users in the project will see this
description when they view the Summary page for the
Host.

' Note: The Description is mandatory.

3. Click Add New to add your new URL mapping.

The new URL mapping is active immediately. To test it, try accessing the resulting URL from your desktop.

Stop URL mapping
When you don't need a URL mapped, it's a good idea to remove the mapping.

e Note: Only TeamForge Lab Management domain administrators can administer host URL mappings.

1. On the Administration tab, click Host URL Mapping in the navigation bar.
2. Click Delete for the URL mapping you want to stop.

The URL mapping is immediately disabled and deleted forever.

' Note: You can always create a new URL mapping with the same properties in the future.

e Tip: To temporarily disable a URL mapping, clear Enable and click Update for the URL mapping you wish
to disable. To enable the URL mapping again, select Enable and click Update again.

Delete a project
To conserve resources on your TeamForge Lab Management site, it's a good idea to delete projects that are not in use.

Only TeamForge Lab Management Domain Admins can delete and undelete projects. When a project has been
deleted, only TeamForge Lab Management Domain Admins can access it, and then only to undelete it.

Projects that contain hosts cannot be deleted.
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1. Check that there are no hosts allocated to this project.
You cannot delete the project if there are hosts currently allocated to it.

2. On the Projects tab, find the project you want to delete, and select Edit in the Actions column on the right for that
project.”

3. On the Edit Project page, click Delete, then Confirm Delete.

The project is deleted from the system.

Undelete a project
To bring a project back into your TeamForge Lab Management site, you can undelete the project.

Only TeamForge Lab Management Domain Admins can delete and undelete projects. When a project has been
deleted, only TeamForge Lab Management Domain Admins can access it, and then only to undelete it.

1. On the Administration tab, click Manage Projects in the navigation bar.
In the list of all the projects in the system, deleted projects are in italics and are marked "Currently deleted.".

2. Click the project you want to undelete.
3. On the Edit Project page for the deleted project, click Undelete button, then Confirm Undelete.

The project is restored to being a fully active TeamForge Lab Management project.

Expand your domain with virtual guests

By using virtual guests, you can provide your users with many more machines than you actually have.
Create a virtual guest

To add a virtual guest, go to the configuration page for the host where the guest will live.

.:_ Note: You can only create virtual guests on machines that are allocated to you, are not guests themselves,
and are not marked immutable.

1. On the Manage Hosts page, (or any other page where the host is visible), click the down arrow next to the host
where your virtual guest will live and select Manage Virtual Guests.

2. On the host's Manage Virtual Guests page, specify the details for your new virtual guest under Add New
Virtual Guest.

Migrate a virtual guest
When a virtual guest consumes too many system resources, or you wish to rebuild or perform other more drastic
maintenance on the virtual guest's current virtual host's use, migrate the guest to a different host.

Before moving a virtual guest, make sure the following is true:

*  You are a TeamForge Lab Management domain administrator.
* The current virtual host and guest, and the desired new virtual host, are all in the same project.

» The target virtual host has enough RAM, disk, and CPU to accommodate the virtual guest you wish to migrate to
it. (TeamForge Lab Management displays a drop-down list of hosts that fulfill all these criteria.)

* The virtual guest being moved and the target virtual host are on the same subnet.

1. Go to the Host|Admin page for the virtual guest that you wish to migrate.

2. Inthe Move to Virtual Host drop-down box, select the host you wish to migrate this virtual guest to, and click
Update Allocation Details.

e Note: If you do not see this drop-down box, but instead see the text "No hosts are eligible for re-
parenting," there are no other virtual hosts in this project that could accommodate this virtual guest. You
must delete or reduce the hardware resources assigned to one or more existing guests.

3. Click Confirm Update.

The virtual guest immediately shuts down and begins migrating. The owner of the virtual guest (not necessarily the
user that requested the migration) receives an e-mail when the migration is complete.

.:_ Note: There is no exact time frame or estimate for how long a guest migration takes. A typical "base"
system without much data (e.g., under 10GB) usually migrates in 5-15 minutes. The time required is mostly
dependent on the size of the virtual machine, coupled with the load on the source and destination virtual hosts.



| How to use TeamForge 7.1 | 193

Delete a virtual guest
You delete a virtual guest the same way you delete a physical host.

Important: Before you delete your guest, be aware of one very important difference: As soon as you delete
a virtual guest, the virtual guest system and all its data are wiped out forever! This is in contrast to deleting a
physical host, in which case the machine gets removed from TeamForge Lab Management, but the contents

of its hard drive are not wiped out, and could still be rescued by an administrator with physical access to the
system.

[

1. On the Host|Admin screen, click Delete Host.
2. Click Confirm Delete.

The virtual guest is permanently deleted.

Manage profiles

Like hosts and projects, profiles must be added at the domain level before they can be used by individual projects.
Likewise, they can be administratively disabled from use at the domain level.

Add a profile to the Lab Management domain

In Lab Management, a "profile" is a reproducible collection of software packages that comprise a runnable operating
system and accompanying set of applications. Every system inside the Lab Management environment has an
operating system profile installed on it.

There are three ways to add a new profile to Lab Management :

» Directly add it to the profile repository using a Subversion client, then import it into Lab Management through the
Add Profile page.

* Create the Profile XML file directly, and upload the file through the Add Profile page.

» Make a copy of an existing profile on that profile's Admin page, and edit it to suit your needs.

Among the three, the third is the easiest, and used most often by our own profile creators.
1. Log into TeamForge Lab Management as a user with TeamForge Lab Management Domain Admin privileges.
Click the Administration tab.

On the Administration menu, click Manage Profiles and then the Add New Profile link.
Enter the following information.
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' Note: All fields are mandatory.

Profile name The name of the profile. Must already exist in the
site's Subversion repository before it can be added into
TeamForge Lab Management. This name can never be
changed, so be sure to get the profile named properly
when you initially create it.

You can also upload a profile from your local system
into Lab Management's Subversion repository. The
profile must be in valid Lab Management profile XML
format.

Summary A brief summary of the profile. The Summary can be
changed later on using the Profile Admin page.

Project What project the profile belongs to. If you leave it
blank, the profile will belong to the domain, and either
be accessible to all projects (if the profile is public) or
no projects (if the profile is private). This property can
be changed later on using the Profile Admin page.

Public Whether the profile is public (can be used by any
project) or private (can only be used by the project
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which owns the profile). This property can be changed
later on using the Profile Admin page.

Prebuilt Whether or not the profile is a VMware or other
prebuilt image file. This profile property cannot be
altered once the profile is created. If your profile is
an image file, this will be Yes. If your profile installs
via a network install method like Kickstart(tm) or
Jumpstart(tm), this will be No.

Size (in GB) The minimum disk size required to build and run this
profile. The minimum disk size should be at least 10
GB.

5. Click Add New to add the new profile.

Modify the XML definition for a profile

Rather than using a Subversion client to check out and edit a profile, you can edit the profile XML definition in a text
box in the Lab Management user interface. This allows you the greatest flexibility in changing parts of the profile.

1. Loginto TeamForge Lab Management as a user with TeamForge Lab Management Domain Admin privileges.
Click the Administration tab.

On the Administration menu, click Manage Profiles.

Right-click a profile and select Admin from its context menu.

In the Modify Profile: Profile XML Definition section, click View/Edit XML Definition of Profile.
This brings up the content of the profile XML definition in an editable text box.
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6. To edit the content, we recommend that you copy it to a text editor, edit and save it. Then copy it back into the text
area.

7. To double-check your changes your changes before checking in the new version, click Show Diff.

8. When you're done, click Check In New Version.
If, by some chance, you made a mistake and the profile is invalid, don't worry -- since profiles are versioned, you
can always mark that version as unbuildable.

Stop using a profile

In Lab Management, profiles can be permanently deleted or disabled.

Delete a profile

If a profile in Lab Management has never been used, it can be deleted. This can be helpful, for example, if you wish to

clean up some profiles that were created with incorrect names.

Log into TeamForge Lab Management with TeamForge Lab Management Domain Admin privileges.

Click the Administration tab.

On the Administration menu, click Manage Profiles.

In the list of all profiles currently in the system, click the profile you wish to disable.

Click the Admin tab.
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Disable a profile
When you disable a profile in Lab Management, it will prevent the users from building or rebuilding a host with that
profile. It is possible to make disabled Lab Management profiles accessible again.

A disabled profile gets removed from all projects that currently allow the profile. If you disable a profile and then
enable it later, project managers who previously allowed that profile will have to go back into their project's Profile
Library and add the profile again.

.:-_ Important: Use caution before disabling a profile. Contact the owners of the systems using that profile, and
owners of projects that include that profile, before disabling the profile.

1. Loginto TeamForge Lab Management with TeamForge Lab Management Domain Admin privileges.
2. Click the Administration tab.
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On the Administration menu, click Manage Profiles.

In the list of all profiles currently in the system, click the profile you wish to disable.
Click the Admin tab.

Click Disable Profile.

A

The profile is disabled and removed from all projects that currently allow it.

Enable a profile

To build a machine with a profile that has been disabled, you must re-enable the profile.

Log into TeamForge Lab Management with TeamForge Lab Management Domain Admin privileges.
Click the Administration tab.

On the Administration menu, click Manage Profiles.

In the list of all profiles currently in the system, click the profile you wish to re-enable.

Click the Admin tab.

On the Admin page, click Enable Profile to re-enable the profile.

SNk

Administer clouds

As an administrator, you can set up and manage the clouds in your Lab Management site.

Add a new cloud

When you pool the physical resources into a cloud, they can be partitioned in to different virtual machines and used in
any project on the domain that needs them.

1. Select Administration > Clouds

In the Manage Clouds page, click New Cloud.

Enter a name and brief summary for the cloud.

Enter any additional details in the Description.

AN Sl ol

Select an owning project for the cloud.

The owning project allows the physical source systems in the cloud to be from that project. If you don't specify an
owning project, the sources for the cloud can only be systems that are unallocated and don't belong to any project .

6. Specify whether this is a public or private cloud.

* A public cloud appears in any project on the site that allows clouds, and is available for other project
administrators to include in their list.

» A private cloud appears only in the project that owns it, so that only the users in that project can allocate
systems from it.

7. Specify whether hosts allocated from this cloud should be deleted when they are deallocated.
8. Specify the maximum time (in days) for which a host can be allocated from this cloud.

The default value is 0 and indicates that there is no limit.
9. Click New Cloud.

When your cloud gets created, you can proceed to add hosts to it.
Add acloud host
When you've created a cloud, you can add hosts from physical sources or Amazon EC2 sources.
1. On the Manage Clouds page, click a cloud name and select Admin.
2. Add a cloud source using either of these options:
a) To add a physical host source, select one from the drop-down and click Add Host.
Physical hosts can be partitioned into virtual machines that can be allocated into different projects on the site.
b) To add an Amazon EC2 source, click Add EC2 Source.

e Note: You will need information from your Amazon Web Services account to complete this task.

1. Add a description for the source.


http://aws.amazon.com
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2. Specify the maximum number of hosts that may exist at any given time from the set of EC2 credentials

specified on this page.

3. Fill in the EC2 credentials from the information in your Amazon Web Services account. See Set up
Amazon EC2 credentials on page 197 for details on how to get this information - you'll need to provide
the API Key, API Secret, and the Keypair Name and Keypair Value (your RSA private key).

Click Save.

When you add an EC2 source, make sure that one or both EC2 profiles - Amazon EC2 FC4 base 386,

Amazon EC2 FC8 base 1386 - are enabled for your Lab Management projects.

Define a host type
To add a host type for a cloud, specify its attributes such as CPU, disk size and memory, and price for usage in an
XML configuration file.

1.
2.

On the cloud's Admin page, click Modify Cloud.
Edit the XML fille.

Here's an example:

<host type value="Sun">

<contains>
<size value="extra small">
<price base="0.1" />
<provides>
<memsize value="256" />
<disksize wvalue="10" />
<ncpu value="1" />
</provides>
</size>
<size value="small">
<price base="0.2" />
<provides>
<memsize value="512" />
<disksize wvalue="10" />
<ncpu value="1" />
</provides>
</size>
<size value="medium">
<price base="0.3" />
<provides>
<memsize value="1024" />
<disksize wvalue="20" />
<ncpu value="1" />
</provides>
</size>
<size value="large">
<price base="0.4" />
<provides>
<memsize value="1024" />
<disksize wvalue="40" />
<ncpu value="1" />
</provides>
</size>
<size value="extra large">
<price base="0.5" />
<provides>
<memsize value="2048" />
<disksize wvalue="80" />
<ncpu value="1" />
</provides>
</size>
</contains>

<requires category="cpuarch" op="in">
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sun4u
sunév
</requires>
<requires category="type" op="eq">
physical
</requires>
</host_type>

3. Click Update.

Delete a cloud
When a cloud, and its hosts, are no longer in use, you can delete it.

Note: You can delete a cloud only when all of its physical sources have been removed, and there are no hosts
that were created from the cloud.

1. On the Clouds page, click on a cloud name and select Admin.
2. Click Delete Cloud.

Set up Amazon EC2 credentials
To be able to create an EC2 cloud source in Lab Management, you need to set up an Amazon Web Services account
and supply the EC2 credentials to Lab Management.

To get started, you need to create an Amazon Web Services (AWS) account (or sign in with an existing Amazon
account). You will be required to provide a credit card as part of sign up; this card will be charged for all your running
EC2 instances. You will also be required to provide a callback number to which you have ready access. Amazon will
generate an automated callback to this number to complete registration, and ask you to enter a generated PIN into
your phone. Finally you'll receive a verification email letting you know that your account is set up.

1. Gotohttps://console.aws.amazon.com/ec2/ to view the AWS console.

Note: You should default to the US East region. This is the default that Lab Management assumes for all
AMIs, instances, and key pairs.

[ N

2. Get the API credentials you'll give Lab Management to use your AWS account.

a) In My Account > Security Credentials, scroll down to your Access Keys, and get the Access Key ID (known
as API Key in Lab Management).

b) Show the Secret Access Key (known as API Secret in Lab Management).
3. Generate or upload a Key Pair.
This is a named public/private key pair that will be used to access instances as root.

Note: This key pair is associated with this AWS account, and therefore the credit card and the user that
creates a cloud in Lab Management - take the appropriate precautions!

[ N

Amazon stores only the public key for passwordless SSH access to the instances. If you generate a key pair, you'll
download the private key, which you'll be responsible for keeping secure. If you upload your own public key,
you're still responsible for keeping your private key secure. For Lab Management-controlled EC2 instances, this
key is used for paswordless root SSH access to the instance.

When you create an EC2 cloud source in Lab Management, you'll need to provide the API Key and API Secret
viewed above, as well as the Keypair Name and Keypair Value (your RSA private key) generated above.

Integrate TeamForge 7.1 with other tools

TeamForge 7.1 supports integrations with third-party tools for versioning, reviewing and searching source code.

TeamForge Git integration
TeamForge 7.1 supports an integration with the Git distributed version control tool powered by Gerrit.

While Git is the world's leading distributed version control system, enterprise adoption for Git has been slow.
Concerned with security breaches, compliance violations and lack of governance, many organizations have chosen
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to take a "wait and see" approach. With TeamForge, Git is ready for the enterprise. TeamForge lets you realize all
the benefits of Git while ensuring the security, governance and manageability your business demands. And with
TeamForge, you can even manage Git and Subversion together, within each individual project.

Gerrit is an open source code review system designed to work with Git. Gerrit supports various access control
mechanisms. The TeamForge Git integration uses Gerrit as a vehicle to bring TeamForge project roles and
permissions into Git.

. L]
glt Gerrit Team

v Basic SCM features jgrﬂegim}

v iGi ' ode Quality

v :.i:,:;:i‘:eine v Advanced Git security v Control

v GitWeb : ¥ Git Projects organization v IT standard compliance
v Code-review v" ALM integration
v Replication v Hybrid SCM

Highlights

» Easy Git repository management from TeamForge using TeamForge’s role based access control
* Authentication using SSH keys stored in TeamForge and ht tp using Gerrit’s ht tp passwords
» TeamForge artifact association with Git commits

* it source code browsing and code search

» Single sign-on between TeamForge and the Gerrit web console

* Full support of Gerrit’s APIs to connect with Continuous Integration systems like Jenkins

TeamForge 7.1 supports two versions of the Git integration — one based on Gerrit 2.1.10 (version 7.1.x of the
integration) and the other based on Gerrit 2.6.x (version 8.0.x of the integration). For more information, see these
guides:

» TeamForge Git integration based on Gerrit 2.1.10
» TeamForge Git integration based on Gerrit 2.6.x

Set up Review Board
Review Board is a popular code review tool available with TeamForge 7.1 as a fully-integrated add-on. TeamForge
7.1 supports Review Board 1.7.17.

For instructions on how to install Review Board, see TeamForge 7.1 Administration Guide.

Integrate Review Board with your TeamForge site
When the Review Board application has been installed on your site, you can make it available for projects on your
TeamForge site.

Review Board must be installed and configured before you can integrate it with your TeamForge site. See Install
Review Board.

o Important: You must not create, edit or delete new user accounts while installing the Review Board
application and integrating it with TeamForge.


http://help.collab.net/topic/teamforge71-git-gerrit21x/faq/teamforge_git_integration_overview.html
http://help.collab.net/topic/teamforge71-git-gerrit26x/faq/teamforge_git_integration_overview.html
http://help.collab.net/topic/sysadmin-710/action/iaf-reviewboard.html
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When you have installed Review Board, projects on your site can add Review Board to their set of collaboration

tools.

1. Log into TeamForge as an administrator.

W

Click Create.

=

application to work as a part of TeamForge:

Click Integrated Apps in the Site Administration toolbar.

Use the Browse window to select the application and deployment configuration files that enable the Review Board

* rb-application.xml (Application configuration file): Contains the text strings for the Review Board

user interface.

* rb-deploy.xml (Deployment configuration file): Contains the data that Review Board needs to interact

with TeamForge.

Click Next.

5. On the Preview screen, review the parameters you set in the configuration files.

e Note: You may have to revise one or more values to ensure they are valid.

6. Click Save.

The Review Board application is now available for all projects on your site. Project administrators can refer to the
topic, Add Review Board to a TeamForge project, for instructions on adding Review Board to their own project

toolbars.

.:_ Note: You may need to adjust your site's look and feel to support your integrated application. See the site

admin help for details.

TeamForge - Review Board integration: General usage FAQ
General usage questions about the TeamForge - Review Board integration.

Which version of Review Board does TeamForge 7.1
support?

Which repositories does Review Board support?

How do I manage users in Review Board?

Can I specify 'RB' as a prefix in my project?

Is it possible to grant TeamForge specific-permissions
as part of the system generated Review Board
administrator?

Can I use the Review Board 'Search' feature after
integrating Review Board with TeamForge?

What are the additional features available in Review
Board after you integrate it with TeamForge?

What are the other TeamForge features which
Review Board does not support after you integrate
Review Board with TeamForge?

TeamForge 7.1 supports Review Board 1.7.17.

Review Board supports only Subversion repository in
TeamForge 7.1.

You can manage Review Board users from TeamForge.
Whenever you create or edit users in TeamForge, they
are synchronized automatically in Review Board.

No. You cannot specify 'RB' as a prefix in your project.
The prefix for Review Board must be unique for every
project.

No. It is not possible to grant TeamForge specific-
permissions as part of the system generated Review
Board administrator (integrated application specific role).

No. TeamForge does not support the 'Search' feature of
Review Board.

Review Board uses some of the TeamForge features like
object IDs, links, GO URLs, and SVN integration and
associations. For more information, see How does an
integrated application interact with other TeamForge
tools? on page 292

Global search, page component, recent history and
project template features of TeamForge are not supported
in Review Board.
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Where can I find the documentation for Review You can find the documentation for Review Board /ere.
Board?

How do | control user access for Review Board?
You can control user access for Review Board based on user roles.

The following roles are defined in the XML application configuration file in TeamForge:

Submit / Edit / View Using this permission, you can submit new review
request, modify your existing review requests, and view
the existing requests in Review Board.

Change Status as another user Using this permission, you can change the review request
status of another user.

Submit as another user Using this permission, you can submit a review request
as another user through the post-review command line
tool.

Edit as another user Using this permission, you can modify a review request

of another user through the user interface or the post-
review command line tool.

Admin staff When you have this permission along with the Submit/
Edit/View permission through a site-wide role, you can
access Review Board administration user interfaces.

e Note: Site administrators have all permissions on all projects on the site, by default. Site administrators grant
these permissions to other users based on their roles.

Black Duck Code Sight

With the integration of Black Duck Code Sight, TeamForge 7.1 enables developers to easily find code snippets in
source code repositories.

You can search repositories in all TeamForge projects or specific ones from your "My Projects" list. Besides code
snippets, you can search for things such as file names, and classes or methods in C#, Java, and Python files. For more
information on what you can search for, how search results are ranked, and advanced searches, please have a look at
the Black Duck Code Sight User Guide.

You have the ability to control whether source code is included in search results. For example, you may want to
exclude source code from searches that have sensitive information. You may also want to omit some repositories,
such as the branding and publishing repositories, from search results. The Available in Search Results setting in
Create Repository or Edit Repository page allows you to configure this. By default, this option is selected for all
repositories, except for the branding repository in the look project and for Publishing repositories.

TeamForge site administrators can check the status of the Code Sight server in the Admin > System Tools > Server
Status page.

' Note: Code search can be done only through global search.

For instructions on how to install Black Duck Code Sight, see TeamForge 7.1 Administration Guide.


http://www.reviewboard.org/docs
http://www.blackducksoftware.com/code-sight/support/doc
http://test.help.collab.net/topic/sysadmin-710/action/blackduck-top.html
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Frequently asked questions about CollabNet TeamForge
7.1

Here is some background knowledge to help you make the most of CollabNet TeamForge.

TeamForge FAQ

Frequently asked questions about using CollabNet TeamForge

Use this background knowledge to help you exchange information, track work and collaborate with your team.

What's the best way to search the CollabNet User Information Center?
Searching this site with the Eclipse search tool is a little different from searching the Web with a service such as
Google. Here are some guidelines for getting the most out of a search on this site.

Setting the search scope

To quickly locate topics on a particular subject in the documentation, enter a query in the Search field. You can
narrow the scope of your search by selecting only the sections you are interested in. To set the search scope:

1. Click Search scope next to the Search field.

Select the Search only the following topics option.
Click New.

Type a name in the List name text box.

AN

Select one or more guides (select the check boxes) from the Topics to search list. For example, you can select the
check boxes corresponding to the CollabNet TeamForge 7.0 user and administration guides.
6. Click OK.

Once the search scope is set, you can enter your search query and click GO. Your search is restricted only to the
guides you selected.

Search query guidelines
* Use AND to require the term on each side of the AND operator be present in the topic.

' Note: When you don't put anything between terms, the search tool assumes you mean AND. Topics that
contain every term in the query are listed in the search. For example, if you enter database service, topics
that contain both the term database and the term service display. Topics that contain only the term service
or only the term database do not display.

» Use OR before optional terms. For example, if you enter database OR service, topics that contain either the term
database or the term service display.

» Use NOT before a term that you want to exclude from the search results. For example, database NOT service
displays topics that contain the term database, but do not contain the term service.

* Use ? to match any single character. For example, plu? displays topics that contain plug.

» Use * to match any set of characters, including an empty string. For example, plu* displays topics that contain
plug or plugin.

» Use double quotation marks to enclose a term that is to be treated as a phrase. For example, "edit menu" displays
topics with this entire term, not topics with only the term edit or the term menu.

» Case is ignored. For example, database service displays database service, Database Service, and DATABASE

SERVICE.

» Punctuation acts as a term delimiter. For example, web.xml displays topics that contain web.xml, web, and xml.

To display only topics that contain web.xml, enclose the term in double quotes.
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» Inasearch query, if you enter create, topics that contain create, creates, creating, and creation are displayed. To
only see the term create, enclose the term in double quotes.

» The following English words are ignored in search queries: a, and, are, as, at, be, but, by, in, into, is, it, no, not, of,
on, or, s, such, t, that, the, their, then, there, these, they, to, was, will, with.

Can | assign an artifact or task to a group of users?

Unfortunately this is not possible with the current implementation of groups in CollabNet Team Forge.

As a workaround, you can create a new user account and set its email address to that of a mailing list that all group
members are subscribed to. Then the submitting user can assign the artifact to this user account, and the mailing list
will be notified.

What is an association?

CollabNet TeamForge allows users to easily associate, or link together, any objects in the system to simplify
knowledge sharing and provide traceability throughout the lifecycle.

For example, a discussion post regarding a customer problem could be linked to a document specifying the feature
requirement. An issue might be created to track the defect, the source code commits that fix the issue, and the release
that contains the fix. All of these records can be linked together with an association. When any item is associated with
another, the link appears on the item's Associations tab.

Associations enable development organizations to improve information sharing, capture institutional knowledge, and
simplify regulatory compliance.

How does CollabNet TeamForge support documents?

A key element in a successful product development project is ensuring that stakeholders from all functional groups
are involved in an iterative document review and approval process, particularly for critical documents, such as
Product Requirements Documents.

It is also critical that any changes to key documents are recorded and the new information quickly communicated to
everyone concerned.

The CollabNet TeamForge Document Manager helps you manage your documents throughout their life cycle and
ensure the appropriate level of involvement of other project members. In addition to storing documents for reference
purposes, the Document Manager provides a document review work flow process to allow you to actively engage
other users in the review and approval of a document.

Simple notification process

If you would like to keep other CollabNet TeamForge users informed when the status of a document, such as when
a document is posted or updated, or there is a change in the contents or status of an existing document, but do not
require a formal review and approval process, the following steps provide a best practice for this level of document
management:

* Post the document to the Document Manager in the desired location. If you would like to prevent other users
from editing, moving, or deleting the document, use the 'Lock Document" feature. (If you choose not to lock the
document, any user with the document edit permission can edit and update the document.)

» Notify other users that the document is available and request that they begin monitoring it. All users monitoring an
item receive email notification whenever the item is updated.

Document work flow review and approval

In cases where more formal document review is desired, the CollabNet TeamForge Document Manager provides an
easy-to-use work flow process for managing a document’s review and approval.

After submitting a document, you can start a document review. You are prompted to provide the following
information:

* The names of all required and optional reviewers. (All reviewers must have permission to access the document.)
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» The date by which the review must be completed.
* Email message text.

You will be notified each time a reviewer submits review comments.

When selected to review a document, users receive an email notification with the relevant details and a link to the
document.

You can also choose to attach the document to the email notification. An item also appears in the Documents
Awaiting Review section of each reviewer’s My Page, including the due date.

A Submit a Response section is provided within the Document Manager where reviewers can enter their review
comments. Reviewers should be instructed to include "I approve this document" or similar text in the Submit a
Response section to indicate that they have approved the document.

All reviewers and the document submitter will be able to read the reviews of all other reviewers once they have been
submitted.

Which arbitrary HTML elements can | customize?

CollabNet TeamForge Snippets are customizable HTML text fragments that can be inserted in predefined locations in
CollabNet TeamForge pages.

Snippets can be added in the following locations:

* Below the page title on all CollabNet TeamForge templates.
* Above the footer on all CollabNet TeamForge templates.

Snippets get checked into the templates/html/ directory in the branding repository.
* The file name for the header looks like this:

<applicationname>-<actionname>-Top.html
* The file name for the footer looks like this:

<applicationname>-<actionname>-Bottom.html

For example, to put your own custom snippet at the top of the Tracker ViewArtifact page, name the file tracker-
viewArtifact-Top.html.

e Note: The file names are case-sensitive.
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e Tip: You can find the application name and the action name in the URL of the page you are customizing.
For example, consider a URL such as http://sf5latest/sf/sfmain/do/createProject.
Here, the application name is 'sfmain" (the main CollabNet TeamForge application) and the action name is
'createProject.” If this page had a custom snippet near the header, the file containing the custom snippet would
be templates/html/sfmain-createProject-Top.html.

sfmainf@gjcreateProject

Can I request a role?
If you are a project member in CollabNet TeamForge, you can request a role in your project.

You can use the Project Home > My Roles page to request for a role. Your request is submitted to the project
administrator for approval. You will receive an email notification when your request is either approved or denied.

Note: Based on your project administrator's discretion, some role requests may be granted immediately,
while the other role requests may need approval.
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Can | specify an alternate email address?

Yes, of course you can specify one or more alternate email address. CollabNet TeamForge supports user profiles with
one primary email address and up to three secondary email addresses.

The email address specified while creation of a user account is considered the primary email address. The alternate
email addresses are optional and can be specified while updating the user profile.
e Tip: To add your secondary email addresses, use the Admin > Users page to update your profile.

Why don't | have access to the "Reported in Release” information in my artifact?

If you cannot see the "Reported in Release" information in your artifact, ask your project owner to add the role
required to obtain access to this information.

Users with tracker artifact submit/view/edit permissions will not be able to see "Reported in Release" information in
an artifact, as it is directly associated with the File Releases section.

You can request that the project owner add a role permission of View Only for All Packages in File releases for you
to obtain access.

Moving to a CollabNet TeamForge project from a CollabNet Enterprise Edition project

If you have used the tools in CollabNet Enterprise Edition, you'll find the equivalent tools in CollabNet TeamForge
familiar.

Most of the tools and their functionality are similar between CEE and CTF 7.1. However, within each tool, some
work-around might have been done to bring over your CEE project information.

This table shows how tools in CEE map to CTF 7.1 tools:

CEE Tool CTF 7.1 Tool

Projects Projects

Category (Project) Category (Project Grouping)
Discussion Services Discussion

Docman Document

Issue Tracker Tracker

PCE PCE

Wiki Wiki

Project Tracker Project Tracker (Integrated Application)
Framework Roles and Permissions

SCM SCM

Remote Publishing Remote Publishing

Project Dashboard Project Dashboard
Announcements News

What is change management?

Change management is about monitoring and addressing work items, product defects, feature requirements, and
support requests.
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Do | have to use the administrator-given password always?
No, you don't have to use the administrator-given password beyond your first login into CollabNet TeamForge.
The site administrator may have provided you with a user name and password after creating your user account in

CollabNet TeamForge. When you login using those credentials, you might be asked to change your password for
security reasons. At this time, you can set a password of your choice.

e Tip: You will not be asked to change your password if you had created your own account, or if a password-
request had been raised for you or if an administrator had reset your password.

What software configuration management tools are available in CollabNet TeamForge
?
In CollabNet TeamForge, users can browse the contents of a project's source code repositories and view detailed

information about code commits, changed files, and associations with other CollabNet TeamForge items.

CollabNet TeamForge is not intended to replace your SCM tool. Code must be checked in using Subversion, CVS,
Perforce or GIT.

How do | create an artifact via email?
To create a tracker artifact using email Send an email message to <tracker id>@<TeamForge server>.

You can find the tracker id on the artifact list view page. Fields are mapped as follows:

* To: Tracker email address
* Subject: Artifact title

* Body: Artifact description
» Attachments: Attachments

| don't need the priority and assigned-to fields, how do | get rid of them?
These fields are used internally by the system and can not be deleted or disabled.

Why do the open tracker counts differ from when | filter on "Open"?

The "Open" category on the summary screen is based on the meta status "Open". It includes multiple statuses; Open,
Fixed, and any other statuses that are defined as equivalent to Open by the tracker admin for your project.

For example, suppose the Tracker Summary block shows 21 Open artifacts. However, when filtering on the "Open"
status, only five artifacts are displayed.

If you filter by "All Open" you will see all 21 issues with statuses defined as Open. If you filter specifically by
"Open" you will see only the artifacts that specifically have the status "Open".

Why can't | edit a document when it opens in my browser?

If you click on a document in TeamForge (for example, a Word doc), and it opens in your browser instead of
launching a separate MS Word window, chances are you will not be able to edit this document. The reason for this is
because your browser has either called one of the MS document viewers, which do not have native edit capabilities,
or the browser has "swallowed" the running MS Word process and the document has written to your %TEMP%
directory as a read-only file. You can either choose to download the file to your desktop and then click on it to edit, or
configure your browser to not swallow the application (this is described in various MS KB articles).
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Can I force files to be downloaded, rather than opened in the browser?

You can configure the application to force your users to download files, instead of letting them open them within the
browser.

Turning this mode on can prevent some of the more basic attacks on your other users. Simply
add the following line to /opt/collabnet/teamforge/sourceforge home/etc/
sourceforge configuration.properties:

sf.safeDownloadMode=all

' Note: This token can be updated only by the admin user.

Once the line is in place, simply restart TeamForge for it to take effect. The default for TeamForge sets this to none,
which means that the user's browser will present them with the normal Open/Save options when clicking on files.
When you set this to "all", that pop-up will be altered so that the user's only choice is Save. Should you wish, you can
also set this value to "html" to force the user to save only html documents, while allowing all other content to behave
as normal.

Why are some uploaded documents missing icons when displayed in TeamForge?

TeamForge has a small internal mapping of which icon is associated with which mimetype(s). This mapping is
necessarily small, as a complete mapping would be exceedingly large, and almost always out of date. You can
examine the mimetype that TeamForge is receiving by examining the document's attributes using our SOAP APIL
You can also override this mimetype info via the API by uploading a new version of the document (which can be the
exact same document contents).

There is sometimes a generic icon for documents from certain applications. TeamForge accepts and stores the
mimetype that the user's browser sends on the HTTP upload of the original document. As an example, let's examine
the MS Word document. Some browsers will send strings like application/vnd.ms-word; others will send
application/msword and others will send something completely different.

Can I link to documents outside of TeamForge?

TeamForge has the concept of a "url doc" to support this very usage. When creating a document in TeamForge,
simply choose this type from the Create screen and then enter the URL that references the document in the existing
external system. This will create a "placeholder" document in TeamForge that can be associated to, reviewed, etc as if
it were a normal document, while maintaining the document's actual contents in the external application.

Can | lock a document in TeamForge?
Absolutely, yes. You can specify a document as locked at any point in time (document create, document edit, etc).

You can do this via the normal UI or via the SOAP API. Simply check the Lock document box while in Edit
Document.

Does TeamForge automatically resolve conflicts in documents made by multiple
concurrent editors?

If you store your documents in CVS, Subversion, or some other SCM tool, then that tool will handle conflict
resolution per its normal means. However, if you are using the Document Manager component of TeamForge, then
there is no automated means within the product to prevent another user from uploading a newer version of a given
document that does not contain the changes you just uploaded. To prevent this, we recommend you use the document
locking feature of TeamForge to prevent others from editing a document you are editing.

Why can't | reply when someone comments on my review?

By default, TeamForge doesn't add the review initiator to a review, which would be needed to facilitate this. To work
around this, simply add yourself as an optional reviewer when creating the review. Alternatively, some customers
have chosen to create a forum in TeamForge, and then include the forum's posting address in the review notes.
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What document types are supported in TeamForge?

TeamForge supports all known and unknown document types. In fact, TeamForge makes absolutely no distinction on
a file type when uploading a document. This means that you can even upload binary files (like a Zip archive) into the
document manager. Note that while TeamForge will accept any incoming data stream as a document, it does use the
mimetype sent by the browser to determine if it has the proper icon to display for the document.

What is a document in CollabNet TeamForge?

For CollabNet TeamForge purposes, a document is any file that you track with a document artifact.

Any project involves some number of documents that have to be written, edited, reviewed and published. You
can use a document artifact to facilitate and standardize the work you do with documents. CollabNet TeamForge
automatically maintains the version history of each document, including the person who posted each version, its
status, and any version comments.

If you are the author, use the Review feature to track the process of getting others to evaluate your document.

To make sure everyone who needs to know about a document knows about it, associate it with a task, a code commit,
or another kind of artifact.

Why am | not able to access a folder in TeamForge documents?

You can access a folder in TeamForge documents only if you have permission for the folder or any of its parent
folders.

For TeamForge documents, users having permissions to the parent folder can access all subfolders. Users having
permissions to a subfolder can only view the hierarchy of the parent folders; they cannot access the documents in
those folders.

Why doesn't an open review automatically close when a new version of the document

is uploaded?
TeamForge doesn't automatically close a document review under any circumstances (new document version, review
due date passes, etc). This was a conscious decision on our part in which it was decided that TeamForge cannot
always be aware of the business rules or personnel availability at a customer. For example, TeamForge cannot know
that the one person whose document review input is most needed is on vacation for the four days the document was
under review. If TeamForge were to close the review, then it would disappear from the user's My Page. Additionally,
TeamForge cannot know that a new version of a document supersedes the prior versions (or that it doesn't supersede
it). You may be uploading a "draft" or "work-in-progress" of the new version as document review feedback is
received and if TeamForge were to close the review at this point, you might have received feedback from less than 1
percent of the reviewers.

| am unable to edit a specific artifact via email, but | can via the web Ul. Why is this?

There may be work flow rules applied to the tracker that require specific fields to be set. As you can only define the
artifact title and description via email, the artifact creation fails. If you wish to create artifacts in this tracker via email,
the tracker admin will need to disable these work flow rules.

In addition, you may not be able to edit artifacts belonging to a tracker via email, if the tracker has two mandatory
flex fields with parent-child relationship, but no default value relationship between the default values of the parent
and child flex fields. In such cases, it is recommended to always establish the default value relationship between flex
fields that have a parent-child relationship.

How can | monitor a forum or mailing list?

There are two methods for monitoring a forum or mailing list in TeamForge: At the Discussion Forum level and at the
My Workspace level.

At the Discussion Forum level:

*  Check the box beside the forum in question
* Select the Monitor button
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* Select "Monitor Selected"
At the My Workspace level

» Select Monitoring.

» Select the project name.

» Select the Monitored Applications tab.
* Select Discussions.

» Click Save.

.:_ Note: You must monitor a forum to receive email from the mailing list associated with that forum.

Why is TeamForge Explorer forgetting my settings and not logging me in?

Certain conditions can cause TeamForge Explorer to stop functioning properly and to start behaving oddly. This
can manifest itself as the app not logging you into TeamForge, or forgetting your settings, or other general strange
behavior.

To correct this behavior, you can delete your stored profile from within TeamForge Explorer.

If deleting the profile doesn't correct the behavior, try deleting the profile again, then uninstall and reinstall
TeamForge Explorer.

If that still doesn't fix it, delete the profile, uninstall TeamForge Explorer, and delete the registry key
HKEY CURRENT USERSoftwareVA ?SoftwareSourceForge ?ExplorerWindowsMainWindow (and
all subkeys). Then reboot, then reinstall TeamForge Explorer.

How do | export reports?

There are two ways of exporting reports data from the Reports Details page. You can export a specific report using
the Export button that is placed below the tracker report.You can also export all the tracker data using the Cross
Tracker Report button that is placed in the top right corner of the Reports Details page.

What is the file size limit on uploads or attachments in TeamForge?
TeamForge has a 2GB file size limit on uploads or attachments.

If you attempt to upload a file larger than 2GB using a Windows-based browser, you will not be able to upload the
file and you may not receive an error message.

How do | create a new forum topic?

A forum can have any number of topics. A topic start a message thread to which other users can reply. Create a new
forum topic to begin discussion of a new subject.

To create a forum topic:

Click Discussions in the project navigation bar. The Forum Summary page is displayed.

Click the title of the forum in which you want to create a topic. The Topic Summary page is displayed.
Click Create. The Create a Topic page is displayed.

Enter a description of the topic in the Subject field.

Enter the message text in the Message field. After the topic is created, other users can reply to this message.
(Optional) If you want to add an attachment to the topic, click Browse to select the file.

AR

Click Save. The forum topic is created.

How do | find the email address for a forum?

The email address for the forum is displayed on the Topic Summary page. If a mailing list is not enabled, you will
not see an email address on the Topic Summary page.

To find the email address for a forum:

1. Click Discussions in the project navigation bar. The Forum Summary page is displayed.
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2. Click the title of the forum in which you want to create a forum topic. The Topic Summary page is displayed.
The email address is listed in the Mailing List field.

How do I remove a user from a discussion?
Unfortunately there is not currently a way for a TeamForge admin to remove a user from monitoring. You will need
to have the user login and remove themselves from monitoring via the Monitoring button on the My Workspace
page.

How do | post a reply to a forum topic?

To post a reply to a forum message, follow the steps below.

1. Click Discussions in the project navigation bar. The Forum Summary page is displayed.
2. Navigate to the forum topic in which you want to post a message.
3. In the section containing the message you want to respond to, do one of the following:

* Click Quote to quote the original message in your response message. The Post a Reply page is displayed with
the original message quoted. Click Reply to omit the original message from your response message. The Post
a Reply page is displayed without the original message.
4. Enter the message text.
5. (Optional) If you want to add an attachment to the message, click Browse to select the file.
6. Click Save.

The forum message is now posted. Other project members can reply to it using the same process.

| can see the message | posted to a discussion in the web Ul, but I didn't receive any of
the responses via email. Why is this?

In order to receive form posts via email, you must monitor the forum. You can do this by placing a check next to the
forum you wish to monitor and choosing "monitor selected" from the Monitor drop down at the bottom of the Forum
list.

For more information on this see the section "Monitoring a folder" of the User Guide in the link below.

What is a discussion forum?

CollabNet TeamForge discussions provide workspaces where project members can work together online or by email.

Discussion forums and mailing lists are closely integrated. Forum administrators can choose to enable a mailing list
for each project forum. A mailing list extends the discussion forum functionality to allow project members to post
messages to the forum using email.

Discussion forums can be public or private, depending on the forum's objective and desired level of access into the
forum. Private discussion forums restrict anyone without specific access permissions from viewing or posting into the
forum.

In a moderated discussion, messages from anyone except "trusted" users are screened by a moderator before they are
posted. Messages posted by trusted users do not require the moderator's approval.

It's a good idea to use a discussion forum instead of direct personal email whenever privacy or security concerns don't
prevent it, even when the communication only involves two project members.

*  Members not directly involved often can make unexpected contributions if they are aware of the discussion.

» CollabNet TeamForge archives all news items, forum posts, and mailing list communications, so you can go back
and find valuable information later.

Why are some of the discussions threaded?

Posts that are sent the mailing list address of the discussion will create new topics, and hence will not be threaded.
Posts that are made in response to another post will be threaded beneath the original post.
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How can | import tasks into TeamForge Task Manager?

Tasks can be imported into the Task Manager by using the CollabNet TeamForge Task Management Plugin for
Microsoft Project

Can | associate objects of different projects?
Yes, you can associate an object (for example from document to subversion commit) in one project to an object in

another project if you have access or are a Site Admin.

You must have permission to view the object that you're associating with before you can associate with that object,
unless you are a Site Admin.

| deleted the email that verifies my CVS password. How can | retrieve my password?
You can sync up your TeamForge login and CVS passwords by changing your password in TeamForge:

1. Login and click on My Workspace.

Click on My Settings.

Click on Change Password.

Enter your old password and new password.
Click Submit.

AN

.:_ Note: The old and new passwords can be the same if you do not wish to actually change it.

Does CollabNet TeamForge support merge tracking?

The Subversion repositories that are installed with CollabNet TeamForge run on Subversion 1.5, which supports
merge tracking.

Any Subversion 1.5 servers you have integrated with CollabNet TeamForge support merge tracking. If you need the
merge tracking feature and your Subversion server is running a version earlier than Subversion 1.5, you must upgrade
to Subversion 1.5 to get this functionality.

If you used svnmerge . py (http://www.orcaware.com/svn/wiki/Svnmerge.py) to do merge tracking before
Subversion 1.5, and you want to convert your svnmerge . py data to the Subversion 1.5 merge tracking data format,
CollabNet provides a migration tool, linked below.

What happens when | post to a moderated discussion forum?

A message to a moderated discussion forum is held until a moderator acts on it. (Except if you are a trusted user.
These messages don't require moderation.)

» The moderators of the discussion receive an email notification that you have posted a message. The email
notification contains the URL path to moderate the post.

* A moderator can either approve or reject your message.

+ If the moderator accepts the message, the message status changes to "Accepted" and the message is posted to all
the users monitoring the forum.

» If the moderator accepts the message and trusts the sender, the message status changes to "Approved and Trusted"
and the message is posted to all the users monitoring the forum. All subsequent posts from you are automatically
approved.

» If the moderator rejects the message, he/she can include his’/her comments or reasons in the moderation rejection
email, and the message is removed from the archive.

* Inthe All Topics tab, an hourglass icon indicates which topics contain posts that await approval.

Who can be a moderator?
A discussion forum moderator is selected by the forum administrator.

* You can be a moderator by being a project member with forum post permissions.
* A moderator can moderate a discussion forum using emails or the web UI or one of the CollabNet desktops.
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If the mailing list isn't enabled for a moderated discussion forum, moderation can be done only through the web
UL

* A moderator can approve a message, approve a message and trust the sender, or reject the message.

e Note: To enable or disable moderation or add or remove moderators, you must be either the forum
administrator or project administrator.

How can I reduce the number of emails from monitoring a folder?

Monitoring a folder might spam the mailboxes with emails that are generated for every small change. Email
notification preferences under the Monitoring sub-tab under My Workspace can be modified to Send Daily Digest
Email, which provides a summary of the email alerts.

Go to My Workspace under the TeamForge toolbar
Click on Monitoring
In Edit Monitoring Subscriptions, click on Email notification preference

Pl ol S

For each project, the monitoring folders under various components (Tracker/File Releases/Tasks/Discussions/
Wiki) can be customized to Daily Digest Email.

How can | stay informed about events on my CollabNet TeamForge site?

To keep up with changes, you can be notified by an automatic email when an item you are interested in is updated.

Monitoring items lets you stay up to date automatically on all changes without having to log into CollabNet
TeamForge and check the status of each item.

You can monitor individual items, folders, and entire applications in each project for which you are a member.
You can configure the frequency of email notifications to suit your personal preferences, and suspend monitoring
messages entirely if you are out of the office or for any reason do not want to receive messages.

Items that can be monitored include:

» Entire applications, such as all tasks or all documents.

» Folders, such as task folders or document folders.

* All items in a tracker, forum, or package.

» Individual items, such as a task, a document, a tracker artifact, or a release.

You can tell by looking at each item whether you are currently monitoring it and how to begin or end monitoring it.

» For each item, list of items, or folder, you see a Monitor button or menu option.

» Ifyou are currently monitoring an item, the Monitor option is replaced by a Stop Monitoring option, and the
monitoring icon is displayed.

Whenever you create an item or edit an item, you automatically begin monitoring that item.
You do not receive monitoring notifications for your own changes to a monitored item.
If you have the appropriate permissions, you can see who is monitoring an item.

You can add other users to the monitored item. After a user is added to a monitored item, the user can continue
monitoring the item, configure monitoring preferences for the item, or stop monitoring the item.

Why would | want to make a discussion forum moderated?

Automated processes can only do so much to protect forum quality. Moderated posting can be thought of as a
temporary transfer of control from automated processes to a human decision maker.

Software can instantly analyze an email to determine whether the sender is allowed to post messages directly to the
list or if the message should be sent for moderation. However, the software doesn't recognize the sender as a person
who participates in the organization, nor does it have the sophistication needed to determine whether the message
contents are on-topic for the mailing list.

Advantages of moderated posting:
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» Moderators help keep content on-topic by rejecting off-topic messages and providing helpful suggestions to users
whose posts are rejected.

* Moderators help maintain a positive environment for list users by rejecting messages containing harsh or abusive
language.

*  Moderators can allow deserving nonmembers to post to lists that are ordinarily closed to nonmembers.

* Moderators prevent spam.

Example

Ashish makes the development forum in his project a moderated one as he wants to make sure that all the messages
posted to the discussion come to him for approval before they're included in the forum. When a message arrives, he
reads the message, and if it's appropriate for the discussion, he accepts it; if not, he rejects it.

Over time, Ashish finds that the traffic in his discussion has increased and he is no longer able to moderate all the
posts by himself. So he adds a couple of other senior developers in his project as moderators, who can share the
responsibility of moderating the forum.

After a while, Ashish realises that he doesn't have to reject any messages posted to the forum as everyone seems

to understand the purpose of the forum and uses appropriate language in emails. So he removes the restriction and
make the forum an unmoderated one. Now Ashish and the other moderators no longer receive emails for approval
when a user posts a message to the discussion. Messages are directly included in the forum and delivered to the forum
subscribers.

Is it possible to move an artifact from one tracker to another?

Yes. Simply use the cut button to remove the artifact, then paste it to another tracker. You can also change the tracker
type while editing the artifact using the Edit Artifact page. The destination tracker need not be in the same project,
but if the tracker definitions differ data could be lost.

Can I move a discussion to another project?
No. Discussions cannot be moved between projects.

For more information see: Discussions and mailing lists

How can | change the display order of the fields in my tracker?
Simply drag and drop the fields within your browser. Horizontal rules may also be added in this manner.

How do | find the version of my MS Project plugin?

To obtain the plugin version, select SourceForge>Synchronize, and when the login pops up, hoveri the mouse over
the SourceForge masthead. A tooltip will pop up with the component version numbers.

The version we're interested in is SFProject. DLL. It will show something like:

V2.1.1699.19433

Synchronizing my project plan, why do | get the error "Unable to check for pending
changes"?
This error indicates that at some point after importing your project into TeamForge, you went into TeamForge and
deleted the top-level task folder that was imported.

Once imported, meta data is added to your project file in MS Project that indicates which item ids are inside
TeamForge that correlate to the items within your project plan. By deleting the top-level task folder, the
synchronization method can no longer determine which items in TeamForge correspond to the items within your
project plan. Hence, it cannot determine if there are pending changes. To correct this issue, open MS Project, access
the Tools menu, and then select Unbind from the TeamForge options. This will remove the meta data from your
project plan, effectively returning it to a pre-import state. You should now be able to re-import into TeamForge
without error.
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How can | access the native install version of TeamForge? | can only find the VMWare
version.

You will need to contact your account manager; the TeamForge VMWare license does not include access to native
install media.

How do | create a parent/child artifact?

A tracker artifact can be a parent or a child to another artifact.

» A child artifact can have only one parent.
* A parent artifact can have any number of children.
* A parent artifact cannot be closed if a child is open.

To create a new parent/child artifact of an existing artifact:

1. Click on the Dependencies tab of the artifact.

2. Click on Create New Parent or Create New Child. Fill in the form as you would for submitting an unrelated
artifact.

Click Next.
. Enter a comment that describes the relationship, if appropriate.
. Click Finish.

oA W

.:_ Note: If Choose Parent or Create New Parent is not visible, the artifact already has a parent artifact.

How do | put a notice to my users on the project home page?

To do this you will need to create a news item within the project. News items are posted and displayed on the project
home page. News items are also displayed on the TeamForge home page.

To post a news item:
1. Navigate to the home page of the project in which you want to post the news item.

* From within the project, click Project Home in the project navigation bar.
* From anywhere in TeamForge, choose the project from the Projects menu in the navigation bar.
2. In the Project News section, click Add. The Create News Post page is displayed.
3. Enter a title for the news item.
4. Enter the text for the news item in the message field (up to 4000 characters including spaces), then click Add.

The news item is submitted. It is displayed on the project home page and the TeamForge home page immediately.

What is an agile project team?
As a member of a project team, you implement product features according to user stories created by the product
owner and planning input from the project leader.

Project team members must use their experience and judgment to estimate the effort involved in work that's been
specified by the product owner and the project leader. These estimates will often lead to changes in the product scope
and the project plan. In that sense, project team members are an important part of the agile planning process.

The project team members may be known as developers, programmers, engineers, individual contributors, or
something else that's appopriate to the type of work being done.

In TeamForge, the project team member's main focus is the tracker. Project members can manage and track their work
by observing and maintaining tracker artifacts such as user stories, defects, or tasks.

What is a release?
A release is a group of one or more files that are published as a unit.

Each release can have a maturity level attribute to describe its state of completeness. Maturity levels are predefined
and include development build, alpha, beta, and general availability.
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The CollabNet TeamForge file release system enables users to publish files and groups of files to selected audiences.
Using role-based access control, administrators can control which project members can access each package or
release.

How do | remove a news item?

You can delete any news item that you no longer want displayed on the project home page. Deleting a news item from
a project also deletes it from the TeamForge home page.

To delete a news item:
1. Navigate to the project home page.

* From within the project, click Project Home in the project navigation bar. From anywhere in TeamForge,
choose the project from the Projects menu in the navigation bar.

2. In the Project News section, click Delete next to the news item that you want to delete. When prompted, confirm
that you want to delete the news item, and it will be deleted.

What kind of objects can | create reports on?

Reports can report on data from trackers and tasks. Task reports can report on data in a single project or across
multiple projects. Tracker reports can report on data in a single tracker or across multiple trackers in a project.

How do user roles work?

Project administrators can define specific access permissions for individual project members. They do this by using
global project roles and/or creating roles and assigning the roles to project members.

Under role-based access control (RBAC), permissions are not assigned directly to an individual user. Instead, each
user has the permissions that are attached to any role that is assigned to that user.

A project member can be assigned multiple roles.

In CollabNet TeamForge, site or project administrators assign roles to the site users or project members. Besides this,
a project member can submit a role request to the project administrator. The project administrator can approve or
reject such requests.

When you define users, user groups and roles with specific permissions in one project, they can be inherited in one or
more subprojects. This helps you avoid duplicating the effort of defining users, user groups and roles across projects.

e Note: Permissions are cumulative. If a project member is assigned a role that provides a specific permission,
and another role that does not, the user has that permission.

A role defines these things:

» The applications that project members with that role can and cannot access.
* The resources on which project members with that role can use the applications.
» The actions that project members can take in each application and on each resource.

.:_ Note: If a user has an SCM license, that user can see only the tools that support the core source control
functions of the site, even if the user has a role that would otherwise grant access to other resources.

When a user's roles do not include access to an application or resource, that application or resource is not visible to
that user. For example, imagine that you are assigning roles to Jason, a software developer. Jason needs to check
source code in and out in order to fix bugs, develop features and create software releases. However, Jason does not
need access to the wiki. If you set up Jason's roles according to those requirements, Jason's experience is like this:

» On any page in the project site, Jason can see and click the Trackers, Source Code, and File Releases buttons
along the top of his screen.

« Jason does not see the Wiki button.

» If someone sends Jason a link to a page in the Wiki application and Jason clicks the link, he gets an error message.
(The message does not specify whether the page exists or not.)
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*  When he accesses the project directly from Eclipse or Visual Studio, Jason can expand the project node and
browse the Trackers, Source Code, and File Releases nodes, but not the Wiki node.

e Note: A user's license type also influences what the user can see and do on your site. A user's license type
supersedes any role assignments.

* An ALM license enables the user who holds it to use the full range of TeamForge features: both the core
source-code management tools and the extended application lifecycle management functionality.

* An SCM license enables the user who holds it to use the core TeamForge source-code management tools.

Ask your site administrator how many licenses of each kind are available for your users.

Applications

An application is a collection of related features designed to enable a user to collaborate on particular kinds of tasks.
For example, the Documents application helps users create documents, share in document reviews, and publish
documents, among other things.

In the Web interface, each application is represented by a button in the navigation bar at the top of any project page.
A given user can see the buttons corresponding to applications they have access to by virtue of the roles assigned to
them.

Applications are also known as "tools."

Resources

» The tracker application might contain a bugs tracker and a feature request tracker. These are the tracker resources.
* A project can contain multiple SCM repositories. These are the SCM resources.

Permissions

View Allows users to view and download items, but not
to create or edit items, administer folders, or edit
application settings.

Create or Submit Allows users to create new items, but not to edit items,
administer folders, or edit application settings. Users
with the create or submit permission also have the view
permission.

Edit Allows users to edit items, but not to administer
folders or edit application settings. Users with the edit
permission also have the view permissions.

Administer Allows users to create and edit items, administer folders,
and edit application settings. Users with the administer
permission also have the edit, create or submit, and view
permissions. To delete items, the user needs to have the
delete permission.

Delete Allows users to delete items, but not to administer
folders or edit application settings. Users with the delete
permission also have view permissions. Without the
delete permission, users with the administer permission
are not allowed to delete items.

How do | save a report so | can run it again later?
In order to save a report for later use, you will need to define the report criteria and save it in a report template.

To save a report template:
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1. Click Reports in the project navigation bar. The List Reports page displays a list of existing report templates.
2. From the drop-down menu, choose a type of report template, then click New. The Task or Tracker Report
Criteria page is displayed. Available report types are:
» Task Report - Reports on the numbers of tasks assigned to each user.
» Tracker Report- Reports on the numbers of artifacts submitted to selected project trackers.
3. Select your desired report criteria. The fields on the Report Criteria page differ for each report type. Click
Generate Report.

The report results are displayed and the template is saved.

Can | subscribe to a CollabNet TeamForge discussion forum's mailing list through an
email?
Sure, you can subscribe to a discussion forum's mailing list to keep up with changes, via an email. When you

subscribe or monitor a discussion forum, you are notified by an automatic email whenever there is any update to the
discussion.

To subscribe to a mailing list: You can subscribe to the discussion forum's mailing list by sending an email to
<mailing list name>-project name-subscribe@<domain>.

You must have the "Discussion: view" permission to be made a subscriber. Check with your forum administrator, if
you do not have the permission.

As with other items that you may be monitoring, the discussion forum to which you subscribe via an email is also
added to the My Workspace > Monitoring > Monitored Objects list. Your user name is added to the "Users
Monitoring" list of the discussion forum. Both these entries are removed when you unsubscribe from the mailing list.

To subscribe in digest type, send an email to <mailing list name>-project name-digest-
subscribe@<domain>

To unsubscribe from a mailing list: You can unsubscribe to the discussion forum's mailing list by sending an email
to<mailing list name>-project name-unsubscribe@<domain>.

What is a task dependency?

Task dependencies show what must be done before a given task and what will be done after the task is complete.
Project managers can create dependencies between any two or more tasks in a project.

Task dependencies allow you to establish relationships between tasks. This can help to frame a task in the context of a
larger project plan.

There are two types of task dependencies:
*  Predecessors are tasks on which another task depends.

For example, before you can complete the task "Finalize project plan," you might need another project member to
complete the predecessor task "Hire new staff."
*  Successors are tasks that depend on your task.

In this example, "Finalize project plan" is a successor task to "Hire new staff."
e Note: Task dependencies and tracker artifact dependencies are different things.

» For tracker artifacts, an artifact with dependencies (a "parent" artifact) can't be considered closed unless all
of its dependent artifacts ("children") are closed.

* For tasks, a dependency means one task can't start until another task is completed.

.:-_ Important: A task cannot be dependent on itself. You cannot make a task both a predecessor and a successor
to another single task. If you attempt to do so, you will receive a circular dependency error.
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Why can't | synchronize between Microsoft Project and CollabNet TeamForge?

Some conditions, such as having tasks that are pending change approval in CollabNet TeamForge and Microsoft
Project, cause synchronization to fail.

Tasks pending change approval

If you have tasks that are pending change approval in CollabNet TeamForge , you will receive warnings during
synchronization. Address any pending change requests, then try your synchronization again.

Tasks with no start or end date and dependencies

If you have a task that has either no start or no end date, and one or more dependencies, you will receive warnings
that you're unable to synchronize. Add the missing date or remove the dependencies, then try your synchronization
again.

Milestone dependencies

Milestones with either predecessor or successor dependencies on other milestones or on regular tasks will cause
synchronization errors. To remove these errors, remove the milestone dependencies in your Microsoft Project plan,
then try your synchronization again.

Non task-to-task dependencies

All dependencies must be task-to-task. Predecessor or successor dependencies between a task and a task folder, a task
and a critical or milestone task, or any combination thereof, will cause synchronization errors. To remove these errors,
remove all non task-to-task dependencies, then try your synchronization again.

Non finish-to-start dependencies

All dependencies must be finish-to-start. Microsoft Project supports other types of dependencies, such as start-to-start;
however, these are not supported by CollabNet TeamForge and will cause synchronization errors. To remove these
errors, remove all non finish-to-start dependencies, then try your synchronization again.

Missing journal file

A Microsoft Project journal file is created automatically with each Microsoft Project file that you synchronize

with CollabNet TeamForge Enterprise Edition 4.4 and later versions. If this file is missing, you will receive
synchronization errors or data loss. To remove these errors, locate the journal file and copy it into the same directory
where your Microsoft Project file is saved.

Why are Microsoft Project and CollabNet TeamForge doing things | don't expect?

When you synchronize Microsoft Project and CollabNet TeamForge, in some conditions the tool works as designed
but the behavior might seem unexpected. For example, an empty task folder in CollabNet TeamForge creates a blank
task in Microsoft Project.

Why are there blank tasks in Microsoft Project?

If you have an empty task folder in CollabNet TeamForge, Microsoft Project creates a blank task when
synchronizing. This is because Microsoft Project does not have the concept of a task folder, only a parent task. The
blank task remains only until you add one or more tasks in the folder.

How are task dependencies handled?

Microsoft Project enforces stricter dependency handling than CollabNet TeamForge does. If you use CollabNet
TeamForge dates that conflict with Microsoft Project dependency handling, Microsoft Project adjusts your dates
during synchronization. For example, CollabNet TeamForge allows you to have a task end date later than the start
date of a successor task. Microsoft Project does not, and adjusts the start date of the successor task.
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Are dependency constraints supported?

Synchronization does not support dependency constraints. For example, consider a scenario where the start date of
a successor task equals the end date of a predecessor task plus x number of days. If you change the end date of the
predecessor task in CollabNet TeamForge , and then synchronize, Microsoft Project does not adjust the start date of
the successor task until the end date of the predecessor task runs up against this start date.

.:_ Note: This is contrary to the cascading dependency handling behavior in CollabNet TeamForge.

Are zero-duration milestones synchronized?

Zero-duration milestones in your Microsoft Project plan are not synchronized with CollabNet TeamForge. They
remain in your Microsoft Project plan, but do not generate CollabNet TeamForge tasks. Only milestones with start
dates, end dates, and no dependencies, get synchronized with CollabNet TeamForge.

Does synchronization support removal of dependencies?

In your Microsoft Project plan, if you change the start date of a task that has predecessor dependencies, you are shown
a popup window asking whether you want to retain the dependency. You must exit the popup window and remove

the dependency manually in order for the change to be synchronized with CollabNet TeamForge. If you remove the
dependency using the popup window, it could result in synchronization errors.

Are multiple resource assignments supported?

Microsoft Project allows you to assign a task to multiple resources, and to specify the percentage of time each
resource will spend on the task. CollabNet TeamForge supports only single-resource assignment per task. If you
have more than one resource assigned to a task in Microsoft Project, with or without percentage allocations, this
information gets removed during synchronization. The task is assigned 100 percent to the first resource specified.

Are Gantt chart changes recognized?

Microsoft Project allows you to manipulate task start and end dates by dragging the task bars on the Gantt chart. Task
changes made in this way are not recognized by CollabNet TeamForge and are not synchronized.

Are task notes synchronized?

No, task notes entered in Microsoft Project are not synchronized.

How is task duration handled?

Microsoft Project allows you to have a task duration specified in hours. When synchronizing, any task with a duration
in hours is rounded up to the nearest whole day.

What's the difference between an ALM user license and an SCM user license?
The type of license you have determines what you can do on your TeamForge site.

Your site administrator has assigned you a site license. Your license is of one of two types:

* An ALM license enables you to use the full set of tools on the site, including Source Code, Trackers, Documents,
Tasks and Reports.

* An SCM license enables you to use the site for basic source code management. You can browse repositories and
participate in Wiki conversations.

If you had an account on a TeamForge 5.3 site or earlier, you automatically have an ALM user license.
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Why do | get a TeamForge system error in the project template creation page?

This may be because of a few stale permissions in the project in which you are trying to create the template. You can
resolve this by identifying and deleting the stale records using this SQL.

select role id from role operation ro left outer join ia project association
ia

on (ro.resource value = ia.id) where ia.id is null and resource value like
1o o . - -
Sprpls' ;

select role id from operation cluster ro left outer join

ia project association ia

on (ro.resource value = ia.id) where ia.id is null and resource value like
19 o . - —
sprpls' ;

What fields can | use in a tracker?

You can use fields provided by TeamForge, and you can create your own custom fields. Most trackers use a mix of
TeamForge-provided fields and user-defined fields.

TeamForge-provided fields
Some fields are provided by TeamForge for all trackers.

System-defined fields: Some TeamForge-provided fields are always present in every tracker. These are identified as
"system-defined" fields in the field list.

* The Artifact ID, Title, and Description fields are system-defined fields. They are always present and always
come first when you view an artifact.

» Some system-defined fields can be reordered. For example, the Priority and Assigned To fields are system-
defined fields, so they are always present, but you can move them around in your tracker's display.

Configurable Fields: Some fields are available for any tracker, but can be modified in different ways. These are
called "configurable" fields.

» Any configurable field can be a required field. When a field is required, a user can't submit an artifact without
providing a value for that field.

* Some configurable fields can be disabled. When a field is disabled, TeamForge does not store data for it or
include it in calculations. For example, the Reported in Release ficld is meant for tracking bugs, so you may
want to disable it for a tracker that's for user stories. But the Status field is important for any tracker, so it can't be
disabled.

» For some configurable fields, you can specify whether users see the field when they submit an artifact.
» Some configurable fields need values for users to choose from. You have to provide those choices.
* You can set the width and height of configurable text fields.

User-defined fields

When none of the TeamForge-provided fields captures exactly the information you need to track, you should create
a field tailored to your own needs. Such fields are identified in the field list as "user-defined" fields. See Create your
own tracker fields on page 29 for details.

What is a tracker?
A tracker is a collection of records that follow the development of a unit of work from conception through to

completion. You can create a tracker to manage almost any kind of work that your project calls for.

In each CollabNet TeamForge project, you can create any number of trackers. Each tracker tracks a different type of
data.
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For each tracker, you can define values for status, category, and other default fields. You can create your own fields
to capture additional data that is specific to your project or organization. You can also create tracker workflows to
specify the criteria necessary for users to change tracker status values.

Individual tracker entries are referred to as tracker artifacts. The role-based access control system enables you to
control which project members are allowed to view, create, and edit tracker artifacts.

Summary information about the number and status of project tracker artifacts is provided on each project's Tracker
Summary page. The Project Dashboard also provides an at-a-glance overview of the status of each project member's
projects, including information on the number and status of the tasks and tracker artifacts in each project, and project
overrun and underrun statistics.

What is tracker work flow?
To help users handle their tracker items effectively, you can set up some work flow rules. Workflow rules require a
user to do something to a tracker before they can reassign it or update its status.

Administrators can define these kinds of work flow rules:

Status transitions that a user can make based on an  For example, if an artifact is Open, you can specify that
artifact's current status. it can be changed to Pending or Cannot Reproduce, but
not to Closed.

Status transitions that a user can make based on his  For example, if an artifact is Pending, you can specify
or her role. that only users with the role QA Engineer can change it
to Closed.

Field values that a user must provide when making a  For example, if an artifact is Closed, you can specify

specific status change. that a user must enter a comment in the Comments field
before changing the artifact's status to Open. You can
also require an attachment.

You can create a work flow for each combination of tracker status values in a tracker.

What is an activity table component?
An activity table is a special kind of text component that gives project members quick access to a focused set of

artifacts, action items and work products.

An activity table includes organized links to up-to-the-minute information about work that is going on in the project.
You can add, remove or change these links with the HTML editor that comes with every text component.

You can add static links to particular artifacts, or you can link to a search query. When you link to a query, you enable
project users to get all the results of the query with a single click.

The activity table template is just a suggestion for how you might want to organize your information. You can change
any of its properties to support the way your project members work.

What is a project page component?

A project page is a collection of simple portlet-like components that enable you to add custom HTML content,
reports, project tracker queries, and much more to the project home page so your team quickly access what is
important.

For more information, see the following topics:

* Reorder a project page component
» Delete a project page component
* Rename a project page component


http://help.collab.net/index.jsp?topic=/teamforge710/action/reorderprojectpagecomponents.html
http://help.collab.net/index.jsp?topic=/teamforge710/action/deleteprojectpagecomponent.html
http://help.collab.net/index.jsp?topic=/teamforge710/action/renameprojectpagecomponent.html

What is TeamForge?

| Frequently asked questions about CollabNet TeamForge 7.1 | 222

CollabNet TeamForge integrates software configuration management (SCM), continuous build and test, issue
tracking, project management, lab management, and collaboration tools into a single Web-based application lifecyle
management platform that empowers distributed teams to deliver great software.
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What is a project? on page 228

Watch for changes on page 82

Join a TeamForge site

CollabNet Desktop - Microsoft Windows Edition

10 CollabNet Desktop - Eclipse and Visual Studio Editions
11. Help for project managers

© ® e

12. Work on tasks on page 32

13. Manage source code on page 65

14. Plan and track anything on page 14

15. Build and test your software on page 78

16. Provision hardware on page 70

17. Release products on page 79

18. Reporting on page 112

19. Participate in discussions and mailing lists on page 54
20. Contribute to the project wiki on page 62

21. Document your work on page 45

What is a wiki component?
A wiki component lets you link to an existing wiki page from a project page.

Which role is assigned to me?

There are several ways in which you could have been assigned certain roles in CollabNet TeamForge. Your access to
the projects depends largely on the permissions granted to you via your roles.

You could have been granted access to any CollabNet TeamForge project in any of the following ways:

* Through site-wide roles (assigned directly to the user)
» Through global project roles (assigned directly or inherited via another project, either individually or as a group
member)

» Through project roles (assigned directly or inherited via another project, either individually or as a group member)
» Through permission inheritance (via project hierarchy)

There are two ways you can check which roles are assigned to you in any of your projects:

.:-_ Note: If you are a site administrator, you can view any user's access rights to the system.

To view the roles assigned directly to you:
Use the My Workspace > Projects page and click the My Projects tab.

e Note: You can click the role to view the folder-level permissions assigned to you in a project.

To view all the roles assigned to you:
Use the My Workspace > My Settings page and click the Roles tab.

You can select Roles Created For a Project, Roles Inherited From a Parent Project or Site-wide roles to view the
corresponding roles assigned to you.

.:-_ Note: A global project role that has been assigned to you in a project where you are a direct member will be
listed as a directly assigned role.

.:-_ Note: You can click the role to view the folder-level permissions assigned to you.


http://help.collab.net/topic/cndesktop-win/action/vsdesktop_CTF.html
http://help.collab.net/topic/cndesktop-eclipse/action/vsdesktop_CTF.html
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Who can work with documents?
Any project member with the Document Edit permission can edit a document.

Why would | attach things to a wiki?

The most common example of when you would attach something to a wiki would be when you need an image in
the wiki page and you're concerned that if the image is hosted remotely (a corporate web server, for exampe), it
might be moved or removed. Additionally, you might wish to attach a file to a wiki page if the attachment is only
truly important in the context of the wiki page and therefore isn't important enough to be uploaded to the Document
Manager of TeamForge.

How do | delete an attachement from a wiki page?
Use the steps below to delete an attachment.

» Browse to the wiki page that contains the attachment and click Edit.

» Update the wiki page, even though you've not made any changes to it.
* Click Show Details.

* Click the Attachments tab.

» Select the attachment you want removed and click Remove.

| set my project to "use wiki homepage" so why isn't my wiki showing up?
TeamForge currently uses two distinctly different wikis. There is the wiki you've already edited, which is available
by clicking on the Wiki button at the top of any project page, and there is the "project home" wiki, which is what
you enabled in the Project Admin screen. If you visit the project home page after setting this option, and you have
the proper RBAC permissions, there should be an Edit button in the bottom-right corner of the home page under the
graphs. Use this button to edit the project home page wiki.

How do | edit the wiki 